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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-0206.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Chapter 1. Welcome to applications

In the WebSphere Application Server environment, the components making up a Java 2 Platform,
Enterprise Edition (J2EE) application are referred to as application modules, specifically:

* Web modules

* Enterprise JavaBeans (EJB) modules

» Client modules

After you assemble modules into a main module called an application module or EAR file, you are ready
to deploy the application module onto the application server.

You can deploy both Web and EJB modules as stand-alone applications. A J2EE application is generally
comprised of all three application modules, each deployed in its own container that is provided by the
application server that you have configured. The following diagram depicts how the application modules
interact across the three-tier architecture of enterprise computing:
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1 ' 1
Client modules , :: :
1 1
: ¥ :
Applet client Web modules : EJB modules : : Databases, :
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N S 1 ' o i
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~ Y
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WebSphere o .
Application Server Application client

container

The diagram does not depict interaction between Web modules and the thin application, pluggable, or
J2EE application client because it is a rare requirement. Applications that use these client types, however,
can incorporate Web modules. The product provides different levels of support for the requirement,
according to client type. Refer to articles specifically on your for more information.

Web modules

A Web module consists of the following components, in varying combinations (corresponding to the

application client requirements, security requirements, and so on):

» HyperText Markup Language (HTML) pages and JavaServer Pages (JSP) supply the user interface and
program logic.

» Servlets coordinate work between these components and business logic.

© Copyright IBM Corp. 2004 1



You create a Web module bylets, JSP files, and static content such as HTML pages into
deploy,

a single deployable unit. You can then [deploy] the Web module as a stand-alone Web application, or
combine it with other modules to create J2EE applications.

Whichever application type you deploy, you have the option of activating Session Manager for your Web
module. By using this service to|manage HTTP sessions} you can personalize Web pages for individual
users. A session is a series of requests to a servlet, originating from the same user at the same browser.
Managing HTTP sessions allows servlets running in a Web container to keep track of individual users.

For example, a servlet might use sessions to provide "shopping carts” to on-line shoppers. Suppose the
servlet is designed to record the items each shopper indicates he or she will purchase from the Web site.
It is important that the servlet be able to associate incoming requests with particular shoppers. Otherwise,
the servlet might mistakenly add choices of Shopper 1 to the cart of Shopper 2.

EJB modules

EJB modules are combinations of enterprise beans, which perform various roles in retrieving data from the
Data and Resource tier and running business logic in a J2EE application. You also can deploy an EJB
module as a stand-alone application (refer to [Chapter 31, “Deploying and managing applications,” on page]

for the necessary steps).

Version support

IBM WebSphere Application Server provides broad support for enterprise beans, including the Enterprise
JavaBeans (EJB) 2.0 specification. The EJB 2.0 specification introduces a container-managed persistence
(CMP) 2.0 component model, which provides a number of improvements to aid developer productivity and
application performance. In addition, this product continues to fully support enterprise beans written to the
CMP 1.1 programming model and deployed in previous versions of this product; applications can use CMP
1.1 beans, CMP 2.0 beans, or a mixture of both. CMP 1.1 beans can be directly carried forward in an EJB
1.1 ejb-jar module or may be repackaged and combined with CMP 2.0 beans in an EJB 2.0 module.

Several excellent trade books that cover the latest EJB specification and the CMP persistence model are
already available. A good way to locate some of these is to visit your favorite online bookstore and search
on the term Enterprise JavaBeans. For a more basic orientation, see [‘Enterprise beans: Resources for|
learning” on page 133/

Innovations for EJB development

For EJB 2.0 modules, a feature introduced in Version 5 of this product, called access intent policies,
eases the management of interactions between CMP beans and their underlying data stores. Each policy
sets such data access characteristics such as access type (read or update) and transaction isolation that
affect the locking of resources, letting you choose the level of data integrity and performance for your
application.The Integration Server product adds APIs to enable you to further customize IBM-provided
access intent policies for your particular environment.

Your application development can also include asynchronous messaging, which the product supports as
a method of communication based on the Java Message Service (JMS) programming interface. The base
JMS support enables IBM WebSphere Application Server applications to exchange messages
asynchronously with other JMS clients by using JMS destinations (queues or topics). An application can
explicitly poll for messages on a destination.

The product also provides a message listener service that applications can use to automatically retrieve

messages from JMS destinations for processing by message-driven beans, without the application having
to explicitly poll JMS destinations.
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The Integration Server product provides extended messaging, which uses the EJB container to manage
the messaging infrastructure, and provides more types of messaging beans. This enables application
developers to concentrate on the business logic for enterprise beans and to leave the messaging usage to
messaging objects and configuration of the EJB container.

For information about the types of enterprise beans, see the |Enterprise beans articlel.

Client modules

WebSphere Application Server supports multiple models of a client module, each suitable for different
types of applications. For example: the various dependencies of the models on Web modules for access to
business logic can accommodate different client-side requirements for deployment. If a developer wants to
create an application requiring no initial code deployment to client machines, an appropriate client module
choice is the applet client. This client receives the necessary application code through download from
HTML pages.

Most models of a client module are only available when you install the product. For a list of supported

products and version information, see the [Supported Prerequisites Web site]

[ActiveX application client]

WebSphere Application Server provides an ActiveX to EJB bridge that enables ActiveX programs
to access WebSphere Enterprise JavaBeans through a set of ActiveX automation objects.

W2EE application client
The J2EE application client programming model provides the benefits of Java TM 2 Platform for
WebSphere Application Server Enterprise (J2EE).

|Pluggable application client| (Windows platforms only)

The pluggable application client is a thin application client that uses the Sun Java run-time
environment (JRE) instead of the IBM JRE environment.

Note: The Imaginary Buffer Line product provides a CD-ROM and installation program for installing
application clients without installing the entire application server. This smaller footprint is useful if
you want to run client applications on multiple client machines. For more information, see
lapplication clients|

Web services

Web services are services that you use over the Internet. If you have an existing application, and you want
to make the service that your application provides available to others - either within your own organization
or beyond it - you can use Web services technologies to provide a standard Web interface for your
service. Used in this manner, Web services can be defined as middleware. You can connect applications
together no matter how each application is implemented or where it is located.

Middleware is not new, but what is new is Web services technology and its power to connect by using
open standards. Web services operate at a level of abstraction that is similar to the Internet; they can work
with any operating system, hardware platform or programming language that can be Web-enabled.

The core technologies on which Web services are developed and implemented include:

. (Extensible Markup Language). XML solves the problem of data independence. You use it to
describe data, and also to map that data into and out of any application or programming language.

. |Web services for Java 2 platform, Enterprise Edition (J2EE)| specification defines the programming
model and run-time architecture for implementing Web services based on the Java language.
WebSphere Application Server Version 5.0.2 and 5.1 supports Web Services for J2EE Version 1.0. If
you want to know how to implement a Web service interface to an existing application, then deploy your
Web service within the application server, see [Using Web services based on Web Services for J2EE]
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Pava API for XML-Based RPC (JAX-RPC)| enables you to develop SOAP-based interoperable and

portable Web services and Web services clients. WebSphere Application Server Version 5.0.2 and 5.1
supports JAX-RPC Version 1.0.

(Web Services Description Language). You use this XML-based language to create a description
of an underlying application. It is this description that turns an application into a Web service, by acting
as the interface between the underlying application and other Web-enabled applications. WebSphere
Application Server Version 5.0.2 and 5.1 supports WSDL Version 1.1.

(Simple Object Access Protocol). SOAP is the core communications protocol for the Web, and
most Web services use this protocol to talk to each other. WebSphere Application Server Version 5.0.2
and 5.1 supports SOAP Version 1.1.

[SOAP with attachments API for Java (SAAJ )|is used for SOAP messaging that works behind the

scenes in the Java API for XML-based RPC (JAX-RPC) implementation. You can also use this API to
directly write SOAP messaging applications rather than using JAX-RPC. SAAJ allows you to do XML
messaging from the Java platform by making method calls by creating, sending and consuming XML
messages over the Internet. WebSphere Application Server Version 5.0.2 and 5.1 supports SAAJ
Version 1.1.

WebSphere Application Server also provides other mechanisms that can help you get the most out of your
Web services:

|A private Universal Description, Discovery and Integration (UDDI) registryl

A private UDDI registry provides a way to publish and discover information about Web services
that are available within and through your organization. You can use it to make your Web services
available to people within your organization, or beyond your organization. A group of companies
can use it to share their Web services, or to make them available to others outside the group. At
its simplest, a private UDDI registry does for Web services what a business telephone directory
does for business addresses and telephone numbers (however a private UDDI registry is much
more than just a directory - as it needs to be to harness the considerable power and flexibility of
Web services). If you publish your Web service to UDDI, you make it available for other people or
applications to discover and reuse. This saves development time, effort and cost, and helps
minimize the need to maintain several different implementations of the same application.

You publish your Web service to UDDI after you have deployed it to the application server.

IA Web Services Invocation Framework (WSIF)|

SOAP bindings for Web services are part of the WSDL specification. So when you think of using a
Web service, you probably think of assembling a SOAP message and sending it across the
network to the service endpoint, using some SOAP client APl. The WSDL specification allows for
extensibility points which can describe alternate ways of invoking a Web service. A WSIF client
can make use of these non-SOAP descriptions to invoke a service in a more efficient way. For
example, a Web service provider might offer a SOAP binding for the service and a local Java
binding that allows you to treat the local service implementation (a Java class) as a Web service.
If the client is deployed in the same environment as the service, then the local Java binding for the
service can be used. This provides more efficient communication with the service by making direct
Java calls rather than sending and receiving SOAP messages.

To deploy a Web service as a WSIF-enabled service, you first develop and deploy the Web
service, then you develop the WSIF client based on the WSDL document for that Web service.

IA Web services gateway|

4

You use the gateway to handle Web service invocations between Internet and Intranet
environments. You use it to make your internal Web services available externally, and to make
external Web services available to your internal systems. You also use it to specify:

» The transport mechanisms (or channels) on which messages can be carried to and from the
service.

» The filters or handlers (if any) that act upon these incoming and outgoing messages.
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« The UDDI registries (if any) to which you want the service to be published
* The levels of security that you want to apply to the service.

When you deploy a Web service to the gateway, the gateway creates a copy of the WSDL file for
that service and stores it at a new Web address. Users of the service through the gateway then
use the gateway copy of the WSDL file. You should therefore (if possible) decide whether or not
you want to use the gateway before you make the Web addresses of your deployed services
available to others.

Application services

IBM WebSphere Application Server provides essential services to ease the building of dynamic and
flexible e-business applications. These services support and extend the open standards of J2EE and Web
services, with a focus on application reuse and integration.

The Enterprise Extensions product takes application services to the next level, providing a broad range of
dynamic API extensions that address functional gaps in the J2EE programming model.
» Class loading

The WebSphere Application Server product provides several class-loading modes, policies, and features
to enable you to deploy and run your applications successfully. An application server provides an
Application class-loader policy that enables you to control the isolation of applications in a server. If you
want applications to share classes, choose the SINGLE policy; otherwise choose the MULTIPLE policy,
which isolates the class loaders for each application.

Similarly, at the application level, you can choose a|WAR class-loader policy] that configures the
isolation of Web modules within an application. If you choose the policy APPLICATION, then each Web
module in your application can see the classes of other Web modules. A policy of MODULE creates a
separate class loader for each Web module, resulting in isolation for each of the classes of each Web
module.

The class-loader mode setting, which you can configure at the server, application, or Web module level
depending on your class-loader policy, enables you to control whether application class loaders override
classes contained in base run-time class loaders. By default, the WebSphere Application Server class
loaders have a class-loader mode of PARENT_FIRST, which is the standard JDK mode and does not
allow the application class loader to override classes. You must take care when using the
PARENT_LAST class-loader mode to make all dependent classes available within the application or you
might get LinkageErrors or other class-loader exceptions. For example, if you provide a newer version
of the Xerces. jar file and your application is using XSLT, you must also provide a xalan.jar file within
your application.

* Shared library

Version 5.0 of WebSphere Application Server introduces the concept of a shared library. A shared library
is a CLASSPATH and a symbolic name for that classpath. You define shared libraries at the cell, node,
or server level and then associate the shared libraries either with an application server (making the
classes available to all applications in the server) or with individual applications (making the classes
available only to the referencing application). This mechanism provides a convenient way to make
libraries of classes available to your applications outside of a standard J2EE enterprise application
(EAR) file for easier version management and space efficiency. (See "Managing shared libraries” in the
Information center.)

* EJB query

The EJB query language is used to specify a query over container-managed entity beans. WebSphere’s
EJB query language is compliant with the EJB QL defined in Sun’s EJB 2.0 specification, but adds
additional support as described in the topic |“Comparison of EJB 2.0 specification and WebSphere queryl
[language” on page 819
EJB query can be used to define a finder or select method of an EJB entity bean. Finder and select
queries are specified in the bean deployment descriptor using the <ejb-ql> tag. Queries specified in the
deiloiment descriptor are compiled into SQL during deployment. See [Chapter 14, “Using EJB query,’|
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Internationalization support

If your application component must support multiple locales, the localizable-text API can help both
developers and administrators through central management of displayed strings. The developer
separates strings into a message catalog, which is then translated into the other languages required. All
message catalogs are then deployed with the application component. From then on, the administrator
can add or update message catalogs centrally as required.

The internationalization service manages the distribution of locale and time zone information, or
internationalization context, in applications that run on WebSphere Application Server Enterprise
installations. The internationalization service solves the problem of mismatched locales and time zones
by systematically managing the distribution of internationalization context across the various
components of EJB applications.

The internalization service transparently propagates internationalization context over requests that
originate from J2EE-compliant Web service clients. The service creates a SOAP header block that
contains the invocation context scoped to the current thread; this SOAP representation is then inserted
into the outgoing Web services request. For incoming requests, the service scopes the propagated
internationalization context, referred to as caller context, to the invocation of the stateless session bean
that is enabled as a Web service. The service also scopes an invocation context as prescribed by the
internationalization context management policies that were assigned to the enterprise bean’s methods
during application assembly.

For more information about the internationalization service, see|Chapter 15, “Using thel
[internationalization service,” on page 823
Workarea service

The WorkArea service enables application developers to implicitly propagate information beyond the
information passed in remote calls. Applications can create a work area, insert information into it, and
make remote invocations. The work area is propagated with each remote method invocation, eliminating
the need to explicitly include an appropriate argument in the definition of each method. The methods on
the server side can use or ignore the information in the work area as appropriate. See
[‘Using shared work areas,” on page 987

Application profiling

Application profiling enables you to configure multiple access intent policies on the same method of an
entity bean; and to configure multiple access intent policies for dynamic query on the same entity bean.

To use application profiling, application developers identify named units of work, or tasks. A task
typically corresponds to the execution of a concrete and high-level job within the application. The IBM
WebSphere Application Server run-time environment queries the task at the invocation of any entity
bean, and establishes the appropriate access intent policy under which the bean should execute. An
application profile is the set of access intent or query intent policies that should be selectively applied,
as well as the list of tasks for which the policies should be applied. See [Chapter 16, “Application|
[profiling,” on page 855

Scheduler service

The scheduler service enables J2EE work to be executed at a requested time or interval. The scheduler
API supports different implementations of the Taskinfo interface, each of which can be used to schedule
a particular type of work; for example, you can develop a task that calls a session bean or a task that
sends a JMS message. You can set a notification sink on a task in order to receive the notification
events that are generated by a scheduler when it performs an operation on the task. See
[‘Using the scheduler service,” on page 965|

Asynchronous beans

An asynchronous bean is a Java object or enterprise bean that can be executed asynchronously by a
J2EE application, using the J2EE context of the bean’s creator. These beans also can run with copies
of other J2EE contexts. For example:

— Internationalization context

— Application profiles

— Work areas

— Access intent policies
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Asynchronous beans enable the construction of stateful, "active” J2EE applications. These applications
address a segment of the application space that J2EE has not previously addressed (that is, advanced
applications that require application threading, active agents within a server application, or distributed
monitoring capabilities). See [Chapter 18, “Using asynchronous beans,” on page 933

Object pools

Objects are frequently pooled by Java applications in order to avoid the cost of creating new Java
objects and the associated garbage collection delays that result when these objects are reclaimed after
use. An object pool keeps a number of pre-allocated objects on behalf of its users. Applications can get
an object from the pool, use it, and later return it to the pool. This allows the individual object instances
to be reused and effectively limits the amount of garbage generated by the application.
[‘Using object pools,” on page 955

Startup beans

Startup beans are stateful session beans that enable J2EE applications to execute business logic when
an application starts or stops. The startup bean is loaded when the application starts. The start()
method is then invoked on the bean’s remote interface. This method can execute any business logic
needed by the application at start time. Similarly, the bean’s stop() method is called on the instance

when the application is stopped and can execute any business logic needed by the application at stop
time. See[Chapter 20, “Using startup beans,” on page 963

Startup beans are especially useful when used in combination with asynchronous beans to develop an
active J2EE server application.
Business Rule Beans (BRBeans)

Business Rule Beans are used to separate business rules from an application’s core behavior, allowing
the application code to remain intact and untouched even as business practices change. Each business
rule is represented by an entity bean that persistently stores information related to that rule. Each
business rule is assigned an appropriate rule name and stored in a rule folder. The application
developer identifies "points of variability” within an application and codes trigger points at these
locations. These trigger points invoke one or more business rules. See [Chapter 17, “Using Business|
[Rule Beans,” on page 873|

Transactions

IBM WebSphere Application Server applications can use transactions to coordinate multiple updates to
resources as atomic units (as indivisible units of work) such that all or none of the updates are made
permanent. The way that applications use transactions depends on the type of application component,
as follows:

— A session bean can either use container-managed transactions (where the bean delegates
management of transactions to the container) or bean-managed transactions (where the bean
manages transactions itself)

— Entity beans use container-managed transactions

— Web components (servlets) use bean-managed transactions

The product is a transaction manager that supports the coordination of resource managers through their
XAResource interface and participates in distributed global transactions with other OTS 1.2 compliant
transaction managers (for example, J2EE 1.3 application servers). Applications can also be configured
to interact with databases, JMS queues, and JCA connectors through their local transaction support
when distributed transaction coordination is not required.

Resource managers that offer transaction support can be categorized into those that support two-phase
coordination (by offering an XAResource interface) and those that support only one-phase coordination
(for example through a LocalTransaction interface). The IBM WebSphere Application Server transaction
support provides coordination, within a transaction, for any number of two-phase capable resource
managers. It also enables a single one-phase capable resource manager to be used within a
transaction in the absence of any other resource managers, although a WebSphere transaction is not
necessary in this case. With the Last Participant Support of Enterprise Extensions, you can coordinate
the use of a single one-phase commit (1PC) capable resource with any number of two-phase commit
(2PC) capable resources in the same global transaction. At transaction commit, the two-phase commit
resources are prepared first using the two-phase commit protocol, and if this is successful the
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one-phase commit-resource is then called to commit (one_phase). The two-phase commit resources are
then committed or rolled back depending on the response of the one-phase commit resource.

The ActivitySession service of Enterprise Extensions provides an alternative unit-of-work (UOW) scope
to that provided by global transaction contexts. It is a distributed context that can be used to coordinate
multiple one-phase resource managers. The product EJB container and deployment tooling support
ActivitySessions as an extension to the J2EE programming model. Enterprise beans can be deployed
with lifecycles that are influenced by ActivitySession context, as an alternative to transaction context. An
application can then interact with a resource manager through its LocalTransaction interface for the
period of a client-scoped ActivitySession rather than just the duration of an EJB method.

Naming

Naming clients use |Naming Services| primarily to access objects, such as EJB homes, associated with
applications installed on IBM WebSphere Application Server. Objects are made available to clients by
being bound into a name space. A name space is under the control of a name server. In this product,
there are potentially many name servers, and the name spaces controlled by the various name servers
are federated together to form the view of a single name space. Each name server presents the same
logical view of the federated name spaces.

Name servers provided by this product are a CORBA CosNaming implementation. IBM WebSphere
Application Server provides a CosNaming JNDI plug-in which enables clients to access the name
servers through the JNDI interface. Clients to EJB applications typically use JNDI to perform Naming
operations. Clients may access the name servers directly through the CORBA programming model. The
CosNaming interface is part of the CORBA programming model. CORBA clients which need to access
EJB homes or some other objects bound to the name space would typically use the CORBA
CosNaming interface to perform Naming operations.

Dynamic cache

Dynamic cache improves application performance by caching outputs and contents of outputs of
servlets, JavaServer Pages (JSP) files, Web services, and commands. On subsequent client requests to
the same applications, dynamic cache intercepts these calls and responds by serving the output or the
contents of output from the cache.

Dynamic cache in this product version includes:

Servlet/JSP files caching
This caches output of dynamic servlets and JSP files by working with the Java virtual machine
of the application server by intercepting calls to service methods and serving Web pages from
the cache. This improves server response time, throughput and scalability.

Command caching
Commands that are written to the Command Architecture encapsulate business logic tasks and
provide a standard way to invoke the business logic request. Command objects need to
implement CacheableCommand interface instead of TargetableCommand interface to cache.
Like in servlets and JSP caching, requests to execute business logic in the command is
intercepted by the cache. If a command with the same request attributes are available in cache,
output properties are copied from the cached instance to the requested instance and returned
without executing the business logic again.

Web Services caching
Web service responses can be cached just like servlet and JSP results. These requests are
intercepted and the cache ID is computed based on how the cache ID rules are specified in the
cache policy. A hash of the whole SOAPEnvelope can be used as a cache ID or it can be
parsed and the service name, operation name and parameter names to these operations used
as cache ID. If a cache entry is not found for the computed cache ID, the request is forwarded
to the SOAP engine and the result is cached.

Edge Side Include caching
This provides the ability to cache, assemble and deliver dynamic web pages at the edge of the
enterprise network. Edge Side Includes (ESI) is a simple markup language which enables
dynamic web pages (which by themselves are not so cache efficient) to be broken down into
cacheable fragments. These fragments are then cached on the edge of the network and
assembled into a single page upon user requests.
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Distributed caching
Cache contents can be shared and replicated among servers through dynamic caching by using
an underlying JMS based message broker system, DRS (Data Replication Service). Sharing
characteristics of individual cache entries are configured using the cache policy specification.
* User profiles

Managing allows a company to maintain database tables containing fields for
demographic data of individual customers or other users on the company system. For example, when a

user repeatedly logs onto a Web site that supports user profiles, the Web site can display headlines and
advertising tailored to the shopping preferences of that user. The site can address the user by his or her
logon name. User profile API is deprecated in the current release.

Process choreographer

Process choreographer is a powerful enterprise workflow tool that supports running Business Process
Execution Language (BPEL) processes in a J2EE environment. These processes can be used to integrate
J2EE resources, Web services, and activities that require human interaction.

For more information, refer to process choreographer documentation.
Assembly tools

Assembly is an activity in which you package code components into "modules” that comply with the J2EE
specification. You define configurations for the modules, in the form of XML documents known as
deployment descriptors. The modules can be assembled into an enterprise application (EAR) file and
deployed on a server.

5% The Application Server Toolkit provides a graphical interface tool, called Assembly Toolkit, for
assembly processes. See '[Chapter 30, “Assembling applications with the Assembly Toolkit,” on page]
|1429.I’ For a discussion of archives and Web components supported by the Assembly Toolkit, see
"“Archive support in Version 5.0” on page 1431/

Deployment

Deployment involves placing applications onto application servers and running the applications. The main
tasks include:

1. Installing application files onto an application server.

2. Configuring the application for the particular operational environment.

3. Starting the newly deployed application.

Information on these tasks is available from '[Chapter 31, “Deploying and managing applications,” on page|
’ The information describes how to deploy applications using the WebSphere Application Server
administrative console. You can also deploy applications using the wsadmin tool, which provides
deployment capabilities identical to those available using the administrative console.

Packaging and class loading

You can package your business logic as a Java 2 Platform, Enterprise Edition (J2EE) application
enterprise archive (EAR) file or as an enterprise bean (EJB) or Web module for deployment to WebSphere
Application Server. You must also consider the [class loading| relationships among modules.

Uninstalling and redeploying applications
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At some point, you will need to |uninsta|l your deployed applications. Or you might need to |update youFl
lapplications and deploy them|again. You might be able to use [hot deployment and dynamic reloading,
where you do not need to restart the application server (or the application in some cases) after deploying
an updated application.
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Chapter 2. Using Web applications

A developer creates the files comprising a Web application, and then assembles the Web application
components into a Web module. Next, the deployer (typically the developer in a unit-testing environment
or the administrator in a production environment) installs the Web application on the server.

1. (Optional) Migrate existing Web applications|to run in the new version of WebSphere.

2. Design the Web application and develop its code artifacts: [Servlets [JavaServer Pages (JSP) files} and
static files, as for example, images and Hyper Text Markup Language (HTML) files. See the
"Resources for learning” article for links to design documentation.

3. (Optional) Implement JavaScript within JSP tags using the [Bean Scripting Framework (BSF).

54+ Support in the JSP Engine for the Bean Scripting Framework is deprecated with WebSphere
Application Server 5.1.

4. [Develop the Web application| using WebSphere Application Server extensions to enhance its
functionality.

5. Assemble the Web application into a Web module using thdAssemny Toolkitl Web module assembly
properties might include the ability to:
» Configure servlet page lists.
» Configure servlet filters.
» Serve servlets by class name.
» Enable file serving.

6. |Dep|oy the Web module or application module| that contains the Web application.

Following deployment, you might find it handy to use the |too| that enables batch compiling| of the JSP
files for quicker initial response times.

7. (Optional) Troubleshoot your Web application.

8. (Optional) [Modify the default Web container configuration|in the application server in which you
deployed the Web module or application module containing the Web application.

9. (Optional) [Manage the deployed Web application}

Web applications
A Web application is comprised of one or more related servlets, JavaServer Pages technology (JSP files),
and Hyper Text Markup Language (HTML) files that you can manage as a unit.

The files in a Web application are related in that they work together to perform a business logic function.

For example, one of the WebSphere Application Server samples is a Simple Greeting Web application.
This application, comprised of a servlet and Web pages, greets new users when the application is
accessed.

The Web application is a concept supported by the Java Servlet Specification. Web applications are
typically packaged as .war files.

web.xml file

The web.xml file provides configuration and deployment information for the Web components that comprise
a Web application. Examples of Web components are servlet parameters, servlet and JavaServer Pages
(JSP) definitions, and Uniform Resource Locators (URL) mappings.

The servlet 2.3 specification dictates the format of the web.xm1 file, which makes this file portable among
Java Two Enterprise Edition (J2EE) compliant products.
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Location

The web.xml file must reside in the WEB-INF directory under the context of the hierarchy of directories that
exist for a Web application. For example, if the application is client.war, then the web.xml file is placed in

the install_root/client war/WEB-INF directory.

Usage notes
* |s this file read-only?

No
s this file updated by a product component?

This file is updated by the Assembly Toolkit.
» If so, what triggers its update?

The Assembly Toolkit updates the web.xm1 file when you assemble Web components into a Web
module, or when you modify the properties of the Web components or the Web module.

¢« How and when are the contents of this file used?

WebSphere Application Server functions use information in this file during the configuration and

deployment phases of Web application development.

Sample file entry

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE web-app PUBLIC "-//Sun Microsystems, Inc.

12

//DTD Web Application 2.3//EN"
"http://java.sun.com/j2ee/dtds/web-app 2 3.dtd">

<web-app id="WebApp_1">

<display-name>Persistence Manager Web Client</display-name>
<description>Peristence Manager Web Client</description>
<servlet id="Servlet_1">
<servlet-name>CustomerLocalServlet</servlet-name>
<description>Local Customer Servlet</description>
<servlet-class>CustomerLocalServiet</servliet-class>
</servlet>
<servlet id="Servlet_2">
<servlet-name>CustomerServlet</servlet-name>
<description>Remote Customer Servlet</description>
<servlet-class>CustomerServiet</serviet-class>
</servlet>
<servlet id="Servlet_3">
<servlet-name>CreditCardServiet</serviet-name>
<description>Credit Card Servlet - PM Verification</description>
<servlet-class>CreditCardServiet</servlet-class>
</serviet>
<servlet-mapping id="ServletMapping_1">
<servlet-name>CustomerLocalServlet</servlet-name>
<url-pattern>/CustomerLocal</url-pattern>
</servlet-mapping>
<servlet-mapping id="ServletMapping_2">
<servlet-name>CustomerServiet</servlet-name>
<url-pattern>/Customer</url-pattern>
</servlet-mapping>
<servlet-mapping id="ServletMapping 3">
<servlet-name>CreditCardServiet</servliet-name>
<url-pattern>/CreditCard</url-pattern>
</servlet-mapping>
<welcome-file-1ist id="WelcomeFilelList_ 1">
<welcome-file>index.html</welcome-file>
</welcome-file-Tist>
<security-role id="SecurityRole 1">
<description>Everyone role</description>
<role-name>Everyone Role</role-name>
</security-role>
<security-role id="SecurityRole_2">
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<description>AlTAuthenticated role</description>
<role-name>A11 Role</role-name>

</security-role>

<security-role id="SecurityRole_3">
<description>Deny all access role</description>
<role-name>DenyAl11Role</role-name>

</security-role>

</web-app>

Migrating Web application components

Supported open specification levels in WebSphere Application Server Version 5 are documented in article,
"Migrating.”

Migration of Web applications deployed in WebSphere Application Server Version 4.x is not necessary;
version 2.2 of the servlet specification and version 1.1 of the JavaServerPages (JSP) specification are still
supported. However, where there are behavioral differences between the Java Two Enterprise Edition
(J2EE) 1.2 and J2EE 1.3 specifications, bear in mind that J2EE 1.3 specifications are implemented in
WebSphere Application Server Version 5 and will override any J2EE 1.2 behaviors.

Migration of Web applications deployed in WebSphere Application Server Version 4.0.1 is not necessary;
version 2.2 of the servlet specification and version 1.1 of the JavaServerPages (JSP) specification are still
supported. However, where there are behavioral differences between the Java Two Enterprise Edition
(J2EE) 1.2 and J2EE 1.3 specifications, bear in mind that J2EE 1.3 specifications are implemented in
WebSphere Application Server Version 5 and will override any J2EE 1.2 behaviors.

Servlet migration might be a concern if your application:

» implements a WebSphere internal servlet to bypass a WebSphere Application Server Version 4.x single
application path restriction.

» implements a WebSphere internal servlet to bypass a WebSphere Application Server Version 4.0.1
single application path restriction.

+ extends a PageListServlet that relies on configuration information in the servlet configuration XML file.

» uses a servlet to generate Hyper Text Markup Language (HTML) output.

« calls the response.sendRedirect () method for a servlet using the encodeRedirectURL function or
executing within a non-context root.

JSP migration might be a concern if your application references JSP page implementation classes in
unnamed packages, or if you install WebSphere Application Server Version 4.x EAR files (deployed in
Version 4.x with the JSP Precompile option), in Version 5.

JSP migration might be a concern if your application references JSP page implementation classes in
unnamed packages, or if you install WebSphere Application Server Version 4.0.1 EAR files (deployed in
Version 4.0.1 with the JSP Precompile option), in Version 5.

Follow these steps if migration issues apply to your Web application:

1. Use WebSphere Application Server Version 5 package names for any WebSphere Application Server
Version 4.x internal servlets, which are implemented in your application.
In WebSphere Application Server Version 4.x, Web modules with a context root setting of / are not
supported. Accessing Web modules with this root context results in HTTP 404 - File not Found
errrors.
To bypass the errors, and to enable the serving of static files from the root context, WebSphere
Application Server Version 4.x users are advised to add the servlet class,
com.ibm.servlet.engine.webapp.SimpleFileServiet, to their Web module.

The Version 4.x single path limitation does not exist in Version 5. However, users who choose to use
the com.ibm.servlet.engine.webapp.SimpleFileServiet in Version 5 must do one of the following:
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* Rename com.ibm.servlet.engine.webapp.SimpleFileServiet to
com.ibm.ws.webcontainer.serviet.SimpleFileServiet.

« Opena Web deployment descriptor editor in the |Assembly Toolkit| and select File serving enabled
on the Extensions tab.

The following list identifies the other internal servlets affected by the Version 5 package name change:
» DefaultErrorReporter
* Autolnvoker

Use the Version 5 package name, com.ibm.ws.webcontainer.servlet.serviet class name for these
servlets.

2. Use WebSphere Application Server Version 5 package names for any WebSphere Application Server
Version 4.0.1 internal servlets, which are implemented in your application.

In WebSphere Application Server Version 4.0.1, Web modules with a context root setting of / are not
supported. Accessing Web modules with this root context results in HTTP 404 - File not Found
errrors.

To bypass the errors, and to enable the serving of static files from the root context, WebSphere
Application Server Version 4.0.1 users are advised to add the servlet class,
com.ibm.servlet.engine.webapp.SimpleFileServiet, to their Web module.

The Version 4.0.1 single path limitation does not exist in Version 5. However, users who choose to use

the com.ibm.servlet.engine.webapp.SimpleFileServlet in Version 5 must do one of the following:

* Rename com.ibm.servlet.engine.webapp.SimpleFileServiet to
com.ibm.ws.webcontainer.servlet.SimpleFileServiet.

+ Opena Web deployment descriptor editor in the |Assembly Toolkit|and select File serving enabled
on the Extensions tab.

The following list identifies the other internal servlets affected by the Version 5 package name change:
» DefaultErrorReporter
* Autolnvoker

Use the Version 5 package name, com.ibm.ws.webcontainer.serviet.<serviet class name> for these
servlets.

3. Use the WASPostUpgrade tool to migrate servlets that extend PageListServlet and rely on
configuration information in the associated XML servlet configuration file. In Version 4.x, the XML
servlet configuration file provides configuration data for page lists and augments servlet configuration
information. This file is named as either serviet class_name.servlet or servliet name.servlet, and is
stored in the same directory as the servlet class file.

The XML servlet configuration file is not supported in WebSphere Application Server Version 5.

4. Migrate servlets that extend PageListServlet and rely on configuration information in the associated
XML servlet configuration file. In Version 4.0.1, the XML servlet configuration file provides configuration
data for page lists and augments servlet configuration information. This file is named as either
servlet class_name.servlet or servliet name.servlet, and is stored in the same directory as the
servlet class file.

The XML servlet configuration file is not supported in WebSphere Application Server Version 5. The
direct use of the servlet has been deprecated. The PagelList servlet function is still available but is
configured as part of the servlet extension configuration in the WAR file.

5. Set a content type if your servlet generates Hyper Text Markup Language (HTML) output.

The default behavior of the Web container changed in WebSphere Application Server Version 5. If the
servlet developer does not specify a content type in the servlet then the container is forbidden to set
one automatically. Without an explicit content type setting, the content type is set to null. The Netscape
browser displays HTML source as plain text with a null content type setting.

To resolve this problem, do one of the following:

» Explicitly set a content type in your servlet.

* Opena Web deployment descriptor editor in the|Assemny Toolkit| and select Automatic Response
Encoding enabled on the Extensions tab.
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6. Set the Java environment variable, com. ibm.websphere.sendredirect.compatibility, to true if you
want your URLs interpreted relative to the application root.

The default value of the Java environment variable com.ibm.websphere.sendredirect.compatibility
changed in WebSphere Application Server Version 5. In Version 4, the default setting of this variable is
true. In Version 5, the setting is false.

When this variable is set to false, if a URL has a leading slash, the URL is interpreted relative to the
Web module/application root. However, if the URL does not have a leading slash, it is interpreted
relative to the Web container root (also known as the Web server document root). Therefore, if an
application has a WAR file that has a context root of myPledge app and a servlet that has a servlet
mapping of /Intranet/, a JSP file in the WAR file cannot access the servlet when its
encodeRedirectURL is set to /Intranet/myPledge. The JSP file can access the servlet if the
encodeRedirectURL is set to myPledge app/Intranet/myPlege, or if the
com.ibm.websphere.sendredirect.compatibility variable is set to true.

See the "Setting the sendredirect variable” article for more information.

7. Use the WASPostUpgrade tool to migrate WebSphere Version 4.x enterprise applications to Version 5.
Note: The WebSphere Application Server Version 4.x JSP page implementation class files are not
compatible with the WebSphere Application Server Version 5 JSP container.

The WASPostUpgrade tool automatically precompiles JSP files, which ensures the JSP page
implementation class files are compatible with Version 5.

If you install Version 4.x EAR files, deployed with the JSP Precompile option, in Version 5, and you
choose not to follow the migration path, do one of the following:
» Select the Pre-compile JSP option in the administrative console Install New Application window.

See article [Installing a new application| for more information.
» Specify the -preCompileJSPs option when using the Wsadmin tool.

8. Migrate WebSphere Version 4.0.1 enterprise applications to Version 5.

Note: The WebSphere Application Server Version 4.0.1 JSP page implementation class files are not
compatible with the WebSphere Application Server Version 5 JSP container.

You must do one of the following:
* Select the Pre-compile JSP option in the administrative console Install New Application window.

See article [Installing a new application| for more information.
» Specify the -preCompileJSPs option when using the Wsadmin tool.

9. Import your classes if your application uses unnamed packages.
Section 8.2 of the JSP 1.2 specification states:

The JSP container creates a JSP page implementation class for each JSP page.
The name of the JSP page implementation class is implementation dependent.
The JSP page implementation object belongs to an implementation-dependent
named package. The package used may vary between one JSP and another, so
minimal assumptions should be made. The unnamed package should not be used
without an explicit import of the class.

For example, if myBeanClass is in the unnamed package, and you reference it in a jsp:useBean tag,
then you must explicitly import myBeanClass with the page directive import attribute, as shown in the
following example:

<%@page import="myBeanClass" %>

<jsp:useBean 1'&='.'m)./Bean" class="myBeanClass" scope="session"/>

In WebSphere Application Server Version 5, the JSP engine creates JSP page implementation classes
in the org.apache.jsp package. If a class in the unnamed package is not explicitly imported, then the
javac compiler assumes the class is in package org.apache. jsp, and the compilation fails.
The Incompatibilities section of the version 1.4.Java 2 Platform, Standard Edition (J2SE)
documentation states:

The compiler now rejects import statements that import a type from the
unnamed namespace. Previous versions of the compiler would accept such
import declarations, even though they were arguably not allowed by the
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language (because the type name appearing in the import clause is not in
scope). The specification is being clarified to state clearly that you
cannot have a simple name in an import statement, nor can you import from
the unnamed namespace.

To summarize, the syntax:

import SimpleName;
is no longer Tegal. Nor is the syntax
import ClassInUnnamedNamespace.Nested;
which would import a nested class from the unnamed namespace.

To fix such problems in your code, move all of the classes from the
unnamed namespace into a named namespace.

See "Resources for learning” for links to the J2SE, JSP, and Servlet specification documentation.

Default Application

The IBM WebSphere Application Server provides a default configuration that allows administrators to
easily verify that the Application Server is running. When the product is installed, it includes an application
server called server1 and an enterprise application called Default Application.

Default Application contains a Web Module called DefaultWebApplication and an enterprise bean JAR file
called Increment. The Default Application provides a number of servlets, described below. These servlets
are available in the product.

For additional code examples, visit the Samples Gallery. Learn how to locate and install the Samples
Gallery by viewing the Samples Gallery reference page.

The URL for accessing Samples is: http://1ocalhost:9080/WSamples/
Snoop

Use the Snoop servlet to retrieve information about a servlet request. This servlet returns the following
information:

+ Servlet initialization parameters

» Servlet context initialization parameters

* URL invocation request parameters

» Perferred client locale

» Context path

* User principal

* Request headers and their values

* Request parameter names and their values
» HTTPS protocol information

» Servlet request attributes and their values

* HTTP session information

» Session attributes and their values

The Snoop servlet includes security configuration so that when WebSphere Security is enabled, clients
must supply a user ID and password to execute the servlet.

The URL for the Snoop servlet is: http://localhost:9080/snoop/.
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HelloHTML

Use the HelloHTML pervasive servlet to exercise the PageList support provided by the WebSphere Web
container. This servlet extends the PageListServlet, which provides APIs that allow servlets to call other
Web resources by name or, when using the Client Type detection support, by type.

You can invoke the Hello servlet from an HTML browser, speech client, or most Wireless Application
Protocol (WAP) enabled browsers using the URL: http://1ocalhost:9080/Hel1oHTML. jsp.

HitCount

Use the HitCount Demonstration application to demonstrate incrementing a counter using a variety of
methods, including:

* A servlet instance variable

e An HTTP session

* An enterprise bean

You can instruct the servlet to execute any of these methods within a transaction that you can commit or
roll back. If the transaction is committed, the counter is incremented. If the transaction is rolled back, the
counter is not incremented.

The enterprise bean method uses a Container- Managed Persistence enterprise bean that persists the
counter value to a Cloudscape database. This enterprise bean is configured to use the Default
Datasource, which is set to the DefaultDB database.

When using the enterprise bean method, you can instruct the servlet to look up the enterprise bean, either
in the WebSphere global namespace, or in the namespace local to the application.

The URL for the HitCount application is: http://Tocalhost:9080/HitCount. jsp.

Servlets

Servlets are Java programs that use the Java Servlet Application Programming Interface (API). You must
package servlets in a Web ARchive (WAR) file or Web module for deployment to the application server.
Servlets run on a Java-enabled Web server and extend the capabilities of a Web server, similar to the way
applets run on a browser and extend the capabilities of a browser.

Servlets can support dynamic Web page content, provide database access, serve multiple clients at one
time, and filter data.

For the purposes of IBM WebSphere Application Server, discussions of servlets focus on Hyper Text
Transfer Protocol (HTTP) servlets, which serve Web-based clients.

Developing servlets with WebSphere Application Server extensions

Several WebSphere Application Server extensions are provided for enhancing your servlets. This task
provides a summary of the extensions that you can utilize.

1. Review the supported specifications.
Create Java components, referring to the Servlet specifications from Sun Microsystems.
See |Resources for Iearning| for links to coding specifications and examples.

The application server includes its own packages that extend and add to the Java Servlet Application
Programming Interface (API). These extensions and additions make it easier to manage session
states, create personalized Web pages, generate better servlet error reports, and access databases.
Locate the Javadoc for the application server APIs in the product install_root\web\apidocs directory.
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All the public WebSphere Application Server APls are located in the com.ibm.websphere... packages.

2. Use your favorite integrated development environment (IDE), or a text editor, to develop or migrate
code artifacts that meet the specifications.

3. Test the code artifacts.

Assemble your code artifacts into a Web module using theIAssemny TooIkit| as a prerequisite to deploying
the code to the application server.

Application lifecycle listeners and events

Application lifecycle listeners and events, now part of the Servlet API, enable you to notify interested
listeners when servlet contexts and sessions change. For example, you can notify users when attributes
change and if sessions or servlet contexts are created or destroyed.

The lifecycle listeners give the application developer greater control over interactions with ServietContext
and HttpSession objects. Servlet context listeners manage resources at an application level. Session
listeners manage resources associated with a series of requests from a single client. Listeners are
available for lifecycle events and for attribute modification events. The listener developer creates a class
that implements the javax listener interface, corresponding to the desired listener functionality.

At application startup time, the container uses introspection to create an instance of your listener class and
registers it with the appropriate event generator.

When a servlet context is created, the contextInitialized method of your listener class is invoked, which
creates the database connection for the servlets in your application to use, if this context is for your
application.

When the servlet context is destroyed, your contextDestroyed method is invoked, which releases the
database connection, if this context is for your application.

Listener classes for servlet context and session changes

The following methods are defined as part of the javax.servlet.ServietContextListener interface:
» void contextInitialized(ServletContextEvent) - Notification that the Web application is ready to
process requests.

Place code in this method to see if the created context is for your Web application and if it is, allocate a
database connection and store the connection in the servlet context.

* void contextDestroyed(ServletContextEvent) -Notification that the servlet context is about to shut
down.

Place code in this method to see if the created context is for your Web application and if it is, close the
database connection stored in the servlet context.

Two new listener interfaces are defined as part of the javax.servlet package:
« ServletContextListener
» ServletContextAttributeListener

One new filter interface is defined as part of the javax.servlet package:
» FilterChain interface - methods: doFilter()

Two new event classes are defined as part of the javax.servlet package:
» ServletContextEvent
» ServletContextAttributeEvent

Three new listener interfaces are defined as part of the javax.servlet.http package:
» HttpSessionListener
» HttpSessionAttributeListener
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» HttpSessionActivationListener

One new event class is defined as part of the javax.servlet.http package:
* HttpSessionEvent

Example: com.ibm.websphere.DBConnectionListener.java
The following example shows how to create a servlet context listener:
package com.ibm.websphere;

import java.io.*;
import javax.servlet.x;

public class DBConnectionListener implements ServletContextListener
{

// implement the required context init method

void contextInitialized(ServletContextEvent sce)

{

}

// implement the required context destroy method
void contextDestroyed(ServletContextEvent sce)
{
1
1

Serviet filtering

Servlet filtering is an integral part of the Servlet 2.3 API. Servlet filtering provides a new type of object
called a filter that can transform a request or modify a response.

You can chain filters together so that a group of filters can act on the input and output of a specified
resource or group of resources.

Filters typically include logging filters, image conversion filters, encryption filters, and Multipurpose Internet
Mail Extensions (MIME) type filters (functionally equivalent to the servlet chaining). Although filters are not
servlets, their lifecycle is very similar.

Filters are handled in the following manner:
* The Web container determines whether it needs to construct a FilterChain containing the
LoggingFilter for the requested resource.

The FilterChain begins with the invocation of the LoggingFilter and ends with the invocation of the
requested resource.

» If other filters need to go in the chain, the Web container places them after the LoggingFilter and
before the requested resource.

* The Web container then instantiates and initializes the LoggingFilter (if it was not done previously)
and invokes its doFilter(FilterConfig) method to start the chain.

» The LoggingFilter preprocesses the request and response objects and then invokes the filter chain
doFilter(ServietRequest, ServletResponse) method.

This method passes the processing to the next resource in the chain (in this case, the requested
resource).

* Upon return from the filter chain doFilter(ServletRequest, ServietResponse) method, the
LoggingFilter performs post-processing on the request and response object before sending the
response back to the client.

Filter, FilterChain, FilterConfig classes for servlet filtering

The following interfaces are defined as part of the javax.servlet package:
* Filter interface - methods: doFilter(), getFilterConfig(), setFilterConfig()
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* FilterChain interface - methods: doFilter()
 FilterConfig interface - methods: getFilterName(), getInitParameter(), getinitParameterNames(),
getServletContext()

The following classes are defined as part of the javax.serviet.http package:
+ HttpServletRequestWrapper - methods: See the [Servlet 2.3 Specification|
« HitpServietResponseWrapper - methods: See the[Servlet 2.3 Specificatiod

Example: com.ibm.websphere.LoggingFilter.java
The following example shows how to implement a filter:

package com.ibm.websphere;

import java.io.*;
import javax.servlet.=;

public class LoggingFilter implements Filter

{
File _ToggingFile = null;

// implement the required init method
public void init(FilterConfig fc)
{

// create the logging file

XXX 3

}

// implement the required doFilter method...this is where most of
the work is done
public void doFilter(ServlietRequest request,
ServletResponse response, FilterChain chain)
{
try
{
// add request info to the log file
synchronized(_loggingFile)
{

}

// pass the request on to the next resource in the chain
chain.doFilter(request, response);

XXX 3

catch (Throwable t)
{

}

// handle problem...
1

// implement the required destroy method
public void destroy()
{
// make sure logging file is closed
_ToggingFile.close();
}
}

Configuring page list servlet client configurations

You can define PageListServlet configuration information in the IBM Web Extensions file. The IBM Web
Extensions file is created and stored in the Web Applications archive (WAR) file by thelAssemny TooIkilI.

To configure and implement page lists:
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1. To configure page list information, use the Add Markup Language entry dialog of the Assembly Toolkit.
On the Servlets tab of a Web deployment descriptor editor, select a servlet and click Add under
WebSphere Extensions.

2. Add the callPage() method to your servlet to invoke a JavaServer Page (JSP) file in response to a
client request.

The PagelListServlet has a callPage() method that invokes a JSP file in response to the HTTP request
for a page in a page list. The callPage() method can be invoked in one of the following ways:
» callPage(String pageName, HttpServletRequest request, HttpServletResponse response)

where the method arguments are:
pageName
A page name defined in the PageListServlet configuration
request
The HttpServletRequest object
response
The HttpServletResponse object
e callPage(String miName, String pageName, HttpServletRequest request, HttpServletResponse
response)

where the method arguments are:
miName A markup language type
pageName
A page name defined in the PageListServlet configuration
request
The HttpServletRequest object
response
The HttpServietResponse object

3. Use the Pagelist Servlet client type detection support to determine the markup language type a calling
client requires for the response.

Page lists

Page lists allow you to avoid hard-coding URLs in servlets and JSP files. A page list specifies the location
where a request is to be forwarded, but automatically customizes that location depending on the MIME
type of the servlet. Use these properties to specify a markup language and an associated MIME type. For
the given MIME type, you also specify a set of pages to invoke.

WebSphere Application Server supplies the PageListServlet servlet, which you can use to call a
JavaServer Pages (JSP) file by name based on the configuration data in the client_types.xml file. This
file maps a JSP file to a Uniform Resource Identifier (URI). When the URI is invoked, it specifies another
JSP file in a Web module. This support allows you to access multiple Uniform Resource Locators (URLS)
without hard-coding them in your servlets.

You can also logically group page lists according to the markup language type, such as, Hypertext Markup
Language (HTML) or Wireless Markup Language (WML). This allows applications that use servlets to
extend the PagelListServlet servlet, to call JSP files which return the proper markup-language type for the
client request. For example, a request that originates from a PDA device requires WML data. The
application server sends the request to a servlet that extends the PageListServlet servlet, and the servlet
calls a JSP file that returns a WML response.

Client type detection support

In addition to providing the page list mapping capability, the PageListServlet also provides Client Type
Detection support. A servlet determines the markup language type that a calling client needs in the
response, using the configuration information in the client_types.xml file.

Client type detection support allows a servlet, extending the PageListServlet, to call an appropriate
JavaServer Pages (JSP) file. The servlet invokes the callPage() method, which calls a JSP file based on
the markup-language type of the request.
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client_types.xml

The client_types.xml file provides client type detection support for servlets extending PageListServlet.
Using the configuration data in the client_types.xml file, servlets can determine the language type that
calling clients require for the response.

The client type detection support allows servlets to call appropriate JavaServer Pages (JSP) files with the
callPage() method. Servlets select JSP files based on the markup-language type of the request.

Servlets must use the following version of the cal1Page() method to determine the markup language type
required by the client:

callPage(String mIName, String pageName, HttpServletRequest request,
HttpServletResponse response)

where the arguments are:

* mIName - a markup language type

» pageName - a page name defined in the PageListServlet configuration
* request - the HttpServiletRequest object

* response - the HttpServiletResponse object

Review the [Extending PageListServlet|code example to see how the callPage() method is invoked by a
servlet.

In the example, the client type detection method, getMLTypeFromRequest (HttpServietRequestrequest),
provided by the PagelListServlet, inspects the HttpServietRequest object request headers, and searches
for a match in the client_types.xml file.

The client type detection method does the following:

» Uses the input HttpServietRequest and the client_types.xml file, to check for a matching HTTP
request name and value.

* Returns the markup-language value configured for the <client-type> element, if a match is found.
If multiple matches are found, this method returns the markup-language for the first <client-type>
element for which a match is found.

* If no match is found, returns the value of the markup-language for the default page defined in the
PageListServlet configuration.

Location
The client_types.xml file is located in the install root/properties directory.

Usage notes
* |s this file read-only?

No
 Is this file updated by a product component?

No
 If so, what triggers its update?

This file is created and updated manually by users.
* How and when are the contents of this file used?

Servlets, extending PageListServlet, use this file to determine the language type that calling clients
require for the response.

Sample file entry

<?xml version="1.0" >

<IDOCTYPE clients [

<!ELEMENT client-type (description, markup-language,request-header+)>
<!ELEMENT description (#PCDATA)>
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<!ELEMENT markup-Tlanguage (#PCDATA)>
<!ELEMENT request-header (name, value)>
<!ELEMENT clients (client-type+)>
<!ELEMENT name (#PCDATA)>
<!ELEMENT value (#PCDATA)>]>
<clients>
<client-type>
<description>IBM Speech Client</description>
<markup-Tlanguage>VXML</markup-language>
<request-header>
<name>user-agent</name>
<value>IBM VoiceXML pre-release version 000303</value>
</request-header>
<request-header>
<name>accept</name>
<value>text/vxml</value>
</request-header>
</client-type>
<client-type>
<description>WML Browser</description>
<markup-language>WML</markup-Tanguage>
<request-header>
<name>accept</name>
<value>text/x-wap.wml</value>
</request-header>
<request-header>
<name>accept</name>
<value>text/vnd.wap.xml</value>
</request-header>
</client-type>
</clients>

Example: Extending PageListServiet

The following example shows how a servlet extends the PageListServlet class and determines the
markup-language type required by the client. The servlet then uses the callPage() method to call an
appropriate JavaServer Pages (JSP) file. In this example, the JSP file that provides the the correct
markup-language for the response is Hello.page.

public class HelloPervasiveServlet extends PagelListServlet implements Serializable
{
/*
* doGet -- Process incoming HTTP GET requests
*/
public void doGet(HttpServietRequest request, HttpServletResponse response)
throws IO0Exception, ServletException

// This is the name of the page to be called:
String pageName = "Hello.page";

// First check if the servlet was invoked with a queryString that contains
// a markup-language value.

// For example, if this is how the servlet is invoked:

// http://Tocalhost/servlets/HeloPervasive?mlname=VXML

// then use the following method:

String miname= getMLNameFromRequest (request);

// 1f no markup language type is provided in the queryString,
// then try to determine the client
// Type from the request, and use the markup-language name configured in
// the client_types.xml file.
if (mIName == null)
{
mIName = getMLTypeFromRequest(request);
}

try
// Serve the request page.
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callPage(miName, pageName, request, response);

}

catch (Exception e)

handleError(miName, request, response, e);

}
}

autoRequestEncoding and autoResponseEncoding

Two new WebSphere Application Server extensions are available in Version 5, autoRequestEncoding and
autoResponseEncoding.

In WebSphere Application Server Version 5, the Web container no longer automatically sets request and
response encodings, and response content types. Programmers are expected to set these values using
available methods in the Servlet 2.3 Specification. If programmers choose not to use the character
encoding methods, they can specify the autoRequestEncoding and autoResponseEncoding extensions,
which enable the application server to set the encoding values and content type.

The values of the autoRequestEncoding and autoResponseEncoding extensions are either true or false.
The default value for both extensions is false. If the value is false for both autoRequestEncoding and
autoResponseEncoding, then the request and response character encoding is set to the Servlet 2.3
Specification default, which is 1ISO-8859-1. Also, If the value is set to false for a response, the Web
container cannot set a response content type.

Use the |Assembly Toolkif to change the default values for the autoRequestEncoding and
autoResponseEncoding extensions.

Review the autoRequestEncoding and autoResponseEncoding encoding examples for a description of Web
container behavior when these values are set to true.

Examples: autoRequestEncoding and autoResponseEncoding
encoding examples

The default value of the autoRequestEncoding and autoResponseEncoding extensions is false, which
means that both the request and response character encoding is set to the Servlet 2.3 Specification
default of ISO-8859-1. Different character encodings are possible if the client defines character encoding in
the request header, or if the code includes the setCharacterEncoding(String encoding) method. Also, If
the value is set to false for a response, the Web container cannot set a response content type.

If the autoRequestEncoding value is set to true, and the client did not specify character encoding in the
request header, and the code does not include the setCharacterEncoding(String encoding) method, the
Web container tries to determine the correct character encoding for the request parameters and data.

The Web container performs each step in the following list until a match is found:
» Looks at the character set (charset) in the Content-Type header.

« Attempts to map the servers locale to a character set using defined properties.
» Attempts to use the DEFAULT _CLIENT ENCODING system property, if one is set.

» Uses the ISO-8859-1 character encoding as the default.

If the autoResponsetEncoding value is set to true, and the client did not specify character encoding in the

request header, and the code does not include the setCharacterEncoding(String encoding) method, the

Web container does the following:

» Attempts to determine the response content type and character encoding from information in the
request header.

» Uses the ISO-8859-1 character encoding as the default.
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JavaServer Pages files

JavaServer Pages (JSP) files are application components coded to the Sun Microsystems JavaServer
Pages (JSP) Specification. JSP files enable the separation of the Hypertext Markup Language (HTML)
code from the business logic in Web pages so that HTML programmers and Java programmers can more
easily collaborate in creating and maintaining pages.

The IBM extensions to the JSP Specification include JSP tags that resemble HTML tags. These JSP tags
make it easy for HTML authors to add the power of Java technology to Web pages, without being experts
in Java programming.

JSP files support a division of roles:

HTML authors
Develop JSP files that access databases and reusable Java components, such as servlets and
beans.

Java programmers
Create the reusable Java components and provide the HTML authors with the component names
and attributes.

Database administrators
Provide the HTML authors with the name of the database access and table information.

Developing JavaServer Pages files with WebSphere extensions

Several IBM WebSphere extensions are provided for enhancing your JavaServer Pages (JSP) files. This
task provides a summary of the extensions that you can utilize.

1. Review the supported specifications.
Create Java components, referring to the JSP specifications from Sun Microsystems.
See [Resources for learning| for links to coding specifications and examples.

WebSphere Application Server Version 3.5 added IBM extensions to the base Application Programming
Interfaces (APIs). Since the JavaServer Pages (JSP) 1.1 and JSP 1.2 Specifications are backward
compatible to the JSP 1.0 Specifications, you can invoke the APIs with the IBM extensions without
modification.

The extensions belong to these categories:

Syntax for variable data
Put variable fields in JSP files and have servlets and beans dynamically replace the variables
with values from a database when the JSP output is returned to the browser.

Syntax for database access
Add a database connection to a Web page and then use that connection to query or update
the database. You can provide the user ID and password for the database connection at
request time, or you can hard code the user ID and password within the JSP file.

2. Use your favorite integrated development environment (IDE), or a text editor, to develop or migrate
code artifacts that meet the specifications.

3. Test the code artifacts.
4. (Optional) |Batch compile your JSP files| if necessary.

Tag libraries

Java ServerPages (JSP) tag libraries contain classes for common tasks such as processing forms and
accessing databases from JSP files.

Tag libraries encapsulate, as simple tags, core functionality common to many Web applications. The Java
Standard Tag Library (JSTL) supports common programming tasks such as iteration and conditional
processing, and provides tags for:

* manipulating XML documents
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* supporting internationalization
 using Structured Query Language (SQL)

Tag libraries also introduce the concept of an expression language to simplify page development, and
include a version of the JSP expression language.

A tag library has two parts - a Tag Library Descriptor (TLD) file and a JAR file.

tsx:dbconnect tag JavaServer Pages syntax

Use the <tsx:dbconnect> tag to specify information needed to make a connection to a Java Database
Connectivity (JDBC) or an Open Database Connectivity (ODBC) database.

The <tsx:dbconnect> syntax does not establish the connection. Use the <tsx:dbquery> and <tsx:dbmodify>
syntax instead to reference a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file to establish
the connection.

When the JSP file compiles into a servlet, the Java processor adds the Java coding for the
<tsx:dbconnect> syntax to the servlet service() method, which means a new database connection is
created for each request for the JSP file.

This section describes the syntax of the <tsx:dbconnect> tag.

<tsx:dbconnect id="connection_id"
userid="db_user" passwd="user_password"
url="jdbc:subprotocol :database"
driver="database_driver_name"
jndiname="JNDI_context/logical_name">
</tsx:dbconnect>

where:

* id
Represents a required identifier. The scope is the JSP file. This identifier is referenced by the
connection attribute of a <tsx:dbquery> tag.

» userid
Represents an optional attribute that specifies a valid user ID for the database that you want to access.
Specify this attribute to add the attribute and its value to the request object.

Although the userid attribute is optional, you must provide the user ID. See [<tsx:userid> and
for an alternative to hard coding this information in the JSP file.
* passwd

Represents an optional attribute that specifies the user password for the userid attribute. (This attribute
is not optional if the userid attribute is specified.) If you specify this attribute, the attribute and its value
are added to the request object.

Although the passwd attribute is optional, you must provide the password. See |<tsx:userid> and|
|<tsx:passwd> for an alternative to hard coding this attribute in the JSP file.

e url and driver

Respresents a required attribute if you want to establish a database connection. You must provide the
URL and driver.

The application server supports connection to JDBC databases and ODBC databases.

— For a JDBC database, the URL consists of the following colon-separated elements: jdbc, the
subprotocol name, and the name of the database to access. An example for a connection to the
Sample database included with IBM DB2 is:
url="jdbc:db2:sample"
driver="COM.ibm.db2.jdbc.app.DB2Driver"

— For an ODBC database, use the Sun JDBC-to-ODBC bridge driver included in their Java2 Software
Developers Kit (SDK) or another vendor's ODBC driver.
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The url attribute specifies the location of the database. The driver attribute specifies the name of the
driver to use in establishing the database connection.

If the database is an ODBC database, you can use an ODBC driver or the Sun JDBC-to-ODBC
bridge. If you want to use an ODBC driver, refer to the driver documentation for instructions on
specifying the database location with the url attribute and the driver name.

If you use the bridge, the url syntax is jdbc:odbc:database. An example follows:

url="jdbc:odbc:autos"
driver="sun.jdbc.odbc.JdbcOdbcDriver"
Note: To enable the application server to access the ODBC database, use the ODBC Data Source
Administrator to add the ODBC data source to the System DSN configuration. To access the ODBC
Administrator, click the ODBC icon on the Windows NT Control Panel.
* jndiname
Represents an optional attribute that identifies a valid context in the application server Java Naming and
Directory Interface (JNDI) naming context and the logical name of the data source in that context. The
Web administrator configures the context using an administrative client such as the WebSphere
Administrative Console.

If you specify the jndiname attribute, the JSP processor ignores the driver and url attributes on the
<tsx:dbconnect> tag.

An empty element (such as <url></url>) is valid.

dbquery tag JavaServer Pages syntax

Use the <tsx:dbquery> tag to establish a connection to a database, submit database queries, and return
the results set.

The <tsx:dbquery> tag does the following:

1. References a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file and uses the information
the tag provides to determine the database URL and driver. You can also obtain the user ID and
password from the <tsx:dbconnect> tag if those values are provided in the <tsx:dbconnect> tag.

2. Establishes a new connection

3. Retrieves and caches data in the results object.

4. Closes the connection and releases the connection resource.

This section describes the syntax of the <tsx:dbquery> tag.

<%-- SELECT commands and (optional) JSP syntax can be placed within the tsx:dbquery. --%>
<%-- Any other syntax, including HTML comments, are not valid. --%>

<tsx:dbquery id="query id" connection="connection_id" limit="value" >

</tsx:dbquery>

where:

* id
Represents the identifier of this query. The scope is the JSP file. Use id to reference the query. For
example, from the <tsx:getProperty> tag, use id to display the query results.

The id is a tsx reference to the bean and can be used to retrieve the bean from the page contect. For
example, if id is named mySingleDBBean, instead of using:

— if (mySingleDBBean.getValue("UISEAM",0).startsWith("N"))

use:

— com.ibm.ws.webcontainer.jsp.tsx.db.QueryResults bean =

(com.ibm.ws.webcontainer.jsp.tsx.db.QueryResults)pageContext. findAttribute("mySingleDBBean”); if
(bean.getValue("UISEAM”,0).startsWith("N")). . .

The bean properties are dynamic and the property names are the names of the columns in the results
set. If you want different column names, use the SQL keyword for specifying an alias on the SELECT
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command. In the following example, the database table contains columns named FNAME and LNAME,
but the SELECT statement uses the AS keyword to map those column names to FirstName and
LastName in the results set:

Select FNAME, LNAME AS FirstName, LastName from Employee where FNAME='Jim'
* connection

Represents the identifier of a <tsx:dbconnect> tag in this JSP file. The <tsx:dbconnect> tag provides the
database URL, driver name, and optionally, the user ID and password for the connection.

o limit
Represents an optional attribute that constrains the maximum number of records returned by a query. If
this attribute is not specified, no limit is used. In such a case, the effective limit is determined by the
number of records and the system caching capability.

* SELECT command and JSP syntax

Represents the only valid SQL command, SELECT. The <tsx:dbquery> tag must return a results set.
Refer to your database documentation for information about the SELECT command. See other articles
in this section for a description of JSP syntax for variable data and inline Java code.

dbmodify tag JavaServer Pages syntax

The <tsx:dbmodify> tag establishes a connection to a database and then adds records to a database
table.

The <tsx:dbmodify> tag does the following:
1. References a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file and uses the information
provided by that tag to determine the database URL and driver.

Note: You can also obtain the user ID and password from the <tsx:dbconnect> tag if those values are
provided in the <tsx:dbconnect> tag.

2. Establishes a new connection.

3. Updates a table in the database.

4. Closes the connection and releases the connection resource.

This section describes the syntax of the <tsx:dbmodify> tag.

<%-- Any valid database update commands can be placed within the DBMODIFY tag. -->
<%-- Any other syntax, including HTML comments, are not valid. -->

<tsx:dbmodify connection="connection_id">

</tsx:dbmodify>

where:
e connection

Represents the identifier of a <tsx:dbconnect> tag in this JSP file. The <tsx:dbconnect> tag provides the
database URL, driver name, and (optionally) the user ID and password for the connection.
» Database commands

Represents valid database commands. Refer to your database documentation for details

tsx:getProperty tag JavaServer Pages syntax and examples

The <tsx:getProperty> tag gets the value of a bean to display in a JavaServer Pages (JSP) file.

This IBM extension of the Sun JSP <jsp:getProperty> tag implements all of the <jsp:getProperty> function
and adds the ability to introspect a database bean created using the IBM extension <tsx:dbquery> or
<tsx:dbmodify>.

Note: You cannot assign the value from this tag to a variable. The value, generated as output from this
tag, displays in the browser window.

This section describes the syntax of the <tsx:getProperty> tag:
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<tsx:getProperty name="bean_name"
property="property_name" />

where:
°* name

Represents the name of the bean declared by the id attribute of a <tsx:dbquery> syntax within the JSP
file. See |<tsx:dbquery>|for an explanation. The value of this attribute is case-sensitive.

* property
Represents the property of the bean to access for substitution. The value of the attribute is
case-sensitive and is the locale-independent name of the property.

Tag example:

<tsx:getProperty name="userProfile" property="username" />
<tsx:getProperty name="request" property=request.getParameter("corporation") />

In most cases, the value of the property attribute is just the property name. However, to access the
request bean or to access a property of a property (sub property), specify the full form of the property
attribute. The full form also gives you the option to specify an index for indexed properties. You can specify
the optional index as a constant (such as 2), or an index like the one described in the tag.
Some examples using the full form of the property attribute follow:

<tsx:getProperty name="staffQuery" property=address(currentAddressIndex) />

<tsx:getProperty name="shoppingCart" property=items(4).price />

<tsx:getProperty name="fooBean" property=foo(2).bat(3).boo.far />

tsx:userid and tsx:passwd tag JavaServer Pages syntax

With the <tsx:userid> and <tsx:passwd> tags, you do not have to hard code a user ID and password in the
<tsx:dbconnect> tag.

Use the <tsx:userid> and <tsx:passwd> tags to accept user input for the values and then add that data to
the request object. You can access the request object with a JavaServer Pages (JSP) file, such as the
JSPEmployee.jsp example that requests the database connection.

You must use <tsx:userid> and <tsx:passwd> tags within a <tsx:dbconnect> tag.

This section describes the syntax of the <tsx:userid> and <tsx:passwd> tags.

<tsx:dbconnect id="connection_id"
<font color="red"><userid></font>
<tsx:getProperty name="request" property=request.getParameter("userid") />
<font color="red"></userid></font>
<font color="red"><passwd></font>
<tsx:getProperty name="request" property=request.getParameter("passwd") />
<font color="red"></passwd></font>
url="protocol:database_name:database_table"
driver="JDBC driver_name">

</tsx:dbconnect>

where:
» <tsx:getProperty>

Represents the syntax as a mechanism for embedding variable data.
* userid

Represents a reference to the request parameter that contains the user ID. You must add the parameter
to the request object that passes to this JSP file. You can set the attribute and its value in the request
object, using an HTML form or a URL query string to pass the user-specified request parameters.

* passwd
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Represents a reference to the request parameter that contains the password. Add the parameter to the
request object that passes to this JSP file. You can set the attribute and its value in the request object,
using an HTML form or a URL query string, to pass user-specified values.

tsx:repeat tag JavaServer Pages syntax
The <tsx:getProperty> tag repeats a block of HTML tagging.

Use the <tsx:repeat> syntax to iterate over a database query results set. The <tsx:repeat> syntax iterates
from the start value to the end value until one of the following conditions is met:

* The end value is reached.

* An exception is thrown.

The output of a <tsx:repeat> block is buffered until the block completes. If an exception is thrown before a
block completes, no output is written for that block.

This section describes the syntax of the <tsx:repeat> tag:

<tsx:repeat index=name start="starting_index" end="ending_index">
</tsx:repeat>

where:
¢ index

Represents an optional name used to identify the index of this repeat block. The value is case-sensitive
and its scope is the JSP file.
» start

Represents an optional starting index value for this repeat block. The default is 0.
* end

Represents an optional ending index value for this repeat block. The maximum value is 2,147,483,647.
If the value of the end attribute is less than the value of the start attribute, the end attribute is ignored.

Example: Combining tsx:repeat and tsx:getProperty JavaServer Pages
tags
The following code snippet shows you how to code these tags:

<tsx:repeat>

<tr>
<td><tsx:getProperty name="empgs" property="EMPNO" />
<tsx:getProperty name="empqgs" property="FIRSTNME" />
<tsx:getProperty name="empgs" property="WORKDEPT" />
<tsx:getProperty name="empgs" property="EDLEVEL" />
</td>

</tr>

</tsx:repeat>

Example: tsx:dbmodify tag syntax

In the following example, a new employee record is added to a database. The values of the fields are
based on user input from this JavaServer Pages (JSP) file and referenced in the database commands
using the <tsx:getProperty> tag.

<tsx:dbmodify connection="conn" >
insert into EMPLOYEE

(EMPNO, FIRSTNME ,MIDINIT,LASTNAME,WORKDEPT,EDLEVEL)
values
('<tsx:getProperty name="request" property=request.getParameter("EMPNO") />',
'<tsx:getProperty name="request" property=request.getParameter("FIRSTNME") />',
'<tsx:getProperty name="request" property=request.getParameter("MIDINIT") />',
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'<tsx:getProperty name="request" property=request.getParameter("LASTNAME") />',
'<tsx:getProperty name="request" property=request.getParameter("WORKDEPT") />',
<tsx:getProperty name="request" property=request.getParameter("EDLEVEL") />)

</tsx:dbmodify>

Example: Using tsx:repeat JavaServer Pages tag to iterate over a

results set

The <tsx:repeat> tag iterates over a results set. The results set is contained within a bean. The bean can
be a static bean, for example, a bean created by using the IBM WebSphere Studio database wizard, or a
dynamically generated bean, for example, a bean generated by the <tsx:dbquery> syntax. The following
table is a graphic representation of the contents of a bean called, myBean:

coll col2 col3
row0 friends Romans countrymen
row1 bacon lettuce tomato
row2 May June July

Some observations about the bean:

» The column names in the database table become the property names of the bean. The <tsx:dbquery>
section describes a technique for mapping the column names to different property names.

» The bean properties are indexed. For example, myBean.get (Col1(row2)) returns May.

* The query results are in the rows. The <tsx:repeat> tag iterates over the rows, beginning at the start

row.

The following table compares using the <tsx:repeat> tag to iterate over a static bean, versus a dynamically

generated bean:

Static Bean Example

<tsx:repeat> Bean Example

myBean.class
// Code to get a connection

// Code to get the data
Select * from myTable;

// Code to close the connection

JSP file

<tsx:repeat index=abc>
<tsx:getProperty name="myBean"
property="coll(abc)" />
</tsx:repeat>

Notes:

* The bean (myBean.class) is a static bean.

* The method to access the bean properties is
myBean.get(property(index)).

* You can omit the property index, in which case the
index of the enclosing <tsx:repeat> tag is used. You
can also omit the index on the <tsx:repeat> tag.

» The <tsx:repeat> tag iterates over the bean properties
row by row, beginning with the start row.

JSP file

<tsx:dbconnect id="conn"
userid="alice"passwd="test"
url="jdbc:db2:sample"
driver="COM.ibm.db2.jdbc.app.DB2Driver">
</tsx:dbconnect >

<tsx:dbquery id="dynamic"
connection="conn" >
Select * from myTable;

</tsx:dbquery>

<tsx:repeat index=abc>
<tsx:getProperty name="dynamic"
property="coll(abc)" />
</tsx:repeat>

Notes:

* The bean (dynamic) is generated by the <tsx:dbquery>
tag and does not exist until the syntax executes.

* The method to access the bean properties is
dynamic.getValue("property”’, index).

* You can omit the property index, in which case the
index of the enclosing <tsx:repeat> tag is used. You
can also omit the index on the <tsx:repeat> tag.

» The <tsx:repeat> tag syntax iterates over the bean
properties row by row, beginning with the start row.
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Implicit and explicit indexing

Examples 1, 2, and 3 show how to use the <tsx:repeat> tag. The examples produce the same output if all
indexed properties have 300 or fewer elements. If there are more than 300 elements, Examples 1 and 2
display all elements, while Example 3 shows only the first 300 elements.

Example 1 shows implicit indexing with the default start and default end index. The bean with the smallest
number of indexed properties restricts the number of times the loop repeats.

<table>

<tsx:repeat>
<tr><td><tsx:getProperty name="servicelocationsQuery" property="city" />
</tr></td>
<tr><td><tsx:getProperty name="servicelocationsQuery" property="address" />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="telephone" />
</tr></td>

</tsx:repeat>

</table>

Example 2 shows indexing, starting index, and ending index:

<table>
<tsx:repeat index=myIndex start=0 end=2147483647>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=city(myIndex) />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=address(myIndex) />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=telephone(myIndex) />
</tr></td>
</tsx:repeat>
</table>

Example 3 shows explicit indexing and ending index with implicit starting index. Although the index
attribute is specified, you can still implicitly index the indexed property city because the (myIndex) tag is
not required.

<table>

<tsx:repeat index=myIndex end=299>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="city" /t>
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="address(myIndex)" />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="telephone(myIndex)" />
</tr></td>

</tsx:repeat>

</table>

Nesting <tsx:repeat> blocks

You can nest <tsx:repeat> blocks. Each block is separately indexed. This capability is useful for
interleaving properties on two beans, or properties that have subproperties. In the example, two
<tsx:repeat> blocks are nested to display the list of songs on each compact disc in the user’s shopping
cart.

<tsx:repeat index=cdindex>
<hl><tsx:getProperty name="shoppingCart" property=cds.title /></hl>
<table>
<tsx:repeat>
<tr><td><tsx:getProperty name="shoppingCart" property=cds(cdindex).playlist />
</td></tr>
</tsx:repeat>
</table>
</tsx:repeat>
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JspBatchCompiler tool

As an IBM enhancement to JavaServer Pages support, IBM WebSphere Application Server provides a
batch JSP compiler. Use this function to batch compile your JSP files and thereby enable faster responses
to the initial client requests for the JSP files on your production Web server.

Batch compiling makes the first request for a JSP file much faster because the JSP file is translated and
compiled into a servlet. Batch compiling is also useful as a fast way to resynchronize all of the JSP files
for an application.

To use the JSP batch compiler for JSP files, enter the following command on a single line at an operating
system command prompt:
JspBatchCompiler -enterpriseapp.name <name>
[ -webmodule.name <name>]
[ -cell.name <name>]
[ -node.name <name>]
[ -server.name <name>]
[ -filename <jsp name>]
[ -keepgenerated <true|false>]
[ -verbose <true|false>]
[ -deprecation <true|false>]

If the names specified for these arguments are comprised of two or more words separated by spaces, you
must add quotation marks around the names.

where:
* enterpriseapp.name

Represents the name of the enterprise application you want to compile.
* webmodule.name

Represents the name of the specific Web module that you want to compile. If this argument is not set,
all Web modules in the enterprise application are compiled.
» cell.name

Represents the name of the cell in which the application is deployed. The default is
BaseApplicationServerCell.
* node.name

Represents the name of the node in which the application is deployed. The default is DefaultNode.
* server.name

Represents the name of the server in which the application is deployed. The default is serverl.
» filename

Represents the name of a single JSP file that you want to compile. If this argument is not set, all files in
the Web module are compiled. Alternatively, if filename is set to the name of a directory, only the JSP
files in that directory are compiled.

* keepgenerated

Represents the option to save or erase the generated files.

If set to yes, WebSphere Application Server saves the generated . java files used for compilation on
your server. By default, this argument is set to no and the .java files are erased after the class files
have compiled.

* verbose
Indicates the compiler should generate verbose output while compiling the generated sources.

* deprecation

Indicates the compiler should generate deprecation warnings while compiling the generated sources.
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Bean Scripting Framework

The Bean Scripting Framework (BSF) enables you to use scripting language functions in your Java
server-side applications. This framework also extends scripting languages so that you can use existing
Java classes and Java beans in the JavaScript language. Support in the JSP Engine for the Bean
Scripting Framework is deprecated with WebSphere Application Server 5.1.

With BSF, you can write scripts that create, manipulate and access values from Java objects, or you can
write Java programs that evaluate and access results from scripts.

WebSphere Application Server provides the Bean Scripting Framework, which consists of a BSF manager,
a BSF engine, and a scripting engine.

BSF provides an access mechanism to Java objects for the scripting languages it supports, so that both
the scripting language and the Java code can access code exclusive functions. The access mechanism is
implemented through a registry of objects maintained by BSF.

BSF in WebSphere Application Server supports the Rhino ECMAScript.

The "Resources for Learning” article provides external BSF links that document future supported
languages.

Developing Web applications

Design a Web application and the components that it needs.
For general Web application design information, see "Resources for learning.”

There are two basic approaches to selecting tools for developing Web applications:

* You can use one of the available integrated development environments (IDEs). IDE tools automatically
generate significant parts of the servlet and JavaServer Pages (JSP) code, and Hypertext Markup
Language (HTML) files. They also contain integrated tools for packaging and testing the Web
application components. The IBM WebSphere Application Developer product is the recommended IDE.
For more information, see the documentation for that product.

 If you decide to develop Web components without an IDE, you need at least an ASCII text editor. You
can also use tools available in the Java Software Development Kit (SDK) and in this product to
assemble, test, and deploy the Web application components.

The following steps support the second approach, development without an IDE.
1. If necessary, [migrate any pre-existing codelto the required version of the servlet and JSP specification.

2. Write and compile the components of the Web application. To access classes that were extended,
compile your code using the -classpath option on the javac compiler. This option allows you to
reference the j2ee.jar file in the product <install root>\1ib directory.

For example, to compile a servlet running on the Windows NT version of WebSphere Application
Server, specify:
javac -classpath D:\Program Files\WebSphere\AppServer\lib\j2ee.jar MyServiet.java
To compile that same servlet on the Windows NT version of WebSphere Network Deployment, specify:
javac -classpath D:\Program Files\WebSphere\DeploymentManager\1lib\j2ee.jar MyServlet.java

3. (Optional) Disable JavaServer Pages (JSP) runtime compilation, if necessary.

|Assemb|e the application components in one or more Web modules.|
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Disabling JavaServer Pages run-time compilation

By default, the JavaServer Pages (JSP) engine translates a requested JSP file, compiles the . java file,
and loads the compiled servlet into the run-time environment. In previous releases of WebSphere
Application Server, if a .class file did not exist, the JSP engine always translated and compiled the JSP
file. You had to turn off the Web applications reload capability to prevent additional translations and
recompiles of the file.

With Version 5.0.1 of WebSphere Application Server, you can now change the JSP engine default
behavior by indicating a JSP file should never be translated or compiled at run time, even when a .class
file does not exist.

If run-time compilation is disabled, you must precompile the JSP files, which provides the following

advantages:

* Reduces compilation related disk operations.

* Minimizes disk storage requirements necessary for handling temporary .java and .class files generated
during a run-time compilation.

» Forces you to verify that a JSP file compiled successfully before deploying and installing the application
in WebSphere Application Server.

You can disable run-time JSP file compilation on a global or an individual Web application basis:
» To disable the translation and compilation of JSP files for all Web applications, set the Web container
Custom property disabledspRuntimeCompilation to true.

Set this property through the Web container Custom properties panel in the administrative console. To
view this administrative console page, click:
Servers > Application Servers > server_name > Web Container >
Custom Properties > property_name

Valid values for this setting are true or false. If this property is set to true, then translation and
compilation of the JSP files is disabled at run time for all Web applications.

» To disable the translation and compilation of JSP files for a specific Web application, set the JSP engine
initialization parameter disabledspRuntimeCompilation to true. This setting, if enabled, determines the
run-time behavior of the JSP engine and overrides the Web container custom property setting.

Set this parameter through the JavaServer Pages attribute assembly settings panel in the
[Chapter 30, “Assembling applications with the Assembly Toolkit,” on page 1429.|

Valid values for this setting are true or false. If this parameter is set to true, then, for that specific Web
application, translation and compilation of the JSP files is disabled at run time, and the JSP engine only
loads precompiled files.

 If neither the Web container custom property nor the JSP attribute assembly parameter is set, the first
request for a JSP file results in the translation and compilation of the JSP file when the .class file does
not exist. Subsequent requests for the file also result in compilations and translations, but only if the
following conditions are met:
— Compilations and translations are required.
— Reloading is enabled for the Web module.
— Reload interval is exceeded.

If you disable run-time compilation and a request arrives for a JSP file that does not have a matching
.class file, the JSP engine returns HTTP error 501 (Not implemented) to the browser. If the JSP file does
not exist, the JSP engine returns HTTP error 404 (File not found) to the browser. In both cases, an
exception is written to the System Out (SYSOUT) and First Failure Data Capture (FFDC) logs. In both
cases, an exception is written to the joblog (sysprint) file if ras_trace_outputLocation in was.env file is set
to SYSPRINT or to CTRACE if ras_trace_outputLocation is set to BUFFER. If a JSP file has a matching
.class file but that file is out of date, the JSP engine still loads the .class file into memory.

Perform the following steps to determine whether the disableJspRuntimeCompilation option is enabled in
WebSphere Application Server:
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4.

Enable the Diagnostic Trace Service and set the trace specification to
com.ibm.ws.webcontainer.jsp.serviet.*=all=enabled.

Request a JSP file.

Locate the string, disableJspRuntimeCompilation:true, in the trace.log file.Locate the string,
disabledspRuntimeCompilation:true, in the joblog (sysprint) file if ras_trace_outputLocation in was.env
file is set to SYSPRINT or to CTRACE if ras_trace_outputLocation is set to BUFFER.

Ensure the jspUri: entry matches the requested JSP file.

If both the disabledspRuntimeCompilation:true string and the matching jspUri: entry appear in the trace,
the disabledspRuntimeCompilation setting is enabled for the Web application.

Example: Converting JavaScript source to the Bean Scripting
Framework

JavaScript code is one of the most popular languages of Web developers. This language supports the
following base objects, plus additional objects from the Document Object Model:

array
date
math
number
string

Server-side JavaScript code supports the same base objects, and additional objects that support user
access to databases, file systems and e-mail systems.

Like client-side JavaScript code, server-side JavaScript code is also platform, browser, and language
independent.

You can convert server-side JavaScript applications to the Bean Scripting Framework. This article
describes how to perform this conversion.

Server-side JavaScript source code

Suppose you have the following server-side JavaScript application:

<html>

<head>

<title>Hello World server-side JavaScript example</title>
</head>

<body>

<br><br>

</body>

</html>

<server>
function writePage()

write("<center><font size='6'>Hello World</font></center>");

</server>

Converting server-side JavaScript source code to the Bean Scripting Framework (BSF)

Make the following changes to the JavaScript source code to enable BSF:

<%@ page language="javascript" %>

<html>

<head>

<title>Hello World server-side BSF/JavaScript example</title>
</head>

<body>

<br><br>
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</body>
</html>

<

o

out.printin("<center><font size='6'>Hello World</font></center>");
>

P

Review the other BSF reference articles for deployment information and additional programming examples.

Scenario: Creating a Bean Scripting Framework application

Scenario description

Programming skills in JavaScript code are more prevalent than programming skills using JavaServer
Pages (JSP) tags. Using the Bean Scripting Framework, JavaScript programmers can gradually introduce
JSP tags in their JavaScript applications without completely rewriting the source code. The BSF method
not only reduces the potential of programming errors, but also provides a painless way to learn a new
technology.

The following scenario illustrates how to implement a BSF application using JavaScript within JSP tags.
Developing the BSF application

At ABC elementary school, John Doe teaches third grade mathematics. He wants to help his students
memorize their multiplication tables, and thinks a small Web-based quiz could help meet his objective.
However, John Doe only knows JavaScript.

Using the Bean Scripting Framework to help leverage his JavaScript skills, John Doe creates two JSP
files, multiplication_test.jsp and multiplication_scoring.jsp

In the multiplication_test.jsp file, John Doe uses both client-side and server-side JavaScript code to
generate a test of 100 random multiplication questions, displayed using a three minute timer. He then
writes the multiplication_scoring.jsp file to read the data submitted by the multiplication_test.jsp file
and to generate the scoring results.

John Doe creates the following two files:

multiplication_test.jsp:

<htmi1>

<head>

<title>Multiplication Practice Test</title>
<script language="javascript">

var countMin=3;

var countSec=0;

function updateDisplay (min, sec) {

var disp;
if (min <= 9) disp = " 0";
else disp = " ";

disp += (min + ":");
if (sec <= 9) disp += ("0" + sec);
else disp += sec;
return(disp);
1
function countDown() {
countSec--;
if (countSec == -1) {
countSec = 59;
countMin--;
1
document.multtest.counter.value = updateDisplay(countMin, countSec);
if((countMin == 0) &&(countSec == 0)) document.multtest.submit();
else var down = setTimeout("countDown();", 1000);
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}

</script>

</head>

<body bgcolor="#ffffff" onLoad="countDown();">

<%@ page Tanguage="javascript" %>

<h1>Three Minute Multiplication Drill</hl>

<hpr>

<h2>Remember: this is an opportunity to excel!</h2>

<p>

<form method="POST" name="multtest" action="multiplication_scoring.jsp">

<div align="center">

<table>

<tr>

<td>

<h3>Time left:

<input type="text" name="counter" size="9" value="03:00" readonly>

</h3>

</td>

<td>

<input type="submit" value="Submit for scoring!">

</td>

</tr>

</table>

<table border="1">

<%

var newrow = 0;

var g_num = 0;

function addQuestion(numl, num2) {
if (newrow == 0) out.printin("<tr>");
out.printTn("<td>");

out.printin(numl + " x " + num2 + " = ");
out.printin("</td><td>");
out.print("<input name=\"" + g num + "|" + numl + ":" + num2 + "\" ");

out.printin("type=\"text\" size=\"10\">");
out.printin("</td>");
if (newrow == 3) {

out.printin("</tr>");

newrow = 0;
else newrow++;
q_num++;

for (var i = 0; i < 100; i++) {
var randl = Math.ceil(Math.random() * 12);
var rand2 = Math.ceil(Math.random() * 12);
addQuestion(randl, rand2);

A° ——

>
</table>
</div>
</form>
</body>
</html>

multiplication_scoring.jsp:

<html>

<head>

<title>Multiplication Practice Test Results</title>
</head>

<body bgcolor="#ffffff">

<%@ page Tanguage="javascript" %>
<h1>Multiplication Drill Score</h1>

<hr>

<div align="center">

<table border="1">

<tr><th>Problem</th><th>Correct Answer</th><th>Your Answer</th></tr>
<%

var total_score = 0;
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function score (current, posl, pos2) {
var multiplier = current.substring(posl + 1, pos2);
var multiplicand = current.substring(pos2 + 1, current.length());
var your_product = request.getParameterValues(current)[0];
var true_product = multiplier * multiplicand;
out.printTn("<tr>");
out.printin("<td>" + multiplier + " x " + multiplicand + " = </td>");
out.printin("<td>" + true_product + "</td>");
if (your_product == true_product) {
total_score++;
out.print("<td bgcolor=\"\#00ff00\">");

else {
out.print("<td bgcolor=\"\#ff0000\">");

out.printin(your_product + "</td>");
out.printin("</tr>");
1
var equations = request.getParameterNames();
while(equations.hasMoreElements()) {
var currElt = equations.nextElement();
var splitPosl = currElt.index0f("|");
var splitPos2 = currElt.index0f(":");
if (splitPosl >=0 && splitPos2 >= 0) score(currElt, splitPosl, splitPos2);
</table>
<h2>Total Score: <%= total_score %></h2>
<h3><a href="multiplication_test.jsp">Try again?</a></h3>
</div>
</body>
</html>

Follow these steps to see how John Doe uses BSF to implement JavaScript in a JSP application:
1. Give your files a . jsp extension.
2. Use server-side JavaScript code in your application.

The multiplication_test.jsp file incorporates both client-side and server-side JavaScript. Server-side
JavaScript is similar to client-side JavaScript; the primary difference consists of using a different set of
objects. Whereas client-side Javascript programmers invoke document and window objects,
server-side JavaScript programmers, using the Bean Scripting Framework, invoke a set of objects
provided by the JSP technology. Also, client-side scripts are enclosed in <script> tags, but server-side
scripts use JSP scriptlet and expression tags.

3. Examine the following blocks of code:

<script language="javascript">

var countMin=3;

var countSec=0;

function updateDisplay (min, sec) {

var disp;
if (min <= 9) disp = " 0"
else disp = " ";

disp += (min + ":");
if (sec <= 9) disp += ("0" + sec);
else disp += sec;
return(disp);
}
function countDown() {
countSec--;
if (countSec == -1) {
countSec = 59;
countMin--;
}
document.multtest.counter.value = updateDisplay(countMin, countSec);
if((countMin == 0) && (countSec == 0)) document.multtest.submit();

Chapter 2. Using Web applications 39



40

else var down = setTimeout("countDown();", 1000);

}

</script>
<body bgcolor="#ffffff" onLoad="countDown();">
<form method="POST" name="multtest" action="multiplication_scoring.jsp">

<input type="text" name="counter" size="9" value="03:00" readonly>

The JavaScript code contained in the <script> block implements a timer set within the <input> field
named counter. The onLoad event handler in the <body> tag causes the browser to load and execute
the code when the the page is loaded.

The document.multtest.submit() statement causes the form named multtest to be submitted when
the timer expires.

Identify the code to the BSF function.

The following code example, from the multiplication_test.jsp file, displays the use of a JSP
directive. This directive tells the WebSphere Application Server BSF function that this file is using the
JavaScript language, and that the JavaScript code is enclosed by the <% ... %> scriptlet tags. The out
implicit JSP object in this code example, creates the body section of a table from 100 randomly
generated questions.

<%@ page language="javascript" %>
<%

var newrow = 0;

var g_num = 0;

function addQuestion(numl, num2) {
if (newrow == 0) out.printIn("<tr>");

out.printin("<td>");

out.printin(numl + " x " + num2 + " = ");
out.printin("</td><td>");
out.print("<input name=\"" + g num + "|" + numl + ":" + num2 + "\" ");

out.printin("type=\"text\" size=\"10\">");
out.printin("</td>");

if (newrow == 3) {
out.printin("</tr>");
newrow = 0;

1

else newrow++;
q_numt+;
for (var i = 0; i < 100; i++) {

var randl = Math.ceil(Math.random() * 12);
var rand2 = Math.ceil(Math.random() * 12);

addQuestion(randl, rand2);
}

0,
%>

Read the results.

To score the results of the practice drill, John Doe uses the request implicit JSP object in the
multiplication_scoring.jsp file to obtain the POST data created within the <form> tags in the
multiplication_test.jsp file.
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The multiplication_scoring.jsp file uses the POST data to build an output file containing the original
question, the student’s answer, and the correct answer, and then prints the text in a table format using
the out implicit object.

The following code example from the multiplication_scoring.jsp file illustrates the use of the
request and out JSP objects:

<%@ page Tanguage="javascript" %>
<%
var total_score = 0;
function score (current, posl, pos2) {
var multiplier = current.substring(posl + 1, pos2);
var multiplicand = current.substring(pos2 + 1, current.length());
var your_product = request.getParameterValues(current)[0];
var true_product = multiplier * multiplicand;
out.printin("<tr>");
out.printin("<td>" + multiplier + " x " + multiplicand + " = </td>");
out.printin("<td>" + true_product + "</td>");
if (your_product == true_product) {
total_score++;
out.print("<td bgcolor=\"\#00ff00\">");

else {
out.print("<td bgcolor=\"\#ffo000\">");

out.printin(your_product + "</td>");

out.printin("</tr>");
}
var equations = request.getParameterNames();
while(equations.hasMoreElements()) {

var currkElt = equations.nextElement();

var splitPosl = currElt.index0f("|");

var splitPos2 = currElt.index0f(":");

if (splitPosl >=0 && splitPos2 >= 0) score(currElt, splitPosl, splitPos2);

N

>

<h2>Total Score: <%= total_score %></h2>

Note:Although using separate scriptlet blocks of code for different portions of a conditional expression
is common in JSP files implemented in Java, it is invalid for JSP files implemented using JavaScript
through the Bean Scripting Framework. The JavaScript code must be entirely contained within the
scriptlet tags.

The following code example illustrates invalid usage:

<% if (pass == 0) %>
<i>pass is true</i>

<% else %>
<i>pass is not true</i>

Deploying the BSF application
You assemble and deploy BSF applications in the same manner as JSP applications. Review the

|Chapter 30, “Assembling applications with the Assembly Toolkit,” on page 14291 article for more
information.

Deploy the|BSF code examples| in WebSphere Application Server to view this applications processing and
output. Use the following quick steps to deploy the application.
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The intent of these "quick steps” is to provide you with instant application output. However, the supported
method for deployment is the same as for standard JSP files.

1. Use the [DefaultApplication| to add your BSF files.
Copy your . jsp files to the DefaultApplication directory:

<app server install directory>/installedApps/<node
name>/DefaultApplication.ear/DefaultApplication.war

2. Start the application server.

3. Open a browser and request your BSF application.
Use the following URL to request your application:
http://hostName:9080/<jspFileName>.jsp

Example: Bean Scripting Framework code example

The following code examples show how to implement JavaScript using the Bean Scripting Framework
(BSF).

For a quick demonstration of the BSF function, copy these code examples into 2 separate files, and
deploy them in WebSphere Application Server using the instructions in the BSF scenario article.

Multiplication practice test

<html>

<head>

<title>Multiplication Practice Test</title>

<l--

This file and its companion, multiplication_score.jsp, illustrate the
use of ECMAScript within the BSF framework. The task is a simple
timed math quiz, which is 3 minutes in duration. When the quiz ends,
the score is computed and displayed.

Users are then asked if they wish to try

the quiz again.

-

<l--

This code fragment displays and updates the quiz
countdown in client side JavaScript code.

-

<script language="javascript">

var countMin=3;

var countSec=0;

// This code computes the current countdown time.
function updateDisplay (min, sec) {
var disp;

if (min <= 9) disp = " 0"
else disp = " "3

disp += (min + ":");

if (sec <= 9) disp += ("0" + sec);
else disp += sec;

return(disp);
1
//This code fragment displays the current countdown time in the user's
//browser window,and submits the results for scoring when the countdown
//ends.

function countDown() {
countSec--;
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if (countSec == -1) {

countSec = 59;

countMin--;
1
document.multtest.counter.value = updateDisplay(countMin, countSec);
if((countMin == 0) && (countSec == 0)) document.multtest.submit();
else var down = setTimeout("countDown();", 1000);

}

</script>
</head>
<body bgcolor="#ffffff" onLoad="countDown();">

<l--

The body of the quiz runs as JavaServer Pages (JSP) code using BSF.
The code outputs the problems in table format using the POST method
and invokes the scoring module when the user chooses to end the quiz
or when the countdown ends.

-

<%@ page Tanguage="javascript" %>

<hl>Three Minute Multiplication Drill</h1>
<hr>

<h2>Remember: this is an opportunity to excel!</h2>
<p>

<form method="POST" name="multtest" action="multiplication_scoring.jsp">
<div align="center">

<table>

<tr>

<td>

<h3>Time left:

<input type="text" name="counter" size="9" value="03:00" readonly>
</h3>

</td>

<td>

<input type="submit" value="Submit for scoring!">

</td>

</tr>

</table>

<table border="1">

<%

var newrow = 0;

var g_num = 0;

// This code generates a new random multiplication problem up to the number
//twelve, and enters it into the table of problems.

function addQuestion(numl, num2) {
if (newrow == 0) out.printin("<tr>");

out.printTn("<td>");

out.printin(numl + " x " + num2 + " = ");
out.printin("</td><td>");
out.print("<input name=\"" + g_num + "|" + numl + ":" + num2 + "\" ");

out.printin("type=\"text\" size=\"10\">");
out.printTn("</td>");

if (newrow == 3) {
out.printin("</tr>");
newrow = 0;

}

else newrow++;

q_num++;
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//This code obtains two random operands and formats 100 quiz problems.

for (var i = 0; i < 100; i++) {
var randl = Math.ceil(Math.random() * 12);
var rand2 = Math.ceil(Math.random() * 12);

addQuestion(randl, rand2);
1

%>
</table>
</div>
</form>

</body>
</html>

Multiplication practice test results

<html>

<head>

<title>Multiplication Practice Test Results</title>
</head>

<body bgcolor="#ffffff">

<l--

This JSP code is invoked when the user submits a math quiz for scoring,

or when the quiz countdown expires. The JSP code tabulates the problem 1list,
the correct answer, the user's answer, and scores the test. It then offers
the user an opportunity to try the quiz again.

-

<%0 page language="javascript" %>

<hl>Multiplication Drill Score</h1>
<hr>

<div align="center">

<table border="1">

<tr><th>Problem</th><th>Correct Answer</th><th>Your Answer</th></tr>
<%

var total_score = 0;

// This code parses the submitted form, extracts the a problem generated by the
// multiplication_test.jsp file, outputs it, computes the correct answer,

// and displays this information and the user answer. The code scores

// the quiz using a running sum of correct answers.

function score (current, posl, pos2) {
var multiplier = current.substring(posl + 1, pos2);
var multiplicand = current.substring(pos2 + 1, current.length());
var your_product = request.getParameterValues(current)[0];
var true _product = multiplier * multiplicand;

out.printin("<tr>");
out.printin("<td>" + multiplier + " x " + multiplicand + " = </td>");
out.printin("<td>" + true_product + "</td>");
if (your_product == true_product) {
total_score++;
out.print("<td bgcolor=\"\#00ff00\">");

else {
out.print("<td bgcolor=\"\#ff0000\">");

out.printIn(your_product + "</td>");
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out.printin("</tr>");

// This is the main body of the scoring application. It parses the posted quiz,
// and calls the score() function to score remaining problems.

var equations = request.getParameterNames();
while(equations.hasMoreElements()) {
var currElt = equations.nextElement();
var splitPosl = currElt.index0f("|");
var splitPos2 = currElt.index0f(":");

if (splitPosl >=0 && splitPos2 >= 0) score(currElt, splitPosl, splitPos2);
%>
</table>
<h2>Total Score: <%= total_score %></h2>
<h3><a href="/multiplication_test.jsp">Try again?</a></h3>

</div>

</body>
</html>

Web modules

A Web module represents a Web application. A Web module is created by assembling servlets,
JavaServer Pages (JSP) files, and static content such as HyperText Markup Language (HTML) pages into
a single deployable unit. Web modules are stored in Web archive (WAR) files, which are standard Java
archive files.

A Web module contains:
* One or more servlets, JSP files, and HTML files.
» A deployment descriptor, stored in an Extensible Markup Language (XML) file.

The file, named web.xm1, declares the contents of the module. It contains information about the structure
and external dependencies of Web components in the module and describes how the components are
used at run time.

You can create Web modules as stand-alone applications, or you can combine Web modules with other
modules to create J2EE applications. You install and run a Web module in the Web container of an
application server.

Assembling Web applications

Assemble a Web module to contain servlets, JavaServer page (JSP) files, and related code artifacts.
(Group enterprise beans, client code, and resource adapter code in separate modules). After assembling a
Web module, you can install it as a stand-alone application or combine it with other modules into an
enterprise application.

Use the |Assembly Toolkit| to assemble a Web module in any of the following ways:

* Import an existing Web module (WAR file).

» Create a new Web module.

» Copy code artifacts (such as servlets) from one Web module into a new Web module.

Although you can input various properties for Web archives, available properties are specific to the Servlet,
JSP, and J2EE specification level.

1. [Start the Assembly Toolkit]

Chapter 2. Using Web applications 45



2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

3. Optional: Open the J2EE Hierarchy view. Click Window > Show View > J2EE Hierarchy. Other
helpful views include the Project Navigator view (Window > Show View > Other > J2EE > Project
Navigator) and the Navigator view (Window > Show View > Navigator).

4, 5.1+ Optional: To use application assembly services of WebSphere Business Integration (WBI) Server
Foundation such as |Internationalization} [ActivitySession| or|Application profiling, select the Integration
Server target server.

a. Click Project > Properties > J2EE.

b. For Target server, select Integration Server. For this release, Integration Server v5.1.
c. Click OK.

You can set values for WBI Server Foundation services on the Extended Services tab of a
deployment descriptor editor open on the module.

5. Migrate WAR files| created with the Application Assembly Tool (AAT) or a different tool to the Assembly
Toolkit. To migrate files, import your WAR files|to the Assembly Toolkit.

6. [Create a new Web module]
7. Copy code artifacts (such as servlets) from one Web module into a new Web module.
8. Verify the contents of the new Web module in either of the following ways:

* In the J2EE Hierarchy view, expand Web Modules and view the new module.

» Click Window > Show View > Navigator to see the associated files for the Web module in a
Navigator view.

Context parameters

A servlet context defines a server’s view of the Web application within which the servlet is running. The
context also allows a servlet to access resources available to it.

Using the context, a servlet can log events, obtain URL references to resources, and set and store
attributes that other servlets in the context can use. These properties declare a Web application’s
parameters for its context. They convey setup information, such as a webmaster’'s e-mail address or the
name of a system that holds critical data.

Security constraints
Security constraints determine how Web content is to be protected.

These properties associate security constraints with one or more Web resource collections. A constraint

consists of a Web resource collection, an authorization constraint and a user data constraint.

* A Web resource collection is a set of resources (URL patterns) and HTTP methods on those resources.
All requests that contain a request path that matches the URL pattern described in the Web resource
collection are subject to the constraint. If no HTTP methods are specified, then the security constraint
applies to all HTTP methods.

* An authorization constraint is a set of roles that users must be granted in order to access the resources
described by the Web resource collection. If a user who requests access to a specified URI is not
granted at least one of the roles specified in the authorization constraint, the user is denied access to
that resource.

» A user data constraint indicates that the transport layer of the client or server communications process
must satisfy the requirement of either guaranteeing content integrity (preventing tampering in transit) or
guaranteeing confidentiality (preventing reading while in transit).

Servlet mappings
A servlet mapping is a correspondence between a client request and a servlet.
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Servlet containers use URL paths to map client requests to servlets, and follow the URL path-mapping
rules as specified in the Java Servlet specification. The container uses the URI from the request, minus
the context path, as the path to map to a servlet. The container chooses the longest matching available
context path from the list of Web applications that it hosts.

Invoker attributes
Invoker attributes are used by the servlet that implements the invocation behavior.

Error pages

Error page locations allow a servlet to find and serve a URI to a client based on a specified error status
code or exception type.

These properties are used if the error handler is another servlet or JSP file. The properties specify a
mapping between an error code or exception type and the path of a resource in the Web application. The
container examines the list in the order that it is defined, and attempts to match the error condition by
status code or by exception class. On the first successful match of the error condition, the container
serves back the resource defined in the Location property.

File serving

File serving allows a Web application to serve static file types, such as HTML. File-serving attributes are
used by the servlet that implements file-serving behavior.

Initialization parameters
Initialization parameters are sent to a servlet in its HttpConfig object when the servlet is first started.

Servlet caching

Dynamic caching can be used to improve the performance of servlet and JavaServer Pages (JSP) files by
serving requests from an in-memory cache. Cache entries contain the servlet’s output, results of the
servlet’'s execution, and metadata.

Web components

A web component is a servlet, Java Server Page (JSP), or HTML file. One or more web components make
up a web module.

Web property extensions

Web property extensions are IBM extensions to the standard deployment descriptors for Web applications.
These extensions include mime filtering and servlet caching.

Web resource collections

A Web resource collection defines a set of URL patterns (resources) and HTTP methods belonging to the
resource.

HTTP methods handle HTTP-based requests, such as GET, POST, PUT, and DELETE. A URL pattern is a

partial Uniform Resource Locator that acts as a template for matching the pattern with existing full URLs in
an attempt to find a valid file.

Welcome files
A Welcome file is an entry point file (for example, index.html) for a group of related HTML files.

Welcome files are located by using a group of partial URIs. The Web container uses the partial URIs to
find a valid file when the initial URI is not found.
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Troubleshooting tips for Web application deployment

Deployment of a Web application is successful if you can access the application by typing a Uniform
Resource Locator (URL) in a browser, or if you can access the application by following a link.

If you cannot access your application, follow these steps to eliminate some common errors that can occur
during migration or deployment.

Web module does not run in WebSphere Application Server Version 5.

Symptom Your Web module does not run when you migrate it to Version 5

Problem In Version 4.x, the classpath setting that affected visibility was Module Visibility Mode.
In Version 5, you must use class loader policies to set visibility.

Recommended response Reassemble an existing module, or change the visibility settings in the class loader
policies. in the class loader policies.

See article Migration of module visibility modes from Version 4.4 for more information
and examples.

Welcome page is not visible.

Symptom You cannot access an application with a Web path of:
/webapp/myapp
Problem The default welcome page for a Web application is assumed to be index.html. You

cannot access the default page of the myapp application unless it is named index.html.
Recommended response To identify a different welcome page, modify the properties of the Web module during
assembly.

HTML files are not found.

Symptom Your Web application ran successfully on prior versions, but now you encounter errors
that the welcome page (typically index.html), or referenced HTML files are not found:

Error 404: File not found: Banner.html
Error 404: File not found: HomeContent.html

Problem For security and consistency reasons, Web application URLs are now case-sensitive on
all operating systems.

Suppose the content of the index page is as follows:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 5.0 Frameset//EN">

<HTML>

<TITLE>

Insurance Home Page

</TITLE>
<frameset rows="18,80">
<frame src="Banner.html" name="BannerFrame" SCROLLING=NO>
<frame src="HomeContent.html" name="HomeContentFrame">
</frameset>

</HTML>

However the actual file names in the \WebSphere\AppServer\installedApps\...
directory where the application is deployed are:
banner.html
homecontent.html

Recommended response To correct this problem, modify the index.html file to change the names Banner.html
and HomeContent.html to banner.html and homecontent.html to match the names of
the files in the deployed application.
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For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Modifying the default Web container configuration

The Web container is created initially with default properties values suitable for simple Web applications.
However, these values might not be appropriate for more complex Web applications.

Your application is considered complex if it requires any of the following features:
* virtual host

» servlet caching

» special client request loads

» persistent HTTP session support

» special HTTP transport settings

» transaction class mappings

Modify the following properties if you have a complex application:

1. If your Web application requires a virtual host, other than the default_host, or requires servlet caching,
modify the Web container General Properties.

2. If your application handles special client request loads, modify the Web Container Additional
Properties > Thread Pool setting.

3. If your application requires persistent HTTP session support, modify the Web Container Additional
Properties > Session Management setting.

4. If your application requires one of the following HTTP transport settings:
* Unique hostname and port for client access
* SSL enablement

modify the Web Container Additional Properties > HTTP transports setting.

5. If your application requires global settings for internal servlets for WAR files packaged by third-party
tools, modify the Web Container Additional Properties > Custom Properties setting.

6. If your application uses transaction class mappings to classify workload, modify the Web Container
Additional Properties > Advanced Settings.

Web container

A Web container handles requests for servlets, JavaServer Pages (JSP) files, and other types of files that
include server-side code. The Web container creates servlet instances, loads and unloads servlets,
creates and manages request and response objects, and performs other servliet management tasks.

The Web server plug-ins, provided by the WebSphere Application Server, help supported Web servers
pass servlet requests to Web containers.

Web container settings
Use this page to configure the web container settings.

To view this administrative console page, click Servers > Application Servers > server_instance > Web
container.

Configuration - General Properties
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Default virtual host

Specifies a virtual host that enables a single host machine to resemble multiple host machines. Resources
associated with one virtual host cannot share data with resources associated with another virtual host,
even if the virtual hosts share the same physical machine.

Select a virtual host option:

Default Host
The product provides a default virtual host with some common aliases, such as the machine IP
address, short host name, and fully qualified host name. The alias comprises the first part of the
path for accessing a resource such as a servlet. For example, it is Tocalhost:9080 in the request
http://Tocalhost:9080/myServiet.

Admin Host
This is another name for the application server; also known as server? in the base installation.
This process supports the use of the administrative console.

Servlet caching
Specifies that if a servlet is invoked once and it generates output to be cached, a cache entry is created
containing not only the output, but also side effects of the invocation. These side effects can include calls
to other servlets or Java Server Pages (JSP) files, as well as metadata about the entry, including timeout
and entry priority information.
Enable serviet caching

Check this box to enable servlet caching.

Web Module Deployment settings

Use this page to configure an instance of Web module deployment.

To view this administrative console page, click Applications > Enterprise Application >
application_instance > Web Modules > Web Module_instance.

URI

Specifies a URI that, when resolved relative to the application URL, specifies the location of the module
archive contents on a file system. The URI must match the ModuleRef URI in the deployment descriptor of
an application if the module was packaged as part of a deployed application or enterprise archive (EAR)
file.

Alternate DD

Specifies the file name for an alternative deployment descriptor file to use instead of the original
deployment descriptor file in the module JAR file.

This file is the post-assembly version of the deployment descriptor file. You can edit the original
deployment descriptor file to resolve dependencies and security information. Specifying the use of the
alternative deployment descriptor keeps the original deployment descriptor file intact.

The value of the Alternate DD property must be the full path name of the deployment descriptor file,
relative to the module root directory. By convention, the file is in the ALT-INF directory. If this property is
not specified, the deployment descriptor file is read from the module JAR file.

Starting weight
Specifies the order in which modules are started. Lower weighted modules are started before higher
weighted modules.

Classloader Mode

Specifies whether the class loader should search in the parent class loader or in the application class
loader first to load a class. The standard for JDK class loaders and WebSphere class loaders is
PARENT_FIRST. By specifying PARENT_LAST, your application can override classes contained in the
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parent class loader, but this action can potentially result in ClassCastException or LinkageErrors if you
have mixed use of overriden classes and non-overriden classes.

The options are PARENT_FIRST and PARENT_LAST. The default is to search in the parent class loader
before searching in the application class loader to load a class.

Data type String
Default PARENT_FIRST

Web container advanced settings

Use this page to support Web container advanced settings. This support includes Network QoS and
transaction class mapping

To view this administrative console page, click Servers > Application Servers > server name > Web
Container > Advanced Settings.

Network QoS
Specifies the parameter that will be used to classify outbound data that is delivered in response to HTTP
and HTTPS requests.

The classification parameters are used to construct an ApplicationData parameter for the TCP/IP network
service, which is called Quality of Service (QoS). The ApplicationData parameter is used in a QoS
PolicyRule statement.

You can specify at most one classification parameter. If you do not specify a classification parameter, the
response data will not be classified to the network agent.

Parameter Description

HOST Indicates that the Host value from the Host header, not including the port, is to be used
used to construct an ApplicationData parameter. If you specify this parameter,
WebSphere for z/OS classifies the outbound response data by using the HOST value.

In the request:
http://www.mycompany.com/mywebap/myserviet

www .mycompany . com represents the host value.

URI Indicates that the part of the Universal Resource Locator that specifies the path to a
resource is to be used to construct an ApplicationData parameter. If you specify this
parameter, WebSphere for z/OS classifies the outbound response data by using the
URI value. The path must be specified exactly as it is entered in a browser because the
check for this path is case sensitive.

In the request:
http://www.mycompany.com/mywebap/myserviet

/mywebap/myserviet represents the URI value.

HOSTURI Indicates that the HOST and URI, concatenated together, are to be used to construct
an ApplicationData parameter. If you specify this parameter, WebSphere for z/OS
classifies the outbound response using the concatenated HOST and URI value.

In the request:
Get request: http://www.mycompany.com/mywebap/myserviet

www.mycompany .com/mywebap/myserviet represents the concatentated HOST and URI
value.
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TCLASS Indicates that a valid Workload Management (WLM) transaction class is to be used to
construct an ApplicationData parameter. If you specify this parameter, you must specify
the fully qualified name of the transaction class mapping file on the Transaction Class
Mapping property.

Transaction Class Mapping
Specifies the fully qualified name of the file that contains the rules for classifying the Workload
Management Transaction Class for HTTP or HTTPS requests. The file name is class sensitive.

For example, if tclass.conf is the name of your transaction class mapping file, you would specify the
following for the value on this property:

/mydir/tclass.conf

where mydir is the fully qualified directory where the tclass.conf file is located.
For example
/mydir/tclass.conf

Web container custom properties

Use this page to configure arbitrary name-value pairs of data, where the name is a property key and the
value is a string value that can be used to set internal system configuration properties. Defining a new
property enables you to configure a setting beyond that which is available in the administrative console.

To view this administrative console page, click Servers > Application Servers >server_name> Web
Container > Custom Properties.

Name
Specifies the name (or key) for the property.

Data type String

Value
Specifies the value paired with the specified name.

Data type String

Description
Provides information about the name-value pair.

Data type String

Global settings for internal servlets

Web Archive (WAR) files packaged using third-party tools cannot specify behavior for the services exposed
by the Web container internal servlets. You can globally enable/disable internal servlets for all Web
applications at the Web container level by creating name-value pairs such as:

Name Value
fileServingEnabled true
directoryBrowsingEnabled true
serveServletsByClassnameEnabled true
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Settings defined in an assembly tool take precedence over the global settings set through the custom
properties at the Web container level.

Web application deployment extensions continue to hold configuration information for the services provided
by the internal servlets, and take precedence over the global settings set through the custom properties at
the Web container level.

UTF-8 encoded URLs °*1*

WebSphere Application Server Version 5.1, introduces support for UTF-8 encoded Uniform Resource
Locators (URLs) to support the double-byte characters in URLs. The UTF-8 encoded URL feature is
enabled by default. You can prevent the web container from explicitly decoding URLs in UTF-8 and have
them use the 1ISO-8859 standard as per the current HTTP specification by using the following name-value
pair:

Name Value
DecodeUrlAsUTF8 false

Server HTTP header (Server:) suppression

The application server allows suppression of the server HTTP header (Server:) in responses. When the
server header custom property is not specified, the default is equal to a setting of "true” and the server
header is included in the HTTP response. You can prevent the inclusion of the server header by using the
following name-value pair:

Name Value

ServerHeader false

Response buffer size

The value specified for this custom property denotes the size, in bytes, of the initial buffer allocation for the
response buffer. When the buffer fills up, a flush for this buffer space will automatically occur. This property
can be set at the Web container level or it can be set for each individual transport. If it is set at the Web
container level, it will apply to all transports affiliated with that Web container.

If a value is not specified for this property, the default response buffer size of 32K bytes is used.

Note: The setBufferSize() APl method can be used to override the value specified for this custom property
for a specific servlet.

Name Value

ResponseBufferSize Positive integer

Transaction class mapping file entries
Following is the syntax for entries in a transaction class mapping file:
TransClassMap host:port uritemplate tclass

where:

host Is the value compared against the hostname of the HOST: header of the request. This value can
be a wildcard ™.
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Note: A value of ' for the host:port value is acceptable and is equivalent to "*:*.
port Is the value compared against the port of the request. This value can be a wildcard .

uritemplate
Is the value compared against the URI of the request. Any query string will not be used in the
comparison. This value can be a wildcard ’*, or end in a wildcard.

fclass |s the Workload Manager Transaction Class name that will be used in the creation of the enclave.

Examples:
TransClassMap www.ibm.com:80 /webapl/myserviet TCLASS1

TransClassMap www.ibm.com:* /webapl/myserviet TCLASS2
TransClassMap *:443 * TCLASS3

TransClassMap *:* /webapl/myserviet TCLASS4
TransClassMap www.ibm.com:* /webap2/* TCLASS5
TransClassMap * /myserviet TCLASS6

TransClassMap * * TCLASS6

Web applications: Resources for learning

Use the following links to find relevant supplemental information about Web applications. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

* |“Web applications: Resources for learning’
* |“Web applications: Resources for learning’
* |“Web applications: Resources for learning’

Programming model and decisions
« [J2EE BluePrints for Web applications|
« [Redbook on the design and implementation of Servlets, JSP files, and enterprise beans|

Programming instructions and examples

» |Redbook on Servlet and JSP file Programming
* |Sun’s Java'" Tutorial on Servlet

* [Introduction to JavaServer Pages - Tutoria!

» |Bean Scripting Framework description

» |Web delivered samples in the Samples Gallery|

Programming specifications
» |Java 2 Software DeveIoFment Kit (SDK)|
* [Servlet 2.3 Specification

* [JavaServer Pages 1.2 Specification

« |Differences between JavaScript and ECMAScrip
» [ISO 8859 Specification
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http://java.sun.com/blueprints/guidelines/designing_enterprise_applications/web_tier/index.html
http://publib-b.boulder.ibm.com/Redbooks.nsf/RedbookAbstracts/sg245754.html?OpenDocument
http://publib-b.boulder.ibm.com/Redbooks.nsf/RedbookAbstracts/sg245755.html?OpenDocument
http://java.sun.com/j2ee/tutorial/1_3-fcs/doc/Servlets.html
http://www-4.ibm.com/software/webservers/appserv/education.html#online
http://www.mozilla.org/rhino/bsf.html
http://www7b.software.ibm.com/wsdd/library/samples/AppServer.html
http://java.sun.com/j2se/1.3/
http://jcp.org/aboutJava/communityprocess/first/jsr053/index.html
http://jcp.org/aboutJava/communityprocess/first/jsr053/index.html
http://www.webstandards.org/learn/resources/javascript/index.html
http://www.iso.org/iso/en/CatalogueListPage.CatalogueList

Chapter 3. Managing HTTP sessions

IBM WebSphere Application Server provides a service for managing HTTP sessions: Session Manager.
The key activities for session management are summarized below.

Before you begin these steps, make sure you are familiar with the programming model for accessing
HTTP session support in the applications following the Servlet 2.3 API.

1. Plan your approach to session management, which could include [session tracking, [session recovery|
and [session clustering|

2. Create or modify your own applications to use session support to maintain sessions on behalf of Web
applications.

3. [Assemble your application.|

4. |Deploy your application.|

5. Ensure the administrator appropriately |configures session managementl in the administrative domain.

6. Adjust configuration settings| and perform other|tuning activitie§| for optimal use of sessions in your
environment.

Sessions

A session is a series of requests to a servlet, originating from the same user at the same browser.
Sessions allow applications running in a Web container to keep track of individual users.

For example, a servlet might use sessions to provide "shopping carts” to online shoppers. Suppose the
servlet is designed to record the items each shopper indicates he or she wants to purchase from the Web
site. It is important that the servlet be able to associate incoming requests with particular shoppers.
Otherwise, the servlet might mistakenly add Shopper_1’s choices to the cart of Shopper_2.

A servlet distinguishes users by their unique session IDs. The session ID arrives with each request. If the
user’s browser is cookie-enabled, the session ID is stored as a cookie. As an alternative, the session ID
can be conveyed to the servlet by URL rewriting, in which the session ID is appended to the URL of the
servlet or JavaServer Pages (JSP) file from which the user is making requests. For requests over HTTPS
or Secure Sockets Layer (SSL), Another alternative is to use SSL information to identify the session.

Migrating HTTP sessions

Note: In Version 5 default write frequency mode is TIME_BASED_WRITES, which is different from
Version 4.0 and 3.5 default mode of END_OF_SERVICE.

Migrating from Version 4.0
No programmatic changes are required to migrate from version 4.0 to version 5.
Migrating from Version 3.5

If you have Version 3.5 applications running in Servlet 2.1 mode, some of the following Version 5
differences might influence how you choose to track and manage sessions.

1. During application development, modify session-related APIs as needed.

Some API changes are required in order to redeploy existing applications on Version 5. These include
changes to the HitpSession API itself as well as issues associated with moving to support for the
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Servlet 2.3 specification. Certain Servlet 2.1 APl methods have been deprecated in Servlet 2.3 API .
These deprecated APIs still work in Version 5.0, but they may be removed in a future version of the
API. Changes are summarized in the following list:

* Replace instances of getValue() with getAttribute()

* Replace instances of getValueNames() with getAttributeNames()

* Replace instances of removeValue() with removeAttribute()

* Replace instances of putValue() with setAttribute()

During application development, modify Web application behavior as needed.

In accordance with the Servlet 2.3 specification, HitpSession objects must be scoped within a single
Web application context; they may not be shared between contexts. This means that a session can no
longer span Web applications. Objects added to a session by a servlet or JSP in one Web application
cannot be accessed from another Web application. The same session ID may be shared (because the
same cookie is in use), but each Web application will have a unique session associated with the
session ID. Version 5 provides a feature that can be used to extend scope of a session to enterprise
application.

Use administrative tools to configure Session Manager security settings as needed. Relative to session
security, the default Session Manager setting for Integrate Security is now false. This is different from
the default setting in some earlier releases.

Use administrative tools to configure the JSP enabler and application server as needed.

In Version 3.5 of the product, JSP files that contained the usebean tag with scope set to session did
not always work properly when session persistence was enabled. Specifically, the JSP writer needed
to write a scriplet to explicitly set the attribute (that is, to call setAttribute()) if it was changed as part of
JSP processing.

Two new features in Version 5.0 help address this problem:
* You can set dosetattribute to true on the JSP InitParameter.
* You can set the Write Contents option to Write all.

The differences between the two solutions are summarized in the following table:

Applies to Configured at Action

dosetattribute set to true JSP JSP enabler Assures that JSP

session-scoped beans
always call setAttribute()

Write Contents option set to | servlet or JSP application server All session data (changed
Write all or unchanged) is written to

the external location

If session persistence is enabled and a class reload for the Web application occurs, the sessions
associated with the Web application are maintained in the persistent store and will be available after
the reload.

Developing session management in servlets

This information, combined with the coding example SessionSample.java, provides a programming model
for implementing sessions in your own servlets.

1.

56

Get the HttpSession object.

To obtain a session, use the getSession() method of the javax.servlet.http.HttpServietRequest object in
the Java Servlet 2.3 API.

When you first obtain the HitpSession object, the Session Management facility uses one of three ways
to establish tracking of the session: cookies, URL rewriting, or Secure Sockets Layer (SSL)
information.

Assume the Session Management facility uses cookies. In such a case, the Session Management
facility creates a unique session ID and typically sends it back to the browser as a cookie. Each
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subsequent request from this user (at the same browser) passes the cookie containing the session ID,

and the Session Management facility uses this ID to find the user’s existing HttpSession object.
In Step 1 of the code sample, the Boolean(create) is set to true so that the HttpSession object is

created if it does not already exist. (With the Servlet 2.3 API, the

javax.servlet.http.HttpServietRequest.getSession() method with no boolean defaults to true and

creates a session if one does not already exist for this user.)
2. Store and retrieve user-defined data in the session.

After a session is established, you can add and retrieve user-defined data to the session. The
HttpSession object has methods similar to those in java.util.Dictionary for adding, retrieving, and

removing arbitrary Java objects.

In Step 2 of the code sample, the servlet reads an integer object from the HttpSession, increments it,

and writes it back. You can use any name to identify values in the HttpSession object. The code

sample uses the name sessiontest.counter.

Because the HitpSession object is shared among servlets that the user might access, consider

adopting a site-wide naming convention to avoid conflicts.

3. (Optional) Output an HTML response page containing data from the HttpSession object.

4. Provide feedback to the user that an action has taken place during the session. You may want to pass
HTML code to the client browser indicating that an action has occurred. For example, in step 3 of the
code sample, the servlet generates a Web page that is returned to the user and displays the value of

the sessiontest.counter each time the user visits that Web page during the session.

5. (Optional) Notify Listeners. Objects stored in a session that implement the
javax.servlet.http.HttpSessionBindingListener interface are notified when the session is preparing to
end and become invalidated. This notice enables you to perform post-session processing, including
permanently saving the data changes made during the session to a database.

6. End the session. You can end a session:

« Automatically with the Session Management facility if a session is inactive for a specified time. The

administrators provide a way to specify the amount of time after which to invalidate a session.
» By coding the servlet to call the invalidate() method on the session object.

Example: SessionSample.java

import java.io.*;

import java.util.*;

import javax.servlet.x;
import javax.servlet.http.x;

public class SessionSample extends HttpServiet {

public void doGet (HttpServletRequest request, HttpServletResponse response)

throws ServletException, IOException {

// Step 1: Get the Session object

boolean create = true;
HttpSession session = request.getSession(create);

// Step 2: Get the session data value
Integer ival = (Integer)
session.getAttribute ("sessiontest.counter");
if (ival == null) ival = new Integer (1);
else ival = new Integer (ival.intValue () + 1);
session.setAttribute ("sessiontest.counter", ival);

// Step 3: Output the page

response.setContentType("text/html");
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PrintWriter out = response.getWriter();

out.printin("<html>");

out.printin("<head><title>Session Tracking Test</title></head>");
out.printin("<body>");

out.printin("<hl>Session Tracking Test</h1>");

out.println ("You have hit this page " + ival + " times" + "<br>");
out.printin ("Your " + request.getHeader("Cookie"));
out.printin("</body></htmi>");

Assembling so that session data can be shared

In accordance with the Servlet 2.3 API specification, by default the Session Management facility supports
session scoping by Web module. Only servlets in the same Web module can access the data associated
with a particular session. WebSphere Application Server provides an option that you can use to extend the
scope of the session attributes to an enterprise application. Therefore, you can share session attributes
across all the Web modules in an enterprise application. This option is provided as an IBM extension.

Restriction: To use this option, you must install all the Web modules in the enterprise application on a
given server. You cannot split up Web modules in the enterprise application by servers. For example, with
an enterprise application containing two Web modules, you cannot use this option when one Web module
is installed on one server and second Web module is installed on a different server. In such split
installations, applications might share session attributes across Web modules using distributed sessions,
but session data integrity is lost when concurrent access to a session is made in different Web modules. It
also severely restricts use of some Session Management features, like TIME_BASED_WRITES. For
enterprise applications on which this option is enabled, the Session Management configuration on the Web
module inside the enterprise application is ignored. Then Session Management configuration defined on
enterprise application is used if Session Management is overwritten at the enterprise application level.
Otherwise, the Session Management configuration on the Web container is used.

Serviet APl Behavior

Note: If shared HttpSession context is turned on in an enterprise application, HttpSession listeners
defined in all the Web modules inside the enterprise application are invoked for session events. The
order of listener invocation is not guaranteed.

Do the following to share session data across Web modules in an enterprise application:
1. Start theAssembly Toolkit.

2. In the Assembly Toolkit, right-click the application (EAR file) you want to share and click Open With >
Deployment Descriptor Editor.

3. In the application deployment descriptor editor of the Assembly Toolkit, select Shared session context
under WebSphere Extensions. Make sure the class definition of attributes put into session are
available to all Web modules in the enterprise application. The shared session context does not fully
meet the requirements of the Specifications.

4. Save the application (EAR) file. In the Assembly Toolkit, after you close the application deployment
descriptor editor, confirm that you want to save changes made to the application.

Session security support

You can integrate HTTP sessions and security in IBM WebSphere Application Server. When security
integration is enabled in the Session Management facility and a session is accessed in a protected
resource, you can access that session only in protected resources from then on. You cannot mix secured
and unsecured resources accessing sessions when security integration is turned on. Security integration in
the Session Management facility is not supported in form-based login with SWAM.
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Security integration rules for HTTP sessions

Only authenticated users can access sessions created in secured pages and are created under the
identity of the authenticated user. Only this authenticated user can access these sessions in other secured
pages. To protect these sessions from unauthorized users, you cannot access them from an unsecure

page.

Programmatic details and scenarios

IBM WebSphere Application Server maintains the security of individual sessions.

An identity or user name, readable by the com.ibm.websphere.servlet.session.IBMSession interface, is
associated with a session. An unauthenticated identity is denoted by the user name anonymous. IBM

WebSphere Application Server includes the
com.ibm.websphere.servlet.session.UnauthorizedSessionRequestException class, which is used when a
session is requested without the necessary credentials.

The Session Management facility uses the WebSphere Application Server security infrastructure to
determine the authenticated identity associated with a client HTTP request that either retrieves or creates
a session. WebSphere Application Server security determines identity using certificates, LPTA, and other

methods.

After obtaining the identity of the current request, the Session Management facility determines whether to
return the session requested using a getSession() call or not.

The following table lists possible scenarios in which security integration is enabled with outcomes
dependent on whether the HTTP request is authenticated and whether a valid session ID and user name
was passed to the Session Management facility.

Unauthenticated HTTP request is
used to retrieve a session

HTTP request is authenticated, with
an identity of "FRED" used to
retrieve a session

No session ID was passed in for
this request, or the ID is for a
session that is no longer valid

A new session is created. The user
name is anonymous

A new session is created. The user
name is FRED

A session ID for a valid session is
passed in. The current session
user name is "anonymous”

The session is returned.

The session is returned. Session
Management changes the user name to
FRED

A session ID for a valid session is
passed in. The current session
user name is FRED

The session is not returned. An
UnauthorizedSessionRequest Exception
error is thrown*

The session is returned.

A session ID for a valid session is
passed in. The current session
user name is BOB

The session is not returned. An
UnauthorizedSessionRequestException
error is thrown*

The session is not returned. An
UnauthorizedSessionRequestException
error is thrown*

* A com.ibm.websphere.servlet.session.UnauthorizedSessionRequestException error is thrown to the

servlet.

Session management support

WebSphere Application Server provides facilities, grouped under the heading Session Management, that
support the javax.servlet.http.HttpSession interface described in the Serviet API specification.

In accordance with the Servlet 2.3 API specification, the Session Management facility supports session
scoping by Web module. Only servlets in the same Web module can access the data associated with a
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particular session. Multiple requests from the same browser, each specifying a unique Web application,
result in multiple sessions with a shared session ID. You can invalidate any of the sessions that share a
session ID without affecting the other sessions.

You can configure a session timeout for each Web application. A Web application timeout value of 0 (the
default value) means that the invalidation timeout value from the Session Management facility is used.

When an HTTP client interacts with a servlet, the state information associated with a series of client

requests is represented as an HTTP session and identified by a session ID. Session Management is

responsible for managing HTTP sessions, providing storage for session data, allocating session IDs, and

tracking the session ID associated with each client request through the use of cookies or URL rewriting

techniques. Session Management can store session-related information in several ways:

* In application server memory (the default). This information cannot be shared with other application
servers.

* In a database. This storage option is known as database persistent sessions.

* In another WebSphere Application Server instance. This storage option is known as
memory-to-memory sessions.

The last two options are referred to as distributed sessions. Distributed sessions are essential for using
HTTP sessions for failover facility. When an application server receives a request associated with a
session ID that it currently does not have in memory, it can obtain the required session state by accessing
the external store (database or memory-to-memory). If distributed session support is not enabled, an
application server cannot access session information for HTTP requests that are sent to servers other than
the one where the session was originally created. Session Management implements caching optimizations
to minimize the overhead of accessing the external store, especially when consecutive requests are routed
to the same application server.

Storing session states in an external store also provides a degree of fault tolerance. If an application
server goes offline, the state of its current sessions is still available in the external store. This availability
enables other application servers to continue processing subsequent client requests associated with that
session.

Saving session states to an external location does not completely guarantee their preservation in case of a
server failure. For example, if a server fails while it is modifying the state of a session, some information is
lost and subsequent processing using that session can be affected. However, this situation represents a
very small period of time when there is a risk of losing session information.

The drawback to saving session states in an external store is that accessing the session state in an
external location can use valuable system resources. Session Management can improve system
performance by caching the session data at the server level. Multiple consecutive requests that are
directed to the same server can find the required state data in the cache, reducing the number of times
that the actual session state is accessed in external store and consequently reducing the overhead
associated with external location access.

Configuring session management by level

When you configure session management at the Web container level, all applications and the respective
Web modules in the Web container normally inherit that configuration, setting up a basic default
configuration for the applications and Web modules below it.

However, you can set up different configurations individually for specific applications and Web modules

that vary from the Web container default. These different configurations override the default for these
applications and Web modules only.
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Note: When you overwrite the default session management settings on the application level, all the Web
modules below that application inherit this new setting unless they too are set to overwrite these
settings.

1. Open the Administrative console.

2. Select the level that this configuration applies to:
* For the web container level:
a. Click Servers > Application Servers.
b. Select a server from the list of application servers.
c. Under Additional Properties, click Web Container.
» For the enterprise application level:
a. Click Applications > Applications.
b. Select an applications from the list of applications.
* For the Web module level:
a. Click Applications > Enterprise Applications.
b. Select an applications from the list of applications.
c. Under Related ltems, click Web Modules.
d. Select a Web module from the list of Web modules defined for this application.

3. Under Additional Properties, click Session Management.
4. Make whatever changes you need to manage sessions

5. If you are working on the Web module or application level and want these settings to override the
inherited Session Management settings, under General Properties, select Overwrite.

6. Click Apply and Save.

Session tracking options

There are several options for session tracking, depending on what sort of tracking method you want to
use:

+ [Session tracking with cookies

+ [Session tracking with URL rewriting|

« [Session tracking with Secure Sockets Layer (SSL) information|

Session tracking with cookies

Tracking sessions with cookies is the default. No special programming is required to track sessions with
cookies.

Session tracking with URL rewriting

An application that uses URL rewriting to track sessions must adhere to certain programming guidelines.
The application developer needs to do the following:

* Program servlets to encode URLs

» Supply a servlet or Java Server Pages (JSP) file as an entry point to the application

Using URL rewriting also requires that you enable URL rewriting in the Session Management facility.

Note: In certain cases, clients cannot accept cookies. Therefore, you cannot use cookies as a session
tracking mechanism. Applications can use URL rewriting as a substitute.

Program session serviets to encode URLs
Depending on whether the servlet is returning URLs to the browser or redirecting them, include either

encodeURL( ) or encodeRedirectURL( ) in the servlet code. Examples demonstrating what to replace in
your current servlet code follow.
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Rewrite URLSs to return to the browser

Suppose you currently have this statement:

out.printin("<a href=\"/store/catalog\">catalog<a>");

Change the servlet to call the encodeURL method before sending the URL to the output stream:

out.printin("<a href=\"");
out.printin(response.encodeURL ("/store/catalog"));
out.printin("\">catalog</a>");

Rewrite URLSs to redirect

Suppose you currently have the following statement:
response.sendRedirect ("http://myhost/store/catalog");

Change the servlet to call the encodeRedirectURL method before sending the URL to the output stream:
response.sendRedirect (response.encodeRedirectURL ("http://myhost/store/catalog"));

The encodeURL() and encodeRedirectURL() methods are part of the HttpServietResponse object. These
calls check to see if URL rewriting is configured before encoding the URL. If it is not configured, the calls
return the original URL.

If both cookies and URL rewriting are enabled and response.encodeURL() or encodeRedirectURLY() is
called, the URL is encoded, even if the browser making the HTTP request processed the session cookie.

You can also configure session support to enable protocol switch rewriting. When this option is enabled,
the product encodes the URL with the session ID for switching between HTTP and HTTPS protocols.

Supply a servlet or JSP file as an entry point

The entry point to an application (such as the initial screen presented) may not require the use of
sessions. However, if the application in general requires session support (meaning some part of it, such as
a servlet, requires session support), then after a session is created, all URLs are encoded to perpetuate
the session ID for the servlet (or other application component) requiring the session support.

The following example shows how you can embed Java code within a JSP file:
<%

response.encodeURL ("/store/catalog");

°
%>

Session tracking with SSL information
No special programming is required to track sessions with Secure Sockets Layer (SSL) information.

To use SSL information, turn on Enable SSL ID tracking in the Session Management property page.
Because the SSL session ID is negotiated between the Web browser and HTTP server, this ID cannot
survive an HTTP server failure. However, the failure of an application server does not affect the SSL
session ID if an external HTTP Server is present between WebSphere Application Server and the browser.

SSL tracking is supported for the IBM HTTP Server and iPlanet Web servers only. You can control the
lifetime of an SSL session ID by configuring options in the Web server. For example, in the IBM HTTP
Server, set the configuration variable SSLV3TIMEOUT to provide an adequate lifetime for the SSL session
ID. An interval that is too short can cause a premature termination of a session. Also, some Web browsers
might have their own timers that affect the lifetime of the SSL session ID. These Web browsers may not
leave the SSL session ID active long enough to serve as a useful mechanism for session tracking. Internal
Http Server of WebSphere also supports SSL Tracking.
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When using the SSL session ID as the session tracking mechanism in a cloned environment, use either
cookies or URL rewriting to maintain session affinity. The cookie or rewritten URL contains session affinity
information that enables the Web server to properly route a session back to the same server for each
request.

Configuring session tracking

To configure session tracking, complete the following:
1. Go to the appropriate level of |Session Management.|

2. Specify which session tracking mechanism you want to pass the session ID between the browser and
the servlet:
» To track sessions with cookies, click Enable Cookies.

To change the cookie settings, click Modify.
» To track sessions with URL rewriting, click Enable URL Rewriting.

If you want to enable protocol switch rewriting, click Enable protocol switch rewriting.
« To track sessions with SSL information, click Enable SSL ID tracking.

3. Click Apply.
4. Click Save.
5. Define the [session recovery| characteristics.

Serializing access to session data

The Servlet API supports concurrent access to a session in a given server instance. WebSphere
Application Server provides an option to prevent the concurrent access to a session in a given server
instance so that concurrent modification of a session does not occur in a given server instance. This
prevention is achieved by synchronizing the requests based on session. When this feature is turned on, a
session is obtained for the request before invoking the servlet and requests are synchronized by locking
the session for the servlet execution time. Note that synchronization is based on the memory copy of
session. So this feature cannot serialize requests across servers based on session when session affinity
fails.

Restriction: Use this feature only when concurrent modification of the same session data is possible and
is not desirable by the application. This feature has overhead of serializing the requests based on a
session.

Do the following to synchronize session access:
1. [Select the level of Session Management on which you want to serialize session access.
2. Under Serialize Session access, click Allow serial access.

3. In the Maximum wait time box, type the amount of time, in milliseconds, a servlet waits on a session
before continuing execution. The default is 120000 milliseconds or two minutes.

4. Select Allow access on timeout if you want the servlet to gain access to the session and continue
normal execution even if the session is still locked by another servlet. If you do not select this box, the
servlet execution will abort when the session request times out.

5. Click Apply.
6. Click Save.

Session Management settings

Use this page to manage HTTP session support. This support includes specifying a session tracking
mechanism, setting maximum in-memory session count, controlling overflow, and configuring session
timeout.
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To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management.

Overwrite Session Management
Specifies whether or not these session management settings take precedence over those normally
inherited from a higher level for the current application or web module.

By default, web modules inherit session management settings from the application level above it, and
applications inherit session management settings from the web container level above it.

Session tracking mechanism
Specifies a mechanism for HTTP session management.

Mechanism Function Default
Enable SSL ID Tracking Specifies that session tracking uses 9600 seconds
Secure Sockets Layer (SSL)
information as a session ID. Enabling
SSL tracking takes precedence over
cookie-based session tracking and
URL rewriting.

There are two parameters available if
you enable SSL ID tracking:
SSLV3Timeout and Secure
Authentication Service (SAS).
SSLV3Timeout specifies the time
interval after which SSL sessions are
renegotiated. This is a high setting
and modification does not provide any
significant impact on performance.
The SAS parameter establishes an
SSL connection only if it goes out of
the Java Virtual Machine (JVM) to
another JVM. If all the beans are
co-located within the same JVM, the
SSL used by SAS does not hinder
performance.

These are set by editing the
sas.server.properties and
sas.client.props files located in the
product_installation_roof\properties
directory, where
product_installation_root is the
directory where WebSphere
Application Server is installed.
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Enable Cookies Specifies that session tracking uses
cookies to carry session IDs. If
cookies are enabled, session tracking
recognizes session IDs that arrive as
cookies and tries to use cookies for
sending session IDs. If cookies are
not enabled, session tracking uses
Uniform Resource Identifier (URL)
rewriting instead of cookies (if URL
rewriting is enabled).

Enabling cookies takes precedence
over URL rewriting. Do not disable
cookies in the Session Management
facility of the application server that is
running the administrative application
because this action causes the
administrative application not to
function after a restart of the server.
As an alternative, run the
administrative application in a
separate process from your
applications.

Click Modify to change these settings.

Enable URL Rewriting Specifies that the session
management facility uses rewritten
URLs to carry the session IDs. If URL
rewriting is enabled, the session
management facility recognizes
session IDs that arrive in the URL if
the encodeURL method is called in
the servlet.

Enable Protocol Switch Rewriting Specifies that the session ID is added
to a URL when the URL requires a
switch from HTTP to HTTPS or from
HTTPS to HTTP. If rewriting is
enabled, the session ID is required to
go between HTTP and HTTPS.

Maximum in-memory session count
Specifies the maximum number of sessions to maintain in memory.

The meaning differs depending on whether you are using in-memory or distributed sessions. For
in-memory sessions, this value specifies the number of sessions in the base session table. Use the Allow
Overflow property to specify whether to limit sessions to this number for the entire Session Management
facility or to allow additional sessions to be stored in secondary tables. For distributed sessions, this value
specifies the size of the memory cache for sessions. When the session cache has reached its maximum
size and a new session is requested, the Session Management facility removes the least recently used
session from the cache to make room for the new one.

Note: Do not set this value to a number less than the maximum thread pool size for your server.

Overflow
Specifies that the number of sessions in memory can exceed the value specified by the Max In Memory
Session Count property. This option is valid only in nondistributed sessions mode.
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Session timeout
Specifies how long a session can go unused before it is no longer valid. Specify either Set timeout or No
timeout. Specify the value in minutes greater than or equal to two.

The value specified in a web module deployment descriptor file takes precedence over the administrative
console settings. However, the value of this setting is used as a default when the session timeout is not
specified in a web module deployment descriptor. Note that to preserve performance, the invalidation timer
is not accurate to the second. When the Write Frequency is time based, ensure that this value is least
twice as large as the write interval.

Security integration
Specifies that when security integration is enabled, the session management facility associates the identity
of users with their HTTP sessions

Serialize session access
Specifies that concurrent session access in a given server is not allowed.

Maximum wait time Specifies the maximum amount of time a servlet request
waits on an HTTP session before continuing execution.
This parameter is optional and expressed in seconds. The
default is 120, or 2 minutes. Under normal conditions, a
servlet request waiting for access to an HTTP session
gets notified by the request that currently owns the given
HTTP session when the request finishes.

Allow access on timeout Specifies whether the servlet is executed normally or
aborted in the event of a timeout. If this box is checked,
the servlet executes normally. If this box is not checked,
the servlet execution aborts and error logs are generated.

Cookie settings
Use this page to configure cookie settings for session management.

To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management > Enable Cookies.

Cookie name
Specifies a uniqgue name for the session management cookie. The servlet specification requires the name
JSESSIONID. However, for flexibility this value can be configured.

Secure cookies
Specifies that the session cookies include the secure field. Enabling the feature restricts the exchange of
cookies to HTTPS sessions only.

Cookie domain

Specifies the domain field of a session tracking cookie. This value controls whether or not a browser
sends a cookie to particular servers. For example, if you specify a particular domain, session cookies are
sent to hosts in that domain. The default domain is the server.

Cookie path

Specifies that a cookie is sent to the URL designated in the path. Specify any string representing a path
on the server. "/" indicates root directory. Specify a value to restrict the paths to which the cookie will be
sent. By restricting paths, you prevent the cookie from going to certain URLs on the server. If you specify
the root directory, the cookie is sent no matter which path on the given server is accessed.
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Cookie maximum age

Specifies the amount of time that the cookie lives on the client browser. Specify that the cookie lives only
as long as the current browser session, or to a maximum age. If you choose the maximum age option,
specify the age in seconds. This value corresponds to the Time to Live (TTL) value described in the
Cookie specification.

Default is the current browser session which is equivalent to setting the value to -1.

Session management custom properties

Custom properties for session management:

CloneSeparatorChange
Use this property to maintain session affinity. The clone ID of the server is appended to session
identifier separated by colon. On some Wireless Application Protocol (WAP) devices, a colon is not
allowed. Set this property to "true” to change clone separator to a plus sign (+).

HttpSessionCloneld
Use this property to change the clone ID of the cluster member. Within a cluster, this name must
be unique to maintain session affinity. When set, this name overwrites the default name generated
by WebSphere Application Server. Default clone ID length: 8 or 940.

HttpSessionldLength
Use this property to configure the session identifier length. Do not use an extremely low value;
using a low value results in reduced number of combinations possible, thereby increasing risk of
guessing the session identifier. In a cluster, all cluster members should be configured with same ID
length. Allowed range: 8 to 128. Default length: 23.

HttpSessionReaperPollinterval
Use this property to set a wake-up interval for the process that removes invalid sessions. Default
is based on maximum inactive interval set in Session Management. Allowed value: integer.

NoAdditionalSessioninfo
Set this value to "true” to force removal of information that is not needed in session identifiers. In
WebSphere Application Server base edition,a clone ID of -1 is never used; therefore, a clone ID is
not included in base edition when this is set. Also, cache ID is not used with nonpersistent
sessions; so the cache ID is not included with nonpersistent sessions when this value is set.

SessionldentifierMaxLength
Use this value to set maximum length that a session identifier can grow. In a cluster, because of
fail-over when a request goes to new cluster member, Session Management appends a new clone
ID to the existing clone ID. In a large cluster, if for some reason servers are failing more often,
then it is possible that the session identifier length can be more than expected reducing room for
URL. So this property helps to find out the condition and take appropriate action to address
servers fail-over. When this is specified, message is logged when specified maximum length is
reached. Allowed value: integer.

SessionRewriteldentifier
Use this property to change the key used with URL rewriting. Default key: jsessionid.

Configuring session tracking for Wireless Application Protocol (WAP)
devices

Most Wireless Application Protocol (WAP) devices do not support cookies. The preferred way to track
sessions for WAP devices is to use URL rewriting. However on most WAP devices, the maximum allowed
URL length is 128 characters. With URL rewriting, a session indentifier is added to the URL itself,
effectively decreasing the space available for the actual URL and the number of parameters that can be
sent on a request.

To reduce the length of session identifier, you can configure key (jsessionid), session ID length and clone
ID. To make these configuration changes, complete the following:

1. Open the Administrative console.
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Click Servers > Application Servers.

Select a server from the list of application servers.
Under Additional Properties, click Web Container
Under Additional Properties, click Custom Properties.

Add the appropriate properties from the following list:
* HttpSessionldLength

« SessionRewriteldentifier

* HttpSessionCloneld

* CloneSeparatorChange

* NoAdditionalSessioninfo

» SessionldentifierMaxLength

7. Click Apply and Save.

ook~

Distributed sessions

WebSphere Application Server provides the following session mechanisms in a distributed environment:

« Database Session persistence, where sessions are stored in the database specified.

* Memory-to-memory Session replication, where sessions are stored in one or more specified
WebSphere Application Server instances.

When a session contains attributes that implement HttpSessionActivationListener, notification occurs
anytime the session is activated (that is, session is read to the memory cache) or passivated (that is,
session leaves the memory cache). Passivation can occur because of a server shutdown or when the
session memory cache is full and an older session is removed from the memory cache to make room for a
newer session. It is not guaranteed that a session is passivated in one application server prior to being
activated in another.

Session recovery support

For session recovery support, WebSphere Application Server provides distributed session support in the
form of database sessions. Use session recovery support under the following conditions:

* When the user’s session data must be maintained across a server restart

* When the user’s session data is too valuable to lose through an unexpected server failure

All the attributes set in a session must implement java.io.Serializable if the session requires external
storage. In general, consider making all objects held by a session serialized, even if immediate plans do
not call for session recovery support. If the Web site grows, and session recovery support becomes
necessary, the transition occurs transparently to the application if the sessions only hold serialized objects.
If not, a switch to session recovery support requires coding changes to make the session contents
serialized.

Distributed Environment settings
Use this page to specify a type for saving a session in a distributed environment.

To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management > Distributed Environment Settings.

Distributed Sessions
Specifies the type of distributed environment to be used for saving sessions.

None Specifies that the session management facility discards
the session data when the server shuts down.
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Database Specifies that the session management facility stores
session information in the data source specified by the
data source connection settings. Click Database to
change these data source settings.

Memory to Memory Replication Specifies that the session management facility stores the
session information in a data source in memory. The
session information is copied to other session
management facilities for failure recovery. Click Memory
to Memory Replication to specify the replicator to use
and to change these memory to memory settings. (For
WebSphere Application Server Network Deployment only.)

Configuring for database session persistence

To configure the session management facility for database session persistence, complete the following:
1. Define a JDBC provider.
2. [Create a DB2 tablelin the z/OS DB2 database that will be used for session persistence.

3. Create a data source pointing to the z/OS DB2 database containing the DB2 table for session
persistence,an existing database, using the JDBC provider that you defined. The data source should
be non-JTA, for example, non-XA enabled. Note the JNDI name of the data source. Under Data
Sources > datasource_name > Custom Properties, make sure the correct database is entered for
the value of the databaseName property. If necessary, contact your database administrator to verify
the correct database name.

Go to the appropriate level of [Session Management|
Click Distributed Environment Settings
Select and click Database.
Specify the Data Source JNDI name from step 3step 2.
Specify the database user ID and password for accessing the database.
9. Retype the password for confirmation.
10. Configure altable space and page sizeg for DB2 session databases.
11. Switch to a|multirow schemal
12. Click OK.
13. If you want to change the tuning parameters, click Custom Tuning Parameters and [select a setting]

orjcustomize one[

14. Click Apply.
15. Click Save.

© N oA

Switching to a multirow schema

By default, a single session maps to a single row in the database table used to hold sessions. With this
setup, there are hard limits to the amount of user-defined, application-specific data that WebSphere
Application Server can access.
1. Modify the Session Management facility properties to switch from single to multirow schema.
2. Manually drop and recreate the database table or delete all the rows in the database table that the
product uses to maintain HttpSession objects.
To drop the table:
a. Determine which data source configuration Session Management is using.
b. In the data source configuration, look up the database name.

c. Use the database facilities to connect to the database.
d. Drop the SESSIONS table.
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See the DB2 UDB for OS/390 and z/OS V7 Administration Guide for a description of how to drop a
DB2 database table.

[Creating a DB2 table for session persistence| describes how to create a new DB2 database table.

Configuring tablespace and page sizes for DB2 session databases

If you are using DB2 for session persistence, you can increase the page size to optimize performance for
writing large amounts of data to the database. Page sizes of 8K, 16K, and 32K are supported.

To use a page size other than the default (4K), do the following:

1.
2.

If the SESSIONS table already exists, drop it from the DB2 database.

Create a new DB2 buffer pool and table space, specifying the same page size (8K, 16K or 32K) for
both, and assign the new buffer pool to this table space.
DB2 Connect to session
DB2 CREATE BUFFERPOOL sessionBP SIZE 1000 PAGESIZE 8K
DB2 Connect reset
DB2 Connect to session
DB2 CREATE TABLESPACE sessionTS PAGESIZE 8K MANAGED BY SYSTEM
USING ('D:\DB2\NODEQOOO\SQLOOOO5\sessionTS.0"') BUFFERPOOL sessionBP
DB2 Connect reset

Refer to DB2 product documentation for details.

Configure the correct table space name and page size in the Session Management facility. Page size
is referred to as row size on the Session Management page.)

When the product is restarted, the Session Management facility creates the new SESSIONS table in the
specified tablespace based on the indicated page size.

Creating a DB2 table for session persistence

If you are using DB2 for session persistence, a DB2 table, in which session data will be collected, must be
created and defined to the application server.

To create a DB2 table for collecting session data, do the following:

1.
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Have your DB2 Administrator create a DB2 database table for storing your session data. (For more
information about creating DB2 databases see the DB2 UDB for OS5/390 and z/OS V7 Administration
Guide.)

The table space in which the database table is created must be defined with row level locking
(LOCKSIZE ROW). It should also have a page size that is large enough for the objects that will be stored
in the table during a session. Following is an example of a table space definition with row level locking
specified and a buffer pool page size of 32K:

CREATE DATABASE database_name

STOGROUP SYSDEFLT
CCSID EBCDIC;

CREATE TABLESPACE tablespace_name IN database_name
USING STOGROUP group_name
PRIQTY 512
SECQTY 1024
LOCKSIZE ROW
BUFFERPOOL BP32K;

The Session Manager will use the DB2 table defined within this table space to process the session
data. This table must have the following format:

CREATE TABLE database_name.table_name (

ID VARCHAR(95) NOT NULL ,
PROPID VARCHAR(95) NOT NULL ,
APPNAME VARCHAR(64) ,
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LISTENERCNT SMALLINT ,
LASTACCESS DECIMAL(19,0),
CREATIONTIME DECIMAL(19,0),
MAXINACTIVETIME INTEGER ,

USERNAME VARCHAR(256) ,

SMALL VARCHAR(3122) FOR BIT DATA ,
MEDIUM VARCHAR(28869) FOR BIT DATA ,
LARGE BLOB(2097152),

SESSROW ROWID NOT NULL GENERATED ALWAYS

)

IN database_name.tablespace_name;

Note: The length attributes specified for VARCHAR in this example are not necessarily the values
your DB2 Administrator should use for the DB2 table he is creating. See the DB2 SQL
Reference for the version of DB2 you will be using for guidance in determining appropriate
values for these length attributes for your installation.

A unique index must be created on the ID and PROPID columns of this table. The following is an
example of the index definition:
CREATE UNIQUE INDEX database_name.index_name.

database_name .table_name

(ID ASC,

PROPID ASC,
APPNAME ASC);

Note:

a. At run time, the Session Manager will access the target table using the identity of the J2EE
server in which the owning Web application is deployed. Any Web container that is
configured to use persistent sessions should be granted both read and update access to the
subject database table.

b. HTTP session processing uses the index defined using the CREATE INDEX statement to
avoid database deadlocks. In some situations, such as when a relatively small table size is
defined for the database, DB2 may decide not to use this index. When the index isn’t used,
database deadlocks can occur. If this situation occurs, see the DB2 Administration Guide for
the version of DB2 you are using for recommendations on how to calculate the space
required for an index, and adjust the size of the tables you are using accordingly.

c. It may be necessary to tune DB2 in order to make efficient use of the sessions database
table and to avoid deadlocks when accessing it. Your DB2 Administrator should refer to the
DB2 Administration Guide for specific information about tuning the version of DB2 you are
using.

A large object (LOB) table space must be defined and an auxiliary table must be defined within that
table space. The following is an example of the LOB table space definition:
CREATE LOB TABLESPACE LOB_tablespace_name IN database_name

BUFFERPOOL BP32K

USING STOGROUP group_name

PRIQTY 512

SECQTY 1024
LOCKSIZE LOB;

CREATE AUX TABLE database_name .aux_table_name
IN database _name.LOB_tablespace _name
STORES database_name .table_name
COLUMN LARGE;

An index must be created for this auxiliary table. The following is an example of the index definition:

CREATE INDEX database_name.aux_index_name ON

database_name .aux_table_name;
Have your DB2 Administrator grant the the z/OS userID, under which the server region is running, the
appropriate access to this DB2 table. For example,issue the following command to grant z/OS userID
CBASRU1, under which the server region is running, access to the table SESSIONS contained in the
database SESSDB:
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GRANT ALL ON SESSDB.SESSIONS TO CBASRU1;

3. Use the administrative console to add the name of this DB2 table to the Web container’s configuration
properties:
a. Open the administrative console.
b. Click Servers > Application Servers.
Select a server from the list of application servers.
Under Additional Properties, click Web Container.
Under Additional Properties, click Custom Properties.
Check SessionTableName and then click New.
In the Value field, enter the name of the DB2 Session Table if you are not using the default value
SESSION. The name must be in the form database_name.table_name. For example, if the
database name is SESSDB and the table name is SESSIONS, enter SESSDB.SESSIONS for
Value.

Optionally, you can update the description of this table in the Description field. For example, you
might enter "Table name for HTTP session data.”
h. Click Apply > Save.

@=0ao

When the product is restarted, the Session Management facility creates the new SESSIONS table in the
specified tablespace.

Database settings
Use this page to specify the settings for database session support.

To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management > Distributed Environment Settings > Database.

Datasource JNDI Name
Specifies the datasource description

The JNDI name of the non-XA enabled data source from which Session Management obtains database
connections. For example, if the JNDI name of the datasource is "jdbc/sessions”, specify "jdbc/sessions.”
The data source represents a pool of database connections and a configuration for that pool (such as the
pool size). The data source must already exist as a configured resource in the environment.

User ID
Specifies the user ID for database access

Password
Specifies the password for database access

Confirm Password
Specifies the password a second time to ensure it recorded correctly.

DB2 Row Size

Specifies the tablespace page size configured for the sessions table, if using a DB2 database. Possible
values are 4, 8, 16, and 32 kilobytes (K). The default row size is 4K.

The default row size is 4K. In DB2, it can be updated to a larger value. This can help database
performance in some environments. When this value is other than 4, you must specify Table Space Name
to use. For 4K pages, the Table Space Name is optional.

Table Space Name
Specifies that tablespace to be used for the sessions table.

This value is required when the DB2 Page Size is other than 4K.
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Multi row schema

Specifies that each instance of application data be placed in a separate row in the database, allowing
larger amounts of data to be stored for each session. This action can yield better performance in certain
usage scenarios. If using multirow schema is not enabled, instances of application data can be placed in
the same row.

Multirow schema considerations

IBM WebSphere Application Server supports the use of a multirow schema option in which each piece of
application specific data is stored in a separate row of the database. With this setup, the total amount of
data you can place in a session is now bound only by the database capacities. The only practical limit that
remains is the size of the session attribute object.

The multirow schema potentially has performance benefits in certain usage scenarios, such as when larger
amounts of data are stored in the session but only small amounts are specifically accessed during a given
servlet processing of an HTTP request. In such a scenario, avoiding unneeded Java object serialization is

beneficial to performance.

Understand that switching between multirow and single row is not a trivial proposition.

In addition to allowing larger session records, using multirow schema can yield performance benefits.
However, it requires a little work to switch from single-row to multirow schema, as shown in the
instructions below.

Coding considerations and test environment

Consider configuring direct single-row usage to one database and multirow usage to another database

while you verify which option suits your application needs. (Do this in code by switching the data source
used; then monitor performance.)

Programming issue Application scenario

Reasons to use single-row * You can read or write all values with just one record
read and write.

» This takes up less space in a database because you
are guaranteed that each session is only one record

long.
Reasons not to use single-row 2-megabyte limit of stored data per session.
Reasons to use multirow * The application can store an unlimited amount of data;

that is, you are limited only by the size of the database
and a 2-megabyte-per-record limit.

» The application can read individual fields instead of the
whole record. When large amounts of data are stored
in the session but only small amounts are specifically
accessed during servlet processing of an HTTP
request, multirow sessions can improve performance
by avoiding unneeded Java object serialization.

Reasons not to use multirow If data is small in size, you probably do not want the extra
overhead of multiple row reads when you can store
everything in one row.

In the case of multirow usage, design your application data objects not to have references to each other,
to prevent circular references. For example, suppose you are storing two objects A and B in the session
using HttpSession.put(..) method, and A contains a reference to B. In the multirow case, because objects
are stored in different rows of the database, when objects A and B are retrieved later, the object graph
between A and B is different than stored. A and B behave as independent objects.
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Memory-to-memory replication

WebSphere Application Server supports session replication to another WebSphere Application Server
instance. This support is referred to as memory-to-memory session replication. In this mode, sessions can
replicate to one or more WebSphere Application Server instances to address HTTP Session single point of
failure (SPOF). This is a new alternative in IBM WebSphere Application Server, Version 5 to the existing
saving of HTTP Session to a database.

The WebSphere Application Server instance in which the session is currently processed is referred to as
the owner of the session. In a clustered environment, session affinity in the WebSphere Application Server
plug-in routes the requests for a given session to the same server. If the current owner server instance of
the session fails, then the WebSphere Application Server plug-in routes the requests to another
appropriate server in the cluster. This server either retrieves the session from a server that has the backup
copy of the session or it retrieves the session from its own backup copy table. The server now becomes
the owner of the session and affinity is now maintained to this server.

When a session is created or updated in a WebSphere Application Server instance, the session is
transferred (or replicated) through one of the replicator entries under the replication domain that is
configured with the session management facility. This session potentially gets replicated to the WebSphere
Application Server instances that are also connected to the same replicator domain. The mode and
partitioning determine whether WebSphere Application Server instances in the same replication domain
gets the session.

There are three possible modes. You can set up a WebSphere Application Server instance to run in:

» Server mode: Only store backup copies of other WebSphere Application Server sessions and not to
send out copies of any session created in that particular server

» Client mode: Only broadcast or send out copies of the sessions it owns and not to receive backup
copies of sessions from other servers

* Both mode: Simultaneously broadcast or send out copies of the sessions it owns and act as a backup
table for sessions owned by other WebSphere Application Server instances

You can select the replication mode of server, client, or both when configuring the session management
facility for memory-to-memory replication. The default is both. This storage option is controlled by the
mode parameter.

With respect to mode, the following are the primary examples of memory-to-memory replication
configuration:

« [Peer-to-peer with a local replicator|

« [Peer-to-peer with remote replicators|
[Client/server with remote replicators]
[Client/server with isolated replicators|

Although the administrative console allows flexibility and additional possibilities for memory-to-memory
replication configuration, only the configurations provided above are officially supported.

In a cluster, by default, sessions are replicated in all the servers in the cluster that are connected to the
same replicator domain. This replication can be redundant if a large number of servers exist in a cluster.
The session management facility has an option to the servers into groups when storing sessions.

Memory-to-memory topology: Peer-to-peer function with a local
replicator

The basic peer-to-peer (both client and server function, or both mode) topology is the default configuration.
This configuration uses a local replicator (a replicator on the same server as the session manager) and no
partitioning.
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M y to y topology: Basic peer to peer or “both mode”

WebSphere Application Server servers
including HttpSessions with local tables, backup tables,
and a replicators.

l Local
/ Back-up
HTTP servers

with affinity —t

Replicate

Local

domain

Back-up
HTTP servers —

with affinity \
Local

Back-up

In this basic peer-to-peer topology, each server Java Virtual Machine (JVM):

* Host the Web application leveraging HTTP session

» Send out changes to the HTTP session that it owns

* Receive backup copies of the HTTP session from all of the other servers in the cluster
* House a replicator to which the session manager connects

This configuration represents the most consolidated topology, where the various system parts are
collocated and requires the fewest server processes. When using this configuration, the most stable
implementation is achieved when each node has equal capabilities (CPU, memory, and so on), and each
handles the same amount of work.

This topology is the most redundant because everyone replicates to everyone. On any failure recovery
scenario, the server routed to already has a copy of the session. But as you add servers, more overhead
(both CPU and memory) is needed to deal with replication. Without , scaling breaks down the
quickest with this configuration. When scaling breaks down because of the machine characteristics, the
client hit rate, the network speed, and the size on average of the HTTP session. The remaining topologies:
client/server with isolated replictors, client/server with remote replictors, and peer-to-peer with remote
replicators help mitigate and manage the scaling characteristics of replication. Replication costs are also
reduced through the use of partitioning and time based write (employed by default) in these topologies.

Memory-to-memory topology: Peer-to-peer function with
remote/isolated replicators
In this topology, the replicators are separated from the clustered servers running the deployed application.

Chapter 3. Managing HTTP sessions 79



M y to y topology: Peer to peer with remote replicators
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This method increases the number of servers used, which can be a increased cost for any installation.
However, if containable, the separation of replicators produces several benefits:

» A replicator can handle the activity from session managers in multiple servers. A one-to-one
correspondence between the replicators and servers can often be unnecessary; having a primary server
(with a second sever as a backup) is often sufficient.

* Not running the replicator in the Java Virtual Machine (JVM) running the application can free up some
heap and central processing unit (CPU) for running the application.

» Putting components into separate processes means that if one of the component processes fails, this
failure does not affect the other components.

Replicators can often handle multiple servers (six to seven). By using this topology, you have two
configuration options:

» Use one replicator, and keep the other as a backup on standby (remember, if a replicator goes down,
the session manager automatically switches to the next replicator domain).

» Split your session manager/application servers between the two replicators.

After selecting memory-to-memory replication on the session manager, you must select
memory-to-memory replication to go to the detail configuration panel. You can select the replication
domain and replicator for this session manager to use.

Memory-to-memory topology: Client/server function with remote
replicators

The following figure depicts the client/server with remote replicators topology. There is a tier of applications
servers that host web applications using HTTP Session, and these sessions are replicated out as they are
created and updated. There is a second tier of servers without a web application installed, where the
session manager receives updates from the replication clients. The replicators facilitating the transfer of
data reside with the replication servers
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Memory to memory topology: Clients and servers with remote replicators
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Benefits of the client/server with remote replicators configuration include:

Isolation (for failure recovery): in this case we are isolating the handling of backup data from local data;
aside from isolating the moving parts in case of a catastrophic failure in one of them, you again free up
memory and processing in the servers processing the web application, much the same as the isolating
of the replicators as showed in the topology for peer-to-peer function with remote replicators.

Isolation (for stopping and starting): you can recycle a backup without affecting the servers running the
application (when there are two or more backups, failure recovery is possible), and conversely recycle
an application JVM without potentially losing that backup data for someone.

Consolidation: there is most likely no need to have a one-to-one correspondence between servers
handling backups and those processing the applications; hence, you are again reducing the number of
places to which you transfer the data.

Disparate hardware: while you run your web applications on cheaper hardware, you may have one or
two more powerful computers in the back end of your enterprise that have the capacity to run a couple
of session managers in replication server mode; allowing you to free up your cheaper web application
hardware to process the web application.

You can define replicators on both the replication client and the server Java Virtual Machines (JVMs),
however, replicators on both the clients and the servers is redundant. In the client/server topologies
defining replicators only on the backup replication server JVMs is recommended.

It is good to spread out the replication clients as equally across the replicators as possible (by default they
select the first replicator in the domain), because both replication servers are doing work and not acting as
a hot standby.

Timing considerations: Start the replication servers first to avoid unexpected timing windows. The clients
attempt to reconnect to the replication domain if you start the replication clients before the replications
servers, even if the initial connection cannot be completed. However, if servers with the application come
up, and requests on the applications occur before the replicators on the backup servers finish coming up,
some expected client replication might not occur.

Memory-to-memory topology: Client/server function with isolated
replicators

The following figure depicts the client/server with isolated replicators topology. In this topology, the
replicators are separated from the backup servers and are on their own servers.
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There is a tier of applications servers that host web applications using HTTP Session, and these sessions
are replicated out as they are created and updated. There is a second tier of servers without a web
application installed, where the session manager receives updates from the replication clients. The
replicators facilitating the transfer of data reside with the replication servers

Memory to memory topology: Clients and servers with isolated replicators
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Benefits of this topology include:

* The catastrophic failure of one server does not affect another server because of separate moving parts
(the replicator and the backup server).

* You do not need a one-to-one correspondence between the replicators and the backup servers.

Although this topology is the most expensive from a Java Virtual Machine (JVM) perspective, and requires
the most configuration through the administrative console, it provides the greatest degree of isolation from
failure of a component, the most flexibility in starting/stopping the parts, and the most flexibility in mixing
the right number of clients, servers, and replicators. Since both servers and clients need to connect to the
replicators, starting the replicators removes the need for connection retries. Similarly, starting the clients
after the servers, avoid timing windows where the clients send data before the servers are ready to
receive them.

Memory-to-memory session partitions

In a replication domain, by default, sessions are replicated to all the servers that are connected to the
same replication domain. This replication can be redundant if a large number of servers are located in a
replication domain.

Group partitioning
The session management facility has an option to partition the servers into groups when storing
sessions. From the session replication perspective, you can view the replicator as having n groups
or partitions. The default is 10 groups (the recommended minimum for performance reasons). The
number of groups is global for the entire replication domain and all the session managers
connected into the replication domain through any of the replicators in that domain.
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By default, the session management facility running in server mode listens to all the partitions on
the replicator. When a session is created in this facility, it is written to one of the partitions on the
replicator through a round-robin assignment performed by the session manager. At the session
manager level, you can configure the session manager (when in either server or both mode) to
listen to a subset of the group (by default, the session manager listens to all of them). Therefore,
you can reduce or partition where the HTTP sessions get replicated. Also note that becasue a
session manager listens to a subset of the groups, it does not mean that those are the only
groups it replicates sessions on. The session manager round robins over all the groups being
listened to by the complete set of session managers connected to the replication domain.

In a cluster environment with a large number of servers, some servers can be configured to listen
on some partitions and others on a different partition. All the servers are still logically linked
together through the replicator domain and you can retrieve a session in any server in the cluster.
The number of groups of the replication domain is set under manage internal replication in the
Environment tab. Configure which groups and partitions a specific Session Management facility
listens to under session management.

Single replica partitioning
The alternative to group partitioning is to replicate the session to only one other server. When this
option is chosen, a session manager dynamically picks another session manager that is connected
to the same replication domain to replicate the HTTP session to during session creation. All
updates to the session are only replicated to that single server. A round-robin algorithm is
employed over the eligible session manager instances. The round robin will not include selection
of other session managers in the same Java virtual machine (JVM), or other JVMs on the same
node unless there is only 1 node connected to the replication domain. Because this is set at the
replication domain level, every session manager connected to this replication domain uses single
replica replication. The mode of the session manager has the same meaning, that is, clients only
send out changes to one other session manager (albeit not in the same JVM or node), servers
only receive, and session managers in both mode, send and receive changes.

Clustered session support

A clustered environment supports load balancing, where the workload is distributed among the application
servers that compose the cluster. In a cluster environment, the same Web application must exist on each

of the servers that can access the session. You can accomplish this setup by installing an application onto
a cluster definition. Each of the servers in the group can then access the Web application

In a clustered environment, the Session Management facility requires an affinity mechanism so that all
requests for a particular session are directed to the same application server instance in the cluster. This
requirement conforms to the Servlet 2.3 specification in that multiple requests for a session cannot coexist
in multiple application servers. One such solution provided by IBM WebSphere Application Server is
session affinity in a cluster; this solution is available as part of the WebSphere Application Server plug-ins
for Web servers. It also provides for better performance because the sessions are cached in memory. In
clustered environments other than WebSphere Application Server clusters, you must use an affinity
mechanism (for example, IBM WebSphere Edge Server affinity).

If one of the servers in the cluster fails, it is possible for the request to reroute to another server in the
cluster. If distributed sessions support is enabled, the new server can access session data from the
database or another WebSphere Application Server instance. You can retrieve the session data only if a
new server has access to an external location from which it can retrieve the session.
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Configuring memory-to-memory replication for the peer-to-peer
function with a local replicator (default memory-to-memory replication)

To configure the session management facility for memory-to-memory session replication for peer-to-peer
functions (both client and server function, or both mode) with a local replicator and no partitioning,
complete the following steps:

1. Create an application cluster. This cluster is used to deploy the application.
a. Go to the Server Cluster page. Click Servers> Clusters.
Click New.
Type a cluster name for this application cluster.
Define a replication domain. Select the Create Replication Domain for this cluster check box.
Click Next.
Define each cluster member server. Type a cluster member name.

Select the Create Replication Entry in this Server check box. This step adds a replicator into this
new server.

Click Apply. Repeat steps f through h for each server created in this cluster.
i. Click Next and review the summary of changes.
j- Click Finish to complete the configuration.
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You have now created a cluster that contains the deployed application and the replication domain.
2. Enable memory-to-memory session replication for each server.

a. Go to the appropriate level of session management for the Web container level. Click Application
Servers> server_name> Web Container> Session Management

b. Click Distributed Environment Settings under Additional Properties.
If a replicator has been created and is associated with this or another server, select Memory to
Memory Replication. If no replicator is already created for any server, a note appears stating this.
In this case, click Memory to Memory Replication. The Internal Replication Domain panels
appear. These panels lead you through the process of creating a replication domain and a
replicator. After you create a replication domain and a replicator, begin again with step 2a.

d. Click Apply.
e. Repeat these steps for each server. Click OK.

3. If you want to change the tuning parameters, click Custom Tuning Parameters and |select a setting or
_

stomize onel

Note: Using the default tuning parameter custom settings, which specifies time based write interval of
10 seconds, may result in data loss when an application server in your cluster fails. However,
this is just a small opportunity for lost data when compared to the significant improvement in

performance.
a. Click Apply.
b. Click Save.

Memory-to-memory sessions settings
Use this page to configure memory-to-memory sessions.

To view the Memory-to-memory Sessions page, click Servers > Application Servers > server_name >

Web Container > Session Management > Distributed Environment Settings > Memory to Memory
Replication.
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Replication
Use one of these options to select the replicator for the session management facility to use for
memory-to-memory replication.

Select replicator from the following domain
Specifies a replicator from a replication domain.

Click this option, and select a domain. Then click Apply to show all the replicators in that domain. Select
the replicator in that domain.

Select replicator from another domain
Specifies a replicator in another domain that is not managed by this cell.
Click this option, and then type the IP address and the port number of the replicator.

Listen to partition groups

Specifies partitions on which the session management facility listens when running in Server mode for
memory-to-memory session replication. The number of partitions is defined in the Manage Internal
Replication pages. For Server mode and Both mode, the default is all partitions.

Runtime mode
Select the mode in which this server has to run: Both, Client and Server. The mode implies whether data
is only sent (client), only received (server), or both. The default is both.

Configuring memory-to-memory replication for peer-to-peer functions
with remote/isolated replicators

To configure the session management facility for memory-to-memory replication for peer-to-peer functions
with remote replicators, complete the following steps:

1. Create an application cluster. This cluster is used to deploy the application.
a. Go to the Server Cluster page. Click Servers> Clusters.
b. Click New.
c. Type a cluster name for the application cluster.
d. Click Next.
e. Define each cluster member server. Type a cluster member name.
f. Click Apply. Complete steps e and f for each server created in this cluster.
g. Click Next and review the summary of changes.
h. Click Finish to complete the configuration.

You have now created a cluster that contains the deployed application.
2. Create a replicator cluster. The replication domain is defined in this replicator cluster.
Go to the Server Cluster page. Click Servers> Clusters.
Click New.
Type a cluster name for this replicator cluster.
Define a replication domain. Select the Create Replication Domain for this cluster check box.
Click Next.

Associate replicators for each server. Select the Create Replication Entry in this Server check
box.

Click Apply. Complete steps f and g for each server created in this cluster.

~® o0 T
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h. Click Next and review the summary of changes.
i. Click Finish to complete the configuration.
You have now created a cluster that contains the replication domain. Do not deploy the application on
this cluster.
3. Enable memory-to-memory session replication for each server.

a. Go to the appropriate level of Session Management for the Web container level. Click Application
Servers> Server_Name> Web Container> Session Management

b. Click Distributed Environment Settings under Additional Properties.
If a replicator is already created and associated with this or another server, select Memory to
Memory Replication. If no replicator has been created for any server, a note appears. In this case,
click Memory to Memory Replication. The Internal Replication Domain panels appear. These
panels lead you through the process of creating a replication domain and a replicator. After you
create a replication domain and a replicator, begin again with step 3a.

d. Click Apply.

e. Repeat these steps for each server. Click OK.

4. If you want to change the tuning parameters, click Custom Tuning Parameters and [select a setting or
_

stomize one|.

Note: Using the default tuning parameter custom settings, which specifies time based write interval of
10 seconds, may result in data loss when an application server in your cluster fails. However,
this is just a small opportunity for lost data when compared to the significant improvement in

performance.
a. Click Apply.
b. Click Save.

Configuring memory-to-memory replication for the client/server
function using isolated replicators

To configure the session management facility for memory-to-memory session replication with replicators
separated from the backup servers, complete the following steps:

1. Create an application cluster. This cluster is used to deploy the application.
a. Go to the Server Cluster page. Click Servers> Clusters.

b. Click New.

c. Type a cluster name for this application cluster.

d. Click Next.

e. Define each cluster member server. Type a cluster member name.

f. Click Apply. Complete steps e and f for each server created in this cluster.
g. Click Next and review the summary of changes.

h. Click Finish to complete the configuration.

Do not create a replication domain or replicators on the member server for the application cluster.
2. Create a cluster of session manager replication servers (backup cluster).
a. Go to the Server Cluster page. Click Servers> Clusters.

b. Click New.

c. Type a cluster name for the session manager of replication servers.
d. Click Next.

e. Define each cluster member server. Type a cluster member name.
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5.

f.

g.
h.

Define a replicator on each cluster member server. Select the Create replication entry in this
server check box.

Click Apply. Complete steps e through g for each server created in this cluster.
Click Next and review the summary of changes.
Click Finish to complete the configuration.

This step creates a cluster of session manager replication servers and creates a replicator on each
cluster member server.

Create a replication cluster. The replication cluster defines the replication domain and each of the

replicators.

a. Go to the Server Cluster page. Click Servers> Clusters.

b. Click New.

c. Type a replication cluster name.

d. Define a replication domain. Select the Create Replication Domain for this cluster check box.
e. Click Next.

f. Define each replicator. Type a cluster member name.

g. Select the Create Replication Entry in this Server check box.

h. Click Apply. Complete steps f through h for each server created in this cluster.

J-

Click Next and review the summary of changes.
Click Finish to complete the configuration.

Enable memory-to-memory session replication for each cluster member server in the application
cluster and the backup cluster. Memory-to-memory session replication does not need enablement in
the replication cluster; these servers act as replicators only.

a.

d.
e.

Go to the appropriate level of session management for the web container level. Click Application
Server > application_cluster_member_server or backup_cluster_member_server > Web Container
> Session Management.

Click Distributed Environment Settings under Additional Properties.

Click Memory to Memory Replication . Verify that each session manager (both the replication
clients and the servers) point to a replicator from the replication cluster, distributing them as evenly
as possible.

Click Apply.
Repeat these steps for each server. Click OK.

This step points the servers to the replicator of your choice.
If you want to change the tuning parameters, click Custom Tuning Parameters and |select a setting| or

customize one|

Note: Using the default tuning parameter custom settings, which specifies time based write interval of

10 seconds, may result in data loss when an application server in your cluster fails. However,
this is just a small opportunity for lost data when compared to the significant improvement in

performance.
a. Click Apply.
b. Click Save.
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Configuring memory-to-memory replication for the client/server
function using remote replicators

To configure the session management facility for memory-to-memory replication for clients and servers
with remote replicators, complete the following steps:

1. Create an application cluster. This cluster is used to deploy the application.

a.

h.

b
c.
d.
e
f

9

Go to the Server Cluster page. Click Servers> Clusters.

Click New.

Type a cluster name for this application cluster.

Click Next.

Define each cluster member server. Type a cluster member name.

Click Apply. Complete steps e and f for each server created in this cluster.
Click Next and review the summary of changes.

Click Finish to complete the configuration.

Do not create a replication domain or replicators on the member server for the application cluster. You
have now created a cluster that contains the replication domain.

2. Create a cluster of session manager replication servers (backup cluster).

i.
-
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Go to the Server Cluster page. Click Servers> Clusters.

Click New.

Type a cluster name for the cluster of session manager replication servers.

Define a replication domain. Select the Create Replication Domain for this cluster check box.
Click Next.

Define each cluster member server. Type a cluster member name.

Define a replicator on each cluster member server. Select the Create Replication Entry in this
Server check box.

Click Apply. Complete steps f through h for each server created in this cluster.
Click Next and review the summary of changes.
Click Finish to complete the configuration.

This step creates a cluster of session manager replication servers and associates a replication domain
with that cluster. This step also creates a replicator on each cluster member server.

3. Enable memory-to-memory session replication for each cluster member server in the application
cluster.

a.

d.
e.

Go to the appropriate level of session management for the Web container level. Click Application
Server > application_cluster_member_server > Web Container > Session Management.

Click Distributed Environment Settings under Additional Properties.

If a replicator is already created and is associated with this or another server, selectMemory to
Memory Replication. If no replicator has been created for any server, a note appears. In this case,
click Memory to Memory Replication. The Internal Replication Domain panels appear. These
panels lead you through the process of creating a replication domain and a replicator. After you
create a replication domain and a replicator, begin again with step 2a.

Click Apply.
Repeat these steps for each server. Click OK.

This step points the servers to the replicator of your choice.

4. If you want to change the tuning parameters, click Custom Tuning Parameters and |select a setting| or
_
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Note: Using the default tuning parameter custom settings, which specifies time based write interval of
10 seconds, may result in data loss when an application server in your cluster fails. However,
this is just a small opportunity for lost data when compared to the significant improvement in
performance.

a. Select the replication domain
Select the replicator to which the member server connects.

Ensure that the member server node is client-only. Verify that the remainder of the member servers
are in client-only mode.

Click Apply.
Click Save.

Tuning session management

IBM WebSphere Application Server session support has features for tuning session performance and
operating characteristics, particularly when sessions are configured in a distributed environment. These
options support the administrator flexibility in determining the performance and failover characteristics for
their environment.

The table summarizes the features, including whether they apply to sessions tracked in memory, in a
database, with memory-to-memory replication, or all. Click a feature for details about the feature. Some
features are easily manipulated using administrative settings; others require code or database changes.

Feature or option Goal Applies to sessions in memory,
database, or memory-to-memory
Write frequency Minimize database write operations. | Database and Memory-to-Memory
Session affinity Access the session in the same All
application server instance.
Multirow schema Fully utilize database capacities. Database
Base in-memory session pool size Fully utilize system capacity without | All

overburdening system.

Write contents Allow flexibility in determining what Database and Memory-to-Memory
session data to write

Scheduled invalidation Minimize contention between session | Database and Memory-to-Memory
requests and invalidation of sessions
by the Session Management facility.
Minimize write operations to database
for updates to last access time only.

Tablespace and row size Increase efficiency of write operations | Database (DB2 only)
to database.

Configuring scheduled invalidation

Instead of relying on the periodic invalidation timer that runs on an interval based on the session timeout

parameter, you can set specific times for the session management facility to scan for invalidated sessions

in a distributed environment. When used with distributed sessions, this feature has the following benefits:

* You can schedule the scan for invalidated sessions for times of low application server activity, avoiding
contention between invalidation scans of database or another WebSphere Application Server instance
and read and write operations to service HTTP session requests.

« Significantly fewer external write operations can occur when running with the End of Service Method
Write mode because the last access time of the session does not need to be written out on each HTTP
request. (Manual Update options and Time Based Write options already minimize the writing of the last
access time.)
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Usage considerations

» With scheduled invalidation configured, HttpSession timeouts are not strictly enforced. Instead, all
invalidation processing is handled at the configured invalidation times.

» HttpSessionBindingListener processing is handled at the configured invalidation times unless the
HttpSession.invalidate method is explicitly called.

* The HttpSession.invalidate method immediately invalidates the session from both the session cache and
the external store.

* The periodic invalidation thread still runs with scheduled invalidation. If the current hour of the day does
not match one of the configured hours, sessions that have exceeded the invalidation interval are
removed from cache, but not from the external store. Another request for that session results in
returning that session back into the cache.

* When the periodic invalidation thread runs during one of the configured hours, all sessions that have
exceeded the invalidation interval are invalidated by removal from both the cache and the external
store.

» The periodic invalidation thread can run more than once during an hour and does not necessarily run
exactly at the top of the hour.

 If you specify the interval for the periodic invalidation thread using the HitpSessionReaperPollinterval
custom property, do not specify a value of more than 3600 seconds (1 hour) to ensure that invalidation
processing happens at least once during each hour.

Configuring write contents

In Session Management, you can configure which session data is written to the database or to another

WebSphere instance, depending on whether you are using database pesistent sessions or memory to

memory replication. This flexibility allows for fewer code changes for the JSP writer when the application

will be operating in a clustered environment. The following options are available in Session Management

for tuning what is to be written back:

» Write changed (the default) - Write only session data properties that have been updated through
setAttribute() and removeAttribute() method calls.

» Write all - Write all session data properties.

The Write all setting might benefit servliet and JSP writers who change Java objects’ states that reside as
attributes in HttpSession and do not call HitpSession.setAttribute().

However, the use of Write all could result in more data being written back than is necessary. If this
situation applies to you, consider combining the use of Write all with Time-based write to boost
performance overall. As always, be sure to evaluate the advantages and disadvantages for your
installation.

With either Write Contents setting, when a session is first created, complete session information is written,
including all of the objects bound to the session. When using database session persistence, in subsequent
session requests, what is written to the database depends on whether a single-row or multirow schema
has been set for the session database, as follows:

Write Contents setting Behavior with single-row schema Behavior with multirow schema
Write changed If any session attribute is updated, all | Only the session data modified
objects bound to the session are through setAttribute() or
written. removeAttribute() calls is written.
Write all All bound session attributes are All session attributes that currently
written. reside in the cache are written. If the
session has never left the cache, all
session attributes are written.

1. Go to the appropriate level of [Session Management)
2. Click Distributed Environment Settings
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3. Click Custom Tuning Parameters.
4. Select Custom Settings, and click Modify.
5. Select the appropriate write contents setting.

Configuring write frequency

In the Session Management facility, you can configure the frequency for writing session data to the

database or to a WebSphere instance, depending on whether you use database distributed sessions or

memory-to-memory replication. This flexibility enables you to weigh session performance gains against

varying degrees of failover support. The following options are available in the Session Management facility

for tuning write frequency:

* End of service servlet- Write session data at the end of the servlet service method call.

* Manual update- Write session data only when the servlet calls the IBMSession.sync method.
m (the default) - Write session data at periodic intervals, in seconds (called the write interval).

When a session is first created, session information is always written at the end of the service call.

Using the time based write or manual update options can result in loss of data in failover scenarios since
the backup copy of the session in the persistent store (for example, a database or another JVM) may not
be in sync with the session in the session cache.

Base in-memory session pool size

The base in-memory session pool size number has different meanings, depending on session support

configuration:

* With in-memory sessions, session access is optimized for up to this number of sessions.

» With distributed sessions (meaning, when sessions are stored in a database or in another WebSphere
Application Server instance); it also specifies the cache size and the number of last access time
updates saved in manual update mode.

For distributed sessions, when the session cache has reached its maximum size and a new session is
requested, the Session Management facility removes the least recently used session from the cache to
make room for the new one.

General memory requirements for the hardware system, and the usage characteristics of the e-business
site, determines the optimum value.

Note that increasing the base in-memory session pool size can necessitate increasing the heap sizes of
the Java processes for the corresponding WebSphere Application Servers.

Overflow in nondistributed sessions

By default, the number of sessions maintained in memory is specified by base in-memory session pool
size. If you do not wish to place a limit on the number of sessions maintained in memory and allow
overflow, set overflow to true.

Allowing an unlimited amount of sessions can potentially exhaust system memory and even allow for
system sabotage. Someone could write a malicious program that continually hits your site and creates
sessions, but ignores any cookies or encoded URLs and never utilizes the same session from one HTTP
request to the next.

When overflow is disallowed, the Session Management facility still returns a session with the

HttpServietRequest getSession(true) method when the memory limit is reached, and this is an invalid
session that is not saved.
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With the WebSphere Application Server extension to HttpSession,
com.ibm.websphere.servlet.session.IBMSession, an isOverflow() method returns true if the session is such
an invalid session. An application can check this status and react accordingly.

Controlling write operations

You can manually control when modified session data is written out to the database or to another
WebSphere Application Server instance by using the sync method in the
com.ibm.websphere.servlet.session.IBMSession interface, which extends the javax.servlet.http.HttpSession
interface. By calling the sync method from the service method of a servlet, you send any changes in the
session to the external location. When manual updateis selected as the write frequency mode, session
data changes are written to an external location only if the application calls the sync method. If the sync
method is not called, session data changes are lost when a session object leaves the server cache. When
end of service servlet or time based is the write frequency mode, the session data changes are written out
whenever the sync method is called. If the sync method is not called, changes are written out at the end of
service method or on a time interval basis based on the write frequency mode selected.

IBMSession iSession = (IBMSession) request.getSession();
iSession.setAttribute("name", "Bob");

//force write to external store
iSession.sync( )

If the database is down or is having difficulty connecting during an update to session values, the sync
method always makes 3 attempts before it finally throws an "BackedHashtable.getConnectionError” error.
For each connection attempt that fails, the "BackedHashtable.StaleConnectionException” is thrown and
can be found in the sync method. If the database comes up during any of these three attempts, the
session data in the memory is then persisted and committed to the database.

However, if the database is still not up after the three attempts, then the session data in the memory is
persisted only after the next check for session invalidation. Session invalidation is checked by a separate
thread that is triggered every five minutes. The data in memory is consistent unless a request for session
data is issued to the server between these events. For example, if the request for session data is issued
within five minutes, then the previous persisted session data is sent.

Sessions are not transactional resources. Because the sync method is associated with a separate thread
than the client, the exception thrown does not propagate to the client, which is running on the primary
thread. Transactional integrity of data can be maintained through resources such as enterprise Java
beans.

Tuning parameter settings
Use this page to set tuning parameters for distributed sessions.

To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management > Distributed Environment Settings > Custom Tuning
Parameters.

Tuning Level
Specifies that the session management facility provides certain predefined settings that affect
performance.

Select one of these predefined settings or customize a setting. To customize a setting, select one of the

predefined settings that comes closest to the setting desired, click Custom settings, make your changes,
and then click OK.
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Very high (optimize for performance)

Write frequency

Write interval

Write contents

Schedule sessions cleanup
First time of day default
Second time of day default

High

Write frequency

Write interval

Write Contents

Schedule sessions cleanup

Medium

Write frequency
Write Contents
Schedule sessions cleanup

Low (optimize for failover)

Write frequency
Write Contents
Schedule sessions cleanup

Custom settings

Write frequency default
Write interval default
Write contents default

Schedule sessions cleanup default

Tuning parameter custom settings

Time based

300 seconds

Only updated attributes
true

0

2

Time based

300 seconds

All session attributes
false

End of servlet service
Only updated attributes
false

End of servlet service
All session attributes
false

Time based

10 seconds

All session attributes
false

Use this page to customize tuning parameters for distributed sessions.

To view this administrative console page, click Servers > Application Servers > server_name > Web
Container > Session Management > Distributed Environment Settings > Custom Tuning Parameters

> Custom settings.

Write frequency

Specifies when the session is written to the persistent store.

End of servlet service

Manual update

A session writes to a database or another WebSphere
Application Server instance after the servlet completes
execution.

A programmatic sync on the IBMSession object is required
to write the session data to the database or another
WebSphere Application Server instance.
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Time based Session data writes to the database or another
WebSphere Application Server instance based on the
specified Write Interval value. Default: 10 seconds

Write contents

Specifies whether updated attributes are only written to the external location or all of the session attributes
are written to the external location, regardless of whether or not they changed. The external location can
be either a database or another application server instance.

Only updated attributes Only updated attributes are written to the persistent store.
All session attribute All attributes are written to the persistent store.

Schedule sessions cleanup
Specifies when to clean the invalid sessions from a database or another application server instance.

Specify distributed sessions cleanup schedule Enables the scheduled invalidation process for cleaning
up the invalidated HTTP sessions from the external
location. Enable this option to reduce the number of
updates to a database or another application server
instance required to keep the HTTP sessions alive. When
this option is not enabled, the invalidator process runs
every few minutes to remove invalidated HTTP sessions.

When this option is enabled, specify the two hours of a
day for the process to clean up the invalidated sessions in
the external location. Specify the times when there is the
least activity in the application servers. An external
location can be either a database or another application
server instance.

First Time of Day (0 - 23) Indicates the first hour, in Greenwich Mean Time (GMT),
during which the invalidated sessions are cleared from the
external location. Specify this value as a positive integer
between 0 and 23. This value is valid only when schedule
invalidation is enabled.

Second Time of Day (0 - 23) Indicates the second hour, in Greenwich Mean Time
(GMT), during which the invalidated sessions are cleared
from the external location. Specify this value as a positive
integer between 0 and 23. This value is valid only when
schedule invalidation is enabled.

Best practices for using HTTP Sessions
* Enable Security integration for securing HTTP sessions

HTTP sessions are identified by session IDs. A session ID is a pseudo-random number generated at the
runtime. Session hijacking is a known attack HTTP sessions and can be prevented if all the requests
going over the network are enforced to be over a secure connection (meaning, HTTPS). But not every
configuration in a customer environment enforces this constraint because of the performance impact of
SSL connections. Due to this relaxed mode, HTTP session is vulnerable to hijacking and because of
this vulnerability, WebSphere Application Server has the option to tightly integrate HTTP sessions and
WebSphere Application Server security. in WebSphere Application Server so that the
sessions are protected in a manner that only users who created the sessions are allowed to access
them.

* Release HttpSession objects using javax.servlet.http.HttpSession.invalidate() when finished.

HttpSession objects live inside the Web container until:
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— The application explicitly and programmatically releases it using the
javax.servlet.http.HttpSession.invalidate() method; quite often, programmatic invalidation is
part of an application logout function.

— WebSphere Application Server destroys the allocated HttpSession when it expires (default = 1800
seconds or 30 minutes). The WebSphere Application Server can only maintain a certain number of
HTTP sessions in memory based on Session Management settings. In case of distributed sessions,
when maximum cache limit is reached in memory, the Session Management facility removes the
least recently used (LRU) one from cache to make room for a session.

Avoid trying to save and reuse the HttpSession object outside of each servlet or JSP file.

The HttpSession object is a function of the HttpRequest (you can get it only through the
reg.getSession() method), and a copy of it is valid only for the life of the service() method of the servlet
or JSP file. You cannot cache the HttpSession object and refer to it outside the scope of a servlet or
JSP file.

Implement the java.io.Serializable interface when developing new objects to be stored in the
HTTP session.

This action allows the object to properly serialize when using distributed sessions. Without this
extension, the object cannot serialize correctly and throws an error. An example of this follows:

public class MyObject implements java.io.Serializable {...}

Make sure all instance variable objects that are not marked transient are serializable.
The HTTPSession API does not dictate transactional behavior for sessions.

Distributed HTTPSession support does not guarantee transactional integrity of an attribute in a failover
scenario or when session affinity is broken. Use transactionally aware resources like enterprise Java
beans to guarantee the transaction integrity required by your application.

Ensure the Java objects you add to a session are in the correct class path.

If you add Java objects to a session, place the class files for those objects in the correct classpath (the
Application Classpath if utilizing sharing across Web modules in an enterprise application, or the
WebModule Classpath if using the Servlet 2.2-complaint session sharing) or in the directory containing
other servlets used in WebSphere Application Server. In the case of session clustering, this action
applies to every node in the cluster.

Because the HttpSession object is shared among servlets that the user might access, consider adopting
a site-wide naming convention to avoid conflicts.
Avoid storing large object graphs in the HttpSession object.

In most applications each servlet only requires a fraction of the total session data. However, by storing
the data in the HttpSession object as one large object, an application forces WebSphere Application
Server to process all of it each time.

Utilize Session Affinity to help achieve higher cache hits in the WebSphere Application Server.

WebSphere Application Server has functionality in the HTTP Server plug-in to help with session affinity.
The plug-in will read the cookie data (or encoded URL) from the browser and helps direct the request to
the appropriate application or clone based on the assigned session key. This functionality increases use
of the in-memory cache and reduces hits to the database or another WebSphere Application Server
instance

Maximize use of session affinity and avoid breaking affinity.

Using session affinity properly can enhance the performance of the WebSphere Application Server.
Session affinity in the WebSphere Application Server environment is a way to maximize the in-memory
cache of session objects and reduce the amount of reads to the database or another WebSphere
Application Server instance. Session affinity works by caching the session objects in the server instance
of the application with which a user is interacting. If the application is deployed in multiple servers of a
server group, the application can direct the user to any one of the servers. If the users starts on server1
and then comes in on server2 a little later, the server must write all of the session information to the
external location so that the server instance in which server2 is running can read the database. You can
avoid this database read using session affinity. With session affinity, the user starts on server1 for the
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first request; then for every successive request, the user is directed back to server1. Server1 has to
look only at the cache to get the session information; server1 never has to make a call to the session
database to get the information.

You can improve performance by not breaking session affinity. Some suggestions to help avoid breaking

session affinity are:

— Combine all Web applications into a single application server instance, if possible, and use modeling
or cloning to provide failover support.

— Create the session for the frame page, but do not create sessions for the pages within the frame
when using multiframe JSP files. (See discussion later in this topic.)

* When using multi-framed pages, follow these guidelines:

— Create a session in only one frame or before accessing any frame sets. For example, assuming
there is no session already associated with the browser and a user accesses a multi-framed JSP file,
the browser issues concurrent requests for the JSP files. Because the requests are not part of any
session, the JSP files end up creating multiple sessions and all of the cookies are sent back to the
browser. The browser honors only the last cookie that arrives. Therefore, only the client can retrieve
the session associated with the last cookie. Creating a session before accessing multi-framed pages
that utilize JSP files is recommended.

— By default, JSPs get a HTTPSession using request.getSession(true) method. So by default JSPs
create a new session if none exists for the client. Each JSP page in the browser is requesting a new
session, but only one session is used per browser instance. A developer can use <% @ page
session="false” %> to turn off the automatic session creation from the JSP files that will not access
the session. Then if the page needs access to the session information, the developer can use
<%HttpSession session = javax.servlet.http.HttpServletRequest.getSession(false); %> to get
the already existing session that was created by the original session creating JSP file. This action
helps prevent breaking session affinity on the initial loading of the frame pages.

— Update session data using only one frame. When using framesets, requests come into the HTTP
server concurrently. Modifying session data within only one frame so that session changes are not
overwritten by session changes in concurrent frameset is recommended.

— Avoid using multi-framed JSP files where the frames point to different Web applications. This action
results in losing the session created by another Web application because the JSESSIONID cookie
from the first Web application gets overwritten by the JSESSIONID created by the second Web
application.

» Secure all of the pages (not just some) when applying security to serviets or JSP files that use

sessions with security integration enabled, .

When it comes to security and sessions, it is all or nothing. It does not make sense to protect access to
session state only part of the time. When security integration is enabled in the Session Management
facility, all resources from which a session is created or accessed must be either secured or unsecured.
You cannot mix secured and unsecured resources.

The problem with securing only a couple of pages is that sessions created in secured pages are
created under the identity of the authenticated user. Only the same user can access sessions in other
secured pages. To protect these sessions from use by unauthorized users, you cannot access these
sessions from an unsecure page. When a request from an unsecure page occurs, access is denied and
an UnauthorizedSessionRequestException error is thrown. (UnauthorizedSessionRequestException is a
runtime exception; it is logged for you.)

» Use manual update and either the sync() method or time-based write in applications that read
session data, and update infrequently.

With END_OF_SERVICE as write frequency, when an application uses sessions and anytime data is
read from or written to that session, the LastAccess time field updates. If database sessions are used, a
new write to the database is produced. This activity is a performance hit that you can avoid using the
Manual Update option and having the record written back to the database only when data values
update, not on every read or write of the record.

To use manual update, turn it on in the Session Management Service. (See the tables above for
location information.) Additionally, the application code must use the
com.ibm.websphere.servlet.session.IBMSession class instead of the generic HttpSession. Within the
IBMSession object there is a method called sync(). This method tells the WebSphere Application Server
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to write the data in the session object to the database. This activity helps the developer to improve
overall performance by having the session information persist only when necessary.

Note: An alternative to using the manual updates is to utilize the timed updates to persist data at

different time intervals. This action provides similar results as the manual update scheme.

Implement the following suggestions to achieve high performance:

If your applications do not change the session data frequently, use Manual Update and the sync()
function (or timed interval update) to efficiently persist session information.

Keep the amount of data stored in the session as small as possible. With the ease of using sessions
to hold data, sometimes too much data is stored in the session objects. Determine a proper balance
of data storage and performance to effectively use sessions.

If using database sessions, use a dedicated database for the session database. Avoid using the
application database. This helps to avoid contention for JDBC connections and allows for better
database performance.

If using memory to memory sessions, define replicators only on the servers and have the client
attach to server replicator.

If using memory to memory sessions, employ partitioning (either group or single replica) as your
clusters grow in size and scaling decreases.

Verify that you have the latest fix packs for the WebSphere Application Server.

Utilize the following tools to help monitor session performance.

Run the com.ibm.servlet.personalization.sessiontracking.IBMTrackerDebug servlet. - To run this
servlet, you must have the servlet invoker running in the Web application you want to run this from.
Or, you can explicitly configure this servlet in the application you want to run.

Use the WebSphere Application Server Resource Analyzer which comes with WebSphere Application
Server to monitor active sessions and statistics for the WebSphere Application Server environment.
Use database tracking tools such as "Monitoring” in DB2. (See the respective documentation for the
database system used.)

Managing HTTP sessions: Resources for learning:

Use the following links to find relevant supplemental information about HTTP sessions. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

Programming model and decisions

Pro

lj

Best practices|

HTTP Session Persistence Best Practices]

Improving session persistence performance with DBZ|

Persistent client state HTTP cookies specification|

ramming instructions and examples

« |Java Servlet documentation, tutorials, and examples site]

Programming specifications

Java Servlet 2.3 API specification download site|

J2EE 1.3 specification download site|
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http://www7b.software.ibm.com/wsdd/zones/bp/
http://www7b.software.ibm.com/wsdd/library/techarticles/0209_draeger/draeger.html
http://www7b.software.ibm.com/dmdd/library/techarticle/0203kitchlu/0203kitchlu.html
http://www.netscape.com/newsref/std/cookie_spec.html
http://java.sun.com/products/servlet/docs.html
http://java.sun.com/products/servlet/download.html
http://java.sun.com/j2ee/download.html
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Chapter 4. Using enterprise beans in applications

1. Design a J2EE application and the enterprise beans that it needs. See "Resources for learning” for
links to design information that is specific to enterprise beans.

2. [Develop any enterprise beans| that your application will use.
3. Prepare for assembly. For your EJB 2.x-compliant entity beans, |[decide on an appropriate access

intent polic

4. Assemble the beans using the |JAssembly Toolkit| into one or more EJB modules. This includes setting

security.
5. Assemble the modules into a J2EE application using the [Assembly Toolkit]
6. >1* Fora given application server, lupdate the EJB container configuration| if needed for the

application to be deployed, and determine if you want to batch commands [patch commands| or [defer|
for container managed persistence.

7. [Deploy the application|in an application server.

8. Test the modules.
* As needed, debug problems with the container.
» Debug access and deployment problems.

9. Assemble the production application using the|Assemny Toolkitl
10. Deploy the application to a production environment.
11. Manage the application:

a. Manage installed EJB modules. After an application has been installed, you can manage its EJB
modules individually through |administrative console settings[

b. [Manage other aspects of the J2EE application.
12. Update the module and redeploy it using the[Assembly Toolkit,
13. Tune the performance of the application. See [Best practices for developing enterprise beans}

Enterprise beans

An enterprise bean is a Java component that can be combined with other resources to create J2EE
applications. There are three types of enterprise beans, entity beans, session beans, and message-driven
beans.

All beans reside in EJB containers, which provide an interface between the beans and the application
server on which they reside.

Entity beans store permanent data. Entity beans with container-managed persistence (CMP) require
connections to a form of persistent storage. This storage might be a database, an existing legacy
application, a file, or another type of persistent storage. Entity beans with bean-managed persistence
manage permanent data in whichever manner is defined in the bean code. For example, they can write
data to databases or XML files

Session beans do not require database access, although they can obtain it indirectly as needed through
entity beans. Session beans can also obtain direct access to databases (and other resources) through the
use of resource references. Session beans can be either stateful or stateless.

Message-driven beans are new in version 2.0 of the Enterprise JavaBeans (EJB) specification. They
enable asynchronous message servicing. The EJB container and a Java Message Service (JMS) provider
work together to process messages. When a message arrives from another application component through
JMS, the EJB container forwards it through an onMessage() call to a message-driven bean instance,
which then processes the message. In other respects, message-driven beans are similar to stateless
session beans.
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Beans that require data access use data sources, which are administrative resources that define pools of
connections to persistent storage mechanisms.

For more information about enterprise beans, see "Resources for learning.”

Developing enterprise beans

Design a J2EE application and the enterprise beans that it needs.
» For general design information, see "Resources for learning.”
« Before developing entity beans with container-managed persistence (CMP), read "Concurrency control.”

There are two basic approaches to selecting tools for developing enterprise beans:

* You can use one of the available integrated development environments (IDEs). IDE tools automatically
generate significant parts of the enterprise bean code and contain integrated tools for packaging and
testing enterprise beans. The IBM WebSphere Application Developer product is the recommended IDE.
For more information, see the documentation for that product.

 If you have decided to develop enterprise beans without an IDE, you need at least an ASCII text editor.
You can also use a Java development tool that does not support enterprise bean development. You can
then use tools available in the Java Software Development Kit (SDK) and in this product to assemble,
test, and deploy the beans.

The following steps primarily support the second approach, development without an IDE.

1. If necessary, |migrate any pre-existing code|to the required version of the Enterprise JavaBeans (EJB)
specification.

2. Write and compile the components of the enterprise bean.

* At a minimum, an EJB 1.1 session bean requires a bean class, a home interface, and a remote
interface. An EJB 1.1 entity bean requires a bean class, a primary-key class, a home interface, and
a remote interface.

* At a minimum, an EJB 2.0 session bean requires a bean class, a home or local home interface, and
a remote or local interface. An EJB 2.0 entity bean requires a bean class, a primary-key class, a
remote home or local home interface, and a remote or local interface. The types of interfaces go
together: If you implement a local interface, you must define a local home interface as well.

Note: Optionally, the primary-key class can be unknown. See|unknown primary-key class| for more
information.
» Available only through EJB 2.0, a message-driven bean requires only a bean class.

3. For each entity bean, complete work to handle persistence operations.
* Create a database schema for the entity bean’s persistent data.

— For entity beans with container-managed persistence (CMP), you must store the bean’s
persistent data in one of the supported databases. WebSphere Application Server application
assembly tools automatically generate SQL code for creating database tables for CMP entity
beans. If your CMP beans require complex database mappings, it is recommended that you use
the IBM WebSphere Studio Application Developer product to generate code for the database
tables.

— For entity beans with bean-managed persistence (BMP), you can create the database and
database table by using the database tools or use an existing database and database table.

For more information on creating databases and database tables, consult your database
documentation.
+ (CMP entity beans for EJB 2.0 only) [Define finder queries|with EJB Query Language (EJB QL).

With EJB QL, you define finders in terms of CMP fields and container-managed relationships, as

follows:

— Public finders are visible in the bean’s home interface. Implemented in the bean class, they
return only remote interfaces and collection types.
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— Private finders, expressed as SELECT statements, are used only within the bean class. They can
return both local and remote interfaces, dependent values, other CMP field types, and collection
types.

(CMP entity beans for EJB 1.1 only: an IBM extension) Create a finder helper interface for each

CMP entity bean that contains specialized finder methods (other than the findByPrimaryKey

method).

The following logic is required for each finder method (other than the findByPrimaryKey method)

contained in the home interface of an entity bean with CMP:

— The logic must be defined in a public interface named NameBeanFinderHelper, where Name is the
name of the enterprise bean (for example, AccountBeanFinderHelper).

— The logic must be contained in a String constant named findMethodName WhereClause, where
findMethodName is the name of the finder method. The String constant can contain zero or more
question marks (?) that are replaced from left to right with the value of the finder method’s
arguments when that method is called.

5.1+ IAssemble the beans in one or more EJB modules.|

Migrating enterprise bean code to the supported specification

Support for Version 2.0 of the Enterprise JavaBeans (EJB) specification is new for Version 5 of this
product. Migration of enterprise beans deployed in Version 4.0.x of this product is not generally necessary;
Version 1.1 of the EJB specification is still supported. Follow these steps as appropriate for your
application deployment.

1. Modify enterprise bean code for changes in the specification.

For Version 1.0 beans, |migrate at least to Version 1.1|

As stated previously, migration from Version 1.1 to Version 2.0 of the EJB specification is not
required for redeployment on this version of the product. However, if your application requires the
capabilities of Version 2.0, [migrate your Version 1.1-compliant code}

Note: The EJB Version 2.0 specification mandates that prior to the EJB container’s executing a
findByMethod query, the state of all enterprise beans enlisted in the current transaction be
synchronized with the persistent store. (This is so the query is performed against current
data.) If Version 1.1 beans are reassembled into an EJB 2.0-compliant module, the EJB
container synchronizes the state of Version 1.1 beans as well as that of Version 2.0 beans.
As a result, you might notice some change in application behavior even though the
application code for the Version 1.1 beans has not been changed.

2. Modify enterprise bean code for changes in deployment requirements. If the enterprise beans were
previously deployed in Version 3.0.x of this product, modify import statements to match standard
package names. In Version 3.0.2.x, the following standard packages were present under nonstandard
names:

javax.sql.*
javax.transaction.*
Any code using WebSphere data sources, including BMP entity beans and session beans that access
databases, must be modified.

3. You might have to modify code for some EJB 1.1-compliant modules that were not migrated to Version
2.0. Use the following information to help you decide.

Some stub classes for deployed enterprise beans have changed in the Java 2 Software
Development Kit, Version 1.4.1.

The task of [generating deployment code] for enterprise beans changed significantly for EJB
1.1-compliant modules relative to EJB 1.0-compliant modules.

If the CMP beans write to databases with mixed-case table or column names and you used IBM
VisualAge for Java, Version 3.5.x, to generate the original deployment code, you cannot simply
reassemble the beans in this product. You must export the original EJB project from the VisualAge
for Java product as an EJB 1.1 JAR. This preserves the metadata needed to generate the correct
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deployment code for mixed-case database tables and columns. For more information, see
[documentation for the Deployment Tool for Enterprise JavaBeans]

For detailed information about source and binary compatibility between deployed versions, see
"Resources for learning.”

4. |Reassemble|and [redeploy] all modules to incorporate migrated code.

Migrating enterprise bean code from Version 1.0 to Version 1.1

The following information generally applies to any enterprise bean that currently complies with Version 1.0
of the Enterprise JavaBeans (EJB) specification. For more information about migrating code for beans
produced with the IBM WebSphere Studio Application Developer tool, see the documentation for that
product. For more information about migrating code in general, see "Resources for learning.”

1. In session beans, replace all uses of javax.jts.UserTransaction with javax.transaction.UserTransaction.
Entity beans may no longer use the UserTransaction interface at all.

2. In finder methods for entity beans, include FinderException in the throws clause.
3. Remove throws of java.rmi.RemoteException; throw javax.ejb.EJBException instead. However,

continue to include RemoteException in the throws clause of home and remote interfaces as required
by the use of Remote Method Invocation (RMI).

4. Remove uses of the finalize() method.

5. Replace calls to getCallerldentity() with calls to getCallerPrincipal(). The use of getCallerldentity() is
deprecated.

6. Replace calls to isCallerlnRole(Identity) with calls to isCallerinRole (String). The use of
isCallerInRole(ldentity) and java.security.ldentity is deprecated.

7. Replace calls to getEnvironment() in favor of JNDI lookup. As an example, change the following code:

String homeName =
aLink.getEntityContext().getEnvironment().getProperty("TARGET _HOME_NAME");
if (homeName == null) homeName = "TARGET_HOME_NAME";

The updated code would look something like the following:

Context env = (Context)(new InitialContext()).lookup("java:comp/env");
String homeName = (String)env.lookup("ejbl0-properties/TARGET_HOME_NAME");

8. In ejbCreate methods for an entity bean with container-managed persistence (CMP), return the bean’s
primary key class instead of void.

9. Add the getHomeHandle() method to home interfaces.
public javax.ejb.HomeHandle getHomeHandle() {return null;}

Consider enhancements to match the following changes in the specification:

* Primary keys for entity beans can be of type java.lang.String.

» Finder methods for entity beans return java.util.Collection.

* Check the format of any JNDI names being used. Local name spaces are also supported.

» Security is defined by role, and isolation levels are defined at the method level rather than at the bean
level.

Migrating enterprise bean code from Version 1.1 to Version 2.0

Enterprise JavaBeans (EJB) Version 2.0-compliant beans may be assembled only in an EJB 2.0-compliant
module, although an EJB 2.0-compliant module can contain a mixture of Version 1.x and Version 2.0
beans.

The EJB Version 2.0 specification mandates that prior to the EJB container’s executing a findByMethod
query, the state of all enterprise beans enlisted in the current transaction be synchronized with the
persistent store. (This is so the query is performed against current data.) If Version 1.1 beans are
reassembled into an EJB 2.0-compliant module, the EJB container synchronizes the state of Version 1.1
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beans as well as that of Version 2.0 beans. As a result, you might notice some change in application
behavior even though the application code for the Version 1.1 beans has not been changed.

The following information generally applies to any enterprise bean that currently complies with Version 1.1
of the EJB specification. For more information about migrating code for beans produced with the IBM
WebSphere Studio Application Developer tool, see the documentation for that product. For more
information about migrating code in general, see "Resources for learning.”

1. In beans with container-managed persistence (CMP) version 1.x, replace each CMP field with abstract
get and set methods. In doing so, you must make each bean class abstract.

2. In beans with CMP version 1.x, change all occurrences of this.field = value to setField(value).
In each CMP bean, create abstract get and set methods for the primary key.
4. In beans with CMP version 1.x, create an EJB Query Language statement for each finder method.

w

Note: EJB Query Language has the following limitations in WebSphere Studio Application Developer
Version 5:

» EJB Query Language queries involving EJBs with keys made up of relationships to other
EJBs appear as invalid and cause errors at deployment time.

« The IBM EJB Query Language support extends the EJB 2.0 spec in various ways, including
relaxing some restrictions, adding support for more DB2 functions, and so on. If portability
across various vendor databases or EJB deployment tools is a concern, then care should be
taken to write all EJB Query Language queries strictly according to instructions described in
Chapter 11 of the EJB 2.0 specification.

5. In finder methods for beans with CMP version 1.x, return java.util.Collection instead of
java.util. Enumeration.

6. Update handling of non-application exceptions.

» To report non-application exceptions, throw javax.ejb.EJBException instead of
java.rmi.RemoteException.

* Modify rollback behavior as needed: In EJB versions 1.1 and 2.0, all non-application exceptions
thrown by the bean instance result in the rollback of the transaction in which the instance is running;
the instance is discarded. In EJB 1.0, the container does not roll back the transaction or discard the
instance if it throws java.rmi.RemoteException.

7. Update rollback behavior as the result of application exceptions.
* In EJB versions 1.1 and 2.0, an application exception does not cause the EJB container to
automatically roll back a transaction.
* In EJB Version 1.1, the container performs the rollback only if the instance has called
setRollbackOnly() on its EJBContext object.
* In EJB Version 1.0, the container is required to roll back a transaction when an application exception
is passed through a transaction boundary started by the container.

8. Update any CMP setting of application-specific default values to be inside ejbCreate (not using global
variables, since EJB 1.1 containers set all fields to generic default values before calling ejbCreate,
which overwrites any previous application-specific defaults). This approach also works for EJB 1.0
CMPs.

Note: In Application Developer Version 5, there is a J2EE Migration wizard to migrate the EJB beans
within an EJB 2.0 project from 1.x into 2.0 (you cannot just migrate individually selected beans).
The wizard performs migration steps #1 to #2 above. It also migrates EJB 1.1 (proprietary)
relationships into EJB 2.0 (standard) relationships, and maintains EJB inheritance.

WebSphere extensions to the Enterprise JavaBeans specification

This article outlines extensions to the Enterprise JavaBeans (EJB) specification that IBM provides with this
product:
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Inheritance in enterprise beans

In the Java language, inheritance is the creation of a new class from an existing class or a new interface
from an existing interface. This product supports two forms of inheritance: standard class inheritance and
EJB inheritance.

In standard class inheritance, the home interface, remote interface, or enterprise bean class inherits
properties and methods from base classes that are not themselves enterprise bean classes or interfaces.

By contrast in enterprise bean inheritance, an enterprise bean inherits properties (such as
container-managed persistence (CMP) fields and container-managed relationship (CMR) fields), methods,
and method-level control descriptor attributes from another enterprise bean.

For more information, see the documentation for the IBM WebSphere Studio Application Developer
product.

Optimistic concurrency control for container-managed persistence
This product supports optimistic concurrency control of data access.
Access intents for EJB persistence

This product supports the application of named data-access policies.
Performance enhancements

Through the lifetime-in-cache settings, this product provides a way for you to improve performance for
beans that are only occasionally updated. For more information, see "Entity bean assembly settings.”

Some enterprise beans created with the IBM WebSphere Studio Application Developer product can utilize
read-ahead for loading a bean and its related beans in a single database operation. An entire object graph
or any part of the graph can be preloaded by configuring a finder method to use read-ahead.

Assembly and deployment extensions

51* This product supports IBM extensions of and deployment options.

Best practices for developing enterprise beans

Use the following guidelines when designing and developing enterprise beans:

* Use a stateless session bean to act as the entry point for business logic. For more information about
using session facades, see "Resources for learning.”

» Entity beans should use container-managed persistence.

* In an Enterprise JavaBeans (EJB) Version 2.0 environment, use local interfaces to improve
communication between enterprise beans in the same Java virtual machine.

Local calls avoid the overhead of RMI/IIOP and use pass-by-reference semantics instead of
pass-by-value. For each call, the caller and callee beans share the state of arguments. EJB 2.0 beans
can have both a local and remote interface but more typically have one or the other.

» For communicating with remote clients, provide remote and remote home interfaces. For communicating
with local clients like servlets, entity beans, and message-driven beans, provide local and local home
interfaces.
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Batch commands for container managed persistence

From JDBC 2.0 on, PreparedStatement objects can maintain a list of commands that can be submitted
together as a batch. Instead of multiple database round trips, there can be only one database round trip
for all the batched persistence requests.

The WebSphere Application Server version 5.0.2 enables you to take advantage of this. You can turn this
option on from the EJB CMP side. When you choose this option, the run time defers
ejbStore/ejbCreate/ejbRemove or the equivalent database persistence requests (insert/update/delete) until
they are needed. This can be at the end of the transaction, or when a flush is needed for finders related to
this EJB type. When the persistence operation finally happens, run time accumulates the database
requests and uses JDBC PreparedStatement batch operation to make a single JDBC call for multiple rows
of the same operation.

Setting the run time for batched commands:

Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Additional Properties area, select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with Dcom.ibm.ws.pm.batch=true.

N o oD~

Deferred Create for container managed persistence

The specification for Enterprise Java Beans (EJB) 2.x states that for Container Managed Persistence
(CMP) during the ejbCreate, the container can create the representation of the entity in the database
immediately, or defer it to a later time.

The WebSphere Application Server version 5.0.2 enables you to take advantage of this specification. You
can turn this option on from the EJB CMP side. When you choose this option, the runtime defers
gjbCreate (or the equivalent database persistence request) until it is needed. This can be at the end of the
transaction, or when a flush is needed for finders related to this EJB type. By doing this you can reduce
two round trips for the newly created entity (insert and update) to one (insert).

Setting the run time for deferred create:

The specification for Enterprise Java Beans (EJB) 2.x states that for Container Managed Persistence
(CMP) during the ejbCreate, the container can create the representation of the entity in the database
immediately, or defer it to a later time. When you choose the defer option, the runtime defers ejbCreate (or
the equivalent database persistence request) until it is needed. This can be at the end of the transaction,
or when a flush is needed for finders related to this EJB type. By doing this you can reduce two round
trips for the newly created entity (insert and update) to one (insert).

1. Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Additional Properties area, select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with Dcom.ibm.ws.pm.deferredcreate=true.

N o o~ DD
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Explicit invalidation in the Persistence Manager cache

Container managed persistence (CMP) entity beans can be configured as long-lifetime beans. A
long-lifetime bean is one that is configured with Lifetime In Cache Usage equal to a value other than the
default OFF . A value other than OFF means that data for this bean is cached beyond the end of the
transaction in which the bean was obtained by a finder or other method. The Lifetime In Cache Usage and
Lifetime In Cache values control the basic length of time the cached data remains valid. When the
specified time runs out, the cached data is no longer valid. See the LifetimelnCache help sections of the
Assembly Toolkit (ATK) for more details.

However, there is also an API that lets the client application code explicitly invalidate the cached data of a
bean on demand, superceding the basic lifetime of the cache data as controlled by the Lifetime In Cache
Usage and Lifetime In Cache settings. This is useful where an application that does not use CMP beans
modifies the data that underlies a CMP bean (for example, it updates a database table to which a CMP
bean is mapped). Such an application can inform WebSphere Application Server that any cached version
of this bean data is stale and no longer matches what is in the database. The data should be invalidated
(in essence, discarded). For CMP beans that cannot tolerate stale data, this is an important feature.

Because the PM Cache Invalidation mechanism does consume resources in exchange for its benefits, it is
not enabled by default. To enable it refer to[Setting Persistence Manager Cache Invalidation|.

Example: Explicit Invalidation in the Persistence Manager Cache:
Usage Scenario

The scenario of use for this feature begins with configuring one or more bean types to be long-lifetime
beans (see |[Explicit Invalidation in the Persistence Manager Cache] and configuring the necessary Java
Message Service (JMS) resources (described below). Once this is done, the server is started. The
scenario continues as follows:

1. Assume that a CMP entity bean of type Department has been configured to be a long-lifetime bean.

2. Transaction 1 begins. Application code looks up Departments home and calls a finder method (such
as findByPrimaryKey("dept01”) ). As this is the first finder to return Department dept01, a trip is made
to the database to obtain the data. Transaction 1 ends.

3. Transaction 2 begins. Application code calls findByPrimaryKey(" dept01") again. Because this is not the
first finder to return Department dept01, we get a cache hit and no database trip is made. So far this is
current WebSphere Application Server behavior for long-lifetime beans. Transaction 2 ends.

4. Another application, which does not use the Department CMP bean, is executed. This application
might or might not be run on the WebSphere Application Server; it could be a legacy application. The
application updates the database table that is mapped to the Department bean, altering the row for
dept01. For example, the budget column in the table (mapped to a Java double CMP attribute in the
Deparment bean) is changed from $10,000.00 to $50,000.00. This application was designed to
cooperate with WebSphere Application Server. After performing the update, the application sends an
invalidate request message to invalidate the Department bean dept0O1.

5. Transaction 3 begins. Application code looks up Departments home and calls a finder method (such
as findByPrimaryKey(" dept01”) ). Because this is the first finder after Department dept01 is invalidated,
a new database trip is made to obtain the data. Transaction 3 ends.

Persistence Manager cache invalidation API

The PM cache invalidation API is in the form of a JMS message that the client sends to a specially-named
JMS topic using a connection from a specifically named JMS TopicConnectionFactory. The JMS message
must be an ObjectMessage created by the client. The client code creates a PMCachelnvalidationRequest
object that describes the bean data to invalidate. Client code places the PMCachelnvalidationRequest
object in the ObjectMessage and publishes the ObjectMessage (for further details on the JMS objects and
terms used here, please see the Java Message Service documentation).
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The public class PMCachelnvalidationRequest is central to the API, so we include a portion of its code
here for illustration purposes (if you see any differences between this illustration and the actual class, the
class is to be considered correct):

packagecom. ibm.websphere.ejbpersistence;

[x*

*An instance of this class represents a request to invalidate one or more
*CMP beans in the PMcache.When an invalidate occurs,cached datafor this
*bean is removed from the cache;the next time an application tries to find
*this bean,a fresh copy of the bean data is obtained from the data store.
*

*The ability to invalidate a bean means that a CMP bean may be configured
*as a long-Tifetime bean and thus be cached across transactions for much
*greater performance on future attempts to find this bean.Yet when some
*outside mechanism updates the bean data,sending an invalidation request
*will remove stale data from the PMcache so applications do not behave falsely
*based on stale data.

*/

public class PMCacheInvalidationRequestimplementsSerializable{

[**
* Constructor used to invalidate a single bean
* @param beanHomeJNDIName the JNDI name of the bean home. This is the same value
* used to look up the bean home prior to calling findByPrimaryKey, for example.
* @param beanKey the primary key of the bean to be invalidated. The actual
* object type must be the primary key type for this bean type.
*
/
public PMCacheInvalidationRequest(String beanHomeJNDIName, Object beanKey)
throws IOException {

}

[**

* Constructor used to invalidate a Collection of beans

* @param beanHomeJNDIName java.lang.String the JNDI name of the bean home.
* This is the same value used to look up the bean home prior to calling

* findByPrimaryKey, for example.

* @param beanKeys a Collection of the primary keys of the beans to be

* invalidated. The actual type of each object in the Collection must be the
* primary key type for this bean type.
*

/

public PMCacheInvalidationRequest(String beanHomeJNDIName, Collection beanKeys)
throws IOException {

}
[**
* Constructor used to invalidate all beans of a given type
* @param beanHomeJNDIName java.lang.String the JNDI name of the bean home.
* This is the same value used to look up the bean home prior to calling
* findByPrimaryKey, for example.
*
/
public PMCacheInvalidationRequest(String beanHomeJNDIName) {

)
}

If the client wants to perform the invalidation in a synchronous way, it can opt to receive an
acknowledgement JMS message when the invalidation is complete. To ask for an acknowledgement (ACK)
message, the client sets a Topic of its own choosing in the JMSReplyTo field of the ObjectMessage for the
invalidation request (see JMS documentation for further details). The client then waits (using the receive()
method of JMS) on receipt of the acknowledgement message before continuing execution.
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An ACK message enables the caller to insure there is not even a brief (seconds or less) window during
which PM cache data is stale. The sending of an acknowledgement for each request does, of course, take
a bit more time and so is recommended to be used only when needed.

The JMS resources used to make an invalidation request ( TopicConnectionFactory, TopicDestination, and
so forth) must be configured by the user (using the Administration console or other method) if they want to
use PM Cache Invalidation. In this way the user can chose whichever JMS provider they prefer (as long
as it supports pub-sub). The names that must be used for these resources are defined as part of the API,
and use names unique to the WebSphere Application Server namespace to avoid name conflict with
customer JMS resources.

The following are the names that must be used when the user configures the JMS resources (shown as
Java constants for clarity):

// The JNDI name of the TopicConnectionFactory
private static final String topicConnectionFactoryJNDIName = "com.ibm.websphere.ejbpersistence.InvalidateTCF";
// The JINDI name of the TopicDestination
private static final String topicDestinationJNDIName = "com.ibm.websphere.ejbpersistence.invalidate";
// The Topic name (part of the TopicDestination)
private static final String topicString = "com.ibm.websphere.ejbpersistence.invalidate";

Here are examples of how these constants can be used in client code:

// Look up the TopicConnectionFactory...
InitialContext ic = new InitialContext();
TopicConnectionFactory topicConnectionFactory = (TopicConnectionFactory) ic.lookup(topicConnectionFactoryJNDIName);

// Look up the Topic
Topic topic = (Topic) ic.lookup(topicDestinationJNDIName);

Note that JMS messages can be sent not only from J2EE application code (for example, a SessionBean
or BMP entity bean method) but also from non-J2EE applications if your chosen JMS provider allows for
this. For example, the IBM MQ provider, available in WebSphere Application Server as the Embedded
Messaging feature (selectable during installation), supports the use of MQ classes (or structures in other
languages) to create a topic connection and topic that are compatible with the TopicConnectionFactory
and TopicDestination you configure using WebSphere Application Server Application Console.

Setting Persistence Manager Cache Invalidation:

Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Additional Properties area, select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with -Dcom.ibm.ws.ejbpersistence.cacheinvalidation=true.

No o~ =

Unknown primary-key class

When writing an entity bean for Enterprise Java Bean Version 2.0, the minimum requirements usually
include a primary-key class. However, in some cases you might choose not to specify the primary-key
class for an entity bean with container managed persistence (CMP). Perhaps there is no obvious primary
key, or you want to allow the deployer to select the primary key fields at deployment time. The primary key
type is usually derived from the type used by the database system that stores the entity objects, and you
might not know what this key is.

So, the unknown key type is actually a type chosen at deployment time, making it changeable each time
the bean is deployed. Your client code must deal with this key as type Object.
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Currently, WebSphere Application Server supports top-down mapping and enables the deployer to choose
String keys generated at the application server. For an example of how to use this function, see the
Samples library.

Using access intent policies

You can use access intent policies to help the product run-time environment manage various aspects of
Enterprise JavaBeans (EJB) persistence. You apply access intent policies to EJB Version 2.0 entity beans
and their methods by using an application assembly tool. A set of default access intent policies comes with
the|Assemny Toolkitl You can also create your own custom policies.

1. Apply default access intent to CMP entity beans. For more information, see the online help available
with the Assembly Toolkit.

Apply access intent policies to methods| of CMP entity beans.

Create a custom access intent policy|

Apply access intent policies to BMP entity bean methods by [using the AccessIntent API|
Apply multiple access intent policies to methods by using|application profiling|

o bk 0N

Access intent policies

An access intent policy is a named set of properties (access intents) that governs data access for
Enterprise JavaBeans (EJB) persistence. You can assign policies to an entity bean and to individual
methods on an entity bean’s home, remote, or local interfaces during assembly. If you have the Integration
Server product installed, you can assign these during development as well. You can set access intents
only within EJB Version 2.x-compliant modules for entity beans with bean-managed persistence or with
CMP Version 2.x.

This product supplies a number of access intent policies that specify permutations of read intent and
concurrency control; the pessimistic/update policy can be qualified further. The selected policy determines
the appropriate isolation level and locking strategy used by the run time environment.

Access intent policies are specifically designed to supplant the use of isolation level and access intent
method-level modifiers found in the extended deployment descriptor for EJB version 1.1 enterprise beans.
You cannot specify isolation level and read-only modifiers for EJB version 2.0 enterprise beans.

Access intent policies configured on an entity basis define the default access intent for that entity. The
default access intent controls the entity unless you specify a different access intent policy based on either
method-level configuration or application profiling

You can use application profiling or method level access intent policies to control access intent more
precisely. Application profiling is only available in the Integration Server product. Method-level access
intent policies are named and defined at the module level. A module can have one or many such policies.
Policies are assigned, and apply, to individual methods of the declared interfaces of entity beans and their
associated home interfaces. A method-based policy is acted upon by the combination of the EJB container
and persistence manager when the method causes the entity to load. A policy is acted upon by either the
combination of the EJB container and persistence manager (for entity beans with container-managed
persistence) or directly by entity beans with bean-managed persistence.

For entity beans that are backed by tables with nullable columns, use an optimistic policy with caution.
Nullable columns are automatically excluded from overqualified updates at deployment time; concurrent
changes to a nullable field might result in lost updates. When used with the IBM WebSphere Studio
Application Developer product, this product provides support for selecting a subset of the non-nullable
columns that are to be reflected in the overqualified update statement that is generated in the deployment
code to support optimistic policies.
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An entity that is configured with a read-only policy that causes a bean to be activated can cause problems
if updates are attempted within the same transaction. Those changes are not committed, and the process
throws an exception because data integrity might be compromised.

Concurrency control

Concurrency control is the management of contention for data resources. A concurrency control scheme is
considered pessimistic when it locks a given resource early in the data-access transaction and does not
release it until the transaction is closed. A concurrency control scheme is considered optimistic when locks
are acquired and released over a very short period of time at the end of a transaction.

The objective of optimistic concurrency is to minimize the time over which a given resource would be
unavailable for use by other transactions. This is especially important with long-running transactions, which
under a pessimistic scheme would lock up a resource for unacceptably long periods of time.

Under an optimistic scheme, locks are obtained immediately before a read operation and released
immediately afterwards. Update locks are obtained immediately before an update operation and held until
the end of the transaction.

To enable optimistic concurrency, this product uses an overqualified update scheme to test whether the
underlying data source has been updated by another transaction since the beginning of the current
transaction. With this scheme, the columns marked for update and their original values are added explicitly
through a WHERE clause in the UPDATE statement so that the statement fails if the underlying column
values have been changed. As a result, this scheme can provide column-level concurrency control;
pessimistic schemes can control concurrency at the row level only.

Optimistic schemes typically perform this type of test only at the end of a transaction. If the underlying
columns have not been updated since the beginning of the transaction, pending updates to
container-managed persistence fields are committed and the locks are released. If locks cannot be
acquired or if some other transaction has updated the columns since the beginning of the current
transaction, the transaction is rolled back: All work performed within the transaction is lost.

Pessimistic and optimistic concurrency schemes require different transaction isolation levels. Enterprise
beans that participate in the same transaction and require different concurrency control schemes cannot
operate on the same underlying data connection.

Whether or not to use optimistic concurrency depends on the type of transaction. Transactions with a high
penalty for failure might be better managed with a pessimistic scheme. (A high-penalty transaction is one
for which recovery would be risky or resource-intensive.) For low-penalty transactions, it is often worth the
risk of failure to gain efficiency through the use of an optimistic scheme. In general, optimistic concurrency
is more efficient when update collisions are expected to be infrequent; pessimistic concurrency is more
efficient when update collisions are expected to occur often.

Read-ahead hints

Read-ahead schemes enable applications to minimize the number of database roundtrips by retrieving a
working set of container-managed persistence (CMP) beans for the transaction within one query.
Read-ahead involves activating the requested CMP beans and caching the data for their related beans,
which ensures that data is present for the beans that are most likely to be needed next by an application.
A read-ahead hint is a canonical representation of the related beans that are to be read. It is associated
with the findByPrimaryKey method for the requested bean type, which must be an EJB 2.x-compliant CMP
entity bean.

Read-ahead hints can be set only using the WebSphere Business Integration Server Foundation assembly
tool or through the Add Access Intent wizard of the IBM WebSphere Studio Application Developer product.

Read-ahead is only supported for access intent policies that can be applied by the backend against which
the application is deployed. Otherwise, the read-ahead hint is disregarded.
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Currently, only findByPrimaryKey methods can have read-ahead hints. Only beans related to the requested
beans by a container-managed relationship (CMR), either directly or indirectly through other beans, can be
read ahead. Beans that use EJB inheritance should not be used in a read-ahead hint.

A read-ahead hint takes the form of a character string. You do not have to provide the string; the wizard
generates it for you based on CMRs defined for the bean. The following example is provided as
supplemental information only.

Suppose a CMP bean type A has a finder method that returns instances of bean A. A read-ahead hint for
this method is specified using the following notation: RelB.RelC; RelD

Interpret the preceding notation as follows:
» Bean type A has a CMR with bean types B and D.
» Bean type B has a CMR with bean type C.

For each bean of type A that is retrieved from the database, its directly-related B and D beans and its
indirectly-related C beans are also retrieved. The order of the retrieved bean data columns in each row of
the result set is the same as their order in the read-ahead hint: an A bean, a B bean (or null), a C bean (or
null), a D bean (or null). For hints in which the same relationship is mentioned more than once (for
example, RelB.RelC;RelB.RelE), a bean’s data columns appear only once, at the position it first appears in
the hint.

The tokens shown in the notation (RelB and so on) must be CMR field names for the relationships as
defined in the deployment descriptor for the bean. In indirect relationships such as RelB.RelC, RelC is a
CMR field name defined in the deployment descriptor for bean type B.

A single read-ahead hint cannot refer to the same bean type in more than one relationship. For example, if
a Department bean has a relationship employees with the Employee bean and also has a relationship
manager with the Employee bean, the read-ahead hint cannot specify both employees and manager.

For more information about how to set read-ahead hints, see the documentation for the Websphere Studio
Application Developer product.

Access intent service

Access intent is a WebSphere Application Server run-time service that enables you to more precisely
manage an application’s persistence. The access intent service defines a set of declarative annotations
used by the Enterprise JavaBeans (EJB) container and its agents to make performance optimizations for
entity bean access. These annotations are organized into sets called access intent policies.

Access intent policies contain a set of annotations considered as hints by the EJB container and its
agents. Most access intent policies are hints representing high-level abstractions that can be mapped to a
specific backend resource manager. It is the responsibility of the EJB persistence machinery to ensure the
necessary concurrency control, connection, and cache management when carrying out the persistence
details. The EJB persistence manager can use access intent hints to make better performance decisions
when carrying out its assigned task. A smaller number of access intents are hints to the EJB container,
influencing the management of EJB collections.

Although it is recommended that you always configure bean level access intent for your applications, if you
find it necessary you can apply access intent policies to methods within the scope of an EJB module. In
such cases the policy becomes the default access intent for all requests upon the configured methods.

You can also apply access intent policies to beans within the scope of application profiles. Consequently,
you can configure beans with multiple and opposing access intent policies. The application profiling
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documentation explains in more detail how to configure an application to apply a particular access intent
policy to a bean for one request, then apply another access intent policy to the same bean for a different
request.

Access intent with BMP entity beans

Access intent’s declarative functionality provides great power to you as a CMP entity bean developer. You
can provide hints on how WebSphere Application Server is to manage the details of persistence without
having to explicitly manage any of the persistence logic from within the application.

There are situations, however, in which you might need to develop BMP entity beans. Because the only
meaningful difference between BMP and CMP components is who provides the persistence logic, BMP
entity beans should be able to leverage access intent hints just as WebSphere Application Server does on
behalf of CMP entity beans. BMP entity beans that use the access intent service participate in application
profiling; that is, the value of the access intent attributes can differ from request to request, allowing the
BMP entity bean to seamlessly modify its persistence strategy.

You can apply access intent policies to BMP entity bean methods as well as CMP entity bean methods.
Because access intent hints are not contractual in nature, there is no obligation for a BMP entity bean to
exploit them. BMP entity beans are expected to use only those access intent attributes that are important
to that particular bean.

The current access intent policy is bound into the java:comp namespace for a particular BMP entity bean.
That policy is current only for the duration of the method call during which the access intent policy was
retrieved. In a typical scenario, you would cache the access type during invocation of the ejbLoad()
method so that appropriate actions can be taken during invocation of the ejbStore() method.

Access intent design considerations

Use the access intent service to solve clear performance problems. Identify usage patterns that lead to
poor application performance and apply appropriate access intent policies.

Refrain from over-tuning an application. You can introduce errors by incorrectly using the access intent
service. For example, misuse of the wsPessimisticUpdate-NoCollision policy can result in lost updates;
inappropriately setting the collection increment value can introduce performance issues; and problem
determination is more difficult when an application is confusingly configured with multiple access intent
policies. Clarity and simplicity should be your guiding principles when using the access intent service. This
is even more important when applying access intent polices within the scope of application profiles (a
feature of WebSphere Business Integration Server Foundation).

Even though access intent policies can be configured on any method of an entity bean, some attributes of
a policy can only be leveraged by the run-time environment under certain conditions. For example,
concurrency and access intent are only used for CMP entity beans when the ejbLoad() method is driven to
open a connection to, and read data from, a given resource; that data is cached and used to drive the
proper queries during invocation of the ejbStore() method. Read-ahead hints are only used during the
execution of a finder for a bean. Finally, the collection increment and resource manager prefetch increment
are only used on multi-object finders. Configuring policies on methods that will not use the policy is not an
error (only certain attributes of any policy are used, even when the policy is appropriately applied to a
method). However, configuring policies unnecessarily throughout an application obscures the design of the
application and complicates the maintenance of the application.

Applying access intent policies to methods

You apply an access intent policy to a method, or set of methods, in an application’s entity beans through
the |Assembly Toolkitl

1. |Start the Assembly Toolkit}
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17.
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Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

Optional: Open the J2EE Hierarchy view. Click Window > Show View > J2EE Hierarchy. Other
helpful views include the Project Navigator view (Window > Show View > Other > J2EE > Project
Navigator) and the Navigator view (Window > Show View > Navigator).

Select the Access tab.

On the right side of the Access Intent for Entities 2.x (Method Level) panel, select Add. The Add
Access Intent panel displays.

Specify the Name for your new intent policy.
Select the Access intent name from the drop-down list.
Enter a Description to help you remember what this policy does.

Optional: Select Read Ahead Hint. A single access intent read ahead hint might not refer to the
same bean type in more than one relationship. For example, if a Department enterprise bean has a
relationship employees with the Employee enterprise bean, and also has a relationship manager with
the Employee enterprise bean, then a read ahead hint cannot specify both employees and manager.

Click Next. The next Add Access Intent panel displays, with optional attributes.

Optional: Decide whether or not to overwrite these optional access intent attributes. Click on those
you want to change.

Click Next. The next Add Access Intent panel, with a list of Enterprise Beans, displays.
Select one or more Enterprise Beans from the list.

Note: If you selected Read Ahead Hint in an earlier step, you can only select ONE bean at this
step.

Click Next. The next Add Access Intent panel, with a list of methods, displays.
Select the methods you want to use.

If you DID NOT select Read Ahead Hint in an earlier step, click Finish. If you DID select the Read
Ahead Hint option, you can click Next to specify your Read Ahead Hint for the specified bean. The
next Add Access Intent panel, with a list of EJB preload paths, displays.

Edit the EJB preload path by selecting relationship roles from the Relationship roles: window.
Click Finish. A new entry is created in the Access Intent for Entities 2.x (Method Level) panel

Using the Accessintent API

This task describes how to programmatically retrieve and call the Accessintent APl during the execution of
BMP entity bean methods.

1.

Look up the current access intent in the namespace. For example:

InitialContext ic = new InitialContext();
AccessIntent ai = ic.lookup("java:comp/websphere/AppProfile/AccessIntent");

Call the necessary get() methods. For example:

int concurrency = ai.getConcurrencyControl();
int accessType = ai.getAccessType();
if ( (concurrency == AccessIntent.CONCURRENCY_ CONTROL_PESSIMISTIC)
&& (accessType == AccessIntent.ACCESS_TYPE_UPDATE) ) {
boolean exclusive = ai.getPessimisticUpdateHintExclusive();

/...
}
/...

Note: The access intent object reference retrieved from the java:comp lookup is current for the duration of

the method in which the reference was looked up. Depending on how you configured the
application profile, subsequent calls of the same method might not retrieve the same access intent
reference. You can only look up the object reference during the call of a BMP entity bean’s method;
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the reference does not exist during a request on a CMP entity bean. Therefore, access intent object
references should not be cached beyond, or used outside of, the scope of the execution of any
given BMP method.

Accesslintent interface
The Accesslintent interface is available to BMP entity beans by the following JNDI lookup:

Jjava:comp/websphere/AppProfile/AccessIntent

Accesslintent interface
package com.ibm.websphere.appprofile.accessintent;

[ **

* This interface defines the essential access intents
* available at runtime.

*/

public interface AccessIntent {

[x%

* Returns the concurrency control intent, which indicates
* the application prefers either pessimistic or optimistic
* concurrency control when accessing the current component
* in the context of the current transaction.

*

/

public int getConcurrencyControl();

public final int CONCURRENCY_CONTROL PESSIMISTIC = 1;
public final int CONCURRENCY_CONTROL_OPTIMISTIC = 2;

[**

* Returns access type intent, which indicates the application

* intends either update or read accesss of the current component
* in the context of the current transaction.

*

/

public int getAccessType();

public final int ACCESS_TYPE_UPDATE= 1;

public final int ACCESS_TYPE_READ = 2;

[ **

* Returns a boolean where true indicates that the runtime should
* assume that there will be no collision on retrieved rows.

*/

public boolean getPessimisticUpdateHintNoCollision();

/*

* Returns a boolean where true indicates that the runtime should
* assume that there will be collisions on retrieved rows.

*/

public boolean getPessimisticUpdateHintExclusive();

[ **

* Returns the collection access intent, which indicates the

* application intends to access the objects returned by the

* currently executing finder in either serial or random fashion.
*

/

public int getCollectionAccess();

pubTic final int COLLECTION_ACCESS_RANDOM = 1;

public final int COLLECTION_ACCESS_SERIAL = 2;

[x%

* Returns the collection scope, which indicates the maximum
* lifespan of a lazy collection.

*

/

public int getCollectionScope();

public final int COLLECTION_SCOPE_TRANSACTION = 1;

public final int COLLECTION_SCOPE_ACTIVITYSESSION = 2;
public final int COLLECTION_SCOPE_TIMEOUT = 3;
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[**

* Returns the timeout value in seconds when collectionScope is Timeout.
*/

public int getCollectionTimeout();

[**

* Returns the number of elements the application requests be contained
* in each segment of the element collection returned by the currently
* executing finder.

*/

public int getCollectionIncrement();

[**

* Returns the ReadAheadHint requested by the application for the currently
* executing finder.

*/

public ReadAheadHint getReadAheadHint();

[ **

* Returns the number of elements the application requests be contained in
* each segment of a a query made on a database.

*/

public int getResourceManagerPreFetchIncrement();

}

Access intent exceptions

The following exceptions are thrown in response to the application of access intent policies:

com.ibm.ws.ejbpersistence.utilpm.PersistenceManagerException
If the method that drives the ejbLoad() method is configured to be read-only but updates are then
made within the transaction that loaded the bean’s state, an exception is thrown during invocation
of the ejbStore() method, and the transaction is rolled back. Likewise, the ejpRemove() method
cannot succeed in a transaction that is set as read-only. If an update hint is applied to methods of
entity beans with bean-managed persistence, the same behavior and exception results. The
forwarded exception object contains the message string PMGR1103E: update instance level read
only bean beanName

This exception is also thrown if the applied access intent policy cannot be honored because a
finder, ejbSelect, or container-managed relationship (CMR) accessor method returns an inherently
read-only result. The forwarded exception object contains the message string PMGR1001: No such
DataAccessSpec - methodName

The most common occurrence of this error is when a custom finder that contains a read-only EJB
Query Language (EJB QL) statement is called with an applied access intent of
wsPessimisticUpdate or wsPessimisticUpdate-Exclusive. These policies require the use of a USE
AND KEEP UPDATE LOCKS clause on the SQL SELECT statement to be executed, but a
read-only query cannot support USE AND KEEP UPDATE LOCKS. Other examples of read-only
queries include joins; the use of ORDER BY, GROUP BY, and DISTINCT keywords.

To eliminate the exception, edit the EJB query so that it does not return an inherently read-only

result or change the access intent policy being applied.

» If an update access is required, change the applied access intent setting to
wsPessimisticUpdate-WeakestLockAtLoad or wsOptimisticUpdate.

+ If update access is not truly required, use wsPessimisticRead or wsOptimisticRead.

 If connection sharing between entity beans is required, use wsPessimisticUpdate-
WeakestLockAtLoad or wsPessimisticRead.

com.ibm.websphere.ejb.container.CollectionCannotBeFurtherAccessed
If a lazy collection is driven after it is no longer in scope, and beyond what has already been
locally buffered, a CollectionCannotBeFurtherAccessed exception is thrown.
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com.ibm.ws.exception.RuntimeWarning
If an application is configured incorrectly, a run-time warning exception is thrown as the application
starts; startup is ended. You can validate an application’s configuration by choosing the verify
function. Some examples of misconfiguration include:
* A method configured with two different access intent policies
* A method configured with an undefined access intent policy

javax.ejb.NoSuchEntityException
If an update fails under optimistic concurrency because fields changed within another transaction
between load and store requests, a NoSuchEntityException is raised and the commit fails.

Access intent assembly settings

Access intent policies contain data-access settings for use by the persistence manager. Default access
intent policies are configured on the entity bean. Optionally, you can associate access intent policies with
one or more methods.

These settings are applicable only for EJB 2.x-compliant entity beans that are packaged in EJB
2.x-compliant modules. Connection sharing between beans with bean-managed persistence and those with
container-managed persistence is possible if they all use the same access intent policy.

Name
Specifies a name for a mapping between an access intent policy and one or more methods.

Description
Contains text that describes the mapping.

Methods - Name
Specifies the name of an enterprise bean method, or the asterisk character (*). The asterisk is used to
denote all of the methods of an enterprise bean’s remote and home interfaces.

Methods - Enterprise bean
Specifies which enterprise bean contains the methods indicated in the Name setting.

Methods - Type
Used to distinguish between a method with the same signature that is defined in both the home and
remote interface. Use Unspecified if an access intent policy applies to all methods of the bean.

Data type String
Range Valid values are Home, Remote,Local, LocalHome or
Unspecified

Methods - Parameters
Contains a list of fully qualified Java type names of the method parameters. This setting is used to identify
a single method among multiple methods with an overloaded method name.

Applied access intent
Specifies how the container must manage data access for persistence. Configurable both as a default
access intent for an entity and as part of a method-level access intent policy.

Data type String
Default wsPessimisticUpdate-WeakestLockAtLoad. With Oracle,
this is the same as wsPessimisticUpdate.
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Range Valid settings are wsPessimisticUpdate,
wsPessimisticUpdate-NoCollision, wsPessimisticUpdate-
Exclusive, wsPessimisticUpdate-WeakestLockAtLoad,
wsPessimisticRead, wsOptimisticUpdate, or
wsOptimisticRead. Only wsPessimisticRead and
wsOptimisticRead are valid when class-level caching is
enabled in the EJB container.

This product supports lazy collections. For each segment of a collection, iterating through the collection
(next()) does not trigger a remote method call to retrieve the next remote reference. Two policies
(wsPessimisticUpdate and wsPessimisticUpdate-Exclusive) are extremely lazy; the collection increment
size is set to 1 to avoid overlocking the application. The other policies have a collection increment size of
25.

If an entity is not configured with an access intent policy, the run-time environment typically uses
wsPessimisticUpdate-WeakestLockAtLoad by default. If, however, the Lifetime in cache property is set on
the bean, the default value of Applied access intent is wsOptimisticRead; updates are not permitted.

Additional information about valid settings follows:

Profile name Concurrency control Access type Transaction isolation

wsPessimisticRead (Note 1) pessimistic read For Oracle, read committed.
Otherwise, repeatable read

wsPessimisticUpdate (Note pessimistic update For Oracle, read committed.

2) Otherwise, repeatable read

wsPessimisticUpdate- pessimistic update serializable

Exclusive (Note 3)

wsPessimisticUpdate- pessimistic update read committed

NoCollision (Note 4)

wsPessimisticUpdate- pessimistic update Repeatable read

WeakestLockAtLoad (Note

5)

wsOptimisticRead optimistic read read committed

wsOptimisticUpdate (Note  optimistic update read committed

6)

Notes:

1. Read locks are held for the duration of the transaction.

2. The generated SELECT FOR UPDATE query grabs locks at the beginning of the transaction.

3. SELECT FOR UPDATE is generated; locks are held for the duration of the transaction.

4. A plain SELECT query is generated. No locks are held, but updates are permitted. Use cautiously. This intent
enables execution without concurrency control.

5. Where supported by the backend, the generated SELECT query does not include FOR UPDATE; locks are
escalated by the persistent store at storage time if updates were made. Otherwise, the same as
wsPessimisticUpdate.

6. Generated overqualified-update query forces failure if CMP column values have changed since the beginning of
the transaction.

Be sure to review the rules for forming overqualified-update query predicates. Certain column types (for example,
BLOB) are ineligible for inclusion in the overqualified-update query predicate and might affect your design.

Access intent best practices

This topic outlines issues to consider when applying access intent policies to Enterprise JavaBeans (EJB)
methods.
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» Start by configuring the default access intent policy for an entity. After your application is built and
running, you can more finely tune certain access paths in your application using application profiling or
method-level access intent.

* Don’t mix access types. Avoid using both pessimistic and optimistic policies in the same transaction.
For most databases, pessimistic and optimistic policies use different isolation levels. This can result in
multiple database connections, which prevents you from taking advantage of the performance benefits
possible through connection sharing.

» Take care when applying wsPessimisticUpdate-NoCollision. This policy does not ensure data
integrity. No database locks are held, so concurrent transactions can overwrite each other’s updates.
Use this policy only if you can be sure that only one transaction will attempt to update persistent store
at any given time.

Frequently asked questions: Access intent
| have not applied any access intent policies at all. My application runs just fine with a DB2
database, but it fails with an Oracle database with the following message:
com.ibm.ws.ejbpersistence.utilpm.PersistenceManagerException: PMGR10O1E: No such DataAccessSpec
:FindA11Customers. The backend datastore does not support the SQLStatement needed by this
AccessIntent: (pessimistic update-weakestLockAtLoad) (collections: transaction/25) (resource
manager prefetch: 0) (AccessIntentImp1@d23696a). Why?
If you have not configured access intent, all of your data is accessed under the default access
intent policy (wsPessimisticUpdate-WeakestLockAtLoad). On DB2 databases, the weakest lock is a
shared one, and the query runs without a USE AND KEEP UPDATE LOCKS clause. On Oracle
databases, however, the weakest lock is an update lock; this means that the SQL query must
contain a USE AND KEEP UPDATE LOCKS clause. However, not every SQL statement
necessarily supports USE AND KEEP UPDATE LOCKS; for example, if the query is being run
against multiple tables in a join, USE AND KEEP UPDATE LOCKS is not supported.

To avoid this problem, try either of the following:
» Modify your SQL query or reconfigure your application so that an update lock is supported
» Apply an access intent policy that supports optimistic concurrency

| am calling a finder method and | get an InconsistentAccessintentException at run time. Why?
This can occur when you use method-level access intent policies to apply more control over how a
bean instance is loaded. This execption indicates that the entity bean was previously loaded in the
same transaction. This could happen if you called a multifinder method that returned the bean
instance with access intent policy X applied; you are now trying to load the second bean again by
calling its findByPrimaryKey method with access intent Y applied. Both methods must have the
same access intent policy applied.

Likewise, if the entity was loaded once in the transaction using an access intent policy configured
on a finder, you might have called a container-managed relationship (CMR) accessor method that
returned the entity bean configured to load using that entity’s default access intent.

To avoid this problem, ensure that your code does not load the same bean instance twice within
the same transaction with different access intent policies applied. Avoid the use of method-level
access intent unless absolutely necessary.
| have two beans in a container-managed relationship. | call findByPrimaryKey() on the first bean
and then call getBean2( ), a CMR accessor method, on the returned instance. At that point, | get an
InconsistentAccessintentException. Why?
You are probably using read-ahead. When you loaded the first bean, you caused the second bean
to be loaded under the access intent policy applied to the finder method for the first bean.
However, you have configured your CMR accessor method from the first bean to the second with
a different access intent policy. CMR accessor methods are really finder methods in disguise; the
run-time environment behaves as if you were trying to change the access intent for an instance
you have already read from persistent store.

To avoid this problem, beans configured in a read-ahead hint are all driven to load with the same
access intent policy as the bean to which the read-ahead hint is applied.
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| have a bean with a one-to-many relationship to a second bean. The first bean has a
pessimistic-update intent policy applied. When | try to add an instance of the second bean to the
first bean’s collection, | get an UpdateCannotProceedWithintegrityException. Why?
The second bean probably has a read intent policy applied. When you add the second bean to the
first bean’s collection, you are not updating the first bean’s state, you are implicitly modifying the
second bean’s state. (The second bean contains a foreign key to the first bean, which is modified.)

To avoid this problem, ensure that both ends of the relationship have an update intent policy
applied if you expect to change the relationship at run time.

EJB modules

An EJB module is used to assemble one or more enterprise beans into a single deployable unit. An EJB
module is stored in a standard Java archive (JAR) file.

An EJB module contains the following:

» One or more deployable enterprise beans.

* A deployment descriptor, stored in an Extensible Markup Language (XML) file. This file declares the
contents of the module, defines the structure and external dependencies of the beans in the module,
and describes how the beans are to be used at run time.

You can deploy an EJB module as a stand alone application, or combine it with other EJB modules or with
Web modules to create a J2EE application. An EJB module is installed and run in an enterprise bean
container.

For more information about EJB modules, see "Resources for learning.”

Assembling EJB modules

Assemble an Enterprise JavaBeans (EJB) module to contain enterprise beans and related code artifacts.
Group Web components, client code, and resource adapter code in separate modules. After assembling
an EJB module, you can install it as a stand-alone application or combine it with other modules into an
enterprise application.

To increase performance, break container-managed persistence (CMP) enterprise beans into several
enterprise bean modules during assembly. The load time for hundreds of beans is improved by distributing
the beans across several JAR files and packaging them to an EAR file. Load time is faster when the
administrative server attempts to start the beans, for example, 8-10 minutes versus more than one hour
when one JAR file is used.

Use the |Assembly Toolkitf to assemble an EJB module in any of the following ways:

* Import an existing EJB module (EJB JAR file).

» Create a new EJB module.

Copy code artifacts (such as entity beans) from one EJB module into a new EJB module.

1. |Start the Assembly Toolkit,

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

3. Optional: Open the J2EE Hierarchy view. Click Window > Show View > J2EE Hierarchy. Other
helpful views include the Project Navigator view (Window > Show View > Other > J2EE > Project
Navigator) and the Navigator view (Window > Show View > Navigator).

4, 5% Optional: To use an application assembly service of WebSphere Business Integration (WBI)
Server Foundation, select the Integration Server target server. Available WBI assembly services
include |ActivitySession| [Application profiling, [Extended access)], [Extended messaging]
[Internationalization| [Last participant support, and |Pushdown|
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a. Click Project > Properties > J2EE.
b. For Target server, select Integration Server. For this release, Integration Server v5.1.
c. Click OK.

5. Migrate enterprise bean (JAR) files| created with the Application Assembly Tool (AAT) or a different tool
to the Assembly Toolkit. To migrate files, |import your enterprise bean files| to the Assembly Toolkit.

6. [Create a new EJB module}
7. Copy code artifacts (such as entity beans) from one EJB module into a new EJB module.
8. Verify the contents of the new EJB module in either of the following ways:

* In the J2EE Hierarchy view, expand EJB Modules and view the new module.

* Click Window > Show View > Navigator to see the associated files for the EJB module in a
Navigator view.

Container transactions

Container transaction properties specify how an EJB container is to manage transaction scopes for the
enterprise bean’s method invocations. A transaction attribute is mapped to one or more methods.

Method extensions
Method extensions are IBM extensions to the standard deployment descriptors for enterprise beans.

Method extension properties are used to define transaction isolation levels for methods, to control the
delegation of a principal’s credentials, and to define custom finder methods.

Method permissions

A method permission is a mapping between one or more security roles and one or more methods that a
member of the role can call.

References

References are logical names used to locate external resources for enterprise applications. References
are defined in the application’s deployment descriptor file. At deployment, the references are bound to the
physical location (global JNDI name) of the resource in the target operational environment.

This product supports the following types of references:
* An EJB reference is a logical name used to locate the home interface of an enterprise bean.
» A resource reference is a logical name used to locate a connection factory object.

These objects define connections to external resources such as databases and messaging systems. The
container makes references available in a JNDI haming subcontext. By convention, references are
organized as follows:

» EJB references are made available in the java:comp/env/ejb subcontext.

* Resource references are made available as follows:

JDBC DataSource references are declared in the java:comp/env/jdbc subcontext.

JMS connection factories are declared in the java:comp/env/jms subcontext.

JavaMail connection factories are declared in the java:comp/env/mail subcontext.

URL connection factories are declared in the java:comp/env/url subcontext.

EJB containers

An Enterprise JavaBeans (EJB) container provides a run-time environment for enterprise beans within the
application server. The container handles all aspects of an enterprise bean’s operation within the
application server and acts as an intermediary between the user-written business logic within the bean and
the rest of the application server environment.
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One or more EJB modules, each containing one or more enterprise beans, can be installed in a single
container.

The EJB container provides many services to the enterprise bean, including the following:

» Beginning, committing, and rolling back transactions as necessary.

* Maintaining pools of enterprise bean instances ready for incoming requests and moving these instances
between the inactive pools and an active state, ensuring that threading conditions within the bean are
satisfied.

* Most importantly, automatically synchronizing data in an entity bean’s instance variables with
corresponding data items stored in persistent storage.

By dynamically maintaining a set of active bean instances and synchronizing bean state with persistent
storage when beans are moved into and out of active state, the container makes it possible for an
application to manage many more bean instances than could otherwise simultaneously be held in the
application server's memory. In this respect, an EJB container provides services similar to virtual memory
within an operating system.

Between transactions, the state of an entity bean can be cached. The EJB container supports option A, B,

and C caching.

» With option A caching, the application server assumes that the entity bean is used within a single
container. Clients of that bean must direct their requests to the bean instance within that container. The
entity bean has exclusive access to the underlying database, which means that the bean cannot be
cloned or participate in workload management if option A caching is used.

* With option B caching, the entity bean remains active in the cache throughout the transaction but is
reloaded at the start of each method call.

» With option C caching (the default), the entity bean is always reloaded from the database at the
beginning of each transaction. A client can attempt to access the bean and start a new transaction on
any container that has been configured to host that bean. This is similar to the session clustering facility
described for HTTP sessions in that the entity bean’s state is maintained in a shared database that can
be accessed from any server when required.

This product supports the cloning of stateful session bean home objects among multiple application
servers. However, it does not support the cloning of a specific instance of a stateful session bean. Each
instance of a particular stateful session bean can exist in just one application server and can be accessed
only by directing requests to that particular application server. State information for a stateful session bean
cannot be maintained across multiple members of a server cluster.

For more information about EJB containers, see "Resources for learning.”

Container Managed Persistence over anything

Before the release of WebSphere Business Integration Server Foundation Version 5.1, Container Managed
Persistence (CMP) supported a number of relational backend systems. Users wanting to use the earlier
WebSphere Application Server Enterprise Editions to host stateful and live business models needed a way
to represent all the entities that existed in the business model, including non-relational backend systems.
Version 5.1 addresses this need.

The CMP infrastructure is designed to work with the J2EE Connector Architecture (JCA), through an
interface called EJBToRAAdapter. In addition to the current implementation of this interface (which
connects to relational backend systems), Version 5.1 provides a new implementation that connects to
procedural backend systems. The EJB Deployment tool can be used to return either of these
implementations. The new procedural implementation contains generic logic for adapting between JCA and
the WebSphere Application Server persistence manager. Note that all of the actual connection logic is
contained down in the FunctionSet of the bean.
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However, the CMP over anything (CMP/A) function is not limited to JCA connectors. There are other
approaches to backend data store connectivity that you can use. CMP over the web services, which
enable communication with backend systems indirectly through a web service using JAX-RPC, or WSIF
are available. You can also use a composed EJB model, where a CMP bean delegates its persistence
logic to another EJB.

So now you can develop a simple CMP bean that works with whatever backend system you need, rather
than having to go the cumbersome Bean Managed Persistence (BMP) bean development route, where all
of the connection logic must go directly in the bean implementation class.

Version 5.1 introduces support for pushdown methods, which can be thought of as container managed
business methods. In the CMP framework, you can use the class called
UserDefinedPushDownMethodsImpl, to place connectivity logic with a non-relational backend data store.
The Java source code for this class is generated by the WebSphere Application Server deployment tools
and contains methods corresponding to each CRUD method and each pushdown data-logic method
defined in the PME EJB deployment descriptor.

This means that methods can be defined on a CMP bean that, rather than being implemented by the
developer (in a BMP style of putting connection logic directly in the EJB’s method implementation), are
instead handled by the container and deployment tools. This is accomplished by defining the method as
abstract, and then marking new PME extended deployment descriptor settings for these
PushDownMethodElements. The new command-line code generation tool reads these extensions and
generates appropriate entries.

WebSphere Business Integration Server Foundation Version 5.1 also includes a generic
UserDefinedPushDownMethods interface (unrelated to the backend) and a
UserDefinedPushDownMethodsImpl class that implements the interface and that is specific to a given
backend. When a method has been marked userDefined, the FunctionSet is delegated to the
corresponding method of the UserDefinedPushDownMethodsimpl. The implementer of the
UserDefinedPushDownMethodsImpl does not need to worry about processing CCl Records - it can simply
do its work and let the FunctionSet code take care of that.

See [Example: Container Managed Persistence over anything -- CCl{and [Example: Container Managed|
[Persistence over anything -- EJB| for examples.

Version 5.1 provides tooling that you can invoke from the command line or from the Assembly Toolkit. The
tool generates the bean’s UserDefinedPushDownMethods interface, and generates skeleton Java source
code for the bean’s UserDefinedPushDownMethodsImpl class. You must fill this class in with the
appropriate logic, compile it, and package it into the appropriate EJB JAR file. See [Applying Container|
[Managed Persistence services over anything|for complete information.

The following links provide additional information concerning the procedural functions that use a CMP EJB.
For relational stored procedure information, refer to "Stored procedure support for CMP EJB” in the
Information Center.

Applying Container Managed Persistence services over anything

1. Develop your Container Managed Persistence (CMP) bean as usual. See [Developing enterprise beans|
for more information. Optionally, you can also define abstract methods that are treated as pushdown
methods.

2. Assemble the Enterprise JavaBean (EJB) Java Archive (JAR) file. In addition to standard packaging
steps, make sure to set the proper deployment descriptor settings.

Note: Ensure that you have |Enab|ed Server Target support for J2EE projects| and that you
as Integration Server v5.1. Without properly setting one of these target servers the
panels listed in the following steps night not appear. Furthermore, after enabling or changing the
target server you might need to close and re-open any currently open Deployment Descriptor

118 I1BM WebSphere Business Integration Server Foundation for z/OS V5.1:: Applications



a.
b.

Editors for these changes to be reflected in the given Deployment Descriptor Editor. Note that
Pushdown support is only available when the server target is Integration Server v5.1.

Use the [Assembly Toolkif to make your settings.

There is a PushDownContainerManagedEntityExtension method associated with your CMP bean,
and its procedural attribute is set to True. Set its backEndType attribute to one of the following:

CcCl Creates skeleton for the UserDefinedPushDownMethodsImpl java file with some
boiler-plate CCI code generated.

EJB Creates skeleton for the UserDefinedPushDownMethodslmpl java file with some
boiler-plate EJB code generated.

JAX-RPC
Creates skeleton for the UserDefinedPushDownMethodsImpl java file with some
boiler-plate JAX-RPC code generated.

WSIF Creates skeleton for the UserDefinedPushDownMethodsimpl java file with some
boiler-plate WSIF code generated.

Custom
Creates empty skeleton for the UserDefinedPushDownMethodsimpl java file.

Set additional attributes required for each backEndType. You are prompted for attributes according
to which backEndType you specified.

CCl Set your bean’s connectionSpecClassName attribute to the appropriate fully-qualified J2EE
Connector Architecture (JCA) ConnectionSpec class name. For example, the class name
for use with CICS ECI is com.ibm.connector2.cics.ECIConnectionSpec.

Set the interactionSpecClassName attribute to the appropriate fully-qualified J2EE
Connector Architecture (JCA) InteractionSpec class name. For example, the class name for
use with CICS ECI is com.ibm.connector2.cics.EClInteractionSpec.

EJB Set the gjbRefName value that specifies the java:comp name for a reference to another
EJB. For example, ejb/AccountBackend.

JAX-RPC
Set the wsdlServiceFileName attribute to the fully-qualified path (inside a JAR file) to a
WSDL file that defines the web service being used.

WSIF Set the wsdlServiceFileName attribute to the fully-qualified path (inside a JAR file) to a
WSDL file that defines the web service being used.

Custom
No special attributes.

All backend types
All backend types have an ejbToRAAdapterClassName entry, which enables you to specify
a fully-qualified class name of a custom EJBToRAAdapter implementation.

If you defined any abstract methods for pushdown, define a PushDownMethodElement for each of
them, and set the backEndMethodName attribute to the name of the corresponding method.

3. Deploy the EJB JAR.

a.

Run the code generation tool CMPDeploy against the assembled EJB JAR file. You can do this
from within the IDE or from the command line. The command syntax is:

CMPDeploy <ejb.jar | application.ear> <-dir directory> <-overwrite> <-verbose>

ejb.jar | application.ear
The name of the JAR or EAR file you want to deploy.

-dir Optional. The name of the directory into which you want the output files placed.

If you do not specify -dir the tool outputs its files into a package-based directory structure
rooted at the current directory.
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-overwrite
Optional. Causes any existing UserDefinedPushDownMethodsimpl class to be overwritten
by the one you are creating.

If you do not specify -overwrite the tool will abort the process with a warning message if
the UserDefinedPushDownMethodsImpl class already exists.

-verbose
Optional. Causes tracing messages to display during processing.

If you do not specify the -verbose option the tool does not display tracing messages, but
only displays a message at the end of the process specifying either what was emitted or
else what problems were encountered.

This command accepts either an EAR or JAR file, and generates the
UserDefinedPushDownMethods interface, and skeleton Java source code for the bean’s
UserDefinedPushDownMethodsimpl class. For example, if the EJB JAR contains a procedural
CMP bean called Account, then CMPDeploy Account.jar emits a generic
AccountUserDefinedPushDownMethods interface, and a backend specific
AccountUserDefinedPushDownMethodsImpl.java class that implements the interface.

4. Edit the emitted implementation class. Enter the appropriate connectivity logic for your specified
backend data store.

5. Compile the emitted files.
6. Zip/jar the compiled files into the EJB JAR file.

7. Run the EJB deployment tool against the EJB JAR file. For more information, see documentation on
the EJB deployment tool.

8. Package the deployed EJB JAR file into an EAR file.

9. Install the application containing this EJB EAR file. During installation, when asked for the resource
binding for the CMP bean, specify the JNDI name of a J2C ConnectionFactory (instead of the usual
case of specifying the JNDI name of a JDBC Data Source). For a CCl based CMP/A bean, this is a
J2C ConnectionFactory scoped underneath a JCA 1.0 compliant resource adapter (a .rar file, such as
for CICS or IMS). Note that your CMP/A bean is only transactional if you are using a transactional
resource adapter. In the case of a resource adapter that only supports single-phase commit (non-XA)
transactions, if you need your transactions to also include one or more beans capable of two-phase
commit (XA) transactions, then you should [assemble your application to enable Last Participant]

Bupport
For a non-CCIl based CMP/A bean (one that does NOT use JCA connectors, such as one with a
backEndType of EJB, JAX-RPC, WSIF, or Custom), you must install the WebSphere Procedural
Resource Adapter provided with WebSphere Business Integration Server Foundation Version 5.1, and
specify a binding to it. To do this, you need to install the
WebSphere/AppServer/installableApps/cmpaAdapter.rar file.

Open the administrative console

Choose Resources > Resource Adapters > Install RAR.

Install WebSphere/AppServer/installableApps/cmpaAdapter.rar.

Create a J2C Connection Factory underneath it. Specify a JNDI name for the factory. During the
application installation, you must specify the same JNDI name as your CMP/A bean’s datasource.

oo o p

Note: Such beans are inherently non-transactional, and should be marked with a transaction policy
of NotSupported, unless your UserDefinedPushDownMethodsImpl code (or code called from
it) registers with JTA. For non-transactional CMP/A beans, you must use Compensation to
enable transaction rollback functionality.
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Example: Container Managed Persistence over anything -- CCI
Usage Scenario

For a CMP bean whose fully-qualified name is com.ibm.test.BeCashAcctBean (whose bean

implementation class is named BeCashAcctBean), the BeCashAcctBeanUserDefinedPushDownMethods

interface would be in the com.ibm.test.websphere_deploy package, and the
BeCashAccttBeanUserDefinedPushDownMethodsImpl for a backEndType of CCI would be in the
com.ibm.test.websphere_deploy.cci package.

Example

~
*
*

User-defined push-down method ejbCreate.

@param bean Reference to the bean implementation class

@param connection The CCI connection to the back-end system. This
connection was previously obtained (by the EJBToRAAdapter implementation)
via connectionFactory.getConnection(connectionSpec). For non-CCI based
beans, this will be null and the user will have to manually connect to
the back-end system.

@exception javax.ejb.CreateException Thrown if an exception occurs creating bean data
@exception ResourceException Any other exceptions are wrapped in a
ResourceException.

£ %k X X X ok 3k X X X X F

*
/
public void ejbhCreate(BeCashAcctBean bean, Object connection)
throws javax.ejb.CreateException, ResourceException {
if (tc.isEntryEnabled())
Tr.entry(

tc,

"ejbCreate(BeCashAcctBean, Object)",

new Object[] { bean, connection });

try {

com.ibm.connector2.cics.ECIInteractionSpec iSpec =
new com.ibm.connector2.cics.ECIInteractionSpec();
iSpec.setFunctionName ("BECASHAC") ;

// Specify any additional iSpec settings here
iSpec.setCommarealength(1242);

iSpec.setReplylLength(1242);

iSpec.setInteractionVerb(
com.ibm.connector2.cics.ECIInteractionSpec.SYNC_SEND_RECEIVE);

WSStreamableRecord input = helper.createCCIStreamableRecord();

String inputBufferString = createlInputBuffer("01", bean);
input.setValue(inputBufferString);

WSStreamableRecord output =
(WSStreamableRecord) helper.executeCCIInteraction(
connection,
iSpec,
input);

String errorCode =
prossessOutputBuffer("01", bean, output.toString());
if (lerrorCode.equals("00000000")) {
if (errorCode.equals("00000014")) {
if (tc.isDebugEnabled()) {
Tr.debug(tc, "Record already exists");

javax.ejb.DuplicateKeyException d =
new javax.ejb.DuplicateKeyException();
throw d;

} else {

if (tc.isDebugEnabled()) {
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Tr.debug(

tc,

"Unknown error with return code " + errorCode);
}

javax.ejb.CreateException c =
new javax.ejb.CreateException(
"Unknown error with return " + "code " + errorCode);
throw c;

}

}
if (tc.isDebugEnabled()) {
Tr.debug(tc, "Record created");

} catch (Exception e) {
ResourceException re =
helper.createResourceException(e, this.getClass());

if (tc.isEntryEnabled())
Tr.exit(tc, "ejbCreate(BeCashAcctBean, Object)", re);

throw re;

}

//Note that if the return code from the back-end datastore interaction
//indicated that a user-defined exception (declared in the push-down
//method's signature) should be thrown, then throw it here.

if (tc.isEntryEnabled())
Tr.exit(tc, "ejbCreate(BeCashAcctBean, Object)");

}

[**
* This method will use the bean information to create an
* input buffer string for WSStreamableRecord input that
* maps to the COBOL commarea.
*
* Commarea:

*

This program uses a commarea to pass information to the backend
program. The format and size of the commarea is as follows:

Request type (2) - the method to invoke. Must have a leading
zero

Return Codel (8) - CICS DFHRESP value or a string with the
word ERROR or ABEND

Return Code2 (8) - CICS DFHRESP2 value or a string with the
error type or abend code.

Trace flag (1) - If set to something other than space or hex
zero, trace information will be written to a
CICS TransientData queue.

Total Records (4) - Number of records found on a browse.

ResType (2) - The resType for the CashAccount record
AccountId (8) - The accountid for the CashAccount record
Balance (8) - The balance for the CashAccount record
Type (1) - The type for the CashAccount record

Utilities (1200) - The utility info for the CashAccount record

@param request type of method to invoke
@param bean Reference to the bean implementation class

LR I R R S R T R R R R R

@return string that contains the mapped commarea.

*/

public String createInputBuffer(String requestType, BeCashAcctBean bean) {
if (tc.isEntryEnabled())

122 1BM WebSphere Business Integration Server Foundation for z/OS V5.1:: Applications



/

S
s
/
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/

S
i
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s

S
s

Tr.entry(
tc,
"createInputBuffer(requestType, bean)",
new Object[] { requestType, bean });
*
* Initialize buffer
*/
tringBuffer sb = new StringBuffer(1242);
b.append(requestType);
/ request type (Ol=create, 02=find, 03=update, 04=delete)
b.append("00000000"); // return code 1
b.append("00000000"); // return code 2
b.append(" "); // trace
b.append("0001"); // total records
b.append("99"); // resType
b.append("88888888"); // accountld
b.append("00000000"); // balance
b.append("1"); // type
b.append("A"); // utilities

*

* Update values from bean

*/

tring resType = bean.getResType();

nt start = 25 - resType.length();

nt end = 25;

b.replace(start, end, resType); // resType

tring accoutId = bean.getAccountId();
tart = 33 - accoutlId.length();

end = 33;

S

.i

}

.i

.i

r

}
/*

*
*
*
*
*

b.replace(start, end, accoutId); // accountld

/*

* Update values for ejbStore

*

/

f (requestType.equals("03")) {
String balance = String.valueOf(bean.getBalance());
start = 41 - balance.length();
end = 41;
sb.replace(start, end, balance);
String rType = bean.getUType();
start = 41;
end = 42;
sb.replace(start, end, rType);
String utility = bean.getUtility();
start = 42;
end = 42 + utility.length();
sb.replace(start, end, utility);

f (tc.isDebugEnabled()) {
Tr.debug (
tc,
"The created string buffer for execute is " + sh.toString());

f (tc.isEntryEnabled())
Tr.exit(tc, "createlnputBuffer(requestType, bean)");
eturn sb.toString();

*

This method will use the bean information to parse the
output buffer string that maps to information returned
from the helper.executeCCIInteraction plus the

COBOL commarea.
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*

Commarea:

*

*

* This program uses a commarea to pass information to the backend
* program. The format and size of the commarea is as follows:

*

% Request type (2) - the method to invoke. Must have a leading

* Zero

% Return Codel (8) - CICS DFHRESP value or a string with the

* word ERROR or ABEND

% Return Code2 (8) - CICS DFHRESP2 value or a string with the

* error type or abend code.

* Trace flag (1) - If set to something other than space or hex
* zero, trace information will be written to a
* CICS TransientData queue.

% Total Records (4) - Number of records found on a browse.

*  ResType (2) - The resType for the CashAccount record

* AccountId (8) - The accountid for the CashAccount record

%= Balance (8) - The balance for the CashAccount record

*  Type (1) - The type for the CashAccount record

*

Utilities (1200) - The utility info for the CashAccount record
*

@param request type of method to invoke

@param bean Reference to the bean implementation class

@param output buffer that contains the commarea

* ok Sk X X

@return first error code.
*
/
public String prossessOutputBuffer(
String requestType,
BeCashAcctBean bean,
String outputBuffer) {
if (tc.isEntryEnabled())
Tr.entry(
tc,
"prossessOutputBuffer(requestType, bean, outputBuffer)",
new Object[] { requestType, bean, outputBuffer });

String returnCodel = outputBuffer.substring(25, 33);
String returnCode2 = outputBuffer.substring(33, 41);
if (requestType.equals("03") && returnCodel.equals("00000000")) {
String balance = outputBuffer.substring(56, 64);
bean.setBalance(Integer.parselnt(balance));

String utype = outputBuffer.substring(64, 65);
bean.setUType(utype);

String utility = outputBuffer.substring(65, outputBuffer.length());
bean.setUtility(utility);

if (tc.isDebugEnabled()) {

Tr.debug(tc, "Balance is " + balance);

Tr.debug(tc, "utype is " + utype);

Tr.debug(tc, "utility is " + utility);

}
}
if (tc.isEntryEnabled())

Tr.exit(

tc,

"prossessOutputBuffer(requestType, bean, outputBuffer)");

return returnCodel;

}

Example: Container Managed Persistence over anything -- EJB
Usage Scenario

For a CMP bean whose fully-qualified name is com.ibm.test.Account (whose bean implementation class is
named AccountBean), the AccountBeanUserDefinedPushDownMethods interface would be in the
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com.ibm.test.websphere_deploy package, and the AccountBeanUserDefinedPushDownMethodsimpl for a
backEndType of EJB would be in the com.ibm.test.websphere_deploy.ejb package.

Example

public float computeAverageDailyBalance(Date argl, Date arg2, AccountBean bean,
Object connection) throws AccountAccessException, ResourceException
{
AccountBackendLocalHome home = helper.getEJBHome("ejb/AccountBackend",
AccountBackendLocalHome.class);
//throws ResourceException on error

AccountBackend bean = null;
float returnValue = 0.0;
int id = bean.getId();
try {
bean = home.create();
returnValue = bean.computeAverageDailyBalance(id, argl, arg2);
} catch (Exception e) {
throw helper.createResourcekException(e, this.getClass());

}
if (returnValue == -1) throw new AccountAccessException();

return returnValue;

Managing EJB containers

Each application server can have a single EJB container; one is created automatically for you when the
application server is created. The following steps are to be performed only as needed to improve
performance after the EJB application has been deployed.

1. Adjust EJB container settings.
2. Adjust EJB cache settings.

If adjustments do not improve performance, consider adjusting access intent policies for entity beans,
reassembling the module, and redeploying the module in the application.

EJB container settings
Use this page to configure and manage a specific EJB container.

To view this administrative console page, click Servers > Application Servers > serverName > EJB
Container.

Passivation directory
Specifies the directory into which the container saves the persistent state of passivated stateful session
beans.

Beans are passivated when the number of active bean instances becomes greater than the cache size
specified in the container configuration. When a stateful bean is passivated, the container serializes the
bean instance to a file in the passivation directory and discards the instance from the bean cache. If, at a
later time, a request arrives for the passivated bean instance, the container retrieves it from the
passivation directory, deserializes it, returns it to the cache, and dispatches the request to it. If any step
fails (for example, if the bean instance is no longer in the passivation directory), the method invocation
fails.

For a cluster of servers that span multiple systems in a sysplex and have stateful session beans with an
activation policy of Transaction deployed in them, the passivation directory must reside on a hierarchical
file system (HFS) that is shared across the multiple systems.
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Inactive pool cleanup interval
Specifies the interval at which the container examines the pools of available bean instances to determine if
some instances can be deleted to reduce memory usage.

Data type Integer
Units Milliseconds
Range 0to2 147 483 674

Default datasource JNDI name
Specifies the JNDI name of a data source to use if no data source is specified during application
deployment. This setting is not applicable for EJB 2.x-compliant CMP beans.

Servlets and enterprise beans use data sources to obtain these connections. When configuring a
container, you can specify a default data source for the container. This data source becomes the default
data source used by any entity beans installed in the container that use container-managed persistence
(CMP).

The default data source for a container is secure. When specifying it, you must provide a user ID and
password for accessing the data source.

Specifying a default data source is optional if each CMP entity bean in the container has a data source
specified in its configuration. If a default data source is not specified and a CMP entity bean is installed in
the container without specifying a data source for that bean, applications cannot use that CMP entity bean.

Initial state

Specifies the execution state requested when the server first starts.

Data type String

Default Started

Range Valid values are Started and Stopped

EJB container system properties

In addition to the settings accessible from the administrative console, you can set the following system

property by command-line scripting:

com.ibm.websphere.ejbcontainer.poolSize
Specifies the size of the pool for the specified bean type. This property applies to stateless,
message-driven and entity beans. If you do not specify a default value, the container defaults of
50 and 500 are used.

Set the pool size for a given entity bean as follows:

beantype=min,max[:beantype=min,max...]

beantype is the J2EE name of the bean, formed by concatenating the application name, the #
character, the module name, the # character, and the name of the bean (that is, the string
assigned to the <ejb-name> field in the bean’s deployment descriptor). min and max are the
minimum and maximum pool sizes, respectively, for that bean type. Do not specify the square
brackets shown in the previous prototype; they denote optional additional bean types that you can
specify after the first. Each bean-type specification is delimited by a colon (:).

Use an asterisk (*) as the value of beantype to indicate that all bean types are to use those values
unless overridden by an exact bean-type specification somewhere else in the string, as follows:

*=30,100
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To specify that a default value be used, omit either min or max but retain the comma (,) between
the two values, as follows (split for publication):

SMApp#PerfModule#TunerBean=54,
:SMApp#SMModule#TypeBean=100,200

You can specify the bean types in any order within the string.

EJB cache settings

Use this page to configure and manage the cache for a specific EJB container. To determine the cache
absolute limit, multiply the number of enterprise beans active in any given transaction by the total number
of concurrent transactions expected. Then, add the number of active session bean instances. You can use
the Tivoli Performance Viewer to view bean performance information.

To view this administrative console page, click Servers > Application Servers > serverName > EJB
Container > EJB Cache Settings.

Cleanup interval
Specifies the interval at which the container attempts to remove unused items from the cache in order to
reduce the total number of items to the value of the cache size.

The cache manager tries to maintain some unallocated entries that can be allocated quickly as needed. A
background thread attempts to free some entries while maintaining some unallocated entries. If the thread
runs while the application server is idle, when the application server needs to allocate new cache entries, it
does not pay the performance cost of removing entries from the cache. In general, increase this parameter
as the cache size increases.

Data type Integer

Units Milliseconds
Range 0to2 147 483 674
Default 3000

Cache size

Specifies the number of buckets in the active instance list within the EJB container.

A bucket can contain more than one active enterprise bean instance, but performance is maximized if
each bucket in the table has a minimum number of instances assigned to it. When the number of active
instances within the container exceeds the number of buckets, that is, the cache size, the container
periodically attempts to reduce the number of active instances in the table by passivating some of the
active instances. For the best balance of performance and memory, set this value to the maximum number
of active instances expected during a typical workload.

Data type Integer

Units Buckets in the hash table

Range Greater than 0. The container selects the next largest
prime number equal to or greater than the specified value.

Default 2053

Container interoperability

Container interoperability describes the ability of WebSphere Application Server clients and servers at
different versions to successfully negotiate differences in native Enterprise JavaBeans (EJB) Version 1.1
finder methods support and Java 2 Platform, Enterprise Edition (J2EE) Version 1.3 compliance.
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At one time, there were significant interoperability problems among WebSphere Application Server,
versions 4.0.x and 3.5.x distributed, and Version 4.0.x for zSeries. The introduction of interoperable
versions of some class types solved these problems for distributed versions 3.5.6, 4.0.3, and 5 as well as
for zSeries Version 4.0.x.

Older 4.0.x and 3.5.x client and application server versions do not support the interoperability classes,
which makes them uninteroperable with versions that use the classes. The system property
com.ibm.websphere.container.portable remedies this situation by enabling newer versions of the
application server to turn off the interoperability classes. This lets a more recent application server return
class types that are interoperable with an older client.

Depending on the value of com.ibm.websphere.container.portable, application servers at versions 5 and
later, 4.0.3 and later, and 3.5.6 and later, return different classes for the following:
» Enumerations and collections returned by EJB 1.1 finder methods
* EJBMetaData
* Handles to:
— Entity beans
— Session beans
— Home interfaces

If the property is set to false, application servers return the old class types, to enable interoperability with
versions 3.5.5 and earlier, and 4.0.2 and earlier. If the property is set to true, application servers return the
new classes.

Instructions for setting the com.ibm.websphere.container.portable property are in the release notes for
versions 3.5.6 and later, and 4.0.3 and later. The following tables show interoperability characteristics for
various version combinations of application servers and clients as well as default property values for each
combination.

Interoperability of Version 3.5.x client with Version 5 (and later) application server

Clients at Version 3.5.5 and earlier are not interoperable with Version 5 and later servers when using:
* EJBMetaData

* Enumerations returned by EJB 1.x finder methods

* Handles to entity beans

If you would like to use updated Handle classes in EJB 2.x-compliant beans but have one of the older
clients (versions 3.5.5 and earlier) installed, set the system property
com.ibm.websphere.container.portable.finder to false. With this setting in place, the Version 5
application server uses the updated handles but returns the enumerations and collections that were
used in the earlier clients.

To interoperate with Version 5 application servers, you must upgrade all Version 3.5.x clients to Version
3.5.6 or later.

Interoperability of Version 5 (and later) client with Version 3.5.x application server

Client at Version 5 and

later, using this function

Application server at
Version 3.5.6, property
true

Application server at
Version 3.5.6, property
false (default)

Application server at
Version 3.5.5 and earlier

EJBMetaData Does not work across Works Does not work
domains
Handle to session bean Works Works Does not work

Handle to entity bean

Does not work across
domains

Does not work across
domains

Does not work across
domains
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Client at Version 5 and
later, using this function

Application server at
Version 3.5.6, property
true

Application server at
Version 3.5.6, property
false (default)

Application server at
Version 3.5.5 and earlier

Enumeration returned by

Works

Works

Works

EJB 1.x finder method

Interoperability of Version 4.0.x client with Version 5 (and later) application server
Ideally, all 4.0.x clients that use Version 5 application servers should be at Version 4.0.3 or later.

Version 5 and later application servers return the interoperability class types by default (true). This can
cause interoperability problems for distributed clients at versions 4.0.1 or 4.0.2. In particular, problems can
occur with collections and enumerations returned by EJB 1.1 finder methods.

Although it is strongly discouraged, you can set com.ibm.websphere.container.portable to false on a

Version 5 and later application server. This causes the application server to return the old class types,

providing interoperability with clients at Version 4.0.2 and earlier. This is discouraged because:

* The Version 5 application server instance would become non-J2EE 1.3 compliant with regard to
handles, home interface handles, and EJBMetaData.

« EJB 1.x finder methods return collection and enumeration objects that do not originate from
ejbportable.jar.

* Interoperability restrictions still exist with the property set to false.

» Version 5 and later client handles to entity beans and home interfaces do not work across domains for
the server you set to false.

If you would like to use updated Handle classes in EJB 2.x-compliant beans but have one of the older
clients (versions 4.0.2 and earlier) installed, set the system property
com.ibm.websphere.container.portable.finder to false. With this setting in place, the Version 5 and later
application server uses the updated handles but returns the enumerations and collections that were
used in the earlier clients.

Interoperability of client at Version 4.0.2 and earlier with Version 5 (and later) application server

Client at Version 4.0.2 and earlier,
using this function

Application server at Version 5 and | Application server at Version 5 and
later, property true (default) later, property false

EJBMetaData Does not work Works for 4.0.2 client
Handle to session bean Does not work Works

Handle to entity bean Does not work Does not work across cells
Enumeration returned by EJB 1.x Does not work Works

finder method

Collection returned by EJB 1.x finder |Does not work Works

method

Handle to home interface Does not work Does not work across cells

If you would like to use updated Handle classes in EJB 2.x-compliant beans but have one of the older
clients (versions 3.5.5 and earlier, and 4.0.2 and earlier) installed, set the system property
com.ibm.websphere.container.portable.finder to false. With this setting in place, the Version 5 and later
server uses the new Handle classes but returns the older enumeration and collection classes.

Interoperability of client at Version 4.0.3 and later with Version 5 and later application server

Clients at Version 4.0.3 and later work well with Version 5 and later application servers. However, if you
set the com.ibm.websphere.container.portable to false, client handles to entity beans and home interfaces
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do not work across domains for the server you set to false.

Client at Version 4.0.3 and later, Application server at Version 5 and | Application server at Version 5 and
using this function later, property true (default) later, property false

EJBMetaData Works Works

Handle to session bean Works Works

Handle to entity bean Works Does not work across cells
Enumeration returned by EJB 1.x Works Works

finder method

Collection returned by EJB 1.x finder | Works Works

method

Handle to home interface Works Does not work across cells

Interoperability of Version 5 and later client with Version 4.0.x application server

Clients at Version 5 and later work well with Version 4.0.3 application servers if you set
com.ibm.websphere.container.portable to true. Client handles to entity beans and home interfaces do not
work across domains for any Version 4.0.3 server with com.ibm.websphere.container.portable at the
default value, false. Version 5 client handles to application servers at Version 4.0.2 and earlier also have
restrictions.

Client at Version 5 and Application server at Application server at Application server at
later, using this function | Version 4.0.3, property Version 4.0.3, property Version 4.0.2 or earlier
true false (default)

EJBMetaData Works Works Works for 4.0.2 server only

Handle to session bean Works Works Works

Handle to entity bean Works Does not work across Does not work across
domains domains

Enumeration returned by Works Works Works

EJB 1.x finder method

Collection returned by EJB | Works Works Works

1.x finder method

Handle to home interface Works Does not work across Does not work across
domains domains

Interoperability of zSeries Version 4.0.x client with Version 5 and later application server

The only valid configuration for container interoperability with zSeries Version 4.0.x clients is the default
configuration for the Version 5 application server.

Interoperability of Version 5 and later client with zSeries Version 4.0.x application server
Version 5 clients should work with a zSeries Version 4.0.x application server with the correct

interoperability fixes described in the zSeries documentation. The interoperability characteristics should be
the same as for a Version 4.0.3 distributed application server with the property set to true.

Client at Version 5 and later, using this function zSeries application server at Version 4.0.x
EJBMetaData Works
Handle to session bean Works
Handle to entity bean Works
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Client at Version 5 and later, using this function zSeries application server at Version 4.0.x
Enumeration returned by EJB 1.x finder method Works
Collection returned by EJB 1.x finder method Works
Handle to home interface Works

Interoperability of the handle formats in WebSphere Application Server, Version 5 and Version 5.0.1

Applications that attempt to persist handles to enterprise beans and EJBHome needed to subclass
ObjectinputStream in WebSphere Application Server, Version 5. This action was required so that the
subclass ObjectinputStream could utilize the context class loader to resolve the classes for enterprise
beans and EJBHome stubs.

In addition, handles created and persisted in WebSphere Application Server, Version 5 only work with
objects that have an unchanged remote interface. If the remote interface is changed, the handle is no
longer valid because the stub is serialized inside the handle and its serial Version UID changes if the
remote interface changes.

This release introduces a new handle persistence mechanism that avoids the implementation drawbacks

of the previous version. However, if handles are used for this WebSphere Application Server deployment,
you should consider the following issues when applying this update, future WebSphere Application Server
Fix Packs and EJB Container cumulative fixes for WebSphere Application Server, Version 5.

If a WebSphere Application Server, Version 5 persisted handle or home handle is encountered by a
WebSphere Application Server, Version 5.0.1 system, it can be read and utilized. In addition, it will be
converted to WebSphere Application Server, Version 5.0.1 format if it is re-persisted. The WebSphere
Application Server, Version 5.0.1 format cannot be read by a WebSphere Application Server, Version 5
system unless PQ72184 is applied.

Problems arise when handles are persisted and shared across systems that are not at the WebSphere
Application Server, Version 5.0.1 level or later. However, a Version 5 system can receive a handle from
Version 5.0.1 remotely through a call to get a handle on an enterprise bean or a getHomeHandle on an
EJBHome. The remote call will succeed, however, any attempt to persist it on the Version 5 system will
have the same limitations regarding the use of ObjectinputStream and changes in remote interface
invalidating the persisted handle.

When your application stores handles persistently and shares this persistence with multiple clients or
application servers, apply WebSphere Application Server, Version 5.0.1 or PQ72184 to both the client and
server systems at the same time. Failure to do so can result in the inability of these systems to read the
handle data stored by upgraded systems. Also, handles stored by the WebSphere Application Server,
Version 5 can force the applications of the updated system to still subclass ObjectInputStream.
Applications using the WebSphere Application Server Enterprise, Version 5 scheduler and process
choreographer, are affected by these changes. These users should update their Version 5 systems at the
same time with either Version 5.0.1 or PQ72184.

If the applications store handles in the session context, or locally in a file on the same system, that is not
shared by other applications, on different systems, they might be able to update their systems individually,
rather than all at once. If Client Container and thin client applications do not share persisted handle data,
they can be updated as needed as well. However, handles created and persisted in WebSphere
Application Server, Version 5, Version 4.0.3 and later (with the property flag set), or Version 3.5.7 and later
(with the property flag set) are not usable if either the home or the remote interface changes.

If any WebSphere Application Server, Version 3.5.7 or Version 4.0.3 and later enables the system property
com.ibm.websphere.container.portable to true, any handles to objects on that server have the same
interoperability limitations. In addition, if any WebSphere Application Server, Version 3.5.7 and later or

Chapter 4. Using enterprise beans in applications 131



Version 4.0.3 applications store a handle obtained from a WebSphere Application Server, Version 5 or
Version 5.0.1, the same restrictions apply, regarding the need to subclass ObjectinputStream and the
usability of handles after a change to the remote interface is made.

Replication of the Http Session and Handles

This note applies to you if you place Handles to Homes or EJBs, or EJB or EJBHome references in the
Http Session in your application and you use Http Session Replication. If you intend to replicate a mixed
environment of Version 5.0.0 and Version 5.0.1 or 5.0.2 machines you should first apply the latest Version
5.0.0 container cumulative e-fix to the Version 5.0.0 machines before allowing the Version 5.0.1 or 5.0.2
server into the typology. The reason for this is that Version 5.0.0 servers are not able to understand the
persisted Handle format used on the Version 5.0.1 and 5.0.2 server. This is similar to the case of Version
5.0.0 and Version 5.0.1 or 5.0.2 systems trying to use a shared database, mentioned above. But in this
case, it is the Http Session object and not the database providing the persistence.

Top Down Deployment Mapping

The size of the Handle objects has grown due to the fix put in to allow serialization and deserialization to
occur without the previous requirements of subclassing the ObjectlinputStream and so on. Top down
deployment of an object that contains EJB and EJBHome references create a database table ddl that has
a field of 1000 bytes of VARCHAR for BITDATA which will contain the Handle. It might be that your
object’s Handle does not fit in the 1000 byte default field, and you might need to adjust this to a higher
value. You might try increments of 250 bytes, that is, 1250, 1500, and so on.

Deploying EJB modules

Assemble one or more EJB modules, [assemble one or more Web modules| and[assemble them into al
J2EE application|

1. Prepare the deployment environment.
2. |Deploy the application)
3. 1%

[Update the configuration for each EJB module|as needed for the deployment environment.
4. For information about the EJB deployment tool, see information on the EJB deployment tool.

The next step is to test and debug the module.

EJB module collection
Use this page to manage the EJB modules deployed in a specific application.

To view this administrative console page, click Applications > Enterprise Applications >
applicationName > EJB modules. Click the check boxes to select one or more of the EJB modules in
your collection.

URI

When resolved relative to the application URL, this specifies the location of the module’s archive contents
on a file system. The URI matches the <ejb> or <web> tag in the <module> tag of the application
deployment descriptor.

EJB module settings

Use this page to configure and manage a specific deployed EJB module.

Note: You cannot start or stop an individual EJB module for modification. You must start or stop the
appropriate application entirely.
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To view this administrative console page, click Applications > Enterprise Applications >
applicationName > EJB modules > moduleName.

URI

When resolved relative to the application URL, this specifies the location of the module archive contents
on a file system. The URI must match the URI of a ModuleRef URI in the deployment descriptor of the
deployed application (EAR).

Alternate DD
Specifies a deployment descriptor to be used at run time instead of the one installed in the module.

Starting weight
Specifies the order in which modules are started when the server starts. The module with the lowest
starting weight is started first.

Data type Integer
Default 5000
Range Greater than 0

Troubleshooting tips for EJIBDEPLOY relationships

Problems may exist when EJBDeploy creates a data relationship in DB2 for z/OS Version 7.x. EJBDeploy
creates a table with a composite of the two primary keys of the EJBs that are related to each other. If the
composite keys are larger than 254 characters, DB2 for z/OS V7.x will not accept this relationship and the
user will be conforonted with errors such as:

DSNT408I SQLCODE = -613, ERROR: THE PRIMARY KEY OR A UNIQUE CONSTRAINT

IS TOO LONG OR HAS TOO MANY COLUMNS
DSNT418I SQLSTATE = 54008 SQLSTATE RETURN CODE

This problem can be seen when the primary keys that are created for the two related beans have primary
keys that are strings. This results in the composite being made up of 2 varchar(250) primary keys for a
total of 500, which is greater than 254 maximum in DB2 for z/OS version 7.x.

Things to consider when utilizing top-down mappings to ensure you do not experience this problem:

» Top-down mappings are a guideline and must be reviewed with the DBA.

» Schemas created 'top-down’ by EJBDeploy are designed only for testing, and as a guideline for the
actual schema required. The use of the 'meet-in-the-middle’ mapping does not present this problem.

* The composite key constraint problem is not experienced when using DB2 V8, which has 2K max key
lengths.

EJBDEPLOY_JVM_OPTIONS
Set the EJBDEPLOY_JVM _OPTIONS property to override Java virtual machine (JVM) options that are passed to
the code that deploys EJBs (ejbdeploy.sh). Set this property in one of the following locations:

deploymentmanager/bin/setupCmdLine.sh or appServerHome/bin/setupCmdLine.sh

For example, the following command increases the heap size of the JVM for ejbdeploy.sh:
export EJBDEPLOY_JVM_OPTIONS="-Xms128m -Xmx512m"

Enterprise beans: Resources for learning

Use the following links to find relevant supplemental information about enterprise beans. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.
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These links are provided for convenience. Often, the information is not specific to this product but is useful
all or in part for understanding the product. When possible, links are provided to technical papers and
Redbooks that supplement the broad coverage of the release documentation with in-depth examinations of
particular product areas.

View links to additional information about:

¢ |Planning, business scenarios, and IT architecture|
 |Programming model and decisions|

¢ |Programming instructions and examples|

« [Programming specifications|

Planning, business scenarios, and IT architecture
« [Mastering Enterprise JavaBeans|

A comprehensive treatment of Enterprise JavaBeans (EJB) programming in nonprintable form (PDF).
One must be registered to download the PDF, but registration is free. Information about purchasing a
hardcopy is available on the Web site.

» Enterprise JavaBeans by Richard Monson-Haefel (O’Reilly and Associates, Inc.: Third Edition, 2001)

Programming model and decisions
|ﬁgead all about EJB 2.0|

A comprehensive overview of the specification.
+ [The J2EE Tutoriall

This set of articles by Sun Microsystems covers several EJB-related topics, including the basic
programming models, persistence, and EJB Query Language.

Programming instructions and examples
|ﬁgules and Patterns for Session Facades|
EJB programming practice: Fronting entity beans with a session-bean facade.
+ [WebSphere Application Server Development Best Practices for Performance and Scalability

Programming practice for enterprise beans and other types of J2EE components.
+ [Optimistic Locking in IBM WebSphere Application Server 4.0.2|

Examples of the effect of optimistic concurrency on application behavior. Although the paper is based on
a previous version of this product, the data access issues discussed in it are current.

This paper does not seem to be available directly by URL. To view this paper, visit the specified URL
and search on "optimistic Tocking”

Programming specifications
« [What's new in the Enterprise JavaBeans 2.0 Specification?|

You can also download the specification itself from this URL.
« [JavaTM 2 Platform: Compatibility with Previous Releases|

This Sun Microsystems article includes both source and binary compatibility issues.

EJB method Invocation Queuing

Method invocations to enterprise beans are only queued for remote clients, making the method call. An
example of a remote client is an enterprise Java bean (EJB) client running in a separate Java virtual
machine (JVM) (another address space) from the enterprise bean. In contrast, no queuing occurs if the
EJB client, either a servlet or another enterprise bean, is installed in the same JVM on which the EJB
method runs and on the same thread of execution as the EJB client.

Remote enterprise beans communicate by using the Remote Method Invocation over an Internet Inter-Orb
Protocol (RMI-IIOP). Method invocations initiated over RMI-IIOP are processed by a server-side object
request broker (ORB). The thread pool acts as a queue for incoming requests. However, if a remote
method request is issued and there are no more available threads in the thread pool, a new thread is
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created. After the method request completes the thread is destroyed. Therefore, when the ORB is used to
process remote method requests, the EJB container is an open queue, due to the use of unbounded
threads. The following illustration depicts the two queuing options of enterprise beans.

EJB Queuing

Serviet Engine
Request queued , . Jy_
in the Servlet Engine  ,~ EJB Container
Threads .~ A
s 1
7 | ORB Thread Pool
-7 WebSphere
L e - Application Server
-~ Request
EJB Client queued
in the ORB
REMOTE Thread Pool
WebSphere
Application Server

The following are two tips for queueing enterprise beans:
* Analyze the calling patterns of the EJB client.

When configuring the thread pool, it is important to understand the calling patterns of the EJB client. If a
servlet is making a small number of calls to remote enterprise beans and each method call is relatively
quick, consider setting the number of threads in the ORB thread pool to a value lower than the Web
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The degree to which the ORB thread pool value needs increasing is a function of the number of
simultaneous servlets, that is, clients, calling enterprise beans and the duration of each method call. If
the method calls are longer or the applications spend a lot of time in the ORB, consider making the
ORB thread pool size equal to the Web container size. If the servlet makes only short-lived or quick
calls to the ORB, servlets can potentially reuse the same ORB thread. In this case, the ORB thread
pool can be small, perhaps even one-half of the thread pool size setting of the Web container.

* Monitor the percentage of configured threads in use.

Tivoli Performance Viewer shows a metric called percent maxed, which is used to determine how often
the configured threads are used. A value that is consistently in the double-digits, indicates a possible
bottleneck a the ORB. Increase the number of threads.
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Chapter 5. Using extended messaging in applications

These topics provide information about implementing WebSphere enterprise applications that use
extended messaging.

WebSphere Application Server supports asynchronous messaging as a method of communication based
on the Java Message Service (JMS) programming interface. Extended messaging extends the base JMS
support, support for EJB 2.0 message-driven beans, and the Enterprise Java Bean (EJB) component
model, to use the existing container-managed persistence and transactional behavior.

Using extended messaging, you can build enterprise beans that can provide messaging services along
with methods that implement business logic. The enterprise beans can use the standard JMS styles of
messaging (point-to-point and publish/subscribe). However, with extended messaging, the JMS usage is
simplified, because JMS support is managed by the extended messaging service. This helps to effectively
separate business logic from the messaging infrastructure. The use of data mapping enables messages to
drive existing or new enterprise beans as though they were invoked from any EJB client.

You can use WebSphere Studio Application Developer Integration Edition to develop applications that use
extended messaging. You can use the WebSphere Application Server runtime tools, like the administrative
console, to deploy and administer applications that use extended messaging.

For more information about implementing WebSphere enterprise applications that use extended
messaging, see the following topics:

* [Extended messaging - overview

+ |[Extended messaging - application usage scenarios|

+ [Extended messaging - components|

+ [Designing an enterprise application to use a message-driven bean|

+ [Developing an enterprise application to use a message-driven bean|

+ [Deploying an enterprise application to use a message-driven bean|

+ [Configuring extended messaging service resources|

+ [Troubleshooting extended messaging|

Extended messaging - overview

Extended messaging extends the base JMS support, support for EJB 2.0 message-driven beans, and the
Enterprise Java Bean (EJB) component model, to use the existing container-managed persistence and
transactional behavior.

In addition to providing such container-managed messaging, extended messaging provides new types of
enterprise beans and administrative objects for messaging, and new functionality like data mapping and
late response handling. (The abbreviation, CMM, for the term container-managed messaging is sometimes
used to represent extended messaging.)

Extended messaging uses the bean-managed messaging implementation to provide the JMS interfaces,
which ensures that both bean-managed and extended messaging use consistent JMS support.

An application that uses extended messaging can receive messages by using a receiver bean, either by
the onMessage() method of a message-driven bean or by a stateless session bean that polls for a
message from a named destination. With extended messaging and a message-driven bean, code within
the bean can use the message to invoke business logic, as either a method within the same bean or
another enterprise bean. Both the incoming message and the invocation of the receiver bean can be
included within the scope of a transaction. For outbound messages, an application calls a sender bean
that turns a method call into a JMS message that is then sent asynchronously. These message beans are
implemented as enterprise beans by WebSphere Application Server. Application developers can create
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these message beans by using WebSphere Studio Application Developer Integration Edition, although they
can be created without the help of WebSphere Studio.

With extended messaging, the JMS usage is simplified, because JMS support is managed by the
extended messaging service. This helps to effectively separate business logic from the messaging
infrastructure. Also, the use of data mapping enables messages to drive existing or new enterprise beans
as though they are invoked from any EJB client. WebSphere Studio enables the types of message beans
that support extended messaging to be developed easily and hides the messaging infrastructure from
developers.

For more conceptual information about extended messaging, see the following topics:
» |Extended messaging - application usage scenariosl

» |Extended messaging - components|

» [Receiving messages with extended messaging|

+ [Sending messages with extended messaging|

« |Data mapping with extended messaging|

+ [Handling late responses with extended messaging|

+ [Transactional support with extended messaging|

+ [Exception handling with extended messaging|

Extended messaging - receiving messages

To receive messages, applications that use extended messaging use a receiver bean, which can be a

message-driven bean or a session bean:

* A receiver bean (deployed as a message-driven bean) is invoked when a message arrives at a JMS
destination for which a listener is active.

* An application-callable receiver bean (deployed as a session bean) polls a JMS destination until a
message arrives, gets the parsed message as an object, and can use getter methods to retrieve the
message data.

Application
(Enterprise JavaBean)
A 1
' |
Input port 7 Re"pIySender()
- _ K method
JMS 1]
destinations - =
R
JMS Provider WebSphere container

Figure 1. Receiving messages with extended messaging. This figure shows an application calling a receiver bean (as
a session bean) to receive messages from the JMS destination defined on an input port. The application also calls the
ReplySender() method of the receiver bean to send a reply to the original message received. For more information
about what is shown in this figure, see the text that accompanies this figure.

When a receiver bean gets a message, it can invoke another method passing either the JMS Message, or
a set of parameters extracted from the message content. The invoked method can be contained in the
receiver bean or in another enterprise bean (which is the preferred application structure). If data mapping
is used, the method invoked by a receiver bean is unaware of the original JMS message.
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In addition to receiving messages, extended messaging enables applications to reply to received
messages in either of the following ways:

Sending a synchronous reply. In this mode, which can be used by only receiver beans deployed as
message-driven beans, the reply from the method invoked by the receiver bean is mapped to a JMS
message and sent as a reply to the original message, using the replyTo field in the JMS header as the
target destination.

Sending an asynchronous reply. In this mode, which cannot be used receiver beans deployed as
message-driven beans, the application calls the ReplySender() method to send the reply message. If
the reply is passed as a set of parameters to the ReplySender() method, the reply is mapped to a JMS
message before being sent.

If a receiver bean gets a JMS message, then depending upon the programming model (associated with
the receiver bean by WebSphere Studio), one of the following interactions occurs:

Receive a request and send no reply.

The receiver bean provides an anonymous invocation in the form of a method call. The data passed to
the method is either the JMS message (if no data mapping is invoked) or a set of parameters mapped
from the JMS message. The receiver bean cannot return a reply to this invocation. This mode of
interaction can be used with point-to-point or publish/subscribe messaging.

Receive a request and send a synchronous reply.

If the receiver bean gets a message, it invokes another method either in the same bean or another
enterprise bean. When the method returns, the data returned from that call is mapped to a JMS
message and sent to the reply destination specified in the original request message. The type of reply
destination (queue or topic) must be the same as the type used by the original request received.
Receive a request and send an asynchronous reply.

For a receiver bean deployed as a message-driven bean, the reply is returned (using the bean’s
ReplySender method) to the replyTo destination specified in the original request message.

For a receiver bean deployed as a session bean, the reply is returned to the destination defined in the
input port for the receiver bean.

In addition to the asynchronous model of this interaction, this mode of interaction enables a method to
send multiple replies to a single invocation.

Extended messaging - sending messages

To send messages, applications that use extended messaging call a method on a sender bean. A sender
bean turns its method invocation into a JMS message, then passes that message to JMS. If needed, the
sender bean can retrieve a response message, then translate that message into a result value and return
it to the caller. If data mapping is used, the method that invokes a sender bean is unaware of the original
JMS message. The sender bean methods can use data mapping to build JMS messages from data
passed on the method call.
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Figure 2. Sending messages with extended messaging. This figure shows an application calling a sender bean to send
messages to the JMS destination defined on an output port. The application also calls the receiveResponse() method
of the sender bean to receive a reply to the original message sent. For more information about what is shown in this
figure, see the text that accompanies this figure.

A sender bean is an enterprise bean (stateless session bean) that can be built by WebSphere Studio
Application Developer. A sender bean should not contain any application logic, to help preserve the
separation between the messaging and business logic.

Each method defined on a class that implements a sender bean has one of the following modes of
interaction (which is defined when the sender bean is built). The interaction extends the sender interface to
address the issue of synchronizing anonymous invocations.

» Send a request and receive no response.

To send a JMS message, an application invokes the sender bean’s method. The caller of the sender
bean’s method cannot receive a response to the message sent. This mode of interaction can be used
with point-to-point or publish/subscribe messaging.

* Send a request and receive a synchronous response.

To send a JMS message and wait for a synchronous response, an application invokes the sender
bean’s method. The sender bean uses the message sender (an interface to JMS provided by extended
messaging) to send the message and, when the response is received, to return the response message
to the caller of the sender bean. This mode of interaction can be used with point-to-point messaging
only.

» Send a request and receive a deferred response.
To send a JMS message and wait for a deferred response, an application invokes the sender bean’s
method. The sender bean uses the message sender to send the message, then returns to the caller
without waiting for the response. The response is returned by a generated receiveResponse() method.
This mode of interaction enables an application to receive more than one response message, as the
application is responsible for retrieving the responses. This mode of interaction can be used with
point-to-point messaging only.

Extended messaging - data mapping
A message bean can use data mapping to map between a JMS message and data as arguments:

» With data mapping, the target method of a receiver bean for an anonymous invocation receives the
contents of an asynchronous message as arguments. The extended messaging service parses the JMS
message and maps from the JMS message to the method arguments. Similarly, to send a message, an
application invokes a method on a sender bean with appropriate arguments. The extended messaging
service packs appropriate arguments into a JMS message then sends the asynchronous request.

» Without data mapping, the target method of a receiver bean for an anonymous invocation receives a
JMS message; no data mapping is performed by extended messaging. Similarly, to send a message, an
application invokes a method of a sender bean with a JMS message.
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If a developer selects data mapping when creating a sender or receiver bean, extended messaging uses
the parameter properties specified on the sender or receiver bean method signatures to perform the data

mapping.

Extended messaging - handling late responses

If an application uses a sender bean to send a message, it can optionally retrieve a response to the
message. The sender bean can either wait for the response or defer retrieval of the response. Sometimes
a response is delayed within the messaging infrastructure, and therefore the application cannot receive the
response. Extended messaging can retrieve such a response message (referred to as a late-response
message) when it does arrive and pass it to a message-driven bean provided by the application to handle
late responses. The message-driven bean used to handle the late response is a standard EJB 2.0
message-driven bean or a receiver bean deployed as a message-driven bean. The deployed
message-driven bean can then perform its processing on the message.

Late responses should not be considered normal application behaviour.

For extended messaging to handle late responses for an application, the sender bean must be deployed
with the Handle late responses option enabled.

Definition of a late response

A late response occurs when the application is no longer able to retrieve responses to messages that it
has sent, as follows:
* Send with deferred response.

The application (enterprise bean) repeatedly tries to retrieve a response until it ends. When the
application no longer wants to retry to get a response, it can register a request for extended messaging
to handle the late response, by calling a registerLateResponse() method on the sender bean.

+ Send with synchronous response handling.

When the sender bean sends a message, it waits for the response. The result of this is that either the
sender bean retrieves the response message or a timeout error occurs. If the system raises a timeout
error, the application can no longer retrieve a response to the message. At this time the extended
messaging service registers the the message for a late response.

Handling responses

Extended messaging handles responses in the following stages:
1. Registering an interest in having a late response retrieved when it is available.

To request the system to handle late responses for a sender bean, you deploy the sender bean with
the Handle late responses extension to the deployment Descriptor.

If selected, the Handle late responses option defines that extended messaging should pass the
response, when it becomes available, to the message-driven bean provided by the application to
handle late responses. When the sender bean is deployed a specialized listener port is associated with
the bean. This listener port is known as a handle late response listener port.

If the option is not selected, then the system does not handle late responses, and it is the application’s
responsibility to handle any late responses.

2. Starting a JMS listener to retrieve the message when it is available, which then drives the message
bean to handle the JMS message.

The listener port must be defined with the following properties:

* The same JMS destination as specified as the JMS response destination on the output port used by
the sender bean.

* Alistener port extension with Handle Late Responses enabled.

You cannot use a temporary destination for late responses.
3. If a request is made to handle a late response, the extended messaging service immediately registers
a LateResponse message request with the extended message consumer for the given listener port.
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The message request is registered independently of any transaction context that the sender bean has.
A request record (containing the MessagelD of the late response) is added to the AsyncMessagelog
log. When the message is eventually received, it is passed to the message-driven bean deployed
against the specified late response ListenerPort.

Extended messaging - transactional support

The global transaction context is not flowed on asynchronous (messaging) requests, so the receipt of an
asynchronous message cannot be part of some existing remotely-established transaction. Reliability in an
asynchronous environment is built on the message provider’s ability to guarantee a once-and-once-only
message delivery.

Transactional support with extended messaging builds on, and extends, the transactional support provided
with bean-managed messaging, as follows:

* [Transactional support for receiving messages|

« [Transactional support for sending messages|

Transactional support for receiving messages (receiver beans)

The extended messaging transactional behaviour for receiver beans depends upon whether the bean is a

receiver bean or an application-callable receiver bean.

» For a receiver bean (deployed as a message-driven bean), incoming message receipts are defined by
the Transaction attribute of the onMessage() bean method. Message-driven beans can use
bean-managed transactions (BMT) or container-managed transactions (CMT). For message-driven
beans using CMT there are only two supported transaction options: Not supported and Required. If a
message is to be received within a transaction, the message-driven bean must be using CMT with the
Transaction attribute set to Required.

» For a receiver bean as a session bean, the bean only supports container-managed transactions, and
the behaviour is defined by the Transaction attribute of the receiver bean method.

Dealing with retries

Note: In the asynchronous environment of transaction processing, rolling back a message receipt means
that the message is not removed from the source destination. Although this behaviour is desirable
and correct, it causes the message retained on the source queue to be reprocessed until the
transaction commits. For receiver beans, you can control this behaviour as follows:

* Receiver bean.

To limit the number of times that a transaction is retried, you can either rely on the facilities of the

JMS provider or use the retry limit facility of the Message Listener:

— WebSphere MQ JMS support provides the ability to move the message to a backout queue
and uses two queue attributes, the backout threshold and the backout-requeue queue, to
perform this.

— The Message Listener retry count can be used to stop the listener processing the queue if the
threshold is reached. The listener behaviour can be disabled by setting the retry count value
higher than the JMS provider threshold value.

* Application-callable receiver bean.

To limit the number of times that a transaction is retried depends on the facilities of the JMS
provider to move the message to a backout queue.

Transactional support for sending messages (sender beans)

The transactional behaviour for sending messages is defined by the Transaction attribute on the send
method within the sender bean.
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If the send() method is part of a transaction, then the sending of an outgoing message occurs within any
currently active transaction. This means that the message is not transmitted until the transaction is
committed. If no transaction is active when the request to send the message occurs, then the message is
transmitted immediately.

The transactional behaviour where the mode of interaction for a sender bean method specifies a response

(that is, either Send message and receive synchronous response or Send message and receive deferred

response) depends upon the type of response, as follows:

Transactional behaviour for a synchronous response
The sending of the request message and the receipt of the response message cannot be
performed inside a transaction, because they are both performed within the same method.
Therefore, the send is always non-transactional, regardless of the transactional setting for the
method. The receive is either transactional or not, depending upon the Transaction setting of the
method.

Transactional behaviour for a deferred response
The response message is received by a receiveResponse() method, which can have a different
transactional behaviour to the sender method inside the sender bean. The transaction containing
the send command must commit before the response can be received. The transactional
behaviour is specified on the send and receive methods of the Sender bean.

Extended messaging - exception handling

Extended messaging provides the following exception handling for receiver beans and sender beans:
« [Error handling for receiver beans|
+ [Error handling for sender beans|

Error handling for receiver beans

The following error conditions can lead to extended messaging exceptions
» Formatting error parsing the message, when performing data mapping
» Exception thrown by the application method

+ CMMException when sending the reply

Errors are always logged. If the application does not catch the exception, the default behavior is to roll
back any active transaction. If the received message is rolled back, then it can be processed again. This
can occur a number of times until the message causing the error is removed from the queue by the JMS
provider. (For more information, see Dealing with retries in|Transactional support with extended

messaging

With data mapping, if a receiver bean is deployed as a message-driven bean and a replyTo destination is
configured, then error messages are sent as replies to that destination.

Application enterprise beans that call receiver beans deployed as session beans need to handle the
CMMException exception. CMMException is an application exception which is declared in the throws
clause of the methods in the generated receiver bean.

Error handling for sender beans

The following error conditions can lead to extended messaging exceptions

» Constructing the JMS message when data mapping from the parameters to the message
» Creating a message sender and sending the message

» Getting the response and parsing the message content

Errors are always logged. If the application does not catch the exception, the default behavior is to roll
back any active transaction.
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Application enterprise beans that call sender beans need to handle the CMMException exception, which is
declared in the throws clause of the methods in the generated sender bean.

Extended messaging - application usage scenarios

Applications can use extended messaging to receive and send messages in a variety of ways:
» To receive messages, applications that use extended messaging use a receiver bean(deployed as a
message-driven bean) or an application-callable receiver bean (deployed as a session bean):
— Avreceiver bean is invoked when a message arrives at a destination for which a listener is active.
— An application-callable receiver bean polls a destination (defined by an input port) until a message
arrives or a timeout occurs.

In addition to receiving messages, extended messaging enables applications to send replies in
response to the received messages.

For more conceptual information about receiving messages, see|Receiving messages with extended

» To send messages, applications that use extended messaging call sender bean methods. The sender
bean sends messages to the target destination defined by an output port. The sender bean methods
can be passed either a JMS message or a number of parameters that are mapped by extended
messaging into a JMS message. Whether or not data mapping is used is specified when the application
is developed.

In addition to sending messages, applications can choose to receive a response to the message, and
can handle any responses either synchronously or asynchronously. If a response is not received in time,
then the system can handle the late response by directing the message to a message-driven bean.

For more conceptual information about sending messages, see |[Sending messages with extended
» Applications can combine receiving and sending messages in a variety of different ways. For example,
a receiver bean deployed as a message-driven bean can forward the message by calling a sender
bean. The receiver bean can give message data to sender bean in either of the following ways:
— The receiver bean can pass the JMS message to the sender bean, which forwards that message.
— The receiver bean can extract data from the initial message and send that data to the sender bean.
The sender bean can then map the data values to a new JMS message, which it forwards.

The application can receive a response to the message that it sent, and then can send the message
received or a new message built from data in the message received, as a response to the original
message.

Also, data mapping can be used to hide the JMS message structure from the application logic. For more
information about data mapping, see [Extended messaging - data mapping|

Extended messaging - components

Extended messaging builds on the base support for JIMS messaging and message-driven beans provided
by WebSphere Application Server. The new messaging components for extended messaging are referred
to as the Message Bean package.

Components for receiving messages

The following components, shown in the figure [Components for receiving messages, are used to receive

messages:

Receiver bean
An application that uses extended messaging can receive messages by using a receiver bean
(using the onMessage() method of a message-driven bean) or an application-callable receiver
bean (a stateless session bean that polls for a message from a named destination). Both receiver
beans and application-callable receiver beans can receive and process asynchronous messages,
and optionally return selected data as a response message.
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Input port
An input port specifies the properties needed by receiver beans as session beans, by defining the
following information:
» Information about the source destination for the message to be received
* Information about how to select and handle the message received
» Optional information about a reply destination, which is used if a reply is expected and replyTo
information is not present in the JMSHeader of the message received.

A receiver bean as a deployed message-driven bean uses the associated listener port, so does
not need an input port. For more information about message-driven beans and listener ports, see
IMessage-driven beans - components.

For more conceptual information about receiving messages, see |Receiving messages with extended|

messaging
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Figure 3. Components for receiving messages. This figure shows an application calling a receiver bean (as a session
bean) to receive messages from the JMS destination defined on an input port. The application also calls the
ReplySender() method of the receiver bean to send a reply to the original message received. For more information
about what is shown in this figure, see the text that accompanies this figure.

Components for sending messages

The following components, shown in the figure [Components for sending messages) are used to send
messages:
Sender bean
Bean instances of a sender bean (also known as a message sender bean) can send
asynchronous messages. The sender bean methods can be passed either a JMS message or a
number of parameters that are mapped by extended messaging into a JMS message, which is
then passed to JMS.
Output port
An output port specifies the properties needed by sender beans, to define the destination for the
message being sent, and other optional properties if a response is expected. It is associated with
the Sender Bean at deployment time and contains the following information:
» Information about the target destination for the message to be sent
* Information about how to select and handle the message to be sent
* Information about the destination used for the response.
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For more conceptual information about sending messages, see [Sending messages with extended|

messaging
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Figure 4. Components for sending messages. This figure shows an application calling a sender bean to send
messages to the JMS destination defined on an output port. The application also calls the receiveResponse() method
of the sender bean to receive a reply to the original message sent. For more information about what is shown in this
figure, see the text that accompanies this figure.

Designing an enterprise application to use extended messaging

This topic describes things to consider when designing an enterprise application to use extended
messaging.

The design of JMS-usage for applications that use extended messaging is the same as the design for JMS
and message-driven beans, except that the JMS-usage is simplified because JMS support is managed by
the extended messaging service. For design considerations related to JMS and message-driven beans,
see the following topics:

The extra design consideration for applications that use extended messaging are as follows. For more
detail, see the related topics.

1. For a receiver bean, decide whether to use a message-driven bean or stateless session bean.
Message-driven bean
You can use a deployed message-driven bean as a receiver bean, to automatically handle
messages received at the associated listener port. As with any message-driven bean, when a
message is received on the JMS destination monitored by the listener port, the message is
passed to the onMessage() method of the message-driven bean.

You need to develop and deploy the message-driven bean, and configure its associated
listener port, separately from the extended messaging tasks.

Stateless session bean
You can use a stateless session bean as a receiver bean, to poll for messages on a named
destination associated with an input port.

You need to develop and deploy the session bean separately from the extended messaging
tasks, but configure the associated input port as part of the extended messaging tasks.
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2. Decide whether or not you want to use data mapping. If you call the methods of sender and receiver
beans with data arguments, you need to use data mapping to construct the JMS messages needed.
For data mapping, you need to decide what data arguments need to be specified as properties on the
sender or receiver bean method signatures.

For a receiver bean deployed as a message-driven bean, you can define the mapping behavior if a
data exception is caught by extended messaging. That is, you define whether a message should be
flowed back if a ReplyTo destination is defined in the JMS message header.

3. Decide whether or not you want to handle late responses.

A sender bean can optionally retrieve a response to messages sent. If a response is delayed within the
messaging infrastructure, the bean cannot receive the response. Extended messaging can retrieve
such a response message (referred to as a late-response message) when it does arrive and pass it to
a message-driven bean provided by the application to handle late responses. To handle late
responses, you need to develop and deploy a standard EJB 2.0 message-driven bean that contains a
registerLateResponse() method, and associate it with a listener port to be used to receive late
responses.

Developing an enterprise application to use extended messaging

This topic describes how to develop an enterprise application to use extended messaging.

This task description assumes that developers are using the WebSphere Studio Application Developer to
develop the application code (receiver and sender beans).

To develop an enterprise application to use extended messaging, complete the following steps:

1. Creating the Enterprise Application project. Because the sender and receiver beans used for extended
messaging are EJB 2.0 enterprise beans, you must first have created a J2EE 1.3 Enterprise
Application project for which extended messaging beans will be created.

a. Ensure that you have selected 1.3 as the highest J2EE version that is to be used in WebSphere
Studio. For example: Window-> Preferences... J2EE preferences-> Select the highest J2EE
version that is to be used-> 1.3

b. Create a J2EE 1.3 Enterprise Application project, as described in the WebSphere Studio article
[Creating an Enterprise Application project]

2. Creating the application code.

To create the application code, use WebSphere Studio to generate the sender and receiver beans
needed by the application, by completing one or more of the following subtasks as described in the
WebSphere Studio Extended Messaging documentation:

« |[Creating a sender bean|

« |[Creating a receiver bean|

« |[Creating an application-callable receiver bean|

- |Creating a sender bean and receiver bean|

+ [Creating a sender bean and application-callable receiver bean|

The result of this stage is an enterprise bean, containing code automatically generated for extended
messaging, that can be assembled into an .EAR file for deployment.

3. Assembling and packaging the application for deployment.

You can use WebSphere Studio to assemble and package the application for deployment.

The following aspects are specific to extended messaging:

a. Configure a message selector for a receiver bean.

b. Associate the JNDI names for sender and receiver beans with output and input ports.
c. Specify the timeout for a sender bean response.
d

Configure that a sender bean is to handle late responses and identify the listener port to be used
for late responses.
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The result of this task is an .EAR file, containing an application enterprise bean with code for extended
messaging, that can be deployed in WebSphere Application Server.

For information about deploying an application to use extended messaging, see [Deploying an enterprisel
lapplication to use extended messaging

Deploying an enterprise application to use extended messaging

This topic describes how to deploy an enterprise application to use extended messaging.

This task description assumes that you have an .EAR file, which contains an application enterprise bean
with code for extended messaging, that can be deployed in WebSphere Application Server.

The Application Install task is also a standard WebSphere Application Server task. As part of the install
procedure you need to associate the Input and Output ports defined in System Management with the
installed .EAR.

To deploy an enterprise application to use extended messaging, complete the following steps:

1. Use the administrative console to define and configure the extended messaging resources to be used
by the application, as described in |Configuring extended messaging service resources| You should
define the input ports for receiver beans, the output ports for sender beans, and listener port
extensions for any sender beans that are to handle late responses.

2. Ensure that the deployment descriptor attributes for the sender and receiver beans match those of the
extended messaging resources that you configured using the administrative console. The deployment
descriptor values can be set when you generate the deployment code for the application, using
WebSphere Studio Application Developer.

31% You can change the deployment descriptor values by using the Assembly Toolkit, as
described in the following topics:

— [Configuring deployment attributes for a receiver bean|

— [Configuring deployment attributes for a sender bean|

3. If a sender bean is to handle late responses, deploy the message-driven bean to be used for late
responses. For more information about deploying message-driven beans, see [Deploying an enterprise]
fapplication to use message-driven beans|

4. Install the application into WebSphere Application Server.
This stage is a standard WebSphere Application Server task, as described in [Installing a new|
When you install the application, you are prompted to specify the name of the listener port that the
application is to use for late responses. Select the listener port, then click OK.

Configuring deployment attributes for a receiver bean

Use this task to configure the deployment attributes for a receiver bean for use with the extended
messaging service.

You can specify these deployment attributes on each EJB method, as part of the deployment of the
receiver bean. Changes to the deployment attributes override the values defined when the receiver bean
was developed and deployment code was generated for the application.

You can configure the deployment attributes of an application by using the Deployment Descriptor Editor of
WebSphere Studio Application Developer or the Assembly Toolkit.

This task description assumes that you have an EAR file for an application component, that can be
deployed in WebSphere Application Server. For more details about using the Assembly Toolkit, see
[Assembling applications with the Assembly Toolkit.
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To configure the deployment attributes for a receiver bean, you can use the Assembly Toolkit to complete
the following steps:

1.
2.

[Start the Assembly Toolkit |

Create or edit the application EAR file. For example, to change attributes of an existing application,
use the import wizard to import the EAR file into the Assembly Toolkit. To start the import wizard:

a. Click File-> Import-> EAR file
b. Click Next, then select the EAR file.
c. Click Finish

In the J2EE Hierarchy view, right-click the component instance, then click Open With > Deployment
Descriptor Editor. A property dialog notebook for the component is displayed in the property pane.

In the property pane, click the Extended Messaging tab.

Specify appropriate deployment attributes: For example:

Method policies
Add or remove method policies. To add a new method policy, complete the Method policy
name and Method policy description fields, then click Add. To remove a method policy,
select its name in the list displayed, then click Remove.

Input port
For an application-callable receiver bean, this is the name of the input port to be used to
receive messages.

Message selector
For an application-callable receiver bean, this is a string used to select messages to be
received.

Save your changes to the deployment descriptor.

a. Close the deployment descriptor editor.

b. When prompted, click Yes to indicate that you want to save changes to the deployment descriptor.
[Verify the archive files]

[Generate code for deployment| for EJB modules or for enterprise applications that use EJB modules.

Optional: Test your completed module on a WebSphere Application Server installation. Right-click a
module, click Run on Server, and follow the instructions in the displayed wizard. Note that Run on
Server works on the Windows, Linux/Intel, and AIX operating systems only; you cannot deploy
remotely from the Assembly Toolkit to a WebSphere Application Server installation on a UNIX
operating system such as Solaris.

Important

Important: Use Run On Server for unit testing only. The Assembly Toolkit controls the WebSphere
Application Server installation and, when an application is published remotely, the Toolkit
overwrites the server configuration file for that server. Do not use on production servers.

For instructions on remote testing, see the article “Setting Up a Remote WebSphere Application Server

in WebSphere Studio V5” at |http://www7b.boulder.ibm.com/wsdd/techjournal/0303_yuen/yuen.html|

After assembling your application, use a systems management tool to deploy the EAR file onto the
application server that is to run the application; for example, using the administrative console as described
in [Deploying and managing applications,

Configuring deployment attributes for a sender bean
Use this task to configure the deployment attributes for a sender bean.

You can specify deployment attributes on each EJB method.

Changes to the deployment attributes override the values defined when the sender bean was developed
and deployment code was generated for the application.
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You can configure the deployment attributes of an application by using the Deployment Descriptor Editor of
WebSphere Studio Application Developer or the Assembly Toolkit.

This task description assumes that you have an EAR file for an application component, that can be
deployed in WebSphere Application Server. For more details about using the Assembly Toolkit, see

|Assemb|ing applications with the Assembly Toolkitl

To change the deployment attributes for a sender bean, you can use the Assembly Toolkit to complete the
following steps:

1.
2.

[Start the Assembly Toolkit|

Create or edit the application EAR file. For example, to change attributes of an existing application,
use the import wizard to import the EAR file into the Assembly Toolkit. To start the import wizard:

a. Click File-> Import-> EAR file
b. Click Next, then select the EAR file.
c. Click Finish

In the J2EE Hierarchy view, right-click the component instance, then click Open With > Deployment
Descriptor Editor. For example, expand EJB Modules-> ejb_module_instance-> Session Beans
then select the bean instance. A property dialog notebook for the component is displayed in the
property pane.

In the property pane, click the Extended Messaging tab.

In the property pane, specify appropriate deployment attributes:

Output port
This is the name of the output port to be used to send messages.

Enable handle late responses
Select this checkbox if the sender bean is to handle late responses. If you select this
checkbox, also specify the following properties: ReplyTimeout and Late response handler
listener port name.

Late response handler listener port name
For a sender bean that has been developed to handle late responses, this is the name of the
listener port to be used for late responses.

Reply Timeout
For a sender bean that has been developed to handle late responses, this is the time after
which responses are considered late. This property is used if a response timeout is not
specified on a sender method call.

Save your changes to the deployment descriptor.

a. Close the deployment descriptor editor.

b. When prompted, click Yes to indicate that you want to save changes to the deployment descriptor.
|Verify the archive files]

[Generate code for deployment| for EJB modules or for enterprise applications that use EJB modules.

Optional: Test your completed module on a WebSphere Application Server installation. Right-click a
module, click Run on Server, and follow the instructions in the displayed wizard. Note that Run on
Server works on the Windows, Linux/Intel, and AIX operating systems only; you cannot deploy
remotely from the Assembly Toolkit to a WebSphere Application Server installation on a UNIX
operating system such as Solaris.

Important

Important: Use Run On Server for unit testing only. Assembly Server Toolkit controls the WebSphere
Application Server installation and, when an application is published remotely, the Toolkit
overwrites the server configuration file for that server. Do not use on production servers.

For instructions on remote testing, see the article “Setting Up a Remote WebSphere Application Server

in WebSphere Studio V5” at |http://www7b.boulder.ibm.com/wsdd/techjournal/0303_yuen/yuen.html|
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Configuring extended messaging service resources

Use these tasks with the WebSphere Administrative console to configure resources needed by the
extended messaging service and applications that use extended messaging.

You can use WebSphere Application Server system management to configure resources needed by the
extended messaging service and applications that use extended messaging.

For more information about the tasks involved, see the following topics:
« [Adding a new input pori

e [Adding a new output port

* [Configuring an input por

» |Configuring an output po

» Configuring a listener port to handle late responses

Adding a new input port
Use this task to add a new input port to WebSphere Application Server.

An input port is for use by an application that uses extended messaging.

During this task you configure the initial properties of the input port. You can later change the properties of
the port, as described in [Configuring an input port|

To add a new input port, complete the following steps:
1. Start the WebSphere Administrative console.

2. In the navigation pane, select Resources-> Extended messaging provider This displays resources
for extended messaging in the content pane.

3. In the Additional Properties table of the content pane, select Input ports This displays a list of the
input ports in the content pane.

Click New.

Specify appropriate [properties of the input port

Click OK.

To save your configuration, click Save on the task bar of the Administrative console window.
To have the changed configuration take effect, stop then restart the application server.

® N o o A

Adding a new output port

Use this task to add a new output port to WebSphere Application Server, and configure its properties, for
use by an application that uses extended messaging.

During this task you configure the initial properties of the output port. You can later change the properties
of the port, as described in|Configuring an output port.

To add a new output port, complete the following steps:
1. Start the WebSphere Administrative console.

2. In the navigation pane, select Resources-> Extended messaging provider This displays resources
for extended messaging in the content pane.

3. In the Additional Properties table of the content pane, select Output ports This displays a list of the
output ports in the content pane.

4. Click New.
5. Specify appropriate |properties of the output portl
6. Click OK.
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7. To save your configuration, click Save on the task bar of the Administrative console window.
8. To have the changed configuration take effect, stop then restart the application server.

Configuring an input port
Use this task to change the properties of an input port for use by an application that uses extended
messaging.

To change the properties of an input port, complete the following steps:
1. Start the WebSphere Administrative console.

2. In the navigation pane, select Resources-> Extended messaging provider This displays resources
for extended messaging in the content pane.

3. In the Additional Properties table of the content pane, select Input ports This displays a list of the
input ports in the content pane.

Select the input port that you want to change.

Specify appropriate [properties of the input pori

Click OK.

To save your configuration, click Save on the task bar of the Administrative console window.
To have the changed configuration take effect, stop then restart the application server.

© N o ok

Configuring an output port

Use this task to change the properties of an output port for use by an application that uses extended
messaging.

To change the properties of an output port, complete the following steps:
1. Start the WebSphere Administrative console.

2. In the navigation pane, select Resources-> Extended messaging provider This displays resources
for extended messaging in the content pane.

3. In the Additional Properties table of the content pane, select Output ports This displays a list of the
output ports in the content pane.

Select the output port that you want to change.

Specify appropriate [properties of the output port

Click OK.

To save your configuration, click Save on the task bar of the Administrative console window.
To have the changed configuration take effect, stop then restart the application server.

© N o oA

Extended messaging service settings
Use this page to enable or disable the extended messaging service.

The Extended Messaging Service provides run-time service for the support of extended messaging.

To view this administrative console page, click Servers > Application Servers > server_name >
Extended Messaging Service .

Startup
Specifies whether the server will attempt to start the extended messaging service.

Default Selected
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Range Selected
When the application server starts, it attempts to
start the extended messaging service
automatically.

Cleared

The server does not try to start the extended
messaging service. If extended messaging is to
be used in applications that run on this server,
the system administrator must start the extended
messaging service manually or select this
property then restart the server.

Late response handling extension collection
Use this page to view the configuration properties of late response handling extensions.
Late response handling extensions enable the handling of late responses with extended messaging

To view this administrative console page, click Application Servers > server_name > Extended
Messaging Service > Listener Port Extensions .

Enabled:

Specifies whether the handling of late responses is enabled.

Range Selected
Handling of late responses is enabled.
Cleared
Handling of late responses is not enabled.

Request Interval:

Specifies the interval that elaspes between checking for late responses.

Data type Integer

Units milliseconds

Default 5

Range An integer number of milliseconds, greater than or equal
to O:

» 0 indicates that the late response handler continually
checks for requests

» Other values are an integer number of milliseconds
between checks for requests.

Request Timeout:

Specifies the duration of time after which to give up waiting for a response.

Data type Integer

Units seconds

Default 0

Range An integer number of milliseconds, greater than or equal
to -1:

* -1 indicates that requests to handle late responses are
never discarded.

» Other values are an integer number of milliseconds
after which requests are discarded.
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Listener Ports:

Specifies the name of the listener port to be used to handle late responses.
Late response handling extension settings:

Use this page to configure late response handling extensions.

To view this administrative console page, click Application Servers > server_name > Extended
Messaging Service > Listener Port Extensions >extension_name .

Enabled:

Specifies whether the handling of late responses is enabled.

Range Selected
Handling of late responses is enabled.
Cleared
Handling of late responses is not enabled.

Request Interval:

Specifies the interval that elaspes between checking for late responses.

Data type Integer

Units milliseconds

Default 5

Range An integer number of milliseconds, greater than or equal

to -1:

» -1 indicates that requests to handle late responses are
never discarded.

» Other values are an integer number of milliseconds
after which requests are discarded.

Request Timeout:

Specifies the duration of time after which to give up waiting for a response.

Data type Integer

Units seconds

Default 0

Range An integer number of milliseconds, greater than or equal

to -1:

* -1 indicates that requests to handle late responses are
never discarded.

» Other values are an integer number of milliseconds
after which requests are discarded.

Listener Ports:

Specifies the name of the listener port to be used to handle late responses.
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Extended messaging provider settings
Use this page to manage extended messaging providers.

The extended messaging provider manages resources defined for use with extended messaging.

To view this administrative console page, click Resources > Extended Messaging Providers .

Name

The name of the resource provider.

Data type String

Range 1 through 30 ASCII characters
Description

An optional description for the resource factory.

Data type String

Input port collection

Use this page to view the configuration properties of input ports..

An input port specifies the properties needed by receiver beans as session beans. Receiver beans as
message-driven beans do not need an input port, because the properties needed are associated with the
deployed message-driven bean and the Message Listener service.

To view this administrative console page, click Resources > Extended Messaging Providers > Input
Port .

Name:

The name by which the input port is known for administrative purposes.

Data type String
Units En_US ASCII characters
JNDI Name:

The JNDI name for the resource.

Data type String

Description:

A description of the input port, for administrative purposes.

Data type String

Category:

A string that can be used to classify or group the resource.

Data type String
Range 1 through 30 ASCII characters
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JMS Connection Factory JNDI Name:

The JNDI name for the JMS connection factory to be used by the input port; for example,
jms/connFactoryl.

Data type String

JMS Destination JNDI Name:

The JNDI name for the destination to be used by the input port; for example, jms/destnl.

Data type String

JMS Acknowledgement Mode:
JMS acknowledgment mode to be used for acknowledging messages.

This property applies only to message-driven beans that use bean-managed transaction demarcation
(Transaction type is set to Bean).

Default Auto Acknowledge
Range Auto Acknowledge
The session automatically acknowledges a
message in either of the following cases:
* When the session has successfully returned
from a call to receive a message.
* When the session has called a message
listener to process the message and received
a successful response from that listener.
Dups OK Acknowledge
The session acknowledges only the delivery of
messages. This is likely to result in the delivery
of some duplicate messages if JMS fails, so it
should be used only by consumers that are
tolerant of duplicate messages.

Destination Type:

The type of the JMS resource.

Default Queue
Range Queue The receiver bean receives messages from a
queue destination.
Topic The receiver bean receives messages from a
topic destination.

Subscription durability:

[Topic destinations only.] Specifies whether a JMS topic subscription is durable or non-durable.

Default Durable
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Range Durable
A subscriber registers a durable subscription with
a unique identity that is retained by JMS.
Subsequent subscriber objects with the same
identity resume the subscription in the state it
was left in by the earlier subscriber. If there is no
active subscriber for a durable subscription, JMS
retains the subscription’s messages until they are
received by the subscription or until they expire.

Nondurable

Nondurable subscriptions last for the lifetime of
their subscriber object. This means that a client
sees the messages published on a topic only
while its subscriber is active. If the subscriber is
not active, the client is missing messages
published on its topic.

Reply JMS Connection Factory JNDI Name:

JNDI name of the JMS Connection Factory to be used for replies.

Data type String

Reply JMS Destination JNDI Name:

JNDI name of the JMS Destination to be used for replies.

Data type String

Input port settings:
Use this page to configure an input port.

To view this administrative console page, click Resources > Extended Messaging Providers > Input
Port > inputport_name .

Name:

The name by which the input port is known for administrative purposes.

Data type String
Units En_US ASCII characters
JNDI Name:

The JNDI name for the resource.

Data type String

Description:

A description of the input port, for administrative purposes.

Data type String
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Category:

A string that can be used to classify or group the resource.

Data type String
Range 1 through 30 ASCII characters

JMS Connection Factory JNDI Name:

The JNDI name for the JMS connection factory to be used by the input port; for example,
jms/connFactoryl.

Data type String

JMS Destination JNDI Name:

The JNDI name for the destination to be used by the input port; for example, jms/destnl.

Data type String

JMS Acknowledgement Mode:
JMS acknowledgment mode to be used for acknowledging messages.

This property applies only to message-driven beans that use bean-managed transaction demarcation
(Transaction type is set to Bean).

Default Auto Acknowledge
Range Auto Acknowledge
The session automatically acknowledges a
message in either of the following cases:
* When the session has successfully returned
from a call to receive a message.
» When the session has called a message
listener to process the message and received
a successful response from that listener.
Dups OK Acknowledge
The session acknowledges only the delivery of
messages. This is likely to result in the delivery
of some duplicate messages if JMS fails, so it
should be used only by consumers that are
tolerant of duplicate messages.

Destination Type:

The type of the JMS resource.

Default Queue
Range Queue The receiver bean receives messages from a
queue destination.
Topic The receiver bean receives messages from a
topic destination.

Subscription durability:
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[Topic destinations only.] Specifies whether a JMS topic subscription is durable or non-durable.

Default
Range

Reply JMS Connection Factory JNDI Name:

A subscriber registers a durable subscription with
a unique identity that is retained by JMS.
Subsequent subscriber objects with the same
identity resume the subscription in the state it
was left in by the earlier subscriber. If there is no
active subscriber for a durable subscription, JMS
retains the subscription’s messages until they are
received by the subscription or until they expire.

Nondurable

Nondurable subscriptions last for the lifetime of
their subscriber object. This means that a client
sees the messages published on a topic only
while its subscriber is active. If the subscriber is
not active, the client is missing messages
published on its topic.

JNDI name of the JMS Connection Factory to be used for replies.

Data type

Reply JMS Destination JNDI Name:

JNDI name of the JMS Destination to be used for replies.

Data type

Output port collection

Use this page to view the configuration properties of output ports.

The Output port defines the parameters required by the extended messaging sender bean. These
properties define the destination for the message being sent, together with optional details if a response is

expected.

To view this administrative console page, click Resources > Extended Messaging Providers > Output

Port .

Name:

The name by which the output port is known for administrative purposes.

Data type

JNDI Name:

The JNDI name for the output port.

Data type

Description:
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A description of the output port, for administrative purposes.

Data type String

Category:

A string that can be used to classify or group the resource.

Data type String

JMS Connection factory JNDI name:

The JNDI name for the JMS connection factory to be used by the output port; for example,
jms/connFactoryl.

Data type String
Units En_US ASCII characters
Range 1 through 30 ASCII characters

JMS Destination JNDI name:

The JNDI name for the destination to be used by the output port; for example, jms/destnl.

Data type String

JMS Delivery Mode:

Specifies whether all messages sent to the destination are persistent or non-persistent.

Default Persistent
Range Persistent
Messages put onto the destination are persistent.
Nonpersistent
Messages put onto the destination are not
persistent.

JMS Priority:

The message priority for this queue destination.

Data type Integer
Default 4
Range Oto 9.

JMS Time To Live:

The time in milliseconds after which messages on this queue expire.

Data type Integer
Units Milliseconds
Default 0
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Range 0 ton
0 messages never time out.
n messages time out in n milliseconds.

JMS Disable Message I.D.:

Specifies that the system should not generate a JMS message ID.

Default Cleared
Range Selected
The system does not generate message IDs.
Cleared

The system generates message IDs
automatically.

JMS Disabled Message Time Stamp:

Specifies that the system should not generate a JMS message timestamp.

Default Cleared
Range Selected
Message time stamps are added automatically to
messages sent.
Cleared
Message time stamps are not added
automatically to messages sent.

Response JMS Connection Factory JNDI nhame:

The JNDI name for the JMS connection factory to be used for response messages handled by the output
port; for example, jms/connFactoryl.

Data type String
Units En_US ASCII characters
Range 1 through 30 ASCII characters

Response JMS Destination JNDI name:

The JNDI name for the destination to be used for response messages handled by the output port; for
example, jms/destnl.

Data type String

Output port settings:

Use this page to configure an output port.

An output port specifies the properties needed by sender beans to define the destination for the message
being sent, and other optional properties if a response is expected. The output port is associated with the
sender bean at deployment time.

To view this administrative console page, click Resources > Extended Messaging Providers > Output

Port >outputport_name .
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Name:

The name by which the output port is known for administrative purposes.

Data type String

JNDI Name:

The JNDI name for the output port.

Data type String

Description:

A description of the output port, for administrative purposes.

Data type String

Category:

A string that can be used to classify or group the resource.

Data type String

JMS Connection factory JNDI name:

The JNDI name for the JMS connection factory to be used by the output port; for example,
jms/connFactoryl.

Data type String
Units En_US ASCII characters
Range 1 through 30 ASCII characters

JMS Destination JNDI name:

The JNDI name for the destination to be used by the output port; for example, jms/destnl.

Data type String

JMS Delivery Mode:

Specifies whether all messages sent to the destination are persistent or non-persistent.

Default Persistent
Range Persistent
Messages put onto the destination are persistent.
Nonpersistent
Messages put onto the destination are not
persistent.

JMS Priority:
The message priority for this queue destination.
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Data type
Default
Range

JMS Time To Live:

Integer
4
0to 9.

The time in milliseconds after which messages on this queue expire.

Data type
Units
Default
Range

JMS Disable Message I.D.:

Integer

Milliseconds

0

0 ton

0 messages never time out.

n messages time out in n milliseconds.

Specifies that the system should not generate a JMS message ID.

Default
Range

JMS Disabled Message Time Stamp:

Cleared
Selected
The system does not generate message IDs.
Cleared
The system generates message 1Ds
automatically.

Specifies that the system should not generate a JMS message timestamp.

Default
Range

Response JMS Connection Factory JNDI name:

Cleared

Selected
Message time stamps are added automatically to
messages sent.

Cleared
Message time stamps are not added
automatically to messages sent.

The JNDI name for the JMS connection factory to be used for response messages handled by the output

port; for example, jms/connFactoryl.

Data type
Units
Range

Response JMS Destination JNDI name:

String
En_US ASCII characters
1 through 30 ASCII characters

The JNDI name for the destination to be used for response messages handled by the output port; for

example, jms/destnl.

Data type

String
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Troubleshooting extended messaging

Use this overview task to help resolve a problem that you think is related to the extended messaging
service.

The extended messaging service uses the standard WebSphere Application Server RAS facilities. If you
encounter a problem that you think might be related to the extended messaging service, complete the
following stages:

1. Check for extended messaging service messages in the application server's SystemQOut log at
was_home\logs\server_name\SystemOut. Any error messages associated with the extended
messaging service are labelled with EMSG. The error message indicates the nature of the problem
and provides some detail. The extended messaging service issues EMSG error messages if it fails to
initialize, parse its configuration file, or encounters some runtime error.

2. Check for more messages in the application server’'s SystemOut log. If the JMS server is running, but
you have problems accessing JMS resources, check the SystemOut log file, which should contain
more error messages and extra details about the problem.

3. Check the Release Notes for specific problems and workarounds The section Possible Problems and
Suggested Fixes of the Release Notes, available from the [WebSphere Application Server library welf
site] is updated regularly to contain information about known defects and their workarounds. Check the
latest version of the Release Notes for any information about your problem. If the Release Notes does
not contain any information about your problem, you can also search the Technotes database on the
WebSphere Application Server web site.

4. Check for problems with the WebSphere Messaging functions or message-driven beans For more
information about troubleshooting WebSphere Messaging, see the related topics listed at the bottom of
this file.

5. Get a detailed exception dump for extended messaging. If the information obtained in the preceding
steps is still inconclusive, you can enable the application server debug trace for the “Messaging” group
to provide a detailed exception dump.

Extended Messaging: Resources for learning

Use the following links to find relevant supplemental information about Extended Messaging. The
information resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of
the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

* [‘Extended Messaging: Resources for learning’
» [“Extended Messaging: Resources for learning’
* |“Extended Messaging: Resources for learning’

Programming model and decisions
|§?m’s Java Message Service (JMS) specification documentation|

Programming specifications
» [Java Message Service API, 1.0.2|
* |Enterprise JavaBeans Technology Downloads & Specifications|

Other
+ [WebSphere Application Server Enterprise Version 5 Overview: Extended J2EE Development|

Accelerators|
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http://www-3.ibm.com/software/webservers/appserv/infocenter.html
http://www-3.ibm.com/software/webservers/appserv/infocenter.html
http://developer.java.sun.com/developer/technicalArticles/Networking/messaging/
http://java.sun.com/products/jms/
http://java.sun.com/products/ejb/docs.html
http://www-3.ibm.com/software/info1/websphere/index.jsp?tab=products/appserv_enterprise#extended
http://www-3.ibm.com/software/info1/websphere/index.jsp?tab=products/appserv_enterprise#extended

Listing of PDF files to learn about WebSphere Application Server Version 5

Listing of all IBM WebSphere Application Server Redbooks|

Listing of all IBM WebSphere Application Server Whitepapers|

WebSphere Application Server Enterprise Edition 4.0: A Programmer’s Guide]
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http://www-3.ibm.com/software/webservers/appserv/appserv_v5.html
http://publib-b.boulder.ibm.com/Redbooks.nsf/Portals/WebSphere
http://www-4.ibm.com/software/webservers/appserv/whitepapers.html
http://www.redbooks.ibm.com/redbooks/SG246504.html
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Chapter 6. Using message-driven beans in applications

WebSphere Application Server supports asynchronous messaging as a method of communication based
on the Java Message Service (JMS) programming interface.

Message-driven beans (a type of enterprise bean defined in the EJB 2.0 specification) extend the base
JMS support and the Enterprise JavaBean component model to provide automatic asynchronous
messaging. When a message arrives on a destination, a listener passes the message to a new instance of
a user-developed message-driven bean for processing.

You can use WebSphere Studio Application Developer to develop applications that use message-driven
beans. You can use the WebSphere Application Server runtime tools, like the administrative console, to
deploy and administer applications that use message-driven beans.

For more information about implementing WebSphere enterprise applications that use message-drive
beans, see the following topics:

« [An overview of message-driven beans|

« [Designing an enterprise application to use a message-driven bean|

» [Developing an enterprise application to use a message-driven bean|

* [Deploying an enterprise application to use a message-driven bean
» [Configuring message listener resources for message-driven beans
« [Troubleshooting problems with message-driven beans|

Message-driven beans - an overview

WebSphere Application Server supports automatic asynchronous messaging with message-driven beans
(a type of enterprise bean defined in the EJB 2.0 specification). Messaging with message-driven beans is
shown in the figure [Message-driven beans - an overview.]

The support for message-driven beans is based on the message listener service, which comprises a
listener manager that controls and monitors one or more listeners. Each listener monitors a JMS
destination for incoming messages. When a message arrives on the destination, the listener passes the
message to a new instance of a user-developed message-driven bean (an enterprise bean) for processing.
The listener then looks for the next message without waiting for the bean to return.

Messages arriving at a destination being processed by a listener have no client credentials associated with
them; the messages are anonymous. Security depends on the role specified by the RunAs Identity for the
message-driven bean as an EJB component. For more information about EJB security, see "EJB
component security” in the information center.

You are recommended to develop a message-driven bean to delegate the business processing of
incoming messages to another enterprise bean, to provide clear separation of message handling and
business processing. This also enables the business processing to be invoked by either the arrival of
incoming messages or, for example, from a WebSphere J2EE client.
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Figure 5. Message-driven beans and the message listener service. This figure shows an incoming message being
passed by a JMS listener to a message-driven bean, which passes the message on to a business logic bean for
business processing. This messaging is controlled by the listener manager. For more information, see the text that
accompanies this figure.

Message-driven beans - components

The WebSphere Application Server support for message-driven beans is based on JMS message listeners
and the message listener service, and builds on the base support for JMS. The main components of
WebSphere Application Server support for message-driven beans are shown in the following figure and
described after the figure:
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Figure 6. The main components for message-driven beans. This figure shows the main components of WebSphere
support for message-driven beans, from JMS provider through a connection to a destination, listener port, then
deployed message-driven bean that processes the message retrieved from the destination. Each listener port defines
the association between a connection factory, destination, and a deployed message-driven bean. The other main
components are the message listener service, which comprises a listener for each listener port, all controlled by the
same listener manager. For more information, see the text that accompanies this figure.

The message listener service is an extension to the JMS functions of the JMS provider and provides a
listener manager, which controls and monitors one or more JMS listeners.

Each listener monitors either a JMS queue destination (for point-to-point messaging) or a JMS topic
destination (for publish/subscribe messaging).

A connection factory is used to create connections with the JMS provider for a specific JMS queue or topic
destination. Each connection factory encapsulates the configuration parameters needed to create a
connection to a JMS destination.

A listener port defines the association between a connection factory, a destination, and a deployed
message-driven bean. Listener ports are used to simplify the administration of the associations between
these resources.

When a deployed message-driven bean is installed, it is associated with a listener port and the listener for
a destination. When a message arrives on the destination, the listener passes the message to a new
instance of a message-driven bean for processing.

When an application server is started, it initializes the listener manager based on the configuration data.
The listener manager creates a dynamic session thread pool for use by listeners, creates and starts
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listeners, and during server termination controls the cleanup of listener message service resources. Each

listener completes several steps for the JMS destination that it is to monitor, including:

» Creating a JMS server session pool, and allocating JMS server sessions and session threads for
incoming messages.

* Interfacing with JMS ASF to create JMS connection consumers to listen for incoming messages.

« If specified, starting a transaction and requesting that it is committed (or rolled back) when the EJB
method has completed.

* Processing incoming messages by invoking the onMessage() method of the specified enterprise bean.

Message-driven beans - transaction support

Message-driven beans can handle messages read from JMS destinations within the scope of a
transaction. If transaction handling is specified for a JMS destination, the JMS listener starts a global
transaction before it reads any incoming message from that destination. When the message-driven bean
processing has finished, the JMS listener commits or rolls back the transaction (using JTA transaction
control).

Note:
» All messages retrieved from a specific destination have the same transactional behavior.

If messages are queued to be sent within a global transaction they are sent when the transaction is
committed. If the processing of a message causes the transaction to be rolled back, then the message
that caused the bean instance to be invoked is left on the JMS destination.

You can configure the Maximum retries property of the listener port to define the maximum number of
times the listener attempts to read a message from a destination. When the Max retries limit is reached,
the listener for that destination is stopped. When you have resolved the problem, you must then restart the
listener.

Designing an enterprise application to use message-driven beans

This topic describes things to consider when designing an enterprise application to use message-driven
beans.

The considerations in this topic are based on a generic enterprise application that uses one
message-driven bean to retrieve messages from a JMS queue destination and passes the messages on to
another enterprise bean that implements the business logic.

To design an enterprise application to use message-driven beans, complete the following steps:

1. Identify the JMS resources that the application is to use. This helps to identify the properties of
resources that need to be used within the application and configured as application deployment
descriptors or within WebSphere Application Server.

JMS resource type Properties

Queue connection factory Name: SamplePtoPQueueConnectionFactory
JNDI Name: Sample/JMS/QCF

Queue destination Name: Q1
JNDI Name: Sample/JMS/Q1

Listener port (for the destination) Name: SamplePtoPListenerPort

Connection Factory JNDI Name: Sample/JMS/QCF
Destination JNDI Name: Sample/JMS/Ql
Maximum Sessions: 5

Maximum Retries: 10

Maximum Messages: 1
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JMS resource type Properties

Message-driven bean (deployment Name: JMSppSampleMDBBean
properties) Transaction type: Container
Destination type: Queue
Listener port name: SamplePtoPListenerPort

Business logic bean Name: MyLogicBean

Ensure that you use consistent values where needed; for example, the JNDI names for the connection
factory and destination must be the same for both those resources and the equivalent properties of the
listener port.

2. Separation of business logic. You are recommended to develop a message-driven bean to delegate
the business processing of incoming messages to another enterprise bean. This provides clear
separation of message handling and business processing. This also enables the business processing
to be invoked by either the arrival of incoming messages or, for example, from a WebSphere J2EE
client.

3. Security considerations.

Messages arriving at a destination being processed by a listener have no client credentials associated
with them; the messages are anonymous. Security depends on the role specified by the RunAs Identity
for the message-driven bean as an EJB component. For more information about EJB security, see
"EJB component security” in the information center.

4. General JMS considerations For Publish/Subscribe messaging, choose the JMS server port to be used

depending on your needs for transactions or performance:

Queued port
The TCP/IP port number of the listener port used for all point-to-point and Publish/Subscribe
support.

Direct port
The TCP/IP port number of the listener port used for direct TCP/IP connection
(non-transactional, non-persistent, and non-durable subscriptions only) for Publish/Subscribe
support.

Note: Message-driven beans cannot use the direct listener port for Publish/Subscribe support.
Therefore, any topic connection factory configured with Portset to Direct cannot be
used with message-driven beans.

A non-durable subscriber can only be used in the same transactional context (for example, a global

transaction or an unspecified transaction context) that existed when the subscriber was created. For
more information about this context restriction, see "The effect of transaction context on non-durable
subscribers” in the information center.

Developing an enterprise application to use message-driven beans

Use this task to develop an enterprise application to use a message-driven bean. The message-driven
bean is invoked by a JMS listener when a message arrives on the input queue that the listener is
monitoring.

You are recommended to develop the message-driven bean to delegate the business processing of
incoming messages to another enterprise bean, to provide clear separation of message handling and
business processing. This also enables the business processing to be invoked by either the arrival of
incoming messages or, for example, from a WebSphere J2EE client. Responses can be handled by
another enterprise bean acting as a sender bean, or handled in the message-driven bean.

You develop an enterprise application to use a message-driven bean like any other enterprise bean,
except that a message-driven bean does not have a home interface or a remote interface.
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This topic describes how to develop a completely new message-driven bean class. If you have a WAS 4.0
enterprise application that uses the JMS listener, you can migrate that application to use message-driven
beans.

For more information about writing the message-driven bean class, see Creating a message-driven bean
in the WebSphere Studio help bookshelf.

To develop an enterprise application to use a message-driven bean, complete the following steps:
1. Creating the Enterprise Application project, as described in the WebSphere Studio article .
2. Creating the message-driven bean class.

You can use the New Enterprise Bean wizard of WebSphere Studio Application Developer to create an
enterprise bean with a bean type of Message-driven bean. The wizard creates appropriate methods for
the type of bean.

By convention, the message bean class is named nameBean, where name is the name you assign to
the message bean; for example:

public class MyJMSppMDBBean implements MessageDrivenBean, MessagelListener

The message-driven bean class must define and implement the following methods:
» onMessage(message), which must meet the following requirements:

— The method must have a single argument of type javax.jms.Message.

— The throws clause must not define any application exceptions.

— If the message-driven bean is configured to use bean-managed transactions, it must call the
javax.transaction.UserTransaction interface to scope the transactions. Because these calls occur
inside the onMessage() method, the transaction scope does not include the initial message
receipt. This means the application server is given one attempt to process the message.

To handle the message within the onMessage() method (for example, to pass the message on to
another enterprise bean), you use standard JMS. (This is known as bean-managed messaging.)
» ejbCreate()

You must define and implement an ejbCreate method for each way in which you want a new
instance of an enterprise bean to be created.
* ejbRemove().

This method is invoked by the container when a client invokes the remove method inherited by the
enterprise bean’s home interface from the javax.ejb.EJBHome interface. This method must contain
any code that you want to execute before an enterprise bean instance is removed from the
container (and the associated data is removed from the data source).

For example, the following code extract shows how to access the text and the JMS MessagelD, from a
JMS message of type TextMessage:
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public void onMessage(javax.jms.Message msg)

{

null;
null;

String text
String messagelD

try

{
text = ((TextMessage)msg).getText();

System.out.printIn("senderBean.onMessage(), msg text2: "+text);

//

// store the message id to use as the Correlator value

//
messageID = msg.getJMSMessagelID();

// Call a private method to put the message onto another queue
putMessage (messagelD, text);

}

catch (Exception err)

{
}

return;

err.printStackTrace();

}

Figure 7. Code example: The onMessage() method of a message bean. This figure shows a code extract for a basic
onMessage() method of a sample message-driven bean. The method unpacks the incoming text message to extract
the text and message identifier and calls a private putMessage method (defined within the same message bean class)
to put the message onto another queue.

The result of this step is a message-driven bean that can be assembled into an .EAR file for
deployment.

3. Assembling and packaging the application for deployment.
You can use WebSphere Studio to assemble and package the application for deployment.

The result of this task is an .EAR file, containing an application message-driven bean, that can be
deployed in WebSphere Application Server.

After you have developed an enterprise application to use message-driven beans, configure and deploy
the application; for example, define the listener ports for the message-driven beans and, optionally, change
the deployment descriptor attributes for the application. For more information about configuring and
deploying an application that uses message-driven beans, see [Deploying an enterprise application to use]
[message-driven beans]

Deploying an enterprise application to use message-driven beans

Use this task to deploy an enterprise application to use message-driven beans.

This task description assumes that you have an .EAR file, which contains an application enterprise bean
with code for message-driven beans, that can be deployed in WebSphere Application Server.

To deploy an enterprise application to use message-driven beans, complete the following steps:

1. Use the WebSphere administrative console to define the listener ports for the application, as described
in|[Adding a new listener port|

2. 1% For each message-driven bean in the application, configure the deployment attributes to match
the listener port definitions, as described in [Configuring deployment attributes using the Assembly|
Toolkit|
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3. Use the WebSphere administrative console to install the application.
This stage is a standard WebSphere Application Server task, as described in [Installing a new|
When you install the application, you are prompted to specify the name of the listener port that the
application is to use for late responses. Select the listener port, then click OK.

Configuring deployment attributes using the Assembly Toolkit

Use this task to configure the message-driven beans deployment attributes for an enterprise bean, to
override the deployment attributes defined within the application EAR file.

You can configure the deployment attributes of an application by using the Deployment Descriptor Editor of
WebSphere Studio Application Developer or the Assembly Toolkit.

This topic describes the use of the Assembly Toolkit to configure the deployment attributes of an
application. This task description assumes that you have an EAR file, which contains an application
enterprise bean developed as a message-driven bean, that can be deployed in WebSphere Application
Server. For more details about using the Assembly Toolkit, see [Assembling applications with the Assemblyl

To configure the message-driven beans deployment attributes for an enterprise bean, use the Assembly
Toolkit to configure the deployment attributes of the application to match the listener port definitions:

1. |Start the Assembly Toolkit)|

2. Create or edit the application EAR file. For example, to change attributes of an existing application,
use the import wizard to import the EAR file into the Assembly Toolkit. To start the import wizard:

a. Click File-> Import-> EAR file
b. Click Next, then select the EAR file.
c. Click Finish

3. In the J2EE Hierarchy view, right-click the EJB module for the message-driven bean , then click Open
With > Deployment Descriptor Editor. A property dialog notebook for the message-driven bean is
displayed in the property pane.

4. Specify general deployment properties.
a. In the property pane, select the Beans tab.

b. Specify the following properties:
Transaction type
Whether the message bean manages its own transactions or the container manages
transactions on behalf of the bean. All messages retrieved from a specific destination
have the same transactional behavior. To enable the transactional behavior that you want,
you must configure the JMS destination with the same transactional behavior as you
configure for the message bean.
Bean The message bean manages its own transactions
Container
The container manages transactions on behalf of the bean
5. Specify advanced deployment properties.
a. Specify the following properties:
Message selector
The JMS message selector to be used to determine which messages the message bean
receives; for example:

JMSType="'car' AND color='blue' AND weight>2500

The selector string can refer to fields in the JMS message header and fields in the
message properties. Message selectors cannot reference message body values.
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Acknowledge mode
How the session acknowledges any messages it receives.

This property applies only to message-driven beans that uses bean-managed transaction

demarcation (Transaction type is set to Bean).

Auto Acknowledge
The session automatically acknowledges a message when it has either
successfully returned from a call to receive, or the message listener it has called
to process the message successfully returns.

Dups OK Acknowledge
The session lazily acknowledges the delivery of messages. This is likely to result
in the delivery of some duplicate messages if JMS fails, so it should be used only
by consumers that are tolerant of duplicate messages.

As defined in the EJB specification, clients cannot use using Message.acknowledge() to

acknowledge messages. If a value of CLIENT_ACKNOWLEDGE is passed on the

createxxxSession call, then messages are automatically acknowledged by the application

server and Message.acknowledge() is not used.

Destination type

Whether the message bean uses a queue or topic destination.

Queue
The message bean uses a queue destination.

Topic The message bean uses a topic destination.

Subscription durability

Whether a JMS topic subscription is durable or non-durable.

Durable
A subscriber registers a durable subscription with a unique identity that is retained
by JMS. Subsequent subscriber objects with the same identity resume the
subscription in the state it was left in by the earlier subscriber. If there is no active
subscriber for a durable subscription, JMS retains the subscription’s messages
until they are received by the subscription or until they expire.

Nondurable
Non-durable subscriptions last for the lifetime of their subscriber object. This
means that a client sees the messages published on a topic only while its
subscriber is active. If the subscriber is not active, the client is missing messages
published on its topic.

A non-durable subscriber can only be used in the same transactional context (for
example, a global transaction or an unspecified transaction context) that existed
when the subscriber was created. For more information about this context
restriction, see "The effect of transaction context on non-durable subscribers” in
the information center.

Specify bindings deployment properties.
a. Specify the following property:

Listener port name
Type the name of the listener port for this message-driven bean.

Save your changes to the deployment descriptor.
a. Close the deployment descriptor editor.

b. When prompted, click Yes to indicate that you want to save changes to the deployment
descriptor.

Verify the archive files|

Generate code for deployment| for EJB modules or for enterprise applications that use EJB modules.

Optional: Test your completed module on a WebSphere Application Server installation. Right-click a
module, click Run on Server, and follow the instructions in the displayed wizard. Note that Run on
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Server works on the Windows, Linux/Intel, and AIX operating systems only; you cannot deploy
remotely from the Assembly Toolkit to a WebSphere Application Server installation on a UNIX
operating system such as Solaris.

Important

Important: Use Run On Server for unit testing only. Assembly Server Toolkit controls the
WebSphere Application Server installation and, when an application is published
remotely, the Toolkit overwrites the server configuration file for that server. Do not use on
production servers.

For instructions on remote testing, see the article “Setting Up a Remote WebSphere Application

Server in WebSphere Studio V5” at

[http://www7b.boulder.ibm.com/wsdd/techjournal/0303_yuen/yuen.htmi,

After assembling your application, use a systems management tool to deploy the EAR file onto the
application server that is to run the application; for example, using the administrative console as described
in |Dep|oying and managing applications|.

Configuring message listener resources for message-driven beans

Use the following tasks to configure resources needed by the message listener service to support
message-driven beans.

+ [Configuring the message listener service]

+ [Adding a new listener port|

+ [Configuring a listener por

« [Configuring security for message-driven beans|

Configuring the message listener service
Use this task to configure the properties of the message listener service for an application server.

To configure the properties of the message listener service for an application server, use the administrative
console to complete the following steps:

1. In the navigation pane, select Servers-> Application Servers This displays a table of the application
servers in the administrative domain.

2. In the content pane, click the name of the application server. This displays the properties of the
application server in the content pane.

3. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

4. Specify appropriate [properties of the message listener service}

5. Optional: Specify any of the following optional properties that you need, as Custom properties of the
message listener service: NON.ASF.RECEIVE.TIMEOUT, MQJMS.POOLING.TIMEOUT,
MQJMS.POOLING.THRESHOLD, MAX.RECOVERY.RETRIES, and RECOVERY.RETRY.INTERVAL.

For more information about these custom properties, see |Custom Propertiesl
6. Click OK.
7. Save your configuration.
8. To have the changed configuration take effect, stop then restart the Application Server.

Message listener service

The message listener service is an extension to the JMS functions of the JMS provider. It provides a
listener manager that controls and monitors one or more JMS listeners, which each monitor a JMS
destination on behalf of a deployed message-driven bean.

This panel displays links to the Additional Properties pages for Listener Ports and Custom Properties for
the message listener service.
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To view this administrative console page, click Servers-> Application Servers-> application_server->
Message Listener Service

Thread pool:

Controls the maximum number of threads the Message Listener Service is allowed to run. Select this link
to display the service thread pool properties.

Adjust this parameter when multiple message-driven beans are deployed in the same application server
and the sum of their maximum session values exceeds the default value of 10.

The thread pool is shared out based on demand, so if the thread pool size is equal to the number of
listener ports, then there is no guarantee that one thread is available for each listener port. However, a
listener port should not get blocked by busy threads because scheduling should be based on FIFO
requests.

Data type Integer

Units Not applicable

Default Minimum: 10, maximum 50

Range Not applicable

Recommended Set the minimum thread pool size to the expected

low-load total message-driven beans sessions. Set the
maximum thread pool size to the expected high-load total
message-driven beans sessions.

If the total number of sessions for all listener ports
exceeds this maximum thread pool size, adjust the
minimum and maximum to the appropriate size for JVM
resource reuse, parallel processing of messages, and
speed of delivery; for example:

* Scenario 1. If JVM resource reuse=none, parallel
processing=always, speed of delivery=quick, then
minThreadPool=maxTotalSession and maxThreadPool
does not matter (that is,
maxThreadPool=maxTotalSession ).

e Scenario 2. If JVM resource resuse=whenPossible,
parallel processing=whenPossible, speed of
delivery=quick, then minThreadPool=(a tested number)
< maxTotalSession and
maxThreadPool=maxTotalSession.

Custom Properties:
An optional set of name and value pairs for custom properties of the message listener service.

You can use the Custom properties page to define the following properties for use by the message listener
service.

+ [NON.ASF.RECEIVE.TIMEOUT|
+ [MQJMS.POOLING.TIMEOUT
+ [MQJMS.POOLING.THRESHOLD|
+ [MAX.RECOVERY.RETRIES
- [RECOVERY.RETRY.INTERVAL|

Message listener service custom properties:
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Use this panel to view or change an optional set of name and value pairs for custom properties of the
message listener service.

To view this administrative console page, click Servers-> application_server-> Message Listener
Service-> (In content pane, under Additional Properties) Custom Properties

You can use the Custom properties page to define the following properties for use by the message listener
service.

- [NON.ASF.RECEIVE.TIMEOUT|

« [MQIMS.POOLING.TIMEOUT]

» [MQUMS.POOLING.THRESHOLD]|
- [MAX.RECOVERY.RETRIES]

[RECOVERY.RETRY.INTERVAL|

NON.ASF.RECEIVE.TIMEOUT:

The timeout in milliseconds for synchronous message receives performed by message-driven bean listener
sessions in the non-ASF mode of operation.

You should set this property to a non-zero value only if you want to enable the non-ASF mode of operation
for all message-driven bean listeners on the application server.

The message listener service has two modes of operation, Application Server Facilities (ASF) and
non-Application Server Facilities (non-ASF).

* The ASF mode is meant to provide concurrency and transactional support for applications. For
publish/subscribe message-drive beans, the ASF mode provides better throughput and concurrency,
because in the non-ASF mode the listener is single-threaded.

* The non-ASF mode is mainly for use with generic JMS providers that do not support JMS ASF, which is
an optional extension to the JMS specification. The non-ASF mode is also transactional but, because
the path length is shorter than the ASF mode, usually provides improved performance.

Use non-ASF if:

— Your generic JMS provider does not provide JMS ASF support

— You are using message-driven beans with WebSphere topic connections with the DIRECT port,
because the embedded publish/subscribe broker using that port does not support XA transactions or
JMS ASF.

— Message order is a strict requirement

Data type Integer
Units Milliseconds
Default ASF mode (custom property not created)
Range 0 or greater milliseconds
0 non-ASF mode is disabled
1 or more

The timeout in milliseconds for non-ASF
message-driven bean listener synchronous
session receives
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Recommended If a transaction timeout occurs, the message must recycle
causing extra work. If you want to use the non-ASF mode,
set this property to lower than the transaction timeout, but
leave spare at least the maximum duration of your
message-driven bean’s onMessage() method. For
example, if your message-driven bean’s onMessage()
method typically takes a maximum of 10 seconds, and the
transaction timeout is set to 120 seconds, you might set
the NON.ASF.RECEIVE.TIMEOUT property to no more
than 110000 (110000 milliseconds, that is 110 seconds).

MQJIMS.POOLING.TIMEOUT:
The number of milliseconds after which a connection in the pool is destroyed if it has not been used.
An MQSimpleConnectionManager allocates connections on a most-recently-used basis, and destroys

connections on a least-recently-used basis. By default, a connection is destroyed if it has not been used
for five minutes.

Data type Integer
Units Milliseconds
Default 5 minutes
Range

MQJUMS.POOLING.THRESHOLD:
The maximum number of unused connections in the pool.
An MQSimpleConnectionManager allocates connections on a most-recently-used basis, and destroys

connections on a least-recently-used basis. By default, a connection is destroyed if there are more than
ten unused connections in the pool.

Data type Integer

Units Number of connections
Default 10

Range

MAX.RECOVERY.RETRIES:

The maximum number of times that the listener service tries to get a message from a listener port before
the associated listener is stopped, in the range 0 through 2147483647.

Data type Integer

Units Retry attempts

Default 0 (no retries)

Range 0 (no retries) through 2147483647

RECOVERY.RETRY.INTERVAL:

The time in seconds between retry attempts by the listener service to get a message from a listener port.

Data type Integer
Units Seconds
Default 10
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Range 1 through 2147483647

Message listener port collection:
The message listener ports configured in the administrative domain

This panel displays a list of the message listener ports configured in the administrative domain. Each
listener port is used with a message-driven bean to automatically receive messages from an associated
JMS destination. You can use this panel to add new listener ports or to change the properties of existing
listener ports. For more information about the property fields for listener ports, see |Listener port propertiesl.

To view this administrative console page, click Servers-> application_server-> Message Listener
Service-> Listener Ports

Listener port settings:

A listener port is used to simplify administration of the association between a connection factory,
destination, and deployed message-driven bean.

Use this panel to view or change the configuration properties of the selected listener port.

To view this administrative console page, click Servers-> Application Servers-> application_server->
Message Listener Service-> Listener Ports-> listener_port

Name:

The name by which the listener port is known for administrative purposes.

Data type String
Default Null

Initial state:

The state that you want the listener port to have when the application server is next restarted

Data type Enum

Units Not applicable
Default Started
Range Started

When the application server is next started, the
listener port is started automatically.

Stopped
When the application server is next started, the
listener port is not started automatically. If
message-driven beans are to use this listener
port on the application server, the system
administrator must start the port manually or
select the Started value of this property then
restart the application server.

Description:

A description of the listener port, for administrative purposes within IBM WebSphere Application Server.

Data type String
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Default Null

Connection factory JNDI name:

The JNDI name for the JMS connection factory to be used by the listener port; for example,
jms/connFactoryl.

Data type String
Default Null

Destination JNDI name:
The JNDI name for the destination to be used by the listener port; for example, jms/destnl.

If the extended messaging service is to use this listener port to handle late responses, the value of this
property must match the JMS response destination on the output port used by the sender bean.

You cannot use a temporary destination for late responses.

Data type String
Default Null

Maximum sessions:

Specifies the maximum number of concurrent sessions that a listener can have with the JMS server to
process messages.

Each session corresponds to a separate listener thread and therefore controls the number of concurrently
processed messages. Adjust this parameter when the JMS server does not fully use the available capacity
of the machine and if you do not need to process messages in a specific message order.

Data type Integer

Units Sessions

Default 1

Range 1 through 2147483647

Recommended « If you want to process messages in a strict message

order, set the value to 1, so only one thread is ever
processing messages.

» If you want to process multiple messages
simultaneously (known as “message concurrency”), set
this property to a value greater than 1. Keep this value
as low as possible to prevent overloading client
applications. A good starting point for a 100% JMS
workload with short transaction times is 2 to 4 sessions
per processor. If longer running transactions exist, you
may need more sessions, which should be determined
by experimentation.

» If you are using XA transactions, this property should
always be set to 1. If it this property is set to a higher
value, multiple messages are delivered in the same
transaction, which is usually not the desired behavior.

Maximum retries:
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The maximum number of times that the listener tries to deliver a message before the listener is stopped, in

the range 0 through 2147483647.

The maximum number of times that the listener tries to deliver a message to a message-driven bean

instance before the listener is stopped.

Data type
Units
Default
Range

Maximum messages:

Integer

Retry attempts

0 (no retries)

0 (no retries) through 2147483647

The maximum number of messages that the listener can process in one session with the JMS server.

For WebSphere embedded messaging or WebSphere MQ as the JMS provider, the listener processes all
messages in the session as one batch within the same transaction. For a generic JMS provider, the
listener processes each message in the session within a separate transaction.

Data type
Units

Default

Range
Recommended

Adding a new listener port

Integer

Number of messages

1

1 through 2147483647

For WebSphere embedded messaging or WebSphere MQ
as the JMS provider, if you want to process multiple
messages in a single transaction, then set this value to
more than 1. This enables multiple messages to be
batch-processed into a single transaction, and eliminates
much of the overhead of transactions on JMS messages.
CAUTION:

» If one message in the batch fails processing with an
exception, the entire batch of messages is put back on
the queue for processing.

* Any resource lock held by any of the interactions for the
individual messages are held for the duration of the
entire batch.

* Depending on the amount of processing that messages
need, and if XA transactions are being used, setting a
value greater than 1 can cause the transaction to time
out. If an XA transaction does time out routinely
because processing multiple messages exceeds the
transaction timeout, reduce this property to 1 (to limit
processing to one message per transaction) or increase
your transaction timeout.

Use this task to add a new listener port to the message listener service, so that message-driven beans

can be associated with the port to retrieve messages.

To add a new listener port, use the administrative console to complete the following steps:
1. In the navigation pane, select Servers-> Application Servers This displays a table of the application

servers in the administrative domain.

2. In the content pane, click the name of the application server. This displays the properties of the

application server in the content pane.
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3. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

In the content pane, select Listener Ports. This displays a list of the listener ports.

In the content pane, click New.

Specify appropriate |properties for the listener portl

Click OK.

To save your configuration, click Save on the task bar of the Administrative console window.
To have the changed configuration take effect, stop then restart the application server.

© © N O

If enabled, the listener port is started automatically when a message-driven bean associated with that port
is installed.

Configuring a listener port

Use this task to change the properties of an existing listener port, used by message-driven beans
associated with the port to retrieve messages.

To configure the properties of a listener port, use the administrative console to complete the following

steps:

1. In the navigation pane, select Servers-> Application Servers This displays a table of the application
servers in the administrative domain.

2. In the content pane, click the name of the application server. This displays the properties of the
application server in the content pane.

3. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

4. In the content pane, click Listener Ports. This displays a list of the listener ports.

5. Click the listener port that you want to modify. This displays the properties of the listener port in the
content pane.

6. Specify appropriate [properties for the listener port

7. Click OK.

8. To save your configuration, click Save on the task bar of the Administrative console window.

9. To have the changed configuration take effect, stop then restart the application server.

Deleting a listener port

Use this task to delete a listener port from the message listener service, to prevent message-driven beans
associated with the port from retrieving messages.

To delete a listener port, use the administrative console to complete the following steps:

1. In the navigation pane, select Servers-> Application Servers This displays a table of the application
servers in the administrative domain.

2. In the content pane, click the name of the application server. This displays the properties of the
application server in the content pane.

3. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

In the content pane, select Listener Ports. This displays a list of the listener ports.

In the content pane, select the checkbox for the listener port that you want to delete.

Click Delete. This action stops the port (needed to allow the port to be deleted) then deletes the port.
To save your configuration, click Save on the task bar of the Administrative console window.

To have the changed configuration take effect, stop then restart the application server.
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Configuring security for message-driven beans
Use this task to configure resource security and security permissions for message-driven beans.

Messages arriving at a listener port have no client credentials associated with them. The messages are
anonymous.

To call secure enterprise beans from a message-driven bean, the message-driven bean needs to be
configured with a RunAs Identity deployment descriptor. Security depends on the role specified by the
RunAs Identity for the message-driven bean as an EJB component.

For more information about EJB security, see the "EJB component security” in the information center. For
more information about configuring security for your application, see "Assembling secured applications” in
the information center.

JMS connections used by message-driven beans can benefit from the added security of using J2C

container-managed authentication. To enable the use of J2C container authentication aliases and mapping,

define a J2C container-managed alias on the JMS connection factory definition that the MDB is using to

listen upon (defined by the Connection factory JNDI name property of the listener port). If defined, the

listener uses the container-managed authentication alias for its JMSConnection security credentials instead

of any application-managed alias. To set the container-managed alias, use the administrative console to

complete the following steps:

1. To display the listener port settings, click Servers-> application_server-> Message Listener
Service-> Listener Ports-> listener_port

2. To get the name of the JMS connection factory, look at the Connection factory JNDI nhame property.

3. Display the JMS connection factory properties. For example, to display the properties of a queue
connection factory provided by the embedded WebSphere JMS provider, click Resources->
WebSphere JMS Provider-> (In content pane, under Additional Properties) WebSphere Queue
Connection Factories-> connection_factory

4. Set the Container-managed Authentication Alias property.

5. Click OK

Administering listener ports

Use the following tasks to administer listener ports, which each define the association between a
connection factory, a destination, and a message-driven bean.

You can use the WebSphere administrative console to administer listener ports, as described in the
following tasks.
« [Adding a new listener port|

Use this task to create a new listener port, to specify a new association between a connection factory, a
destination, and a message-driven bean. This enables deployed message-driven beans associated with
the port to retrieve messages from the destination.

Configuring a listener porf

Use this task to view or change the configuration properties of a listener port.
Starting a listener port|

Use this task to start a listener port manually.
. |Stopping a listener port|
Use this task to stop a listener port manually.

Note: If configured as enabled, a listener port is started automatically when a message-driven bean
associated with that port is installed. You do not normally need to start or stop a listener port
manually.
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Starting a listener port
Use this task to start a listener port on an application server, to enable the listeners for message-driven
beans associated with the port to retrieve messages.

A listener is active, that is able to receive messages from a destination, if the deployed message-driven
bean, listener port, and message listener service are all started. Although you can start these components
in any order, they must all be in a started state before the listener can retrieve messages.

If configured as enabled, a listener port is started automatically when a message-driven bean associated
with that port is installed. However, you can start a listener port manually, as described in this topic.

When a listener port is started, the listener manager tries to start the listeners for each message-driven
bean associated with the port. If a message-driven bean is stopped, the port is started but the listener is
not started, and remains stopped. If you start a message-driven bean, the related listener is started.

To start a listener port on an application server, use the administrative console to complete the following

steps:

1. If you want the listener for a deployed message-driven bean to be able to receive messages at the
port, check that the message-driven bean has been started.

2. In the navigation pane, select Servers-> Application Servers This displays a table of the application
servers in the administrative domain.

3. In the content pane, click the name of the application server. This displays the properties of the
application server in the content pane.

4. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

5. In the content pane, select Listener Ports. This displays a list of the listener ports.

6. Select the checkbox for the listener port that you want to start.

7. Click Start.

8. To save your configuration, click Save on the task bar of the Administrative console window.

Stopping a listener port
Use this task to stop a listener port on an application server, to prevent the listeners for message-driven
beans associated with the port from retrieving messages.

When you stop a listener port as described in this topic, the listener manager stops the listeners for all
message-driven beans associated with the port.

To stop a listener port on an application server, use the administrative console to complete the following

steps:

1. In the navigation pane, select Servers-> Application Servers This displays a table of the application
servers in the administrative domain.

2. In the content pane, click the name of the application server. This displays the properties of the
application server in the content pane.

3. In the Additional Properties table, select Message Listener Service This displays the Message
Listener Service properties in the content pane.

In the content pane, select Listener Ports. This displays a list of the listener ports.

In the content pane, select the listener port that you want to stop.

Click Stop.

To save your configuration, click Save on the task bar of the Administrative console window.
To have the changed configuration take effect, stop then restart the application server.
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Important files for message-driven beans and extended messaging

The following files in the WAS_HOME/temp directory are important for the operation of the WebSphere
Application Server messaging service, so should not be deleted. If you do need to delete the
WAS_HOME/temp directory or other files in it, ensure that you preserve the following files.
server_name-durableSubscriptions.ser
You should not delete this file, because the messaging service uses it to keep track of durable
subscriptions for message-driven beans. If you uninstall an application that contains a
message-driven bean, this file is used to unsubscribe the durable subscription.
server_name-AsyncMessageRequestLog.ser
You should not delete this file, because the messaging service uses it to keep track of late
responses that need to be delivered to the late response message handler for the extended
messaging provider.

Troubleshooting message-driven beans

Use this overview task to help resolve a problem that you think is related to message-driven beans.

Message-driven beans support uses the standard WebSphere Application Server troubleshooting facilities.
If you encounter a problem that you think might be related to the message-driven beans, complete the
following stages:

1. Check for more informational and error messages that might provide a clue to a related problem. If the
JMS server is running, but you have problems accessing JMS resources, check for more error
messages and extra details about the problem.

For messages related to WebSphere Messaging, look for the prefixes: MSGS and WMSG.

2. Check the Release Notes for specific problems and workarounds The section Possible Problems and
Suggested Fixes of the Release Notes, available from the [WebSphere Application Server library wekf
site] is updated regularly to contain information about known defects and their workarounds. Check the
latest version of the Release Notes for any information about your problem. If the Release Notes does
not contain any information about your problem, you can also search the Technotes database on the
WebSphere Application Server web site.

3. Check that message listener service has started. The message listener service is an extension to the
JMS functions of the JMS provider. It provides a listener manager that controls and monitors one or
more JMS listeners, which each monitor a JMS destination on behalf of a deployed message-driven
bean.

4. Check your JMS resource configurations If the WebSphere Messaging functions seem to be running
properly (the JMS server is running without problems), check that the JMS resources have been
configured correctly. For example, check that the listener ports have been configured correctly and
have been started.

5. Check for problems with the WebSphere Messaging functions For more information about
troubleshooting WebSphere Messaging, see the related topics.

6. Get a detailed exception dump for messaging. If the information obtained in the preceding steps is still
inconclusive, you can enable the application server debug trace for the "Messaging” group to provide a
detailed exception dump.

Message-driven beans samples

The following examples are provided, as part of the WebSphere Samples Gallery, to illustrate use of the
message-driven beans support. When the Samples are installed on your local machine, they are available
to try out. Locate them at http://localhost:9080/WSsamples/. (The default port is 9080.) For more
information about where to find the Samples Gallery, see Samples Gallery.
* Point-to-point samples:

"Tutorial: Creating JMS message sample”
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This tutorial is designed to help you develop and deploy a JMS message sample application that

tests the WebSphere Application Server message-driven beans support in a point-to-point scenario.

This sample illustrates how to develop and deploy an application that comprises the following

components:

- A Java/JMS program that writes a message to a queue.

- A message-driven bean that is invoked by a JMS listener when a message arrives on a defined
queue.

For more information about this sample, see the samples article "Tutorial: Creating JMS message
sample” that is installed with the Samples option.
— "Sample: Message Listener (point-to-point)”

This sample is designed to demonstrate the use and behavior of message-driven beans for a simple
point-to-point scenario. This sample uses the JMS message sample deployed in the sample above.

For more information about this sample, see the samples article "Sample: Message Listener
(Point-to-Point)” that is installed with the Samples option.

» Publish/subscribe samples
"Tutorial: Creating JMS message publish/subscribe sample”

This tutorial is designed to help you develop and deploy a JMS message sample application that

tests the WebSphere Application Server message-driven beans support in a publish/subscribe

scenario. This sample illustrates how to develop and deploy an application that comprises the

following components:

- Aclient program that starts the message sequence by publishing a message to a selected topic.

- A message-driven bean that is invoked by a JMS listener when the broker passes a message to
the listener from a topic to which it has subscribed.

For more information about this sample, see the samples article "Tutorial: Creating JMS message
publish/subscribe sample” that is installed with the Samples option.
— "Sample: Message Listener (publish/subscribe)”

This sample is designed to demonstrate the use and behavior of message-driven beans for a simple
publish/subscribe scenario. This sample uses the JMS message sample deployed in the
publish/subscribe sample above.

For more information about this sample, see the samples article "Sample: Message Listener
(publish/subscribe)” that is installed with the Samples option.
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Chapter 7. Using application clients

An application client module is a Java ARchive (JAR) file that contains a client for accessing a Java
application. Complete the following steps for developing different types of application clients.

1. |Decide on a type of application client,
2. Develop the application client code.
a. Develop ActiveX application client code.
b. [Develop J2EE application client code
. [Develop pluggable application client code.|
d. Develop thin application client code.
3. Assemble the application client using the|Assembly Toolkit}
4. Deploy the application client.
Deploy the application client on z/OS |
Deploy the application client on Windows.|
5. |Run the application clientlon z/OS or OS/390.

[e]

View the Samples gallery for more information about application clients.

Before you run the basicCalculator sample, verify that the Java Messaging Service (JMS) server is
started.

These samples do not include client applications that communicate with Enterprise server-side examples.

Application clients

In a traditional client server environment, the client requests a service and the server fulfills the request.
Multiple clients use a single server. Clients can also access several different servers. This model persists
for Java clients except that now these requests use a client run-time environment.

In this model, the client application requires a servlet to communicate with the enterprise bean, and the
servlet must reside on the same machine as the WebSphere Application Server.

With WebSphere Application Server Version 5, application clients now consist of the following models:
» ActiveX application client

* Applet client

» J2EE application client

* Pluggable and thin application clients

WebSphere Application Server for z/OS and OS/390 supports only two models:
» J2EE application client
» Pluggable application client

The ActiveX application client model, uses the Java Native Interface (JNI) architecture to programmatically
access the Java virtual machine (JVM) API. Therefore the JVM code exists in the same process space as
the ActiveX application (Visual Basic, VBScript, or Active Server Pages (ASP) files) and remains attached

to the process until that process terminates.

In the Applet client model, a Java applet embeds in a HyperText Markup Language (HTML) document
residing on a remote client machine from the WebSphere Application Server. With this type of client, the
user accesses an enterprise bean in the WebSphere Application Server through the Java applet in the
HTML document.
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The J2EE application client is a Java application program that accesses enterprise beans, Java Database
Connectivity (JDBC) APls, and Java Message Service message queues. The J2EE application client
program runs on client machines. This program follows the same Java programming model as other Java
programs; however, the J2EE application client depends on the application client run time to configure its
execution environment, and uses the Java Naming and Directory Interface (JNDI) name space to access
resources.

The pluggable and thin application clients provide a lightweight Java client programming model. These
clients are useful in situations where a Java client application exists but the application needs
enhancements to use enterprise beans, or where the client application requires a thinner, more lightweight
environment than the one offered by the J2EE application client. The difference between the thin
application client and the pluggable application client is that the thin application client includes a Java
virtual machine (JVM) API, and the pluggable application client requires the user to provide this code. The
pluggable application client uses the Sun Java Development Kit, and the thin application client uses the
IBM Developer Kit for the Java platform.

The J2EE application client programming model provides the benefits of the J2EE platform for the Java
client application. Use the J2EE application client to seamlessly develop, assemble, deploy and launch a
client application. The tooling provided with the WebSphere platform supports the seamless integration of
these stages to help the developer create a client application from start to finish.

When you develop a client application using and adhering to the J2EE platform, you can put the client
application code from one J2EE platform implementation to another. The client application package can
require redeployment using each J2EE platform deployment tool, but the code that comprises the client
application remains the same.

The application client run time supplies a container that provides access to system services for the client
application code. The client application code must contain a main method. The application client run time
invokes this main method after the environment initializes and runs until the Java virtual machine code
terminates.

The J2EE platform supports the application client use of nicknames or short names, defined within the
client application deployment descriptor. These deployment descriptors identify enterprise beans or local
resources (JDBC, Java Message Service (JMS), JavaMail and URL APIs) for simplified resolution through
JNDI. This simplified resolution to the enterprise bean reference and local resource reference also
eliminates changes to the client application code, when the underlying object or resource either changes
or moves to a different server. When these changes occur, the application client can require redeployment.

The application client also provides initialization of the run-time environment for the client application. The
deployment descriptor defines this unique initialization for each client application. The application client run
time also provides support for security authentication to enterprise beans and local resources.

The application client uses the Java Remote Method Invocation-Internet InterORB Protocol (RMI-IIOP).
Using this protocol enables the client application to access enterprise bean references and to use
Common Object Request Broker Architecture (CORBA) services provided by the J2EE platform
implementation. Use of the RMI-IIOP protocol and the accessibility of CORBA services assist users in
developing a client application that requires access to both enterprise bean references and CORBA object
references.

When you combine the J2EE and CORBA environments or programming models in one client application,
you must understand the differences between the two programming models to use and manage each
appropriately.

View the Samples gallery for more information about application clients. Before you run the
basicCalculator sample, verify that the Java Messaging Service (JMS) server is started.
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These samples do not include client applications that communicate with Enterprise server-side examples.

Application client functions
Use the following table to identify the available functions in the different types of clients.

Note: WebSphere Application Server for z/OS supports only two types of application client:
» J2EE client
* Pluggable client

Available functions ActiveX client Applet client J2EE Pluggable client Thin client
client

Provides all the benefits of a Yes No Yes No No

J2EE platform

Portable across all J2EE No No Yes No No

platforms

Provides the necessary run-time  Yes Yes Yes Yes Yes

support for communication
between a client and a server

Supports the use of nicknames in Yes No Yes No No
the deployment descriptor files.

Note: Although you can edit

deployment descriptor files, do

not use the administrative

console to modify them.

Supports use of the RMI-IIOP Yes Yes Yes Yes Yes
protocol

Browser-based application No Yes No No No
Enables development of client Yes Yes Yes Yes Yes

applications that can access
enterprise bean references and
CORBA object references

Enables the initialization of the Yes No Yes No No
client application run-time
environment

Supports security authentication  Yes Limited Yes Yes Yes
to enterprise beans

Supports security authentication  Yes No Yes No No
to local resources

Requires distribution of Yes No Yes Yes Yes
application to client machines

Enables access to enterprise Yes No No No No
beans and other Java classes

through Visual Basic, VBScript,

and Active Server Pages (ASP)

code

Provides a lightweight client No Yes No Yes Yes
suitable for download

Enables access JNDI APIs for Yes Yes Yes Yes Yes
enterprise bean resolution

Runs on client machines that use No No No Yes No
the Sun Java Runtime
Environment
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Supports CORBA services (using No No Yes No No
CORBA services can render the

application client code

nonportable)

ActiveX application clients

WebSphere Application Server provides an ActiveX to EJB bridge that enables ActiveX programs to
access enterprise beans through a set of ActiveX automation objects.

The bridge accomplishes this access by loading the Java virtual machine (JVM) into any ActiveX
automation container such as Visual Basic, VBScript, and Active Server Pages (ASP).

There are two main environments in which the ActiveX to EJB bridge runs:

» Client applications, such as Visual Basic and VBScript, are programs that a user starts from the
command line, desktop icon, or Start menu shortcut.

» Client services, such as Active Server Pages, are programs started by some automated means like the
Services control panel applet.

The ActiveX to EJB bridge uses the Java Native Interface (JNI) architecture to programmatically access
the JVM code. Therefore the JVM code exists in the same process space as the ActiveX application
(Visual Basic, VBScript, or ASP) and remains attached to the process until that process terminates. To
create JVM code, an ActiveX client program calls the XJBInit() method of the XJB.JClassFactory object.
For more information about creating JVM code for an ActiveX program, see "ActiveX to EJB bridge,
initializing JVM code” in the information center.

After an ActiveX client program has initialized the JVM code, the program calls several methods to create
a proxy object for the Java class. When accessing a Java class or object, the real Java object exists in the
JVM code; the automation container contains the proxy for that Java object. The ActiveX program can use
the proxy object to access the Java class, object fields, and methods. For more information about using
Java proxy objects, see "ActiveX to EJB bridge, using Java proxy objects” in the information center. For
more information about calling methods and access fields, see "ActiveX to EJB bridge, calling Java
methods” and "ActiveX to EJB bridge, accessing Java fields” in the information center.

The client program performs primitive data type conversion through the COM IDispatch interface (use of
the IlUnknown interface is not directly supported). Primitive data types are automatically converted between
native automation types and Java types. All other types are handled automatically by the proxy objects For
more information about data type conversion, see "ActiveX to EJB bridge, converting data types” in the
information center.

Any exceptions thrown in Java code are encapsulated and thrown again as a COM error, from which the
ActiveX program can determine the actual Java exceptions. For more information about handling
exceptions, see "ActiveX to EJB bridge, handling errors” in the information center.

The ActiveX to EJB bridge supports both free-threaded and apartment-threaded access and implements
the free threaded marshaler (FTM) to work in a hybrid environment such as Active Server Pages. For
more information about the support for threading, see 'ActiveX to EJB bridge, using threading’ in the
information center.

J2EE application clients

The J2EE application client programming model provides the benefits of the Java 2 Platform for
WebSphere Application Server Enterprise product.
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The J2EE platform offers the ability to seamlessly develop, assemble, deploy and launch a client
application. The tooling provided with the WebSphere platform supports the seamless integration of these
stages to help the developer create a client application from start to finish.

When you develop a client application using and adhering to the J2EE platform, you can put the client
application code from one J2EE platform implementation to another. The client application package can
require redeployment using each J2EE platform deployment tool, but the code that comprises the client
application does not change.

The J2EE application client run time supplies a container that provides access to system services for the
application client code. The J2EE application client code must contain a main method. The J2EE
application client run time invokes this main method after the environment initializes and runs until the
Java virtual machine application terminates.

Application clients can use nicknames or short names, defined within the client application deployment
descriptor with the J2EE platform. These deployment descriptors identify enterprise beans or local
resources (Java Database Connectivity (JDBC), Java Message Service (JMS), JavaMail and URL APIs)
for simplified resolution through JNDI use. This simplified resolution to the enterprise bean reference and
local resource reference also eliminates changes to the application client code, when the underlying object
or resource either changes or moves to a different server. When these changes occur, the application
client can require redeployment. Although you can edit deployment descriptor files, do not use the
administrative console to modify them.

The J2EE application client also provides initialization of the run-time environment for the client application.
The deployment descriptor defines this unique initialization for each client application. The J2EE
application client run time also provides support for security authentication to the enterprise beans and
local resources.

The J2EE application client uses the Java Remote Method Invocation technology run over Internet
Inter-Orb Protocol (RMI-IIOP). Using this protocol enables the client application to access enterprise bean
references and to use Common Object Request Broker Architecture (CORBA) services provided by the
J2EE platform implementation. Use of the RMI-IIOP protocol and the accessibility of CORBA services
assist users in developing a client application that requires access to both enterprise bean references and
CORBA object references.

When you combine the J2EE and the CORBA WebSphere Application Server Enterprise environments or
programming models in one client application, you must understand the differences between the two
programming models to use and manage each appropriately.

Pluggable application clients

The pluggable application client provides a lightweight, downloadable Java application run time capable of
interacting with enterprise beans.

The pluggable application client requires that you have previously installed the Sun Java Runtime
Environment (JRE) files. In all other aspects, the pluggable application client, and the thin application client
are similar.

Note: The pluggable client is only available on the Windows platform.
This client is designed to support those users who want a lightweight Java client application programming
environment, without the overhead of the J2EE platform on the client machine. The programming model

for this client is heavily influenced by the CORBA programming model, but supports access to enterprise
beans.

Chapter 7. Using application clients 193



When accessing enterprise beans from this client, the client application can consider the enterprise beans
object references as CORBA object references.

Tooling does not exist on the client; however, tooling does exists on the server. You are responsible for
developing the client application, generating the necessary client bindings for the enterprise bean and
CORBA objects, and after bundling these pieces together, installing them on the client machine.

The pluggable application client provides the necessary run time to support the communication needs
between the client and the server.

The pluggable application client uses the RMI-IIOP protocol. Using this protocol enables the client
application to access enterprise bean references and CORBA object references and use any supported
CORBA services. Using the RMI-IIOP protocol along with the accessibility of CORBA services can assist a
user in developing a client application that needs to access both enterprise bean references and CORBA
object references.

When you combine the J2EE and CORBA environments in one client application, you must understand the
differences between the two programming models to use and manage each appropriately.

The pluggable application client run time provides the necessary support for the client application for
object resolution, security, Reliability Availability and Serviceability (RAS), and other services. However,
this client does not support a container that provides easy access to these services. For example, no
support exists for using nicknames for enterprise beans or local resource resolution. When resolving to an
enterprise bean (using either the Java Naming and Directory Interface (JNDI) API or CosNaming) sources,
the client application must know the location of the name server and the fully qualified name used when
the reference was bound into the name space.

When resolving to a local resource, the client application cannot resolve to the resource through a JNDI
lookup. Instead the client application must explicitly create the connection to the resource using the
appropriate API (JDBC, Java Message Service (JMS), and so on). This client does not perform
initialization of any of the services that the client application might require. For example, the client
application is responsible for the initialization of the naming service, either through CosNaming or JNDI
APls.

The pluggable application client offers access to most of the available client services in the J2EE
application client. However, you cannot access the services in the pluggable client as easily as you can in
the J2EE application client. The J2EE client has the advantage of performing a simple Java Naming and
Directory Interface (JNDI) name space lookup to access the desired service or resource. The pluggable
client must code explicitly for each resource in the client application. For example, looking up an enterprise
bean Home object requires the following code in a J2EE application client:

java.lang.Object ejbHome = initialContext.lookup("java:/comp/env/ejb/MyEJBHome"
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome,
MyEJBHome.class);

However, you need more explicit code in a Java pluggable application client:

java.lang.Object ejbHome = initialContext.lookup("the/fully/qualified
/path/to/actual/home/in/namespace/MyEJBHome") ;
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome,
MyEJBHome.class);

In this example, the J2EE application client accesses a logical name from the java:/comp name space.
The J2EE client run time resolves that name to the physical location and returns the reference to the client
application. The pluggable client must know the fully qualified physical location of the enterprise bean
Home object in the name space. If this location changes, the pluggable client application must also change
the value placed on the lookup() statement.
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In the J2EE client, the client application is protected from these changes because it uses the logical name.
A change can require a redeployment of the EAR file, but the actual client application code remains the
same.

The pluggable application client is a traditional Java application that contains a main function. The
WebSphere pluggable application client provides run-time support for accessing remote enterprise beans,
and provides the implementation for various services (security, Workload Management (WLM), and
others). This client can also access CORBA objects and CORBA-based services. When using both
environments in one client application, you need to understand the differences between the enterprise
bean and the CORBA programming models to manage both environments.

For instance, the CORBA programming model requires the CORBA CosNaming name service for object
resolution in a name space. The enterprise beans programming model requires the JNDI name service.
The client application must initialize and properly manage these two naming services.

Another difference applies to the enterprise bean model. Use the Java Naming and Directory Interface
(JNDI) implementation in the enterprise bean model to initialize the Object Request Broker (ORB). The
client application is unaware that an ORB is present. The CORBA model, however, requires the client
application to explicitly initialize the ORB through the ORB.init() static method.

The pluggable application client provides a batch command that you can use to set the CLASSPATH and
JAVA_HOME environment variables to enable the pluggable application client run time.

Migration tips for application clients

Tips for migrating thin application client code:

The Java invocation used to run non-J2EE application clients has changed in Version 5.0. You must

specify -Xbootclasspath/p:%WAS_BOOTCLASSPATH% on Windows systems or

-Xbootclasspath/p:$WAS _BOOTCLASSPATH on UNIX systems when you invoke the Java command. Set the

WAS_BOOTCLASSPATH environment variable in one of the following:

* setupClient.bat for Windows systems or setupClient.sh for UNIX systems on a WebSphere
Application Server client installation.

* setupCmdLine.bat for Windows systems or setupCmdLine.sh for UNIX systems on a WebSphere
Application Server installation.

For more information about using -Xbootclasspath, view sample code at the following path after you
preform the application client installation:

install_root\samples\bin\ActiveXBridgeClients\VB\XJBExamples\modXJBHelpers.bas
Tips for migrating J2EE application client code:
If your J2EE application client uses resource references and you configured those resources using the

Application Client Resource Configuration Tool (ACRCT), you must run the ClientUpgrade command to
migrate the resource configuration information in WebSphere Application Server Version 5.

Installing application clients

All client applications run on a machine with the WebSphere Application Server installed. However, if the
system does not have the Application Server installed, you can install Application Server clients, which

provide a stand-alone client run-time environment for your client applications. See the [Supported
—

rerequisites| page on the IBM external Web site for more information on supported product platforms.

This article describes how to install the WebSphere Application Server clients using the installation image
on the product CD-ROM labelled, Application Clients. The CD-ROM is not available for WebSphere
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Application Server for z/OS. The steps that follow provide enough detail to guide you through preparing
for, choosing, and installing the variety of options and features provided. To prepare for installation and to
make yourself familiar with installation options, complete the steps in this article and read the related
topics, before you start to use the installation tools. Specifically, read these topics before installing the
product:

+ |Installing silently|
« |Best practices for installing|

As a general rule, if you launch an installation and there is a problem such as not having enough
temporary space or not having the right packages on your Linux or UNIX-based systems, then cancel the
installation, make the required changes, and restart the installation to pick up changes you made.

Although it is not supported or recommended, you can install this product as a non-root user on a UNIX
operating system, or from a user ID that is not part of the Administrator group on a Windows platform.
However, there are certain components, such as the Embedded Messaging Client feature, that require you
to install as root or as part of the Administrator group.

As previously mentioned, this installation method is not supported or recommended, but you can install the
application client product on a machine with WebSphere Application Server installed. However, there are
certain components, such as the Embedded Messaging Client feature, which might not install if the feature
has already been installed during the WebSphere Application Server installation. On Windows platforms,
WebSphere Application Server clients assume that the Embedded Messaging Client is installed in its
default location; whereas, the WebSphere Application Server installation can install the messaging client in
a different location.

1. Prepare a Linux or UNIX operating platform for the Embedded Messaging Client feature.

If you are installing the embedded messaging feature, you must create two operating system groups
as described in "Installing WebSphere embedded messaging as the JMS provider” in the information
center.

The Solaris Operating Environment and HP-UX also require you to increase kernel settings as
described in "Installing WebSphere embedded messaging as the JMS provider” in the information
center.

2. Start the installation.

a. lIssue launchpad.sh (or launchpad.bat) to initiate the launchpad tool and begin the installation
process.

b. Click Install the product from the launchpad tool to launch the InstallShield for MultiPlatforms
installation wizard. This action launches the installation wizard.

The Readme documentation to which the launchpad links is the readme.html file in the CD root
directory. The readme directory off the root of the CD has more detailed Readme files. The
Installation Guide is in the /docs directory of the CD root directory.

When you install application clients, the current working directory must be the directory where the
installer binary program is located. This placement is important because the resolution of the
class files location is done in the current working directory. For example:

cd /install_root
./install

or when installing from the product CD-ROM:

cd <CD mount point>
./install

Failing to use the correct working directory can cause ISMP errors that abort the installation.

The installation wizard does not upgrade or remove previous WebSphere Application Server
clients installation automatically. However, you must uninstall any previous installation manually or
the installation wizard aborts the installation.
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c. As indicated in the previous example, you can start the installation wizard from the product
CD-ROM, using the command line. The installation program is in the operating system platform
directory on the product CD-ROM.

On other Linux platforms and UNIX-based platforms, run the ./install command.
On Windows platforms, run the Install.exe command.

d. You can also perform alsilent installation| using the -options responsefile parameter, which
causes the installation wizard to read your responses from the options response file, instead of
from the interactive graphical user interface. Customize the response file before installing silently.
After customizing the file, issue the command to silently install. Silent installation is particularly
useful if you install the product often.

The rest of this procedure assumes that you are using the installation wizard. There are
corresponding entries in the response file for every prompt that is described as part of the wizard.
Review the description of the response file for more information. Comments in the file describe
how to customize its options.

3. Click Next to continue when the Welcome panel is displayed. The license displayed during the GUI
installation can contain characters that display incorrectly in Japanese. For example, the section
labeled Part 1 does not show the number 1. These missing characters do not significantly affect the
content of the license agreement.

a. Click the radio button beside the | accept the terms in the license agreement message if you
agree to the license agreement, and click Next to continue.

4. Choose a type of installation, and click Next.

If you use the GUI, you can choose a Typical installation type, which installs J2EE and Java Thin
Application Client, Samples and Embedded Messaging Client features, or a Custom installation type.

The Custom installation type lets you select which features to install. However you can not install the
J2EE and Java Thin Application Client feature and the Pluggable Application Client feature together.

(Windows Only) If you select the ActiveX to EJB Bridge feature, then the following is displayed in a
dialog box: Do you want to add Java runtime to the system path and make it the default JRE? If
you answer Yes, then the Java run time is added to the beginning of the system path. If you answer
No, then the ActiveX to EJB Bridge does not function from the Active Server Pages (ASP), unless
you add the Java run time to the path. To add the Java run time later, see the topic
[application clientd| or reinstall Application clients.(Windows Only) If you select the Applet Client
feature, then the following message might be displayed: An existing JDK or JRE has been detected
on your computer. You chose to install the Applet Client, which will overwrite the registry
entries for this JDK or JRE. Do you want to continue and install the Applet Client? If you
select Yes, the installation overrides the registry on your machine. If you select No, the applet client
feature is not installed, and you are directed back feature dialog box.

5. Install the samples development environment. If you choose to install any of the Samples features, a
message box is displayed requesting conformation to install the Samples development environment.

a. Click Yes to install the Samples development environment that includes the IBM Developer Kit
and the Apache Ant Tool.

b. Click No to skip installing the Samples development environment.
6. Specify a destination directory. Click Next to continue.
a. Ensure that there is adequate space available in the target directory.

b. Specify a target directory for the WebSphere Application Server clients product. If you install the
Embedded Messaging Client feature, then you cannot change its default installation directory.

c. Enter the required target directory to proceed to the next panel. Deleting the default target location
and leaving an installation directory field empty prevents you from continuing the installation
process.
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7. Enter the host name of the WebSphere Application Server machine. Click Next to continue. If you are
connecting to a product Version 4 server or you are not using the default port, you must specify the
server port number. The default port number for product Version 4 server is 900, and the default port

number for product Version 5 is 2809.

8. Review the summary information, and click Next to install the product code or you might also click
Back to change your specifications. When the installation is complete, the wizard displays the
install_root\logs\mq_install.log installation log, if you selected the Embedded Messaging Client
feature, and there are errors with its installation.

9. Review the mq_install.log installation log, if it appears. Click Next to continue.

10. Click Finish to exit the wizard, after the WebSphere Application Server client installs.

You successfully installed WebSphere Application Server clients and the features you selected.

If the installation is not successful, fix the error as indicated in the installation error message. For example,
if you do not have enough disk space, add more space, and reinstall application clients.

Best practices for installing application clients

The following table offers tips for installing

application clients on multiple platforms.

Operating environment

Tip

Linux and UNIX systems

Spaces are not supported in the name of the installation directory on
Linux and UNIX platforms.

UNIX systems

When client application installations are successful, the return code 1
is issued from the UNIX shell where you issued the /install
command. Any other return code indicates an unsuccessful
installation.

Solaris systems

Double-byte character set (DBCS) characters are not supported in the
name of the installation directory on Solaris systems.

Windows NT systems

Spaces are not supported in the name of the installation directory.
Note: WebSphere Application Server Version 5.1 does not support
the Windows NT platform.

All platforms Reserve at least 4 to 5MB free space in the target platform temporary
directory.
All platforms When specifying a different temporary directory while installing

application clients, the following message is displayed if the target
platform default temporary directory does not have enough free space
to install application clients:

Error writing file = There may not be enough
temporary disk space.

Try using -is:tempdir to use a temporary
directory on a partition with more disk
space.

Use the -is:tempdir installation option to specify a different
temporary directory. For example, the following command uses /swap
as a temporary directory during installation:

./install -is:tempdir /swap

198 1BM WebSphere Business Integration Server Foundation for z/OS V5.1:: Applications




All platforms After the installation, when changing the installation settings for the
WebSphere Application Server host name and the port number, edit
the setupClient.bat for Windows or setupClient.sh for UNIX.
Change the DEFAULTSERVERNAME and SERVERPORTNUMBER to the new
WebSphere Application Server host name and port number,
respectively. If the SERVERPORTNUMBER is not set, then the default is
2809. Review the following example:

set DEFAULTSERVERNAME=NDServerName

set SERVERPORTNUMBER=9810

The setupClient.bat file or setupClient.sh file is located in the bin
sub-directory under the application clients installation destination.

Using the Konqueror file in the K Desktop Environment 5.1+

When starting the Launchpad program for WebSphere Application Server clients, Version 5.1 using the
Konqueror file manager in the K Desktop Environment (KDE) on Linux systems, a "Could not find the
program launchpad.sh” error occurs.

Because the Taunchpad.sh command uses a relative path to locate the Java program, you should run the
launchpad.sh command from the directory where the Taunchpad.sh command is located. When using the
Konqueror file manager to issue the Taunchpad.sh command, the current directory is your home directory,
and therefore, the Taunchpad.sh command does not function.

Do not use the Konqueror file manger to issue the Taunchpad.sh command. Open a Konsole session in
the KDE, change the current directory to where the Taunchpad.sh command is located, and then run the
launchpad.sh command.

Installing application clients silently

Use these steps to perform a silent installation, which uses the installation wizard to install the product.
Instead of displaying a user interface, the silent installation provides interaction between you and the
wizard by reading all of your responses from a file that you must customize.

1. Ensure that the user ID that you are using to run the silent installation has sufficient authority to
perform the task.

If you are installing the embedded messaging feature, you must create two operating system groups
as described in the article, "Installing WebSphere embedded messaging as the JMS provider” in the
information center.

Although it is not supported or recommended, you can install this product as a non-root user on a
UNIX-based operating system, or from a user ID that is not apart of the Administrator group on a
Windows platform. However, there are certain components, such as the Embedded Messaging Client
feature, that require you to install as root or as part of the Administrator group.

2. Customize the option response file.

a. Locate the sample options response file. The file name is setup.response in the operating system
platform directory on the product CD-ROM.

Make a copy to preserve the original response file. For example, copy the file as myoptionsfile.

Edit the copy in your flat file editor of choice, on the target operating system. Read the directions
within the response file to choose appropriate values.

Note: To prepare the file for a silent installation on AlX, use UNIX line-end characters (0xODOA) to
terminate each line of the options response file.

d. Make the first non-commented option -silent to have a silent install.
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e. Include custom option responses that reflect parameters for your system.
f. Follow the instructions in the response file to choose appropriate values.
g. Save the file.

3. Issue a command to use your custom response file: Install.exe -options myoptionsfile for
Windows platforms install -options ./myoptionsfile for Linux and UNIX platforms

The sample options response file is located in the operating-system platform directory on the product
CD-ROM.

4. Optional: Restart your machine in response to the prompt that appears on Windows platforms. If you
install the Embedded Messaging Client feature, -P JSMSupport.active="true"”, certain conditions, such
as a locked file, might require you to restart your system. You have the option of restarting
immediately, after which the installation program resumes the installation process. You can also defer
restarting to a more convenient time, such as after the installation is complete.

You installed application clients silently by using the response file.

To further verify that the silent installation was successful, examine the WAS.Client.Install.1og file for a
line similar to:

The InstallShield Wizard has successfully installed IBM WebSphere Application Server clients, Version 5.1.

If you installed the Embedded Messaging Client feature, you can search the mq_install.log for any
errors.

Developing J2EE application client code

A J2EE application client program operates similarly to a standard J2EE program in that it runs its own
Java virtual machine (JVM) code and is invoked at its main method.

A J2EE application client program operates similarly to a standard J2EE program in that it runs its own
ASCII Java virtual machine code and is invoked at its main method. This JVM run-time environment is part
of the client container, which provides the following services for the application client:

» Security

* Communications protocol support (for RMI/IIOP, HTTP, and so on)

* Naming support

The Java Virtual Machine application client program differs from a standard Java program because it uses
the Java Naming and Directory Interface (JNDI) namespace to access resources. In a standard Java
program, the resource information is coded in the program.

Storing the resource information separately from the client application program makes the client application
program portable and more flexible.

1. Write the client application program. Write the J2EE application client program on any development
machine. At this stage, you do not require access to the WebSphere Application Server.

Rules: If you are writing a client application program that will run on z/OS, the following rules apply:

» Client programs may start their own transactions but cannot join in or start transactions in the
WebSphere Application Server for z/OS run-time.

» Application client code must contain a main method.

« All input and output files for the application client must be in ASCII, because the client run-time runs
in an ASCIl JVM.

Using the javax.naming.InitialContext class, the client application program uses the look-up
operation to access the Java Naming and Directory Interface (JNDI) namespace. The InitialContext
class provides the Tookup method to locate resources.

The following example illustrates how a client application program uses the InitialContext class:
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import javax.naming.=

public class myAppClient

{

public static void main(String argv[])

{

InitialContext initCtx = new InitialContext();

Object homeObject = initCtx.lookup("java:comp/env/ejb/BasicCalculator");
BasicCalculatorHome bcHome = (BasicCalculatorHome)
javax.rmi.PortableRemoteObject.narrow(homeObject, BasicCalculatorHome.class);
BasicCalculatorHome bc = bcHome.create();

In this example, the program looks up an enterprise bean called BasicCalculator. The
BasicCalculator EJB reference is located in the client JNDI namespace at
java:comp/env/ejb/BasicCalculator . Since the actual Enterprise Java Bean run on the server, the
application client run time returns a reference to the BasicCalculator home interface.

If the client application program lookup was for a resource reference or an environment entry, then the
look up function returns an instance of the configured type as defined by the client application
deployment descriptor. For example, if the program lookup was a JDBC data source, the lookup would
return an instance of javax.sql.DataSource. Although you can edit deployment descriptor files, do not
use the administrative console to modify them.

2. |Assemble the application client using the Assembly Toolkit|

The JNDI namespace knows what to return on a lookup because of the information assembled by the

assembly tool.

Assemble the J2EE application client on any development machine with the assembly tool installed.

When you assemble your application client, provide the application client run time with the required

information to initialize the execution environment for your client application program.

Remember following when you configure resources used by your client application program:

* Resource environment references are different than resource references. Resource environment
references allow your application client to use a logical name to look-up a resource bound into the
server JNDI namespace. A resource reference allows your application to use a logical name to look
up a local J2EE resource. The J2EE specification does not specify a particular implementation of a
resource. The following table contains supported resource types and identifies the resources to
which the WebSphere Application Server provides a client implementation.

Resource Type Client Configuration Notes Client implementation
provided by WebSphere
Application Server
javax.sql.DataSource Supports specification of any No
data source implementation
class
java.net.URL Supports specification of Provided by Java Runtime
custom protocol handlers Environment files
javax.mail.Session Supports custom protocol Yes - POP3, SMTP, IMAP
configuration
javax.jms.QueueConnectionFactory, Supports configuration of Yes - WebSphere embedded
javax.jms.TopicConnectionFactory, javax.jms.Queue, = WebSphere embedded messaging
javax.jms.Topic messaging, IBM MQ Series
and other JMS providers

3. Assemble the Enterprise Archive (EAR) file.

The application is contained in an enterprise archive or .ear file. The .ear file is composed of:
» Enterprise bean, application client, and user-defined modules or .jar files
* Web applications or .war files
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* Metadata describing the applications or application .xm1 files
You must assemble the .ear file on the server machine.
4. Distribute the EAR file.
The client machines configured to run this client must have access to the .ear file.

If all the machines in your environment share the same image and platform, run the Application Client
Resource Configuration Tool (ACRCT) on one machine to configure the external resources, and then
distribute the configured .ear file to the other machines.

If your environment is set up with a variety of client installations and platforms, run the ACRCT for
each unique configuration.

You can either distribute the .ear files to the correct client machines, or make them available on a
network drive.

Distributing the .ear files is the responsibility of the system and network administrator.
5. |Dep|oy the application client.|
6. |Configure the application client resources|

If the client application defines the local resources, run the ACRCT (clientConfig command) on the
local machine to reconfigure the .ear file. Use the ACRCT to change the configuration. For example,
the .ear file can contain a DB2 resource, configured as C:\DB2. If, however, you installed DB2 in the
D:\Program Files\DB2 directory, use the ACRCT to create a local version of the .ear file.

7. Deploy the application client.

If you plan to deploy the client on z/OS or OS/390, you have two options for running the Application
Client Resource Configuration Tool (ACRCT):

+ |Run the ACRCT on Windows)} or

+ |Run the ACRCT scripting tool on z/OS |

Both of these options produce equivalent output; only the tool interfaces are different. The ACRCT on
Windows presents a graphical user interface, whereas the ACRCT for z/OS uses a scripting interface.

8. Use the WebSphere Administrative console to install the application client on z/OS or OS/390.

After developing the J2EE application client code, [launch the application clientl After completing these
steps, [launch the application client,

J2EE application client class loading

When you run your J2EE application client, a hierarchy of class loaders is created to load classes used by
your application.

The following list describes the hierarchy of class loaders:

» The topmost class loader, the bootstrap class loader, contains the JAR files that make up the Java
virtual machine code, such as rt. jar, plus those JAR files defined by the -Xbootclasspath parameter
on the Java command. The WebSphere application client run time sets this value to the
WAS_BOOTCLASSPATH environment variable.

* The extensions class loader class loader is a child to the bootstrap class loader. This class loader
contains JAR files in the java/jre/1ib/ext directory or those JAR files defined by the -Djava.ext.dirs
parameter on the Java command. The WebSphere application client run time does not set
-Djava.ext.dirs parameters, so it uses the JAR files in the java/jre/1ib/ext directory.

» The system class loader class loader contains JAR files and classes that are defined by the -classpath
parameter on the Java command. The WebSphere application client run time sets this parameter to the
WAS_CLASSPATH environment variable.

* The WebSphere class loader class loader loads the WebSphere application client run time and any
classes placed in the WebSphere application client user directories. The directories used by this class
loader are defined by the WAS_EXT_DIRS environment variable. The WAS_BOOTCLASSPATH, WAS_CLASSPATH,
and the WAS_EXT DIRS environment variables are set in the installation_root/bin/setupCmdLine
command shell for WebSphere Application Server installations, or in the
installation_root/bin/setupClient command shell for client installations.
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As the J2EE application client run time initializes, additional class loaders are created as children of the
WebSphere class loader. If your client application uses resources such as Java Database Connectivity
(JDBC) API, Java Message Service (JMS) API, or Uniform Resource Locator (URL), a different class
loader is created to load each of those resources. Finally, the application client run time sets the
WebSphere class loader to load classes within the .ear file by processing the client JAR manifest
repeatedly. The system class path, defined by the CLASSPATH environment variable is never used and is
not part of the hierarchy of class loaders.

To package your client application correctly, you must understand which class loader loads your classes.
When the Java code loads a class, the class loader used to load that class is assigned to it. Any classes
subsequently loaded by that class will use that class loader or any of its parents, but it will not use children
class loaders.

In some cases the WebSphere application client run time can detect when your client application class is
loaded by a different class loader from the one created for it by the WebSphere application client run time.
When this detection occurs, you see the following message:

WSCLO205W: The incorrect class loader was used to load [0]

This message occurs when your client application class is loaded by one of the parent class loaders in the
hierarchy. This situation is typically caused by having the same classes in the .ear file and on the hard
drive. If one of the parent class loaders locates a class, that class loader loads it before the application
client run time class loader. In some cases, your client application still functions correctly. In most cases,
however, you receive "class not found” exceptions.

Configuring the classpath fields

When packaging your J2EE client application, you must configure various class path fields. Ideally, you
should package everything required by your application into your .ear file. This is the easiest way to
distribute your J2EE client application to your clients. However, you should not package such resources as
JDBC APIs, JMS APIs, or URLs. In the case of these resources, use class path references to access
those classes on the hard drive. You might also have other classes installed on your client machines that
you do not need to redistribute. In this case, you also want to use classpath references to access the
classes on the hard drive, as described below.

Referencing classes within the EAR file

WebSphere product J2EE applications do not use the system class path. Use the MANIFEST Class path
entry to refer to other JAR files within the .ear file. Configure these values using the module Class path
fields in the Application Assembly Tool Assembly Toolkit. For example, if your client application needs to
access the path of the EJB JAR file, add the deployed enterprise bean module name to your application
client Class path field in the Assembly Tool. The format of the Class path field for each of the different
modules (Application Client, EJB, Web) is the same:

» The values must refer to .jar and .class files that are contained within the .ear file.

* The values must be relative to the root of the .ear file.

* The values cannot refer to absolute paths in the file systems.

» Multiple values must be separated by spaces, not colons or semi-colons.

Note: This is the Java method for allowing applications to function platform independent.

Typically, you add modules (. jar files) to the root of the .ear file. In this case, you only need to specify
the name of the module (.jar file) in the Class path field. If you choose to add a module with a path, you
need to specify the path relative to the root of the .ear file.

For referencing .class files, you must specify the directory relative to the root of the .ear file. With the
Assembly Tool you can add individual class files to the .ear file. It is recommended that these additional
class files are packaged in a . jar file. Add this . jar file to the module Class path fields. If you add .class
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files to the root of the .ear file, add ./ to the module Class path fields. Consider the following example
directory structure in which the file myapp.ear contains an application client JAR file named client.jar
and a mybeans. jar EJB module. Additional classes reside in classi.jar and utility/class2.zip files. A class
named xyz.class is not packaged in a JAR file but is in the root of the EAR file. Specify ./ mybeans.jar
utility/class2.zip class1.jar as the value of the Classpath property. The search order is:
myapp.ear/client.jar myapp.ear/xyz.class myapp.ear/mybeans.jar myapp.ear/utility/class2.zip
myapp.ear/classl.jar

Resource class paths

When you configure resources used by your client application using the Application Client Resource
Configuration Tool(ACRCT), or the z/OS ACRCT scripting tool, you can specify class paths that are
required by the resource. For example, if your application is using a JDBC to a DB2 database, add
db2java.zip to the class path field of the database provider. These class path values are platform-specific
and require semi-colons or colons to separate multiple values.

Using the launchClient API
If you use the TaunchClient shell and bat command, the WebSphere class loader hierarchy is created for

you. However, if you use the TaunchClient API, you must perform this setup yourself. Copy the
TaunchClient shell command in defining the Java system properties.

Developing pluggable application client code

As you prepare to install the pluggable application client, remember that pluggable clients are only
available on Windows systems.

1. Install the pluggable application client from the WebSphere Application Client CD by selecting option
Pluggable Application Client from the Custom client installation panel.

2. Set the Java application pluggable client environment by using the setupClient shell, located in:
install_root\AppClient\bin\setupClient.bat

3. Add your specific Java client application JAR files to the CLASSPATH and start your Java client
application from this environment, after setting the environment variables.

4. Run the following Java command to invoke your client application:

%JAVA_HOME%/bin/java -Xbootclasspath/p:%WAS_BOOTCLASSPATH% -classpath

<list of your application jars and classes> -Djava.ext.dirs=%WAS_EXT_DIRS%
-Djava.naming.provider.url=iiop://<your WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
%SERVER_ROOT% %CLIENTSAS% <fully qualified class name to run>

$JAVA_HOME/bin/java -Xbootclasspath/p:$WAS BOOTCLASSPATH -classpath

<list of your application jars and classes> -Djava.ext.dirs=$WAS_EXT DIRS
-Djava.naming.provider.url=iiop://<your WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
$SERVER ROOT $CLIENTSAS <fully qualified class name to run>

View the Samples Gallery for more information about application clients. Before you run the
basicCalculator Sample, ensure the JMS Server is started.

These samples do not include client applications that communicate with Enterprise server-side examples.

Assembling application clients

Assemble a client module to contain |app|ication cIient| code. Group enterprise beans, Web components,
and resource adapter code in separate modules.
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Application client projects contain programs that run on networked client systems. An application client
project is deployed as a JAR file.

Use the |Assembly Toolkif to assemble an application client module in any of the following ways:
* Import an existing application client JAR file.
» Create a new application client module.

1. [Start the Assembly Toolkit,

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

3. Optional: Open the J2EE Hierarchy view. Click Window > Show View > J2EE Hierarchy. Other
helpful views include the Project Navigator view (Window > Show View > Other > J2EE > Project
Navigator) and the Navigator view (Window > Show View > Navigator).

4, 5% Optional: To use application assembly services of WebSphere Business Integration (WBI) Server

Foundation such as|AppIication profilind, select the Integration Server target server.

a. Click Project > Properties > J2EE.

b. For Target server, select Integration Server. For this release, Integration Server v5.1.
c. Click OK.

You can set values for WBI Server Foundation services on the Extended Services tab of a
deployment descriptor editor open on the module.

5. |Migrate application client JAR files|created with the Application Assembly Tool (AAT) or a different tool
to the Assembly Toolkit. To migrate files, jmport your application client JAR files|to the Assembly
Toolkit.

6. |Create a new application clienf.
7. Verify the contents of the new application client in either of the following ways:
* In the J2EE Hierarchy view, expand Application Client Modules and view the new module.

» Click Window > Show View > Navigator to see the associated files for the application client
module in a Navigator view.

After you finish assembling all of your application’s modules, you are ready to deploy your application.

After you finish assembling all of your application’s modules, you are ready to deploy your application:
« [On Windows} or
+ [On z/OS or 0S/390}

Deploying application clients on z/0S

For J2EE application clients that will run on z/OS or OS/390, you may use one of the following options to
define resources:

+ |Run the Application Client Resource Configuration Tool (ACRCT) on Windows]

* Run the Application Client Resource Configuration Tool (ACRCT) scripting tool on z/OS.

Both options produce identical output with one possible exception: the sequence in which resource
definitions are stored in the Enterprise Archive (EAR) file of the application client. The client container on
z/OS uses these resource definitions for resolving and creating an instance of the resources for the
application client.

Before you begin: Make sure you have completed the following tasks:

1. [Develop the J2EE application client according to guidelinesl.

2. [Assemble the application client

3. Find out what resources are available on the z/OS system on which you will install the client. These
resources include:

Chapter 7. Using application clients 205



* Enterprise beans

* JMS message resources

« JDBC databases

» Java Mail providers

* Environment entries (native types)

* URLs

Decide whether you want to provide resource properties for the ACRCT scripting tool on the command
line or through an input file. If you do not specify required properties, the ACRCT scripting tool issues
an error message to the MVS console and ends its processing.

Recommendation: |Determine which resource or provider properties are requiredl
. |Use the administrative console to install the application client on z/OS or 03/390|.

(Optional) Set up a plain text input file to provide on the command line when you start the ACRCT
scripting tool.

Rules:

» Each line in the input file may contain only one key and value pair that defines a property of the
resource to be configured.

» For each resource to be configured, [determine which resource or provider properties are required,

+ Follow the syntax rules explained in|Application Client Resource Configuration Tool (ACRCT)|
[Scripting tool for z/OS|

* You may define your own properties for the resource, using the format property.name=value.

Sample: Input file for a data source provider:

providertype=DataSourceProvider
providername=DB2UDBV7
name="PolicyDatasource”
description="Datasource for Policy App”
jndiname=jdbc/PolicyDS
databasename=POLICYAPP
user=dbuser

password=dbpw

reenterpassword=dbpw
property.my.resource.property.one=value1
property.my.resource.property.two=value2

On z/OS or OS/390, start the ACRCT scripting tool by invoking the shell script clientConfig in the UNIX
System Services (USS) environment.

Example:
/usr/1pp/WebSphere/V5ROMO/bin/c1ientConfig.sh

Rule: You must specify the application client’s Enterprise Archive (EAR) file on the command line. You

may either specify resource parameters directly on the command line, or specify an input file. The

syntax and parameter descriptions appear in|Application Client Resource Configuration Tool (ACRCT)|

[Scripting tool for /OS]

 If the resource parameters are properly specified, the ACRCT scripting tool updates the application
client’s client-resources.xmi file with appropriate resource definitions.

« If the resource parameters are not properly specified or are missing, the ACRCT scripting tool
issues an error message to the MVS console, and ends its processing.

Tip: If you receive an error message in response to the invocation, consider using the help function
described in IAppIication Client Resource Configuration Tool (ACRCT) Scripting tool for z/OSI

When the scripting tool successfully completes, the application client’s EAR file is updated with the
appropriate resource definitions.

When you have finished defining or updating the application client’s resources, [launch the application|
client
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Application Client Resource Configuration Scripting tool for z/0S

This section describes the command line syntax for the z/OS scripting version of the Application Client
Resource Configuration Tool (ACRCT). The ACRCT scripting tool for z/OS allows you to:

» Define or delete resources for an application client that will run on z/OS.

» List the properties of a resource or provider that is already defined for the application client.

For define and delete actions, the ACRCT scripting tool alters the Enterprise Archive (EAR) file for the
application client, as instructed by options you specify. If the ACRCT scripting tool encounters an error at
any time during its processing, the tool issues an error message to the MVS console and terminates
without changing the original contents of the application client EAR file.

When you use the ACRCT scripting tool, you may specify:
* More than one action (define, delete, or list) to perform for a specific application client.
* More than one EAR file, to define or delete resources for more than one application client at a time.

The command line invocation syntax for the ACRCT scripting tool follows. When you have a choice of one
required keyword, those keywords appear within brackets [].
» To define or delete resources:

acrct -earfile earfile [-define | -delete] [-provider | -resource]
[-f inputfile | key=value]
* To list resources:

acrct -list [-provider | -resource] [-f inputfile | -p key=value]
* To get help information:
acrct -help

Parameters

where:

-earfile
Is a required parameter that indicates the input filename of the application client EAR file.

earfilename
Identifies the location and name of the EAR file that contains the application client. This path and
filename must directly follow the -earfile parameter.

-define
Instructs the scripting tool to define a provider or resource based on the input properties.
-delete
Instructs the scripting tool to delete a provider or resource based on the input properties.
-list
Instructs the scripting tool to the properties of a particular provider or resource, based on the input
properties.
-help
Instructs the scripting tool to list basic examples and guidelines for using quotes around key values.
-provider
Indicates that the object to be defined or deleted, or for which properties are to be listed, is a provider.
-resource
Indicates that the object to be defined or deleted, or for which properties are to be listed, is a
resource.

-f Indicates that the input properties for the provider or resource are provided in an input file, rather than
specified directly on the command line.
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inputfile
Identifies the location and name of the input file that contains the provider or resource properties. This
path and filename must directly follow the -f parameter.

key=value
Specifies an input property for the provider or resource, in the form of key and value pairs.

Rules:

* You must use lowercase for keys.

* You cannot use blanks within a key and value pair; a blank signals the end of one key/value pair.

* Because blanks separate key and value pairs, you must be careful when a value you supply
contains blanks. When you specify a value that contains blanks, enclose the value in single quotes
or double quotes. Because some shells processes quotes differently, you might have to do some
testing to determine whether you must use single or double quotes.

Example: Suppose you invoke the scripting tool, passing this input:

/WebSphere/VV5ROMO0/AppServer/bin:>acrct -earfile
usr/lpp/myapps/applclient2.ear -define
-provider providername="WebSphere JMS Provider

The response is an error message along with an echo of the input string that the shell receives,
followed by the input string as the scripting tool will process it:

-earfile usr/lpp/myapps/applclient2.ear -define
-provider providername=WebSphere JMS Provider

String to be parsed by the Scripting Tool:

-earfile usr/lpp/myapps/applclient2.ear -define
-provider providername=WebSphere JMS Provider

Ear file is missing or is improperly specified.
Invalid syntax: -earfile usr/lpp/myapps/applclient2.ear -define -provider providername=WebSphere JMS Provider
As you can see from the response, the shell has stripped off the single quotes, and passes invalid
input to the scripting tool. To correct the problem, you need to use double quotes.

* The number of key and value pairs you specify depends on the type of resource or provider you are
configuring. For each resource to be configured, use this information to |[determine which resource of
[provider properties are required|

The following examples demonstrate correct syntax:
Defining a new provider for an application client, using an input file:
acrct -earfile usr/l1pp/myapps/applclientl.ear -define -provider -f
usr/1pp/myapps/inputProviderl.def
Defining a new provider for an application client, specifying properties directly on the command
line: acrct -earfile usr/lpp/myapps/appiclient2.ear -define -provider -p
providertype=DataSourceProvider name=DB2UDBV7
Defining a new provider and deleting the resource it replaces, in the same EAR file:
acrct -earfile usr/1pp/myapps/applclientl.ear -define -provider -f
usr/1pp/myapps/inputProvider2.def -delete -resource -f usr/1pp/myapps/inputProviderl.def
Defining a new provider in more than one EAR file:
acrct -earfile usr/l1pp/myapps/applclientl.ear -define -provider -f
usr/Tpp/myapps/inputProvider2.def -earfile usr/Tpp/myapps/applclient2.ear -define
-provider -f usr/1pp/myapps/inputProvider2.def
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Determining required properties for z/OS application client resources

When you deploy application clients on z/OS or OS/390, you need to determine the required properties to
specify when using the z/OS scripting version of the Application Client Resource Configuration Tool

(ACRCT).

Note: This procedure applies only for J2EE application clients.
Use the following information to determine required properties to specify for application client resources.

If the application uses this type of resource or
provider:

Find required and optional properties in these
articles:

Data source

+ |Datasource Provider

. Datasource|

JMS « UMS Provideﬂ
* UMS Connection
* UJMS Destination

Mail session e [Mail provider|

* [Mail session

Resource environment

« [Resource environment provider|
+ |Resource environment entry|

URL

* |URL provider
* |URL facto

WebSphere MQ queue

» |WebSphere MQ queue connection factory|
» [WebSphere MQ queue destination factory

WebSphere MQ topic

» [WebSphere MQ topic connection factory
« |WebSphere MQ topic destination factory|

WebSphere queue

» [WebSphere queue connection factory
» [WebSphere queue destination factory

WebSphere topic

» [WebSphere topic connection factory
» [WebSphere topic destination factory

Properties for data source providers

name required
description optional
implementation optional
classpath optional
Properties for data sources

providertype=DataSourceProvider required
providername required
name required
description optional
jndiname required
databasename optional
user optional
password optional
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providertype=DataSourceProvider
providername=DB2UDBV7
name="PolicyDatasource”
description="Datasource for Policy App”
jndiname=jdbc/PolicyDS
databasename=POLICYAPP

user=dbuser
password=dbpw

Properties for JMS providers

name required

description optional

classpath optional

externalinitialcontextfactory optional

externalproviderurl optional

Properties for JMS connections

providertype=JMSProvider required

providername required

name required

description optional

jndiname required

externaljndiname optional

type required Valid values are:
* QUEUE
+ TOPIC

user optional

password optional

Properties for JMS destinations

providertype=JMSProvider required

providername required

name required

description optional

jndiname required

externaljndiname optional

type required Valid values are:
* QUEUE
« TOPIC

Properties for mail providers

name required

description optional
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| classpath

optional

Properties for mail sessions

providertype=MailProvider required
providername required
name required
description optional
jndiname required
mailfrom optional
mailstorehost optional
mailstoreuser optional
mailstorepassword optional
mailtransporthost optional
mailtransportprotocol required Valid values are:
+ smtp
* imap
* pop3
mailtransportuser optional
mailtransportpassword optional
debug required Valid values are True or False.

Properties for resource environment providers

name required
description optional
classpath optional

Properties for resource environment entries

providertype=ResourceEnvironmentProvider required
providername required
name required
description optional
jndiname required
Properties for URL providers

name required
description optional
protocol optional
classpath optional
streamhandlerclass optional

Chapter 7. Using application clients

211




Properties for URL factories

providertype=URLProvider required
providername required
name required
description optional
jndiname required
url required

Properties for WebSphere MQ queue connection factories

providertype=JMSProvider required

providername="MQ JMS Provider” required

name required

description optional

jndiname required

transporttype required Valid values are:
* CLIENT
« BINDINGS

clientid optional

user optional

password optional

channel optional

ccsid optional

Properties for WebSphere MQ queue destination factories

providertype=JMSProvider required
providername="MQ JMS Provider” required
name required
description optional
jndiname required
persistence required Valid values are:
* APPLICATION_DEFINED
* QUEUE_DEFINED
* PERSISTENT
* NONPERSISTENT
priority required Valid values are:
* APPLICATION_DEFINED
* QUEUE_DEFINED
» specified_integer from 0 through
9
expiry required Valid values are:
* APPLICATION_DEFINED
¢ UNLIMITED
» specified_value
basequeuename required
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basequeuemanagername optional

targetclient required Valid values are:
- JMS
« MQ

ccsid optional

usenativeencoding required Valid values are:

¢ True
* False

Properties for WebSphere MQ topic connection factories

providertype=JMSProvider required

providername="MQ JMS Provider” required

name required

description optional

jndiname required

transporttype required Valid values are:
* CLIENT
+ BINDINGS

clientid optional

brokercontrolqueue optional

brokerqueuemanager optional

brokerpubqueue optional

brokersubqueue optional

brokerccsubq optional

brokerversion required Valid values are:
+ MAOC
+ MQ@slI

userid optional

password optional

ccsid optional

channel optional

Properties for WebSphere MQ topic destination factories

providertype=JMSProvider required
providername="MQ JMS Provider” required
name required
description optional
jndiname required
persistence required Valid values are:

* APPLICATION_DEFINED
* QUEUE_DEFINED

* PERSISTENT

* NONPERSISTENT
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priority required Valid values are:
* APPLICATION_DEFINED
* QUEUE_DEFINED
« specified_integer from 0 through
9
expiry required Valid values are:
* APPLICATION_DEFINED
¢ UNLIMITED
« specified_value
basetopicname required
targetclient required Valid values are:
« JMS
- MQ
brokerdursubqueue optional
brokerccdursubqueue optional
ccsid optional
usenativeencoding required Valid values are:

¢ True
* False

Properties for WebSphere queue connection factories

providertype=JMSProvider required
providername="WebSphere JMS Provider” required
name required
description optional
jndiname required
node required
servername required
user optional
password optional

Properties for WebSphere queue destination factories

providertype=JMSProvider required

providername="WebSphere JMS required

Provider”

name required

description optional

jndiname required

node required

persistence required Valid values are:

* APPLICATION_DEFINED
* PERSISTENT
* NONPERSISTENT
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priority required Valid values are:
* APPLICATION_DEFINED
» specified_integer from 0 through
9
expiry required Valid values are:

« APPLICATION_DEFINED
< UNLIMITED
» specified_value

Properties for WebSphere topic connection factories

providertype=JMSProvider required

providername="WebSphere JMS required

Provider”

name required

description optional

jndiname required

servername required

node required

port required Valid values are:
* QUEUED
* DIRECT

clientid optional

userid optional

password optional

Properties for WebSphere topic destination factories

providertype=JMSProvider required
providername="WebSphere JMS required
Provider”
name required
description optional
jndiname required
topic required
persistence required Valid values are:
* APPLICATION_DEFINED
* PERSISTENT
* NONPERSISTENT
priority required Valid values are:
* APPLICATION_DEFINED
» specified_integer from 0 through
9
expiry required Valid values are:

* APPLICATION_DEFINED
* UNLIMITED
* specified_value
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Deploying application clients on workstation platforms

After developing an application client, deploy this application on client machines. Deployment consists of
pulling together the various artifacts that the application client requires.

If you plan to deploy the client on z/OS or OS/390, you have two options:
* Run the Application Client Resource Configuration Tool (ACRCT) on Windows, or
Run the Client Container Resource Configuration Scripting tool on z/OS)

Both of these tools produce equivalent output. They both provide resource definitions for an application
client, which are stored in the application client .ear file. The application client run time (or container) uses
these configurations for resolving and creating an instance of the resources for the application client.

Note: This task only applies to J2EE application clients. Only perform this task if you configured your
J2EE application client to use resource references.

1. [Start the ACRCT and open an EAR file |

2. [Configure new data source providers]

3. [Configure mail providers and sessions.|

4. [Configure URL providers and sessions.|

5. |Configure Java messaging client resources
6

7

8

. [Configure new environment entries.|
. ((Optional) Remove application client resources.|
Save the EAR file.

Starting the Application Client Resource Configuration Tool and
opening an EAR file

Note: This task only applies to J2EE application clients.
1. Open a command prompt and change to the install_root\bin directory.
2. Run the clientConfig.bat file for a Windows system .

3. Open an EAR file within the Application Client Resource Configuration Tool (ACRCT):
* Click File > Open.
» Select the file and click Open.

4. Save your changes to the file and close the tool:
* Click File > Save.
» Click File > Exit.

Data sources for application clients

The J2EE application client does not support looking up or directly accessing data sources configured on
WebSphere Application Server because the J2EE application client does not support Java 2 Connection
Factories. To use a data source directly from the client application, you must use the ACRCT to configure
your data source. In addition, WebSphere Application Server and WebSphere Application Server clients do
not provide client database drivers to be used directly from a J2EE application client. If your application
client accesses a database directly, you must provide the database drivers on the client machine. You
might contact your database vendor to acquire client database driver code and licenses. Instead of
accessing the database directly, it is recommended that your client application use an enterprise bean.
Accessing a database through an enterprise bean eliminates the need to have database drivers on the
client machine, since the database access is handled by the enterprise bean running on the WebSphere
Application Server. For a current list of providers that are supported on the WebSphere Application Server
go the following site:
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[Supported hardware, software, and APIs|

Configuring new data source providers (JDBC providers) for
application clients

During this task, you create new data source providers, also known as JDBC providers, for your
application client. In a separate administrative task, install the Java code for the required data source
provider on the client machine on which the application client resides.

1. Start the tool and open the EAR file for which you want to configure the new data source provider. The
EAR file contents display in a tree view.

2. Select the JAR file in which you want to configure the new data source provider from the tree.
Expand the JAR file to view its contents.

4. Click the Data Source Providers folder. Do one of the following:
* Right-click the folder and click New Provider.
* Click Edit > New on the menu bar.

5. Configure the data source provider properties in the resulting property dialog.
6. Click OK when you finish.
7. Click File > Save on the menu bar to save your changes.

w

Configuring new data source providers

During this task, you will create new data source providers, also known as JDBC drivers, for your
application client. In a separate administrative task, install the Java code for the required data source
provider on the client machine where the application client resides.

1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Click File > Open, and select the EAR file for which you want to configure the new data source
provider. The EAR file contents display in a tree view.

Select the JAR file in which you want to configure the new data source provider from the tree.
Expand the JAR file to view its contents.

Right click the Data Source Providers folder and select New Provider.

Configure the data source provider properties in the resulting property dialog.

Click OK.

Click File > Save to save your changes.

©® N o oA~

Example: Configuring data source provider and data source settings: The purpose of this article is
to help you to configure data source provider and data source settings.
* Required fields:
— Data Source Provider Properties page: name
— Data Source Properties page: name, jndiName
* Special cases:
— The user name and password fields have no equivalent XMl tags. You must specify these fields in
the custom properties.
— The password is encrypted when you use the Application Client Resource Configuration Tool
(ACRCT). If you do not use the ACRCT the field cannot be encrypted.
* Example:
<resources.jdbc:JDBCProvider xmi:id="JDBCProvider 1" name="jdbcProvider:name"
description="jdbcProvider:description" implementationClassName="jdbcProvider:
ImpTlementationClass">
<classpath>jdbcProvider:classPath</classpath>
<factories xmi:type="resources.jdbc:WAS40DataSource" xmi:id="WAS40DataSource 1"
name="jdbcFactory:name" jndiName="jdbcFactory:jndiName"
description="jdbcFactory:description" databaseName="jdbcFactory:databasename">
<propertySet xmi:id="J2EEResourcePropertySet 13">
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<resourceProperties xmi:id="J2EEResourceProperty 13" name="jdbcFactory:customName"
value="jdbcFactory:customValue"/>

<resourceProperties xmi:id="J2EEResourceProperty 14" name="user"
value="jdbcFactory:user"/>

<resourceProperties xmi:id="J2EEResourceProperty 15" name="password"
value="{xor}NTs9PBk+PCswLSZ1MT4y0g=="/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 14">

<resourceProperties xmi:id="J2EEResourceProperty 16" name="jdbcProvider:customName"
value="jdbcProvider:customeValue"/>

</propertySet>

</resources.jdbc:JDBCProvider>

Data source provider settings for application clients:

Use this page to create a data source under a JDBC provider which provides the specific JDBC driver
implementation class.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Data Source Providers >
and click New. The following fields appear on the General tab:

Name:

Specifies the display name for the data source.

For example you can set this field to Test Data Source.

Data type String

Description:

Specifies a text description for the resource.

Data type String

Class Path:
A list of paths or . jar file names which together form the location for the resource provider classes.
Implementation class:

Use this setting to perform database specific functions.

Data type String
Default Dependent on JDBC driver implementation class

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a hame that is a public property on the object and a value that can be converted from a

string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
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Data source properties for application clients:

Use this page to create or modify the data sources.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Data Source Providers > Data source
provider instance. Right-click Data Sources and click New. The following fields are displayed on the
General tab:

Name:

Specifies the display name of this data source.

Data type String

Description:

Specifies a text description of the data source.

Data type String

JNDI Name:

The application client run time uses this field to retrieve configuration information.
Database Name:

The name of the database to which you want to connect.

User:

Use the user ID with the Password property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
The connection factory User ID and Password properties are used if the calling application does not
provide a user ID and password explicitly.

Password:

Use the password with the User ID property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
Re-Enter Password:

Confirms the password.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.
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You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Configuring new data sources for application clients

During this task, you create new data sources for your application client.

1. Click the data source provider for which you want to create a data source in the tree. Take one of the
following actions as needed:

Configure a new data source provider

» Click an existing data source provider.

2. Expand the data source provider to view its Data Sources folder.

3. Click the data source folder. Take one of the following actions as needed:
* Right click the data source folder and click New Factory.
» Click Edit > New on the menu bar.

4. Configure the data source properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save on the menu bar to save your changes.

Configuring mail providers and sessions for application clients

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of JavaMail
sessions and providers for your application clients to use.

1. Open the ACRCT.
2. Open an EAR file.

3. Locate the JavaMail objects in the tree that displays. For example, if your file contains JavaMail
sessions, expand Resources > application.jar > JavaMail Providers >
java_mail_provider_instance > JavaMail Sessions.

In this example, java_mail_provider_instance is a particular JavaMail provider.

The JavaMail session instances are located in the JavaMail Sessions folder.

Mail provider settings for application clients
Use this page to implement the JavaMail APl and create mail sessions.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Mail Providers > and click
New. The following fields appear on the General tab:

Name:

The name of the JavaMail resource provider.

Description:

An optional description for the resource provider.

Class Path:

Specifies a list of paths or JAR file names which together form the location for the resource provider
classes.

Protocol:
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Specifies the name of the protocol.
Classname:

Specifies the name of the class implementing the protocol. Leave this field blank if you want to use the
default implementation.

Type:
This menu contains the following two values: TRANSPORT or STORE.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Mail session settings for application clients
Use this page to configure mail session properties.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Mail Providers > mail provider
instance. Right-click Mail Sessions and click New. The following fields appear on the General tab:
Name:

Represents the administrative name of the JavaMail session object.

Description:

Provides an optional description for your administrative records.

JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Assembly Tool.

Mail Transport Host:

Specifies the server to connect to when sending mail.

Mail Transport Protocol:

Specifies the transport protocol to use when sending mail.

Mail Transport User:

Specifies the user ID to use when the mail transport host requires authentication.

Mail Transport Password:

Specifies the password to use when the mail transport host requires authentication.
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Re-Enter Password:
Confirms the password.

Mail From:

Specifies the mail originator.

Mail Store Host:

Specifies the mail account host (or "domain”) name.
Mail Store User:

Specifies the user ID of the mail account.

Mail Store Password:

Specifies the password of the mail account.
Re-Enter Password:

Confirms the password.

Mail Store Protocol:

Specifies the protocol to be used when receiving mail.
Mail Debug:

When true, JavaMail interaction with mail servers, along with these mail session properties are printed to
the stdout file.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a hame that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring JavaMail provider and JavaMail session settings for
application clients
The purpose of this article is to help you configure JavaMail provider and JavaMail session settings.
* Required fields:

— JavaMail Provider Properties page: name, and at least one protocol provider

— JavaMail Session Properties page: name, jndiName, mail transport protocol, mail store protocol
* Special cases:

— The password is encrypted when using the ACRCT tool. Without the tool, you cannot encrypt this

field.

* Example:
<resources.mail:MailProvider xmi:id="MailProvider_ 1" name="Default Mail Provider"
description="IBM JavaMail Implementation">
<classpath>mailProvider:classpath</classpath>

<factories xmi:type="resources.mail:MailSession" xmi:id="MailSession_1"
name="mailSession:name" jndiName="mailSession:jndiName"
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description="mailSession:description" mailTransportHost="mailSession:mailTransportHost"
mailTransportUser="mailSession:mailTransportUser"
mailTransportPassword="{xor}Mj42Mww6LCw2MDFIMT4y0g=="
mailFrom="mailSession:mailFrom" mailStoreHost="mailSession:mailStoreHost"
mailStoreUser="mailSession:mailStoreUser"
mailStorePassword="{xor}Mj42Mww6LCw2MDF1MT4y0g==" debug="true"
mailTransportProtocol="ProtocolProvider_1" mailStoreProvider="ProtocolProvider_1">
<propertySet xmi:id="J2EEResourcePropertySet 1">

<resourceProperties xmi:id="J2EEResourceProperty 1"

name="mailSession:customName" value="mailSession:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 2">

<resourceProperties xmi:id="J2EEResourceProperty 2" name="mailProvider:customName"
value="mailProvider:customValue"/>

</propertySet>

<protocolProviders xmi:id="ProtocolProvider 1" protocol="smtp"
classname="smtp:className"/>

<protocolProviders xmi:id="ProtocolProvider_2" protocol="pop3"
classname="pop3:className"/>

<protocolProviders xmi:id="ProtocolProvider_3" protocol="imap"
classname="imap:className"/>

</resources.mail:MailProvider>

Configuring new mail sessions for application clients

During this task, you configure new mail sessions for your application client. The mail sessions are
associated with the pre-configured default mail provider supplied by the product.

1. Start the Application Client Resource Configuration Tool (ACRCT) and open the EAR file. The EAR file
contents are displayed in a tree view.

2. Select the JAR file in which you want to configure the new JavaMail session.
3. Expand the JAR file to view its contents.

4. Click JavaMail Providers > MailProvider > JavaMail Sessions. Complete one of the following
actions:
* Right click the JavaMail Sessions folder and select New Factory.
* Click Edit > New on the menu bar.

5. Configure the JavaMail session properties in the displayed fields.
6. Click OK.
7. Click File > Save on the menu bar to save your changes.

URLs for application clients

A Uniform Resource Locator (URL) is an identifier that points to an electronically accessible resource, such
as a directory file on a machine in a network, or a document stored in a database.

URLs appear in the format scheme:scheme_information.

You can represent a scheme as http, ftp, file, or another term that identifies the type of resource and
the mechanism by which you can access the resource.

In a World Wide Web browser location or address box, a URL for a file available using HyperText Transfer
Protocol (HTTP) starts with http:. An example is http://www.ibm.com. Files available using File Transfer
Protocol (FTP) start with ftp:. Files available locally start with file:.

The scheme_information commonly identifies the Internet machine making a resource available, the path
to that resource, and the resource name. The scheme_information for HTTP, FTP and File generally starts
with two slashes (//), then provides the Internet address separated from the resource path name with one
slash (/). For example,
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http://www-4.ibm.com/software/webservers/appserv/library.html.

For HTTP and FTP, the path name ends in a slash when the URL points to a directory. In such cases, the
server generally returns the default index for the directory.

URL providers for the Application Client Resource Configuration Tool

A URL provider implements the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP). This provider, comprised of a pair of classes, extends the java.net.URLStreamHandler
and java.net.URLConnection classes.

Configuring new URL providers for application clients

During this task, you create URL providers and URLs for your client application. In a separate
administrative task, you must install the Java code for the required URL provider on the client machine on
which the client application resides.

1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new URL provider. The EAR file contents
display in a tree view.

3. Select the JAR file in which you want to configure the new URL provider from the tree.
4. Expand the JAR file to view the contents.

5. Click the folder called URL Providers. Complete one of the following actions:
* Right click the folder and select New Provider.
* Click Edit > New on the menu bar.

6. Configure the URL provider properties in the resulting property dialog.
7. Click OK.
8. Click File > Save on the menu bar to save your changes.

Configuring URL providers and sessions using the Application Client Resource
Configuration Tool

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of URL
providers and URLs to be used by your application clients.

1. Open the ACRCT.
2. Open an EAR file.

3. Locate the URL objects in the tree that displays. For example, if your file contains URL providers and
URLs, expand Resources -> application.jar -> URL Providers -> url_provider_instance

where url_provider_instance is a particular URL provider.

4. If you expand the tree further, you will also see the URLs folders containing the URL instances for
each URL provider instance.

URL settings for application clients:

Use this page to implement the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP).

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > URL Providers > URL provider
instance. Right-click URLs and click New. The following fields appear on the General tab.

This provider, comprised of classes, extends the java.net.URLStreamHandler and java.net.URLConnection
classes.
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Name:

Administrative name for the URL

Description:

Optional description of the URL, for your administrative records

JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the

Application Assembly Tool.

URL:

A Uniform Resource Locator (URL) name that points to an Internet or intranet resource. For example:
http://www.ibm.com.

Custom Propetrties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
URL provider settings for application clients:

Use this page create new URL providers.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click URL Providers, and click
New. The following fields appear on the General tab.

A URL provider implements the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP). This provider, comprised of classes, extends the java.net.URLStreamHandler and
java.net.URLConnection classes.

Name:

Administrative name for the URL

Description:

Optional description of the URL, for your administrative records

Class Path:

A list of paths or JAR file names which together form the location for the resource provider classes.
Protocol:

Protocol supported by this stream handler. For example, "nntp”, "smtp”, "ftp”, and so on.

To use the default protocol, leave this field blank.
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Stream handler class:

Fully qualified name of a User-defined Java class that extends the java.net.URLStreamHandler for a
particular URL protocol, such as FTP.

To use the default stream handler, leave this field blank.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring URL and URL provider settings for application clients
The purpose of this article is to help you to configure URL and URL provider settings.
* Required fields:

— URL Properties page: name, jndiName, url

— URL Provider Properties page: name
* Example:
<resources.url:URLProvider xmi:id="URLProvider_1" name="urlProvider:name"
description="urlProvider:description"
streamHandTerClassName="ur1Provider:streamHandlerClass"
protocol="urlProvider:protocol">
<classpath>urlProvider:classpath</classpath>
<factories xmi:type="resources.url:URL" xmi:id="URL_1" name="urlFactory:name"
jndiName="urlFactory:jndiName" description="urlFactory:description"
spec="urlFactory:url">
<propertySet xmi:id="J2EEResourcePropertySet_18">
<resourceProperties xmi:id="J2EEResourceProperty 20" name="urlFactory:customName"
value="urlFactory:customValue"/>
</propertySet>
</factories>
<propertySet xmi:id="J2EEResourcePropertySet 19">
<resourceProperties xmi:id="J2EEResourceProperty 21" name="urlProvider:customName"
value="urlProvider:customValue"/>
</propertySet>
</resources.url:URLProvider>

Configuring new URLs with the Application Client Resource
Configuration Tool

During this task, you create URLs for your client application.

1. Click the URL provider for which you want to create a URL in the tree. Do one of the following:
Configure a new URL provider.
» Click an existing URL provider.

2. Expand the URL provider to view the URLs folder.

3. Click the URL folder. Complete one of the following actions:
» Right click the folder and click New Factory.
» Click Edit -> New on the menu bar.

4. Configure the URL properties in the displayed fields.
Click OK when you finish.
6. Click File > Save in the menu bar to save your changes.

o
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WebSphere asynchronous messaging using the Java Message Service
API for the Application Client Resource Configuration Tool

WebSphere Application Server supports asynchronous messaging as a method of communication based
on the Java Message Service (JMS) programming interface. The JMS interface provides a common way
for Java programs (clients and J2EE applications) to create, send, receive, and read asynchronous
requests as JMS messages.

This topic provides an overview of asynchronous messaging using JMS support provided by the
WebSphere Application Server.

The base support for asynchronous messaging using the JMS API provides the common set of JMS
interfaces and associated semantics that define how a JMS client can access the facilities of a JMS
provider. This support enables WebSphere product J2EE applications, as JMS clients, to exchange
messages asynchronously with other JMS clients, by using JMS destinations (queues or topics). A J2EE
application can use JMS queue destinations for point-to-point messaging and JMS topic destinations for
Publisher and Subcriber messaging. A J2EE application can explicitly poll for messages on a destination,
and then retrieve messages for processing by business logic beans (enterprise beans).

With the base JMS and XA support, the J2EE application uses standard JMS calls to process messages,
including any responses or outbound messaging. An enterprise bean can handle responses acting as a
sender bean, or within the enterprise bean that receives the incoming messages. Optionally, this process
can use two-phase commit within the scope of a transaction. This level of function for asynchronous
messaging is called bean-managed messaging, and gives an enterprise bean complete control over the
messaging infrastructure, for example, connection and session pool management. The common container
has no role in bean-managed messaging.

WebSphere Application Server also supports automatic asynchronous messaging using message-driven
beans (a type of enterprise bean defined in the EJB 2.0 specification) and JMS listeners (part of the JMS
application server facilities). Messages are automatically retrieved from JMS destinations, optionally within
a transaction, then sent to the message-driven bean in a J2EE application, without the application having
to explicitly poll JMS destinations.

Configuring Java messaging client resources

In a separate administrative task, install the Java Message Service (JMS) client on the client machine
where the application client resides. The messaging product vendor must provide an implementation of the
JMS client. For more information, see your messaging product documentation.

During this task, you create new JMS provider configurations for your application client. The application
client can use a messaging service through the Java Message Service APIs. A JMS provider provides two
kinds of J2EE factories. One is a JMS connection factory, and the other is a JMS destination factory.

1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new JMS provider. The EAR file contents are in
the displayed tree view.

Select the JAR file in which you want to configure the new JMS provider from the tree.
Expand the JAR file to view its contents.

Click the JMS Providers folder and click New Provider.

Configure the JMS provider properties in the resulting property dialog.

Click OK.

Click File > Save.

© N o oA~
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Configuring new JMS providers with the Application Client Resource
Configuration Tool

During this task, you will create new JMS provider configurations for your application client. The
application client makes use of a messaging service through the Java Message Service (JMS) APls. A
JMS provider provides two kinds of J2EE factories. One is a JMS Connection factory, and the other is a
JMS destination factory.

In a separate administrative task, you must install the JMS client on the client machine where the
application client resides. The messaging product vendor must provide an implementation of the JMS
client. For more information, see your messaging product documentation.

1. Start the tool and open the EAR file for which you want to configure the new JMS provider. The EAR
file contents will be displayed in a tree view.

2. From the tree, select the JAR file in which you want to configure the new JMS provider.
3. Expand the JAR file to view its contents.

4. Click the JMS Providers folder. Complete one of the following actions:
* Right click the folder and select New Provider.
* On the menu bar, click Edit > New.

5. In the resulting property dialog, configure the JMS provider properties.
6. Click OK when finished.
7. Click File -> Save on the menu bar to save your changes.

JMS provider settings for application clients

Use this page to configure properties of the Java Messaging Service (JMS) provider, if you want to use a
JMS provider other than the internal WebSphere product JMS provider or the MQSeries product JMS
provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click JMS Providers, and click
New. The following fields appear on the General tab.

Name:

The name by which the JMS provider is known for administrative purposes.

Data type String

Description:

A description of the JMS provider, for administrative purposes

Data type String

Class Path:
A list of paths or . jar file names which together form the location for the resource provider classes.
Context factory class:

The Java class name of the initial context factory for the JMS provider.
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For example, for an LDAP service provider the value has the form: com.sun.jndi.ldap.LdapCtxFactory.

Data type String

Provider URL:
The JMS provider URL for external JNDI lookups.

For example, an LDAP URL for a JMS provider has the form: 1dap://hostname.company.com/contextName.

Data type String

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Version 5 Default Provider queue connection factory settings for application
clients

Use this panel to view or change the configuration properties of the selected queue connection factory for
use with the internal WebSphere Application Server product Java Messaging Service (JMS) provider that
is installed with WebSphere Application Server. These configuration properties control how connections are
created to the associated JMS queue destination.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right-click WAS Queue Connection Factories and click New. The following fields appear on
the General tab.

A queue connection factory is used to create JMS connections to queue destinations. The queue
connection factory is created by the internal WebSphere Application Server product JMS provider. A queue
connection factory for the internal WebSphere Application Server product JMS provider has the following
properties:

Name:

The name by which this queue connection factory is known for administrative purposes within IBM
WebSphere Application Server. The name must be unique within the JMS connection factories across the
WebSphere administrative domain.

Data type String

Description:

A description of this connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String
Default Null
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JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Application Assembly Tool.

User:

The User ID used, with the Password property, for authentication if the calling application does not
provide a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
The connection factory User ID and Password properties are used if the calling application does not

provide a User ID and password explicitly, for example, if the calling application uses the method
createQueueConnection(). The JMS client flows the userid and password to the JMS server.

Data type String

Password:

The password used, with the User ID property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
Re-Enter Password:

Confirms the password.

Node:

The WebSphere node name of the administrative node where the JMS server runs for this connection
factory. Connections created by this factory connect to that JMS server.

Data type String

Application Server:

Enter the name of the application server. This name is not the host name of the machine, but the name of
the configured application server.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a

string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
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Version 5 Default Provider topic connection factory settings for application clients
Use this panel to view or change the configuration properties of the selected topic connection factory for
use with the internal WebSphere Application Server product Java Messaging Service (JMS) provider.
These configuration properties control how connections are created to the associated JMS topic
destination.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right click WAS Topic Connection Factories and click New. The following fields appear on the
General tab.

A topic connection factory is used to create JMS connections to topic destinations. The topic connection
factory is created by the associated JMS provider. A topic connection factory for the internal WebSphere
product JMS provider has the following properties.

Name:
The name by which this queue connection factory is known for administrative purposes within IBM

WebSphere Application Server. The name must be unique within the JMS connection factories across the
WebSphere administrative domain.

Data type String

Description:

A description of this topic connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String
Default Null
JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Assembly Tool.

User:

The user ID used, with the Password property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
The connection factory User ID and Password properties are used if the calling application does not

provide a userid and password explicitly, for example, if the calling application uses the method
createTopicConnection(). The JMS client flows the userid and password to the JMS server.

Data type String

Password:

The password used, with the User ID property, for authentication if the calling application does not provide
a userid and password explicitly.
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If you specify a value for the User ID property, you must also specify a value for the Password property.

Data type String
Default Null

Re-Enter Password:

Confirms the password.
Node:

The WebSphere node name of the administrative node where the JMS server runs for this connection
factory. Connections created by this factory connect to that JMS server.

Data type Enum

Default Null

Range Pull-down list of nodes in the WebSphere administrative
domain.

Application Server:

Enter the name of the application server. This name is not the host name of the machine, but the name of
the configured application server.

Port:

Which of the two ports that connections use to connect to the JMS Server. The QUEUED port is for
full-function JMS publish/subscribe support, the DIRECT port is for non-persistent, non-transactional,
non-durable subscriptions only.

Note: Message-driven beans cannot use the direct listener port for publish/subscribe support. Therefore,
any topic connection factory configured with the Port set to Direct cannot be used with
message-driven beans.

Data type Enum

Units Not applicable
Default QUEUED
Range QUEUED

The listener port used for full-function

JMS-compliant, publish/subscribe support.
DIRECT

The listener port used for direct TCP/IP

connection (non-transactional, non-persistent,

and non-durable subscriptions only) for

publish/subscribe support.

The TCP/IP port numbers for these ports are defined on
the product internal JMS server.

Client ID:

The JMS client identifier used for connections to the MQSeries queue manager.

Data type String
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Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a hame that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Version 5 Default Provider queue destination settings for application clients
Use this panel to view or change the configuration properties of the selected queue destination for use
with WebSphere Application Server product Java Messaging Service (JMS) provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right click WAS Queue Destinations and click New. The following fields are displayed on the
General tab.

A queue destination is used to configure the properties of a JMS queue. Connections to the queue are
created by the associated queue connection factory for the internal product JMS provider. A queue for use
with the internal product JMS provider has the following properties.

Name:

The name by which the queue is known for administrative purposes within IBM WebSphere Application
Server.

Data type String

Description:

A description of the queue, for administrative purposes

Data type String
Default Null
JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Application Assembly Tool.

Persistence:

Whether all messages sent to the destination are persistent, non-persistent, or have their persistence
defined by the application

Data type Enum
Units Not applicable
Default APPLICATION_DEFINED

Chapter 7. Using application clients 233



Range Application defined
Messages on the destination have their
persistence defined by the application that put
them onto the queue.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Persistent
Messages on the destination are persistent.
Non persistent
Messages on the destination are not persistent.

Priority:

Whether the message priority for this destination is defined by the application or the Specified priority
property

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED
Range Application defined

The priority of messages on this destination is
defined by the application that put them onto the
destination.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Specified
The priority of messages on this destination is
defined by the Specified priority property./f you
select this option, you must define a priority on
the Specified priority property.

Specified Priority:

If the Priority property is set to Specified, type here the message priority for this queue, in the range 0
(lowest) through 9 (highest)

If the Priority property is set to Specified, messages sent to this queue have the priority value specified
by this property.

Data type Integer

Units Message priority level

Default Null

Range 0 (lowest priority) through 9 (highest priority)
Expiry:

Whether the expiry timeout for this queue is defined by the application or the Specified expiry property, or
whether messages on the queue expire (have an unlimited expiry timeout).

Data type Enum
Units Not applicable
Default APPLICATION_DEFINED
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Range Application defined

The expiry timeout for messages in this queue is
defined by the application that put them onto the
queue.

Specified
The expiry timeout for messages in this queue is
defined by the Specified expiry property.If you
select this option, you must define a time out on
the Specified expiry property.

Unlimited
Messages in this queue have no expiry timeout,
and those messages never expire.

Specified Expiry:

If the Expiry timeout property is set to Specified, specify the number of milliseconds (greater than 0)
after which messages on this queue expire.

Data type Integer

Units Milliseconds

Default Null

Range Greater than or equal to 0

* 0 indicates that messages never timeout
= Other values are an integer number of milliseconds

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a hame that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Version 5 Default Provider topic destination settings for application clients
Use this panel to view or change the configuration properties of the selected topic destination for use with
the internal WebSphere Application Server product Java Messaging Service (JMS) provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right click WAS Topic Destinations and click New. The following fields appear on the General
tab.

A topic destination is used to configure the properties of a JMS topic for the associated JMS provider.
Connections to the topic are created by the associated topic connection factory. A topic used with the
internal JMS provider has the following properties.

Name:

The name by which the topic is known for administrative purposes.

Data type String

Description:
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A description of the topic, for administrative purposes within IBM WebSphere Application Server.

Data type String
Default Null
JNDI Name:

The application client run-time environment uses this field to retrieve configuration information. The name
must match the value of the Name field on the General tab in the Application Client Resource Reference
section of the Application Assembly Tool.

Topic Name: The name of the topic as defined to the JMS provider.

Data type String

Persistence:

Whether all messages sent to the destination are persistent, non-persistent, or have their persistence
defined by the application

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED
Range Application defined

Messages on the destination have their
persistence defined by the application that put
them onto the queue.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Persistent
Messages on the destination are persistent.
Non persistent
Messages on the destination are not persistent.

Priority:

Whether the message priority for this destination is defined by the application or the Specified priority
property.

Data type Enum
Units Not applicable
Default APPLICATION_DEFINED
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Range Application defined

The priority of messages on this destination is
defined by the application that put them onto the
destination.

Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.

Specified
The priority of messages on this destination is
defined by the Specified priority property./f you
select this option, you must define a priority on
the Specified priority property.

Specified Priority:

If the Priority property is set to Specified, specify the message priority for this queue, in the range 0
(lowest) through 9 (highest).

If the Priority property is set to Specified, messages sent to this queue have the priority value specified
by this property.

Data type Integer

Units Message priority level

Default Null

Range 0 (lowest priority) through 9 (highest priority)
Expiry:

Whether the expiry timeout for this queue is defined by the application or the Specified expiry property, or
messages on the queue never expire (have an unlimited expiry timeout)

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED

Range Application defined
The expiry timeout for messages on this queue is
defined by the application that put them onto the
queue.

Specified

The expiry timeout for messages on this queue is
defined by the Specified expiry property./f you
select this option, you must define a timeout on
the Specified expiry property.

Unlimited
Messages on this queue have no expiry timeout,
so those messages never expire.

Specified Expiry:

If the Expiry timeout property is set to Specified, type here the number of milliseconds (greater than 0)
after which messages on this queue expire

Data type Integer
Units Milliseconds
Default Null
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Range Greater than or equal to 0
» 0 indicates that messages never time out
» Other values are an integer number of milliseconds

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

WebSphere MQ Provider queue connection factory settings for application clients
Use this panel to view or change the configuration properties of the selected queue connection factory for
use with the MQSeries product Java Messaging Service (JMS) provider. These configuration properties
control how connections are created to the associated JMS queue destination.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right click MQ Queue Connection Factories, and click New. The following fields are displayed
on the General tab.

A queue connection factory creates JMS connections to queue destinations. The queue connection factory
is created by the MQSeries product JMS provider. A queue connection factory for the JMS provider has
the following properties.

Note:

* The property values that you specify must match the values that you specified when configuring
MQSeries for JMS resources. For more information about configuring MQSeries product JMS
resources, see the MQSeries Using Java book, located in the [WebSphere MQ Family library

* In MQSeries, names can have a maximum of 48 characters, with the exception of channels
which have a maximum of 20 characters.

Name:

The name by which this queue connection factory is known for administrative purposes within IBM
WebSphere Application Server. The name must be unique within the JMS connection factories across the
WebSphere administrative domain.

Data type String

Description:

A description of this connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String
Default Null
JNDI Name:
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The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Assembly Tool.

User:

The user ID used, with the Password property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.
The connection factory User ID and Password properties are used if the calling application does not

provide a userid and password explicitly; for example, if the calling application uses the method
createQueueConnection(). The JMS client flows the userid and password to the JMS server.

Data type String

Password:

The password used, with the User ID property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.

Data type String
Default Null

Re-Enter Password:

Confirms the password.

Queue Manager:

The name of the MQSeries queue manager for this connection factory.

Connections created by this factory connect to that queue manager.

Data type String

Host:

The name of the host on which the WebSphere MQ queue manager runs for client connection only.

Data type String

Default Null

Range A valid TCP/IP host name
Port:

The TCP/IP port number used for connection to the WebSphere MQ queue manager, for client connection
only.
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This port must be configured on the WebSphere MQ queue manager.

Data type Integer
Default Null
Range A valid TCP/IP port number, configured on the WebSphere

MQ queue manager.

Channel:

The name of the channel used for connection to the WebSphere MQ queue manager, for client connection
only.

Data type String
Default Null
Range 1 through 20 ASCII characters

Transport type:

Specifies whether the WebSphere MQ client connection or JNI bindings are used for connection to the
WebSphere MQ queue manager. The external JMS provider controls the communication protocols
between JMS clients and JMS servers. Tune the transport type when you are using non-ASF
nonpersistent, nondurable, nontransactional messaging or when you want to satisfy security issues and
the client is local to the queue manager node.

Data type Enum

Units Not applicable
Default BINDINGS
Range BINDINGS

JNI bindings are used to connect to the queue
manager. BINDINGS is a shared memory
protocol and can only be used when the queue
manager is on the same node as the JMS client
and poses security risks that should be
addressed through the use of EJB roles.

CLIENT
WebSphere MQ client connection is used to
connect to the queue manager. CLIENT is a
typical TCP-based protocol.

DIRECT
For WebSphere MQ Event Broker using DIRECT
mode. DIRECT is a lightweight sockets protocol
used in nontransactional, nondurable and
nonpersistent Publish/Subscribe messaging.
DIRECT is only works for clients and
message-driven beans using the non-ASF
protocol.

QUEUED
QUEUED is a standard TCP protocol.
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Recommended Queue connection factory transport type
BINDINGS is faster by 30% or more, but it lacks
security. When you have security concerns,
BINDINGS is more desirable than CLIENT.
Topic connection factory transport type

DIRECT is the fastest type and should be used
where possible. Use BINDINGS when you want
to satisfy additional security tasks and the queue
manager is local to the JMS client. QUEUED is
the fallback for all other cases. WebSphere MQ
5.3 before CSD2 with the DIRECT setting can
lose messages when used with message-driven
beans and under load. This loss also happens
with client-side applications unless the broker
maxClientQueueSize is set to 0. You can set this
to 0 with the command:
#wempschangeproperties WAS_nodeName_serverl -e default

-0 DynamicSubscriptionEngine
-n maxClientQueueSize

-v 0

-x executionGroupUUID

where executionGroupUUID can be found by
starting the broker and looking in the Event
Log/Applications for event 2201. This value is
usually ffffffff-0000-0000-000000000000.

Client ID:

The JMS client identifier used for connections to the MQSeries queue manager.

Data type String

CCSID:
The coded character set identifier for use with the WebSphere MQ queue manager.

This coded character set identifier (CCSID) must be one of the CCSIDs supported by WebSphere MQ.

Data type String

For more information about supported CCSIDs, and about converting between message data from one
coded character set to another, see the WebSphere MQ System Administration and the WebSphere MQ
Application Programming Reference books. These references are available from the WebSphere MQ
messaging multiplatform and platform-specific books Web pages; for example, at |http://www-|
13.ibom.com/software/ts/mgseries/library/manualsa/manuals/platspecific.html, the IBM Publications Center| or
from the WebSphere MQ collection kit, SK2T-0730.

Message Retention:

Select this check box to specify that unwanted messages are to be left on the queue. Otherwise,
unwanted messages are handled according to their disposition options.

Data type Enum
Units Not applicable
Default Cleared
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Range Selected
Unwanted messages are left on the queue.
Cleared
Unwanted messages are handled according to
their disposition options.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

WebSphere MQ Provider topic connection factory settings for application clients
Use this panel to view or change the configuration properties of the selected topic connection factory for
use with the MQSeries product Java Messaging Service (JMS) provider. These configuration properties

control how connections are created to the associated JMS topic destination.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right-click MQ Topic Connection Factories and click New.

A topic connection factory is used to create JMS connections to topic destinations. The topic connection
factory is created by the MQSeries product JMS provider. A topic connection factory for the MQSeries
product JMS provider has the following properties.

Note:
* The property values that you specify must match the values that you specified when configuring
MQSeries product JMS resources. For more information about configuring MQSeries product
JMS resources, see the MQSeries Using Java book.
* In MQSeries, names can have a maximum of 48 characters, with the exception of channels
which have a maximum of 20 characters.

Name:

The name by which this topic connection factory is known for administrative purposes within IBM
WebSphere Application Server. The name must be unique within the JMS provider.

Data type String

Description:

A description of this topic connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String
Default Null
JNDI Name:

The Java Naming and Directory Interface (JNDI) name that is used to bind the topic connection factory
into the application server name space.
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As a convention, use the fully qualified JNDI name; for example, in the form jms/Name, where Name is the
logical name of the resource.

This name is used to link the platform binding information. The binding associates the resources defined
by the deployment descriptor of the module to the actual (physical) resources bound into JNDI by the
platform.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 45 ASCII characters
User:

The user ID used, with the Password property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User property, you must also specify a value for the Password property.
The connection factory User and Password properties are used if the calling application does not provide

a userid and password explicitly, for example, if the calling application uses the method
createTopicConnection(). The JMS client flows the userid and password to the JMS server.

Data type String

Password:

The password used, with the User ID property, for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.

Data type String
Default Null

Re-Enter Password:
Confirms the password.
Queue Manager:

The name of the MQSeries queue manager for this connection factory. Connections created by this factory
connect to that queue manager.

Data type String

Host:

The name of the host on which the WebSphere MQ queue manager runs for client connections only.

Data type String
Default Null
Range A valid TCP/IP host name
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Port:

The TCP/IP port number used for connection to the WebSphere MQ queue manager, for client connection
only.

This port must be configured on the WebSphere MQ queue manager.

Data type Integer
Default Null
Range A valid TCP/IP port number, configured on the WebSphere

MQ queue manager.

Channel:

The name of the channel used for client connections to the WebSphere MQ queue manager for client
connection only.

Data type String
Default Null
Range 1 through 20 ASCII characters

Transport Type:

Whether MQSeries client connection or JNDI bindings are used for connection to the MQSeries queue
manager.

Data type Enum

Units Not applicable
Default BINDINGS
Range CLIENT

MQSeries client connection is used to connect to
the MQSeries queue manager.

BINDINGS
JNDI bindings are used to connect to the
MQSeries queue manager.

Client ID:

The JMS client identifier used for connections to the MQSeries queue manager.

Data type String

CCSID:
The coded character set identifier to be used with the WebSphere MQ queue manager.

This coded character set identifier (CCSID) must be one of the CCSIDs supported by WebSphere MQ.

Data type String

Broker Control Queue:

The name of the broker control queue to which all command messages (except publications and requests
to delete publications) are sent.
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The name of the broker control queue. Publisher and subscriber applications as well as other brokers send
all command messages (except publications and requests to delete publications) to this queue.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters

Broker Queue Manager:

The name of the MQSeries queue manager that provides the Publisher and Subscriber message broker.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters

Broker Pub Queue:
The name of the broker input queue that receives all publication messages for the default stream
The name of the broker’s input queue (stream queue) that receives all publication messages for the

default stream. Applications can also send requests to delete publications on the default stream to this
queue.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters

Broker Sub Queue:
The name of the broker queue from which nondurable subscription messages are retrieved.

The name of the broker queue from which nondurable subscription messages are retrieved. The
subscriber specifies the name of the queue when it registers a subscription.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters
Broker CCSubQ:

The name of the broker queue from which nondurable subscription messages are retrieved for a
ConnectionConsumer request. This property applies only for use of the Web container.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters

Broker Version:
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Specifies whether the message broker is provided by the MQSeries MAOC SupportPac or newer versions
of WebSphere family message broker products.

Data type Enum

Units Not applicable
Default Advanced
Range Advanced

The message broker is provided by newer
versions of WebSphere family message broker
products (MQ Integrator and MQ Publish and
Subscribe)

Basic The message broker is provided by the
MQSeries MAOC SupportPac (MQSeries -
Publish and Subscribe)

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

WebSphere MQ Provider queue destination settings for application clients
Use this panel to view or change the configuration properties of the selected queue destination for use
with the MQSeries product Java Messaging Service (JMS) provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right-click MQ Queue Destinations and click New. The following fields are displayed on the
General tab.

A queue destination configures the properties of a JMS queue. Connections to the queue are created by
the associated queue connection factory for the MQSeries product JMS provider. A queue for use with the
MQSeries product JMS provider has the following properties.

Note:
* The property values that you specify must match the values that you specified when configuring
MQSeries product JMS resources. For more information about configuring MQSeries product
JMS resources, see the MQSeries Using Java book.
* In MQSeries, names can have a maximum of 48 characters.

Name:

The name by which the queue is known for administrative purposes within IBM WebSphere Application
Server.

Data type String

Description:

A description of the queue, for administrative purposes

Data type String
Default Null
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JNDI Name:

The application client run-time environment uses this field to retrieve configuration information. The name
must match the value of the Name field on the General tab in the Application Client Resource Reference
section of the Application Assembly Tool.

Persistence:

Whether all messages sent to the destination are persistent, nonpersistent or have their persistence
defined by the application.

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED
Range Application defined

Messages on the destination have their
persistence defined by the application that put
them onto the queue.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Persistent
Messages on the destination are persistent.
Nonpersistent
Messages on the destination are not persistent.

Priority:

Whether the message priority for this destination is defined by the application or the Specified priority
property

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED
Range Application defined

The priority of messages on this destination is
defined by the application that put them onto the
destination.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Specified
The priority of messages on this destination is
defined by the Specified priority property./f you
select this option, you must define a priority on
the Specified priority property.

Specified Priority:

If the Priority property is set to Specified, specify the message priority for this queue, in the range 0
(lowest) through 9 (highest).

Data type Integer
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Units Message priority level

Default Null
Range 0 (lowest priority) through 9 (highest priority)
Expiry:

Whether the expiry timeout value for this queue is defined by the application or the by Specified expiry
property or whether messages on the queue never expire (have an unlimited expiry timeout).

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED

Range Application defined
The expiry timeout for messages on this queue is
defined by the application that put them onto the
queue.

Specified

The expiry timeout for messages on this queue is
defined by the Specified expiry property. If you
select this option, you must define a timeout on
the Specified expiry property.

Unlimited
Messages on this queue have no expiry timeout
and those messages never expire.

Specified Expiry:

If the Expiry timeout property is set to Specified, type here the number of milliseconds (greater than 0)
after which messages on this queue expire.

Data type Integer

Units Milliseconds

Default Null

Range Greater than or equal to 0

* 0 indicates that messages never time out
« Other values are an integer number of milliseconds

Base Queue Name:

The name of the queue to which messages are sent, on the queue manager specified by the Base queue
manager hame property

Data type String

Base Queue Manager Name:
The name of the MQSeries queue manager to which messages are sent

This queue manager provides the queue specified by the Base queue name property.

Data type String

Units En_US ASCII characters

Default Null

Range A valid MQSeries Queue Manager name, as 1 through 48

ASCII characters

248 IBM WebSphere Business Integration Server Foundation for z/OS V5.1:: Applications



CCSID:
The coded character set identifier to use with the WebSphere MQ queue manager.

This coded character set identifier (CCSID) must be one of the CCSID identifier supported by WebSphere
MQ queue manager.

Data type String

Integer encoding:

If native encoding is not enabled, select whether integer encoding is normal or reversed.

Data type Enum
Units Not applicable
Default NORMAL
Range NORMAL
Normal integer encoding is used.
REVERSED

Reversed integer encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.

Decimal encoding:

Indicates that if native encoding is not enabled to select whether decimal encoding is normal or reversed.

Data type Enum
Units Not applicable
Default NORMAL
Range NORMAL
Normal decimal encoding is used.
REVERSED

Reversed decimal encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.

Floating point encoding:

Indicates that if native encoding is not enabled to select the type of floating point encoding.

Data type Enum
Units Not applicable
Default IEEENORMAL
Range IEEENORMAL
IEEE normal floating point encoding is used.
IEEEREVERSED

IEEE reversed floating point encoding is used.
S390 S390 floating point encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.
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Native encoding:

Indicates that the queue destination use native encoding (appropriate encoding values for the Java
platform) when you select this check box.

Data type Enum

Units Not applicable
Default Cleared
Range Cleared

Native encoding is not used, so specify the
following properties for integer, decimal and
floating point encoding.

Selected
Native encoding is used (to provide appropriate
encoding values for the Java platform).

For more information about encoding properties, see the
MQSeries Using Java document.

Target client:

Whether the receiving application is JMS-compliant or is a traditional WebSphere MQ application

Data type Enum

Units Not applicable
Default MQSeries
Range MQSeries

The target is a traditional WebSphere MQ
application that does not support JMS.
JMS The target application supports JMS.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

WebSphere MQ Provider topic destination settings for application clients
Use this panel to view or change the configuration properties of the selected topic destination for use with
the MQSeries product Java Messaging Service (JMS) provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > JMS provider
instance. Right click MQ Topic Destinations, and click New. The following fields are displayed on the
General tab.

A topic destination is used to configure the properties of a JMS topic for the associated JMS provider.
Connections to the topic are created by the associated topic connection factory. A topic for use with the
MQSeries product JMS provider has the following properties.

Note:
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* The property values that you specify must match the values that you specified when configuring
MQSeries product JMS resources. For more information about configuring MQSeries product
JMS resources, see the MQSeries Using Java book.
* In MQSeries, names can have a maximum of 48 characters.
Name:
The name by which the topic is known for administrative purposes.

Data type String

Description:

A description of the topic for administrative purposes within IBM WebSphere Application Server.

JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Application Assembly Tool.

Persistence:

Specifies whether all messages sent to the destination are persistent, nonpersistent, or have their
persistence defined by the application.

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED
Range Application defined

Messages on the destination have their
persistence defined by the application that put
them in the queue.
Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.
Persistent
Messages on the destination are persistent.
Nonpersistent
Messages on the destination are not persistent.

Priority:

Specifies whether the message priority for this destination is defined by the application or the Specified
priority property.

Data type Enum
Units Not applicable
Default APPLICATION_DEFINED
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Range Application defined

The priority of messages on this destination is
defined by the application that put them in the
destination.

Queue defined
[WebSphere MQ destination only] Messages on
the destination have their persistence defined by
the WebSphere MQ queue definition properties.

Specified
The priority of messages on this destination is
defined by the Specified priority property. If you
select this option, you must define a priority for
the Specified priority property.

Specified Priority:

If the Priority property is set to Specified, type the message priority for this queue, in the range 0 (lowest)
through 9 (highest).

If the Priority property is set to Specified, messages sent to this queue have the priority value specified
by this property.

Data type Integer

Units Message priority level

Default Null

Range 0 (lowest priority) through 9 (highest priority)
Expiry:

Whether the expiry timeout for this queue is defined by the application or by the Specified expiry property
or by messages on the queue never expire (have an unlimited expiry timeout).

Data type Enum

Units Not applicable

Default APPLICATION_DEFINED

Range Application defined
The expiry timeout for messages on this queue is
defined by the application that put them in the
queue.

Specified

The expiry timeout for messages in this queue is

defined by the Specified expiry property. If you

select this option, you must define a timeout

value for the Specified expiry property.
Unlimited

Messages on this queue have no expiry timeout,

and these messages never expire.

Specified Expiry:

If the Expiry timeout property is set to Specified, type the number of milliseconds (greater than 0) after
which messages on this queue expire.

Data type Integer
Units Milliseconds
Default Null
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Range Greater than or equal to 0
» 0 indicates that messages never time out
» Other values are an integer number of milliseconds

Base Topic Name:

The name of the topic to which messages are sent.

Data type String

CCSID:
The coded character set identifier to use with the WebSphere MQ queue manager.

This coded character set identifier (CCSID) must be one of the CCSID identifiers that WebSphere MQ
supports.

Data type String

Integer encoding:

Indicates whether integer encoding is normal or reversed when native encoding is not enabled.

Data type Enum
Units Not applicable
Default NORMAL
Range NORMAL
Normal integer encoding is used.
REVERSED

Reversed integer encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.

Decimal encoding:

If native encoding is not enabled, select whether decimal encoding is normal or reversed.

Data type Enum
Units Not applicable
Default NORMAL
Range NORMAL
Normal decimal encoding is used.
REVERSED

Reversed decimal encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.

Floating point encoding:

Indicates the type of floating point encoding when native encoding is not enabled.

Data type Enum
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Units Not applicable

Default IEEENORMAL
Range IEEENORMAL
IEEE normal floating point encoding is used.
IEEEREVERSED

IEEE reversed floating point encoding is used.
S390 S/390 floating point encoding is used.

For more information about encoding properties, see the
WebSphere MQ Using Java document.
Native encoding:

Indicates that the queue destination uses native encoding (appropriate encoding values for the Java
platform) when you select this check box.

Data type Enum

Units Not applicable
Default Cleared
Range Cleared

Native encoding is not used, so specify the
previous properties for integer, decimal and
floating point encoding.

Selected
Native encoding is used (to provide appropriate
encoding values for the Java platform).

For more information about encoding properties, see the
MQSeries Using Java document.

BrokerDurSubQueue:
The name of the broker queue from which durable subscription messages are retrieved.

The subscriber specifies the name of the queue when it registers a subscription.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters
BrokerCCDurSubQueue:

The name of the broker queue from which durable subscription messages are retrieved for a
ConnectionConsumer. This property applies only for use of the Web container.

Data type String

Units En_US ASCII characters
Default Null

Range 1 through 48 ASCII characters

Target Client:

Specifies whether the receiving application is JMS compliant or is a traditional MQSeries application.

254 |IBM WebSphere Business Integration Server Foundation for z/OS V5.1:: Applications



Data type Enum

Units Not applicable
Default MQSeries
Range MQSeries

The target is a traditional MQSeries application
that does not support JMS.
JMS The target is a JMS compliant application.

Custom Properties:

Specifies the name-value pairs for setting additional properties on the object that is created at run time for
this resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Generic JMS connection factory settings for application clients

Use this panel to view or change the configuration properties of the selected JMS connection factory for
use with the associated JMS provider. These configuration properties control how connections are created
to the associated JMS destination.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers >
new_JMS_Provider_instance. Right click JMS Connection Factories, and click New. The following fields
are displayed on the General tab.

A Java Message Service (JMS) connection factory creates connections to JMS destinations. The JMS
connection factory is created by the associated JMS provider. A JMS connection factory for a generic JMS
provider (other than the internal WebSphere product JMS provider or the MQSeries product JMS provider)
has the following properties:

Name:

The name by which this JMS connection factory is known for administrative purposes within IBM
WebSphere Application Server. The name must be unique within the associated JMS provider.

Data type String

Description:

A description of this connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String
Default Null
JNDI Name:

The application client run time uses this field to retrieve configuration information. The name must match
the value of the Name field on the General tab in the Application Client Resource Reference section of the
Application Assembly Tool.

User:
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Indicates the user ID used with the Password property, for authentication if the calling application does
not provide a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.

The connection factory User ID and Password properties are used if the calling application does not
provide a userid and password explicitly; for example, if the calling application uses the method
createQueueConnection(). The JMS client flows the userid and password to the JMS server.

Data type String

Password:

The password used with the User ID property for authentication if the calling application does not provide
a userid and password explicitly.

If you specify a value for the User ID property, you must also specify a value for the Password property.

Data type String
Default Null

Re-Enter Password:
Confirms the password entered in the Password field.
External JNDI Name:

The JNDI name that is used to bind the queue into the application server name space.

As a convention, use the fully qualified JNDI name, for example, jms/Name, where Name is the logical
name of the resource.

This name is used to link the platform binding information. The binding associates the resources defined
by the deployment descriptor of the module to the actual (physical) resources bound into JNDI API by the
platform.

Data type String

Connection Type:
Whether this JMS destination is a queue (for point-to-point) or topic (for pub/sub).

Select one of the following options:
Queue

A JMS queue destination for point-to-point messaging.
Topic A JMS topic destination for publish subscribe messaging.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
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Generic JMS destination settings for application clients
Use this panel to view or change the configuration properties of the selected JMS destination for use with
the associated JMS provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > JMS Providers > new JMS Provider
instance. Right-click JMS Destinations, and click New. The following fields are displayed on the General
tab.

A JMS destination is used to configure the properties of a JMS destination for the associated generic JMS
provider. Connections to the JMS destination are created by the associated JMS connection factory. A
JMS destination for use with a generic JMS provider (not the internal WebSphere product JMS provider or
MQSeries product JMS provider) has the following properties.

Name:

The name by which the queue is known for administrative purposes within IBM WebSphere Application
Server.

Data type String

Description:

A description of the queue, for administrative purposes

JNDI Name:

The JNDI name of the actual (physical) name of the JMS destination bound into JNDI.
External JNDI Name:

The JNDI name that is used to bind the queue into the application server name space.

As a convention, use the fully qualified JNDI name; for example, in the form jms/Name, where Name is the
logical name of the resource.

This name is used to link the platform binding information. The binding associates the resources defined

by the deployment descriptor of the module to the actual (physical) resources bound into JNDI by the
platform.

Data type String

Destination Type:
Whether this JMS destination is a queue (for point-to-point) or topic (for publishing and subscribing).
Select one of the following options:
Queue
A JMS queue destination for point-to-point messaging.
Topic A JMS topic destination for pub/sub messaging.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.
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You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring JMS provider, JMS connection factory and JMS destination
settings for application clients
The purpose of this article is to help you to configure JMS Provider, JMS Connection Factory and JMS
Destination settings.
* Required fields:
— JMS Provider Properties page: name, and at least one protocol provider
— JMS Connection Factory Properties page: name, jndiName, destination type
— JMS Destination Properties page: name, jndiName, destination type
* Special cases:
— The destination type must be QUEUE, or TOPIC.
* Example:

<resources.jms:JMSProvider xmi:id="JMSProvider_3" name="genericJMSProvider:name"
description="genericJMSProvider:description"
externallInitialContextFactory="genericJMSProvider:contextFactoryClass"
externalProviderURL="genericJMSProvider:providerUrl">
<classpath>genericJMSProvider:classpath</classpath>

<factories xmi:type="resources.jms:GenericJMSDestination"
xmi:id="GenericJMSDestination 1" name="jmsDestination:name"
jndiName="jmsDestination:jndiName" description="jmsDestination:description"
externalJNDIName="jmsDestination:externalJndiName" type="QUEUE">

<propertySet xmi:id="J2EEResourcePropertySet 15">

<resourceProperties xmi:id="J2EEResourceProperty 17" name="jmsDestination:customName"
value="jmsDestination:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms:GenericJMSConnectionFactory"
xmi:id="GenericJMSConnectionFactory_1" name="jmsCF:name" jndiName="jmsCF:jndiName"
description="jmsCF:description" userID="jmsCF:user" password="{xor}NTIsHB11MT4yOg=="
externalJNDIName="jmsCF:externaldndiName" type="QUEUE">

<propertySet xmi:id="J2EEResourcePropertySet 16">

<resourceProperties xmi:id="J2EEResourceProperty 18" name="jmsCF:customName"
value="jmsCF:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 17">

<resourceProperties xmi:id="J2EEResourceProperty 19"
name="genericJMSProvider:customName" value="genericJMSProvider:customValue"/>
</propertySet>

</resources.jms:JMSProvider>

Configuring new connection factories for application clients

During this task, you create a new Java Messaging Service (JMS) connection factory configuration for your
application client.

1. Click the JMS provider for which you want to create a connection factory in the tree. Complete one of
the following actions:
+ |Configure a new JMS provider.|
» Click an existing JMS provider.

2. Expand the JMS provider to view its JMS Connection Factories folder.

3. Click the connection factory folder, and complete one of the following actions:
* Right-click the folder and selectNew Factory.
» Click Edit > New on the menu bar.

4. Configure the JMS connection factory properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save on the menu bar to save your changes.
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Configuring new Java Message Service destinations for application
clients

During this task, you create a new Java Message Service (JMS) destination configuration for your
application client.

1. Click the JMS provider in the tree for which you want to create a destination. Complete one of the
following actions:
+ [Configure a new JMS provider)
» Click an existing JMS provider.
2. Expand the JMS provider to view its JMS Destinations folder.
3. Click the provider folder, and complete one of the following actions:
* Right-click the folder and select New Factory.
» Click Edit > New on the menu bar.
4. Configure the JMS destination properties in the displayed fields.
5. Click OK when you finish.

6. Click File > Save on the menu bar to save your changes.

Example: Configuring MQ Queue and Topic connection factories and
destination factories for application clients

The purpose of this article is to help you configure MQ Queue connection factory, MQ Topic connection
factory, MQ Queue destination factory, and MQ Topic destination factory settings.
* Required fields:

— MQ Queue Connection Factory Properties page: name, jndiName and transport type

— MQ Topic Connection Factory Properties page: name, jndiName and broker Version

— MQ Queue Factory Properties page: name, jndiName, persistence, priority, expiry, baseQueueName
and targetClient

— MQ Topic Factory Properties page: name, jndiName, persistence, priority, expiry, baseQueueName
and targetClient

* Special cases:

— The transport type must be CLIENT, or BINDINGS.

— The Broker Version must be MAOC, or MQST.

— The port must be a numerical value between -2417483648 and 2417483647.

— The CCSID must be a numerical value between -2417483648 and 2417483647.

— The persistence value must be APPLICATION DEFINED, QUEUE_DEFINED, PERSISTENT or, NONPERSISTENT.

— The priority must be APPLICATION DEFINED, QUEUE DEFINED, or SPECIFIED.

— The expiry must be APPLICATION DEFINED, UNLIMITED, or SPECIFIED.

— The integer encoding must be Normal, or Reversed.

— The decimal encoding must be Normal, or Reversed.

— The floating encoding must be IEEENormal, IEEEReversed or S390.

— The target client must be JMS or MQ.

— On the MQ Queue Connection Factory Properties page, only set the queueManager, host, and port
values. These are required fields if the transport type is CLIENT.

— On the MQ Topic Connection Factory Properties page, only set the queueManager, host, and port
(required) fields if the transport type is CLIENT.

— On the MQ Topic Factory Properties, and the MQ Queue Factory Properties pages, only set the
Integer encoding, decimal encoding, and floating point encoding (required) fields if you do not set the
nativeEncoding value.

— On the MQ Topic Factory Properties and the MQ Queue Factory Properties pages, the specified
priority entry field must be an integer between 0 and 9 if priority is set to SPECIFIED .

— On the MQ Topic Factory Properties and the MQ Queue Factory Properties pages, the specified
expiry entry field must be a value greater than 0 if the expiry value is set to SPECIFIED.

* Example:
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<resources.jms:JMSProvider xmi:id="JMSProvider_ 1" name="MQ JMS Provider"
description="mqJMSProvider:description”
externalInitialContextFactory="mqJMSProvider:contextFactoryClass"
externalProviderURL="mqJMSProvider:providerUrl">
<classpath>mqJMSProvider:classpath</classpath>

<factories xmi:type="resources.jms.mgseries:MQQueueConnectionFactory"

xmi :id="MQQueueConnectionFactory_ 1" name="mqQCF:name" jndiName="mqQCF:jndiName"
description="mgQCF:description" userID="mgQCF:user" password="{xor}Mi40HB11MT4y0g=="
queueManager="mqQCF:queueManager" host="mqQCF:host" port="1" channel="mqQCF:channel"
transportType="CLIENT" clientID="mqQCF:clientId" CCSID="2">

<propertySet xmi:id="J2EEResourcePropertySet 3">

<resourceProperties xmi:id="J2EEResourceProperty 3" name="mqQCF:customName"
value="mqQCF:customvValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.mgseries:MQTopicConnectionFactory"

xmi :id="MQTopicConnectionFactory 1" name="mqTCF:name" jndiName="mqTCF:jndiName"
description="mqTCF:description" userID="mqTCF:user"
password="{xor}Mi4LHBTINTE7NhE+Mjo=" host="mqTCF:host" port="1"
transportType="CLIENT" channel="mqTCF:channel" queueManager="mqTCF:queueManager"
brokerControlQueue="mqTCF:brokerControlQueue"
brokerQueueManager="mqTCF:brokerQueueManager" brokerPubQueue="mqTCF:brokerPubQueue"
brokerSubQueue="mqTCF:brokerSubQueue" brokerCCSubQ="mqTCF:brokerCCSubQ"
brokerVersion="MAGC" clientID="mqTCF:clientId" CCSID="2">

<propertySet xmi:id="J2EEResourcePropertySet _4">

<resourceProperties xmi:id="J2EEResourceProperty 4" name="mqTCF:customName"
value="mqTCF:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.mgseries:MQQueue" xmi:id="MQQueue_1" name="mqQ:name"
jndiName="mqQ: jndiName" description="mqQ:description" persistence="APPLICATION DEFINED"
priority="SPECIFIED" specifiedPriority="1" expiry="SPECIFIED" specifiedExpiry="1"
baseQueueName="mqQ:baseQueueName" baseQueueManagerName="mqQ:baseQueueManagerName"
CCSID="1" integerEncoding="Normal" decimalEncoding="Normal"
floatingPointEncoding="IEEENormal" targetClient="JMS">

<propertySet xmi:id="J2EEResourcePropertySet 5">

<resourceProperties xmi:id="J2EEResourceProperty 5" name="mqQ:customName"
value="mqQ:customvalue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.mgseries:MQTopic" xmi:id="MQTopic_1"
name="mqT:name" jndiName="mqT:jndiName" description="mqT:description"
persistence="APPLICATION_DEFINED" priority="SPECIFIED" specifiedPriority="1"
expiry="SPECIFIED" specifiedExpiry="2" baseTopicName="mqT:baseTopicName" CCSID="3"
integerEncoding="Normal" decimalEncoding="Normal" floatingPointEncoding="IEEENormal"
targetClient="JMS" brokerDurSubQueue="mqT:brokerDurSubQueue"
brokerCCDurSubQueue="mqT:brokerCCDurSubQueue">

<propertySet xmi:id="J2EEResourcePropertySet 6">

<resourceProperties xmi:id="J2EEResourceProperty 6" name="mqT:customName"
value="mqT:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 7">

<resourceProperties xmi:id="J2EEResourceProperty 7" name="mgqJMSProvider:customName"
value="mqJMSProvider:customValue"/>

</propertySet>

</resources.jms:JMSProvider>

Example: Configuring WAS Queue and Topic connection factories and
destination factories for application clients

The purpose of this article is to help you configure WAS Queue connection factory, WAS Topic connection
factory, WAS Queue destination factory, and WAS Topic destination factory settings.
* Required fields:

— JMS Provider Properties page: name

— WAS Queue Connection Factory Properties page: name, jndiName and node
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— WAS Topic Connection Factory Properties page: name, jndiName, node and port
— WAS Queue Factory Properties page: name, jndiName, node, persistence, priority and expiry
— WAS Topic Factory Properties page: name, jndiName, topic name, persistence, priority and expiry

Special cases:

The port value must be QUEUED or DIRECT.

The CCSID must be a numerical value between -2417483648 and 2417483647.

The persistence value must be APPLICATION_DEFINED, PERSISTENT, or NONPERSISTENT.

The priority value must be APPLICATION_DEFINED, or SPECIFIED.

The expiry value must be APPLICATION DEFINED, UNLIMITED, or SPECIFIED

On the WAS Topic Factory Properties, and the WAS Queue Factory Properties pages, the specified
priority entry field must be an integer between 0 and 9, if the priority value is set to SPECIFIED .

On the WAS Topic Factory Properties, and the WAS Queue Factory Properties pages, the specified
expiry entry field must be a value greater than 0 if expiry is set to SPECIFIED.

Example:

<resources.jms:JMSProvider xmi:id="JMSProvider_2" name="WebSphere JMS Provider"
description="wasJMSProvider:description"
externallnitialContextFactory="wasJMSProvider:contextfactoryclass"
externalProviderURL="wasJMSProvider:providerURL">
<classpath>wasJMSProvider:classpath</classpath>

<factories xmi:type="resources.jms.internalmessaging:WASQueueConnectionFactory"
xmi:id="WASQueueConnectionFactory_1" name="wasQCF:name" jndiName="wasQCF:jndiName"
description="wasQCF:description" userID="wasQCF:user" password="{xor}KD4sDhwZZSos0i0="
node="wasQCF:Node">

<propertySet xmi:id="J2EEResourcePropertySet 8">

<resourceProperties xmi:id="J2EEResourceProperty 8" name="wasQCF:customName"
value="wasQCF:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.internalmessaging:WASTopicConnectionFactory"
xmi:id="WASTopicConnectionFactory_1" name="wasTCF:name" jndiName="wasTCF:jndiName"
description="wasTCF:description" userID="wasTCF:user" password="{xor}KD4sCxwZZTE+Mjo="
node="wasTCF:node" port="QUEUED" clientID="wasTCF:clientId">

<propertySet xmi:id="J2EEResourcePropertySet _9">

<resourceProperties xmi:id="J2EEResourceProperty 9" name="wasTCF:customName"
value="wasTCF:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.internalmessaging:WASQueue" xmi:id="WASQueue 1"
name="wasQ:name" jndiName="wasQ:jndiName" description="wasQ:description"
node="wasQ:node" persistence="APPLICATION_DEFINED" priority="SPECIFIED"
specifiedPriority="1" expiry="SPECIFIED" specifiedExpiry="1">

<propertySet xmi:id="J2EEResourcePropertySet 10">

<resourceProperties xmi:id="J2EEResourceProperty 10" name="wasQ:customName"
value="wasQ:customValue"/>

</propertySet>

</factories>

<factories xmi:type="resources.jms.internalmessaging:WASTopic" xmi:id="WASTopic_1"
name="wasT:name" jndiName="wasT:jndiName" description="wasT:description"
topic="wasT:topicName" persistence="APPLICATION_DEFINED" priority="SPECIFIED"
specifiedPriority="1" expiry="SPECIFIED" specifiedExpiry="1">

<propertySet xmi:id="J2EEResourcePropertySet 11">

<resourceProperties xmi:id="J2EEResourceProperty 11" name="wasT:customName"
value="wasT:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 12">

<resourceProperties xmi:id="J2EEResourceProperty 12" name="wasJMSProvider:customName"
value="wasJMSProvider:customValue"/>

</propertySet>

</resources.jms:JMSProvider>
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Configuring new resource environment providers for application
clients

During this task, you create new resource environment provider configurations for your application client.

To configure a new resource environment provider, perform the following steps:

1. Start the tool and open the EAR file for which you want to configure the new Java Message Service
(JMS) provider. The EAR file contents display in a tree view.

2. Select from the tree the JAR file in which you want to configure the new JMS provider.
3. Expand the JAR file to view its contents.

4. Click the Resource Environment Providers folder. Take one of the following actions:
* Right-click the provider folder, and click New Provider.
» Click Edit > New on the menu bar.

5. Configure the JMS provider properties in the displayed fields.
6. Click OK when you finish.
7. Click File > Save on the menu bar to save your changes.

Resource environment provider settings for application clients
Use this page to specify resource environment entry properties.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Resource Environment
Providers, and click New. The following fields are displayed on the General tab:

Name:

Specifies the administrative name for the resource environment provider.

Description:

Specifies a description of the resource environment provider for your administrative records.

Class Path:

Specifies the path to the JAR file that contains the implementation classes for the resource environment
provider.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Configuring new resource environment entries for application clients

During this task, you create new resource environment entries for your client application.
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new resource environment entry. The EAR file
contents are in the displayed tree view.
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3. Click the desired resource environment provider, and complete the following action to configure new
providers:
« |Configure a new resource environment provider

4. Expand the resource environment provider to view the resource environment entries folder.

5. Click the provider folder, and complete one of the following actions:
* Right-click the folder and select New Factory.
* Click Edit > New on the menu bar.

6. Configure the data source properties in the displayed fields.
7. Click OK.
8. Click File > Save on the menu bar to save your changes.

Resource environment entry settings for application clients
Use this page to specify resource environment entry properties.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Environment Providers >
resource environment instance. Right-click Resource environment entry, and click New. The following
fields appear on the General tab:

Name:

Specifies the administrative name for the resource environment entry.

Description:

Specifies a description of the URL for your administrative records.

JNDI Name:

Specifies the Java Naming and Directory Interface (JNDI) name for the resource, including any naming
subcontexts.

Use this name to link to the binding information of the platform. The binding associates the resources
defined in the deployment descriptor of the module to the actual (physical) resources bound into JNDI by
the platform.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Managing application clients

Perform the following tasks after deploying application clients. This task only applies to J2EE application
clients.

After deploying application clients on z/OS or OS/390, you might want to or need to update the resources

that you configured for those clients. To do so, you may complete one of the following tasks:

* Run the Application Client Resource Configuration Tool (ACRCT) on Windows, according to the
following steps, and then reinstall the application on z/OS; or
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+ [Run the ACRCT scripting tool on z/OS |

1. |Update data source and data source provider configurations.|

2. |Update URLs and URL provider configurations|

3. |Update mail session configurations.|

4. |Update JMS provider, connection factories, and destination configurations.|
5

6

7

Update MQ JMS provider, MQ connection factories, and MQ destination configurations.|
. Update Resource Environment Entry and Resource Environment Provider configurations.l
. |(Optional) Remove application client resources |

Updating data source and data source provider configurations with the
Application Client Resource Configuration Tool

During this task, you update the configuration of an existing data source or data source provider.

1. Start the tool and open the Enterprise Archive (EAR) file containing the data source or data source
provider. The EAR file contents display in a tree view.

2. Select Java Archive (JAR) file from the navigation tree containing the data source or data source
provider to update.

3. Expand the JAR file to view its contents until you locate the particular data source or data source
provider to update. Take one of the following actions:
* Right-click the data source object and click Properties.
» Click Edit > Properties on the menu bar.

4. Update the properties in the displayed fields. For detailed field help, go to:
» Data source provider properties
» Data source properties

5. Click OK when finished.
6. Click File > Save on the menu bar to save your changes.

Updating URLs and URL provider configurations for application clients

1. Start the tool and open the Enterprise Archive (EAR) file containing the URL or URL provider. The EAR
file contents are displayed in a tree view.

2. Select from the tree the Java Archive (JAR) file containing the URL or URL provider to update.
Expand the JAR file to view its contents.

4. Keep expanding the JAR file contents until you locate the particular URL or URL provider to update.
Take one of the following actions:

a. Right-click the URL object and click Properties.
b. Click Edit > Properties on the menu bar.
5. Update the properties in the displayed fields.
6. Click OK when you finish.
7. Click File > Save on the menu bar to save your changes.

w

Updating mail session configurations for application clients

During this task, you update the configuration of an existing JavaMail session. You cannot update the
name of the default JavaMail provider, and you cannot delete the default JavaMail provider from the
navigation tree.

1. Start the tool and open the Enterprise Archive (EAR) file containing the JavaMail session. The EAR file
contents are displayed in the navigation tree view.

2. Select the Java Archive (JAR) file containing the JavaMail session to update from the navigation tree.
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5.
6.
7.

Expand the JAR file to view its contents.

Keep expanding the JAR file contents until you locate the particular JavaMail session to update. Take
one of the following actions:

a. Right-click the object and click Properties

b. Click Edit > Properties from the menu bar.

Update the properties in the displayed fields.

Click OK when you finish.

Select File > Save from the menu bar to save your changes.

Updating Java Message Service provider, connection factories, and
destination configurations for application clients

During this task, you update the configuration of an existing Java Message Service (JMS) provider,
connection factory or destination.

1.

5.
6.

Start the tool and open the Enterprise Archive (EAR) file containing the Java Message Service (JMS)
provider, connection factory, or destination. The EAR file contents display in a tree view.

Select the Java Archive (JAR) file containing the JMS provider, connection factory, or destination to
update from the navigation tree.

Expand the JAR file to view its contents until you locate the particular JMS provider, connection
factory, or destination to update. When you find it, do one of the following actions:

* Right-click the provider, and click Properties.

» Click Edit > Properties on the menu bar.

Update the properties in the displayed fields. For detailed field help, see:
JMS provider properties

* WAS Queue connection factory properties

* WAS Topic connection factory properties

* WAS Queue destination properties

* WAS Topic destination properties

Click OK.
Click File > Save to save your changes.

Updating MQ Java Message Service provider, MQ connection factories,
and MQ destination configurations for application clients

During this task, you update the configuration of an existing MQ JMS provider, MQ connection factory, or
MQ destination.

1.
2.

Start the Application Client Resource Configuration Tool (ACRCT).

Open the Enterprise Archive (EAR) file containing the MQ JMS provider, MQ connection factory, or MQ
destination. The EAR file contents are displayed in the navigation tree view.

Select the Java Archive (JAR) file containing the MQ JMS provider, MQ connection factory, or MQ
destination to update.

Expand the JAR file to view its contents until you locate the particular MQ product JMS provider, MQ
connection factory or MQ destination that you want to update. Complete one of the following actions:
» Right-click the appropriate object and click Properties.

» Click Edit > Properties on the menu bar.

Update the properties in the displayed fields. For detailed field help, see:
» JMS provider properties

* MQ Queue connection factory properties

» MQ Topic connection factory properties

* MQ Queue destination properties
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* MQ Topic destination properties
6. Click OK.
7. Click File > Save to save your changes.

Updating resource environment entry and resource environment
provider configurations for application clients

During this task, you update the configuration of an existing resource environment entry or resource
environment provider.

1. Start the tool and open the Enterprise Archive (EAR) file containing the resource environment entry or
resource environment provider. The EAR file contents display in a navigation tree view.

2. Select from the tree the Java Archive (JAR) file containing the resource environment entry or resource
environment provider to update.

3. Expand the JAR file to view its contents until you locate the resource environment entry or resource
environment provider to update. Take one of the following actions:
* Right-click the resource environment object, and click Properties.
« Click Edit > Properties on the menu bar.

4. Update the properties in the displayed fields. For detailed field help, see:
+ |Resource environment provider properties|
+ |Resource environment entry properties|

5. Click OK when you finish.

6. Click File > Save on the menu bar to save your changes.

Example: Configuring Resource Environment settings
The purpose of this topic is to help you configure Resource Environment settings.
* Required fields:
— Resource Environment Provider page: name
— Resource Environment Entry page: name, jndiName
» Example:

<resources.env:ResourceEnvironmentProvider xmi:id="ResourceEnvironmentProvider 1"
name="resourceEnvProvider:name" description="resourceEnvProvider:description">
<classpath>resourcekEnvProvider:classpath</classpath>

<factories xmi:type="resources.env:ResourceEnvEntry" xmi:id="ResourceEnvEntry 1"
name="resourceEnvEntry:name" jndiName="resourceEnvEntry:jndiName"
description="resourceEnvEntry:description">

<propertySet xmi:id="J2EEResourcePropertySet 20">

<resourceProperties xmi:id="J2EEResourceProperty 22"
name="resourceEnvEntry:customName" value="resourceEnvEntry:customValue"/>
</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 21">

<resourceProperties xmi:id="J2EEResourceProperty 23"
name="resourcekEnvProvider:customName" value="resourceEnvProvider:customValue"/>
</propertySet>

</resources.env:ResourceknvironmentProvider>

Example: Configuring resource environment custom settings for application

clients

The purpose of this topic is to help you configure resource environment custom settings.

* The custom page applies to every resource type. You can specify as many custom names and values
as you need.

* Example:

<propertySet xmi:id="J2EEResourcePropertySet 20">

<resourceProperties xmi:id="J2EEResourceProperty 22"

name="resourceEnvEntry:customName" value="resourceEnvEntry:customValue"/>
</propertySet>
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Removing application client resources

The option to delete an item does not offer a confirmation dialog. As a safeguard, consider saving your
work right before you begin this task. If you change your mind after removing an item, you can close the
EAR file without saving your changes, canceling your deletion. Remember to close the EAR file
immediately after the deletion, or you also lose any unsaved work that you performed since the deletion.

This task only applies to J2EE application clients.

To remove resources for application clients running on z/OS or OS/390, you may complete one of the

following tasks:

* Run the Application Client Resource Configuration Tool (ACRCT) on Windows, according to the steps

below, and then reinstall the application on z/OS; or

Run the ACRCT scripting tool on z/OS

1. Start the Application Client Resource Configuration Tool (ACRCT) and open the Enterprise Archive
(EAR) file from which you want to remove an object. The EAR file contents display in the navigation
tree view. If you already have an EAR file open and have made some changes, click File > Save to
save your work before preceding to delete an object.

2. Locate the object that you want to remove in the tree.
3. Right-click the object, and click Delete.
4. Click File > Save.

Running application clients

The J2EE specification requires support for a client container that runs stand-alone Java applications
(known as J2EE application clients) and provides J2EE services to the applications. J2EE services include
naming, security, and resource connections.

You are ready to run your application client using this tool after you have:

1. Written the application client program.

2. Assembled and installed an application module (.ear file) in the application server run time.
3. Deployed the application using the Application Client Resource Configuration Tool (ACRCT).

This task only applies to J2EE application clients.

1. Pass parameters to the TaunchCTlient command or to your application client program as well. The
launchClient command allows you to do both. The TaunchCTlient command requires that the first
parameter is either:

* An EAR file specifying the application client to launch.
* Arequest for TaunchClient usage information.

All other parameters intended for the TaunchClient command must begin with the -CC prefix.

Parameters that are not EAR files, or usage requests, or that do not begin with the -CC prefix, are
ignored by the application client run time, and are passed directly to the application client program.

The TaunchClient command retrieves parameters from three places:

* The command line

* A properties file

» System properties

The parameters are resolved in the order listed above, with command line values having the highest
priority and system properties the lowest. Using this prioritization you can set and override default
values.
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2. Specify the server name. By default, the launchClient command uses the environment variable
COMPUTERNAME for the BootstrapHost property value. This setting is effective for testing your application
client when it is installed on the same computer as the server. However, in other cases override this
value with the name of your server.

You can override the BootstrapHost value by invoking TaunchClient command with the following
parameters:

launchClient myapp.ear -CCBootstrapHost=abc.midwest.mycompany.com

You can also override the default by specifying the value in a properties file and passing the file name
to the launchClient shell.

Security is controlled by the server. You do not need to configure security on the client because the
client assumes that security is enabled. If security is not enabled, the server ignores the security
request, and the application client works as expected.

You can store launchClient values in a properties file, which is a good method for distributing default
values. You can then override one or more values on the command line. The format of the file is one
launchClient -CC parameter per line without the -CC prefix. For example:

launchClient tool

This section describes the Java 2 Platform Enterprise Edition (J2EE) command line syntax for the
launchClient tool for WebSphere Application Server.

The following example illustrates the command line invocation syntax for the launchClient tool:
lTaunchClient [<userapp.ear> |-help|-?] [-CCname=value] [app args]

where

» userapp.ear is the path and the name of the EAR file that contains the application client
* name is the name of the parameter

* value is the value to which the parameter ID is set

* app args are arguments that pass to the application client

To print the usage information, the first parameter must be a path and a name to an Enterprise Archive
(EAR) file, -help, or -?. All other parameters are optional and can appear in any order. The application
client run time ignores any optional parameters that do not begin with a -CC prefix, and passes them to the
application client.

Parameters

Supported arguments include:

-CCsoapConnectorPort
The Simple Object Access Protocol (SOAP) connector port. If you do not specify this argument, the
WebSphere Application Server default value is used.

-CCverbose
This option displays additional information messages. The default is false.

-CCclasspath
A class path value. When you launch an application, the system class path is not used. If you want to
access classes that are not in the EAR file or part of the resource class paths, specify the appropriate
class path here. Multiple paths can be concatenated.

-CCjar
The name of the client Java Archive (JAR) file that resides within the EAR file for the application you
wish to launch. Use this argument when you have multiple client JAR files in the EAR file.
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-CCadminConnectorHost
Specifies the host name of the server from which configuration information is retrieved. The default is
the value of the -CCBootstrapHost parameter or the value of the local host if the -CCBootstrapHost
parameter is not specified.

-CCadminConnectorPort
Indicates the port number for the administrative client function to use. The default value is 8880 for
SOAP connections and 2809 for Remote Method Invocation (RMI) connections.

-CCadminConnectorType
Specifies how the administrative client connects to the server. Specify RMI to use the RMI connection
type, or specify SOAP to use the SOAP connection type. The default value is SOAP.

-CCadminConnectorUser
Administrative clients use this user name when a server requires authentication. If the connection type
is SOAP, and security is enabled on the server, this parameter is required. The SOAP connector does
not prompt for authentication.

-CCadminConnectorPassword
The password for the user name that the -CCadminConnectorUser parameter specifies.

-CCaltDD
The name of an alternate deployment descriptor file. This parameter is used with the -CCjar parameter
to specify the deployment descriptor to use. Use this argument when a client JAR file is configured
with more than one deployment descriptor. Set the value to null to use the client JAR file standard
deployment descriptor.

-CCBootstrapHost
The name of the host server you want to connect to initially. The format is:
your_server_of choice.com

-CCBootstrapPort
The server port number. If you do not specify this argument, the WebSphere Application Server default
value is used.

-CCproviderURL
Provides bootstrap server information that the initial context factory can use to obtain an initial context.
WebSphere Application Server initial context factory can use either a Common Object Request Broker
Architecture (CORBA) object URL or an Internet Inter-ORB Protocol (IIOP) URL. CORBA object URLs
are more flexible than IIOP URLs and are the recommended URL format to use. This value can
contain more than one bootstrap server address. This feature can be used when attempting to obtain
an initial context from a server cluster. You can specify bootstrap server addresses, for all servers in
the cluster, in the URL. The operation will succeed if at least one of the servers is running, eliminating
a single point of failure. The address list does not process in a particular order. For naming operations,
this value overrides the -CCBootstrapHost and -CCBootstrapPort parameters. A CORBA object URL
specifying multiple systems is illustrated in the following example:

-CCproviderURL=corbaloc:iiop:myserver.mycompany.com:9810, :mybackupserver.mycompany.com:2809

This value is mapped to the java.naming.provider.url system property.

-CCinitonly
Use this option to initialize application client run time for ActiveX application clients without launching
the client application. The default is false.

-CCtrace
Use this option to obtain debug trace information. You might need this information when reporting a
problem to IBM customer support. The default is false For more information, read the topic "Enabling
trace” in the information center.
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-CCtracefile
Indicates the name of the file to which trace information is written. The default is to write output to the
console.

-CCpropfile
Indicates the name of a properties file that contains launchClient properties. Specify the properties
without the -CC prefix in the file. For example: verbose=true.

-CCsecurityManager
Enables and runs the WebSphere Application Server with a security manager. The default is disable.

-CCsecurityMgrClass
Indicates the fully qualified name of a class that implements a security manager. Only use this
argument if the -CCsecurityManager parameter is set to enable. The default is
java.lang.SecurityManager.

-CCsecurityMgrPolicy
Indicates the name of a security manager policy file. Only use this argument if the -CCsecurityManager
parameter is set to enable. When you enable this parameter, the java.security.policy system
property is set. The default is <install root>/ properties/client.policy.

-CCD
Use this option to have the WebSphere Application Server set the specified system property during
initialization. Do not use the equals (=) character after the -CCD. For example:
-CCDcom. ibm.test.property=testvalue. You can specify multiple -CCD parameters. The general format
of this parameter is -CCD<property key>=<property value>.

-CCexitVM
Use this option to have the WebSphere Application Server call the System.exit() method after the
client application completes. The default is false.

-CCdumpJavaNameSpace
Prints out the Java portion of the Java Naming and Directory Interface (JNDI) name space for
WebSphere Application Server. The true value uses the short format that prints out the binding name
and the type of the object bound at that location. The Tong value uses the long format that prints out
the binding name, bound object type, local object, type and string representation of the local object, for
example, IORs and string values. The default value is false.

-CCtraceMode
Specifies the trace format to use for tracing. If the valid value, basic, is not specified the default is
advanced. Basic tracing format is a more compact form of tracing. For more information on basic and
advanced trace formatting, read the topic "Interpreting trace output” in the information center

The following examples demonstrate correct syntax.

On the Windows operating system:
TaunchClient c:\earfiles\myapp.ear -CCBootstrapHost=myWASServer -CCverbose=true
app_parml app_parm2

On the UNIX operating system:
./launchClient.sh /usr/earfiles/myapp.ear -CCBootstrapHost=myWASServer -CCverbose=true
app_parml app_parm2

Specifying the directory for an expanded EAR file

Each time the launchClient tool is called, it extracts the Enterprise Archive (EAR) file to a random directory
name in the temporary directory on your hard drive. Then the tool sets up the thread ClassLoader to use
the extracted EAR file directory and JAR files included in the Manifest.mf client Java Archive (JAR) file. In
a normal J2EE Java client, these files are automatically cleaned up after the application exits. This
cleanup occurs when the client container shutdown hook is called. To avoid extracting the EAR file (and
removing the temporary directory) each time the launchClient tool is called, complete the following steps:
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1. Specify a directory to extract the EAR file by setting the
com.ibm.websphere.client.applicationclient.archivedir Java system property. If the directory does
not exist or is empty, the EAR file is extracted normally. If the EAR file was previously extracted, the
launchClient tool reuses the directory.

2. Delete the directory before running the launchClient tool again, if you need to update your EAR file.
When you call the TaunchClient command, it extracts the new EAR file to the directory. If you do not
delete the directory or change the system property value to point to a different directory, the
launchClient tool reuses the currently extracted EAR file and does not use your changed EAR file.
When specifying the com.ibm.websphere.client.applicationclient.archivedir property, make sure
that the directory you specify is unique for each EAR file you use. For example, do not point the
MyEarl.ear and the MyEar2.ear files to the same directory.

Application client troubleshooting tips

This section provides some debugging tips for resolving common Java 2 Platform Enterprise Edition
(J2EE) application client problems. To use this troubleshooting guide, review the trace entries for one of
the J2EE application client exceptions, and then locate the exception in the guide. Some of the errors in
the guide are samples, and the actual error you receive can be different than what is shown here. You
might find it useful to rerun the TaunchClient command specifying the -CCverbose=true option. This option
provides additional information when the J2EE application client run time is initializing

Error: java.lang.NoClassDefFoundError

Explanation This exception is thrown when Java code cannot load the specified class.
Possible causes * Invalid or non-existent class

» Class path problem

* Manifest problem
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Recommended
response

Check to determine if the specified class exists in a Java Archive (JAR) file within your
Enterprise Archive (EAR) file. If it does, make sure the path for the class is correct. For
example, if you get the exception:

java.lang.NoClassDefFoundError:
WebSphereSamples.HelToEJB.HelloHome

verify that the HelloHome class exists in one of the JAR files in your EAR file. If it exists,
verify that the path for the class is WebSphereSamples.HelloEJB.

If both the class and path are correct, then it is a class path issue. Most likely, you do not

have the failing class JAR file specified in the client JAR file manifest. To verify this situation,

perform the following steps:

1. Open your EAR file with the Application Assembly Tool Assembly Toolkit and click the
Application Client.

2. Add the names of the other JAR files in the EAR file to the Classpath field.

This exception is generally caused by a missing Enterprise Java Beans (EJB) module name
from the Classpath field.

If you have multiple JAR files to enter in the Classpath field, be sure to separate the JAR
names with spaces.

If you still have the problem, you have a situation where a class is loaded from the file
system instead of the EAR file. This error is difficult to debug because the offending class is
not the one specified in the exception. Instead, another class is loaded from the file system
before the one specified in the exception. To correct this error, review the class paths
specified with the -CCclasspath option and the class paths configured with the Application
Client Resource Configuration Tool, or the Client Container Resource Configuration Scripting
tool for z/OS. Look for classes that also exist in the EAR file. You must resolve the situation
where one of the classes is found on the file system instead of in the .ear file. Remove
entries from the classpaths, or include the .jar files and classes in the .ear file instead of
referencing them from the file system.

If you use the -CCclasspath parameter or resource classpaths in the Application Client
Resource Configuration Tool, or the Client Container Resource Configuration Scripting tool for
z/OS, and you have configured multiple JAR files or classes, verify they are separated with
the correct character for your operating system. Unlike the Classpath field in the Application
Assembly Tool Assembly Toolkit, these class path fields use platform-specific separator
characters, usually a colon (on UNIX platforms) or a semi-colon (on Windows systems).
Note: The system class path is not used by the Application Client run time if